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For your safety and protection of the BrailleSense 6, please read and abide by the following safety precautions.
The input voltage of the AC adapter is 100V - 240V, and the outputs are DC 5V 3A and 9V 2A
When the BrailleSense 6 is shipped, the battery may be packaged separate from the unit to avoid damage. When you use the BrailleSense 6 for the first time, you may need to open the package, remove the battery, and insert it into the battery slot at the underside of the unit. (See section 1, introduction, for more details on inserting the battery.) It is possible that the dealer or distributor from whom you purchased the BrailleSense 6 has already done this for you. The battery may not be fully charged when it is shipped. Before you use the BrailleSense 6, you should ensure the battery is fully charged. 
When you use the BrailleSense 6 with the battery for the first time, the battery status may not be displayed accurately. To avoid this, leave the BrailleSense 6 connected to the AC adapter for about five hours with the unit turned on. If you want to use the BrailleSense 6 immediately, you may use it while it is charging.
If you want or need to remove the battery from the unit, power the unit off, and then remove the battery. If the unit is connected to AC power, before re-inserting the battery into the unit, make certain that the power is off.
There is a risk of explosion if the battery is replaced by an incorrect type. Please make certain to use only battery packs produced specifically for the BrailleSense 6 by SELVAS Healthcare. Please dispose of used batteries according to the instructions.
If the usage time is less than 50% as compared to the stated battery run time in the product specifications, even after a full charge, it is recommended that you replace the battery.
It is recommended to remove and store the battery separate from the product during long periods of disuse.
If you drill into or disassemble the product or battery using a sharp point, it may cause electric shock, explosion or fire.
When you are using the BrailleSense 6 on battery power, the status of the remaining battery power is announced when the battery charge is low. When the battery’s charge falls below 15 percent, connect the AC adapter to the unit for recharging. If the remaining battery charge drops to five percent, and the unit is not connected to the AC adapter, the BrailleSense 6 goes in to Sleep Mode one minute after the announcement of the battery’s status. If the battery level falls to 2%, the unit shuts down to preserve settings, etc. The amount of battery life per charge varies depending on the options you have set and the number and type of tasks you are running.
Your BrailleSense 6 needs to be handled with care. The BrailleSense 6 is a very delicate machine. Please handle the unit in a proper, careful manner. The BrailleSense 6 is very sensitive to dust. Make sure to keep it away from dusty environments.
The Braille cells are very sensitive, intricate parts. If the Braille cells are not working properly due to the presence of dust or for any other reason, please contact our repair center, or the dealer from whom you purchased the BrailleSense 6 for support.
You should register your BrailleSense 6 in order to ensure further maintenance, service, and upgrade information. In North America, please visit www.selvasblv.com, to register your information. If you have any trouble when registering your information, please contact the dealer from whom you purchased your BrailleSense 6 for help. International customers should contact their regional dealer for product registration information.
Do not disassemble the BrailleSense 6 yourself. Do not have anyone else who is not authorized by HIMS take apart the BrailleSense 6. If an unqualified person disassembles the unit, serious damage may occur. If an unauthorized person disassembles the unit, it is excluded from any free maintenance, and the warranty becomes void. If any liquid or external force damages the unit, it may also be excluded from free maintenance, even if the damage occurs during the warranty period. The BrailleSense 6 contains a Liquid Contact Indicator sticker that will change color if the unit comes in contact with water or other liquids. This indicator will not activate under humid or other conditions that fall within the product’s normal environmental requirements. 
Do not leave your BrailleSense 6 in closed, high temperature environments such as inside a car on a hot summer day, as the battery may be damaged or catch fire. Please do not let your BrailleSense 6 remain in such environments for long periods of time. 
To prevent possible damage to your hearing, do not listen to audio at high volume levels for long periods.
Operation is subject to the following two conditions.
1. This device may not cause harmful interference, and
2. This device must accept any interference received, including interference that may cause undesired operation.
This equipment can generate, use and radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. 
If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.



FCC regulatory conformance: 
 This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
1. This device may not cause harmful interference.
1. This device must accept any interference received, including interference that may cause undesired operation.
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. 
This equipment generates uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:
- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help
NOTE: The manufacturer is not responsible for any radio or TV interference caused by unauthorized modifications to this equipment. Such modifications could void the user’s authority to operate the equipment. 
RF Exposure Information and Statement
The SAR limit of USA (FCC) is 1.6 W/kg averaged over one gram of tissue. Device types Tablet PC (FCC ID: 2AL4DH632B) has also been tested against this SAR limit. The highest SAR value reported under this standard during product certification for use on the body is 2.4GHz:0639W/kg, 5GHz:0.973W/kg. This device was tested for typical body-worn operations with the back of the handset kept 0mm from the body. To maintain compliance with FCC RF exposure requirements, use accessories that maintain a 0mm separation distance between the user's body and the back of the handset. The use of belt clips, holsters and similar accessories should not contain metallic components in its assembly. The use of accessories that do not satisfy these requirements may not comply with FCC RF exposure requirements, and should be avoided.
5G WIFI indoor used only



[bookmark: _Toc26183630][bookmark: _Toc26183921]I. Your BrailleSense 6 packing box should contain the following items:
1. BrailleSense 6
1. Battery
1. Carrying Case
1. AC Adapter
1. USB C to C Cable 
1. Earbuds
1. Braille Commands Summary
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In this manual you will see references to hot keys and shortcut keys. These keys refer to ways to access menus and functions quickly by using a combination of keystrokes. Please note that not all hot keys and shortcut keys will work from every location on the BrailleSense 6. Some hot keys and shortcut keys are program specific, thus, they require that you be within a specific program for them to work.
Shortcut keys refer to keystrokes used to quickly activate a function from within a menu. Hot keys refer to keys that will activate a function regardless of where you are within the program. When functions are described in this manual, shortcut keys are shown in parentheses, and hot keys are shown in quotes.
This user manual notes how to press hot keys and shortcut keys in the following manner: Keys that are to be pressed at the same time are separated by a - (dash). When you see “Space-b (dots 1-2),” this means that you should press “Space” and dots 1 and 2 simultaneously.
[bookmark: _Toc317238628][bookmark: _Toc317251256][bookmark: _Toc9263827]If you are unable to find a solution to a problem within the manual, or if you need assistance with the BrailleSense 6, please email us at support@selvasblv.com. You may also visit us on the web at www.selvasblv.com or call us at 512-837-2000.
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[bookmark: _Toc209372102]1. Introduction
[bookmark: _Toc492453807][bookmark: _Toc26179696][bookmark: _Toc209372103]1.1 What is the BrailleSense 6?
The BrailleSense 6 is a HIMS branded Braille note taker developed and manufactured by SELVAS Healthcare, for people who are blind and visually impaired. The BrailleSense 6 has a variety of powerful capabilities, including the following.
1. Read TXT, BRF, RTF, PDF, EPUB, and Microsoft Word, Excel and PowerPoint files. Take notes or create formatted documents and e-mails.
2. Play media, DAISY books, and FM Radio and YouTube videos, and stream content from 3rd party services such as Apple music and Netflix.
3. Organize your Appointments and contacts, and synchronize all information with your Google Account.
4. Perform scientific and graphic calculations, set alarms, and explore and set appointments using the Lunar and solar calendars.
5. Use the BrailleSense 6 as a USB or Bluetooth Braille display with a compatible screen reader, such as JAWS, NVDA, SuperNova, Microsoft Narrator, VoiceOver for Mac and iOS and TalkBack for Android™.
6. Use the built-in GPS sensor and digital compass to navigate independently without the need for external devices.
7. Download and install apps on Google Play.
8. Utilize Google Services such as Google Drive, Google Docs, Google Sheets, Google Slides, and Google Classroom via our included screen reader, specially customized to enhance access to these applications.
9. Attend or present at virtual meetings or conferences via Zoom, Google Meet, Microsoft Teams or other accessible platforms.
10. Obtain information and perform functions using your voice with the included Google Assistant, or third party voice assistants like Amazon Alexa.
11. Connect to your favorite smart watch for portable access to BrailleSense notifications and services.
12. Use the built-in 13 megapixel camera, or an external USB camera to scan printed materials, join a video conference, or get sighted assistance from friends and family or via apps such as Envision or AIRA.
13. Use the 3 available USB host ports to connect and use compatible devices such as USB portable monitors, keyboards and mice, USB audio devices, printers, and other Android compatible USB peripherals.

[bookmark: _Toc492453808][bookmark: _Toc26179697][bookmark: _Toc209372104]1.2 Physical Tour
To get the most from your BrailleSense 6, it is important to become oriented to the buttons and ports as well as learning their functions. This section will orient you to your BrailleSense.
Place the BrailleSense on a desk or table top with the Braille display nearest you. 

[bookmark: _Toc492453809][bookmark: _Toc26179698][bookmark: _Toc209372105]1.2.1 The Top Panel
On the top face of the BrailleSense 6 is located a 9 key Perkins-style keyboard, consisting of Braille dots 1:6, "SPACE", "BACKSPACE", and "ENTER". 
On the same row as the Space bar are Control and Alt, as well as 4 marked function keys. Moving from left to right, the row contains F1, F2, Control, Space, Alt, F3 and F4.
Below the keyboard is a 32 cell Braille display. Above the Braille display, there are cursor routing buttons corresponding to each of the 32 Braille cells. When you are editing documents, you can use these keys to route your cursor to the character of the corresponding Braille cell. The cursor routing keys also serve as shortcut keys for navigating lists and groups of fields in certain places on the unit. A dot is placed on each 5th cursor routing button for easier orientation. 
On each side of the Braille display are two capsule shaped keys. These are the "UP" and "DOWN" scroll keys. The scroll keys are used to scroll the Braille display through menus, fields, lists or text. You can use the scroll keys to scroll by display length, paragraph, line, sentence, or character. You can set the left and right sets of scroll keys independently in the "Global Options". (See chapter 3.) 
Near the top center of the unit's top panel, is a liquid crystal display (LCD). The LCD displays the output of the unit visually so that a sighted person can see what is shown on the BrailleSense 6. There are also 2 LED indicators to the right of the LCD. The indicator nearest the LCD shows On/Off status, and the LED to the right indicates charging status.
Stereo speakers are located on the top left and right corners for audio output.

[bookmark: _Toc492453810][bookmark: _Toc26179699][bookmark: _Toc209372106]1.2.2 The Right Panel
[bookmark: _Hlk66092663]The Right edge of the BrailleSense 6 contains 3 USB ports, 2 USB C ports with a USB A port between them. The USB C port nearest the rear of the unit is for powering and charging the unit, as well as connecting to a PC for use as a Braille display, to transfer data, or operate the BrailleSense using Android companion software for Windows. The USB C port nearest the front of the unit is used to connect portable video monitors, and will host other compatible USB C devices as well. To eliminate confusion over which port offers which functions, Braille letter indicators are placed on the top of the casing near each port: the letter p for the power and data port, and the letter v for the video and host port. 
Between the 2 USB C ports is an additional USB A host port for connecting drives, printers, audio devices, cameras, etc.

[bookmark: _Toc492453811][bookmark: _Toc26179700][bookmark: _Toc209372107]1.2.3 The Left Panel
Near the front of the unit on the left panel are 2 small buttons for raising and lowering the master volume of the unit. Use the button nearer the front to decrease the volume, and the button behind it to increase it.
Behind the volume buttons are located 2 small, round jacks. The one nearest the front is the stereo headphone jack, and the one nearer the rear of the unit is the stereo microphone jack for connecting a stereo microphone or line level recording source. 
Nearest the back of the left panel is an SD card slot for auxiliary storage.

[bookmark: _Toc492453812][bookmark: _Toc26179701][bookmark: _Toc209372108]1.2.4 The Rear Panel
The rear panel of the BrailleSense 6 contains another USB A host port, for connecting drives, keyboards and mice, cameras, printers, audio gear and other compatible USB peripherals.

[bookmark: _Toc492453813][bookmark: _Toc26179702][bookmark: _Toc209372109]1.2.5 The Front Panel
On the far left of the front panel is located a 3-position slide switch. This is the key "Lock" switch. This switch is explained in more detail in section 2.11 of this manual.
To the right of it is another 3-position slide switch. This is the "Media Mode" switch, and determines which type of content the front panel buttons control. This switch is explained in more detail in the next chapter.
To the right of the "Media Mode" switch, are five buttons, with a dot on the center one. These buttons control media and DAISY playback as well as providing shortcut keys for other areas of the unit when they are set to Application Mode. As explained above, the type of content controlled by these buttons depends on the position of the "Media Mode" switch. These five buttons are explained further in subsequent chapters of this manual.
To the right of the media buttons is the Power button. To turn on the unit, press and hold this button until you hear a beep and feel a vibration. The first time you power on the unit, it will take some time to boot up. 
Once the unit boots, you can press the Power button quickly to put the unit in standby "screen off" mode. This is similar to locking the screen on a phone or tablet. Press it quickly again to unlock it and return to the position at which you entered Screen off Mode. Press and hold the Power button to completely power down the system. After holding “Power” for around 3 seconds, a menu is displayed offering 3 options: “Power Off”, “Restart” and “Cancel. Press “Enter” on your desired option.


[bookmark: _Toc492453814][bookmark: _Toc26179703][bookmark: _Toc209372110]1.2.6 The Bottom Face
The underside of the unit contains the battery compartment and the camera. The battery contains a rounded edge along one of the sides of its length. This rounded edge should be placed alongside the back edge of the unit's casing. The battery has 2 small protrusions that should be pointed to the right. Place the battery in the unit right side first, and then press down on the left side to click it into place. To remove the battery, Use a finger to pull the battery release lock toward the left edge of the unit, and pull the battery out.
The 13 megapixel camera is located near the upper right corner of the underside of the unit. Applications for OCR and photo capture can be downloaded on Google Play. For best results, hold the BrailleSense 9 to 12 inches above the paper, with the unit off set to the left to account for the camera position. 
Congratulations! You are now familiar with the basic functions of the buttons and ports of the BrailleSense 6. The rest of the manual discusses each function in greater detail to help you maximize the potential of your BrailleSense 6.
[bookmark: _Toc492453815][bookmark: _Toc26179704][bookmark: _Toc209372111]1.3 Hardware Specifications
[bookmark: _Hlk66092550]1. Operating system: Android™ 12
2. Internal storage: 128GB UFS 2.1 (around 100GB available to user).
3. RAM: 6GB LPDDR4X.
4. CPU: Octa-core (4 x 2.0 GHz A76, 4 x 2.0 GHz A55)
5. Battery: Lithium Polymer (detachable), 4590mAh.
6. Battery running time: About 18 hours (with Braille and TTS, internal speaker at mid volume)
7. Keyboard: 9 key Perkins-Style Braille keyboard, Control and Alt, 4 function keys, 32 cursor routing keys, 4 scroll buttons.
8. Additional buttons and switches: key lock switch, Media Mode switch, 5 media buttons.
9. Braille display: 32 refreshable Braille cells.
10. Visual Display: internal LCD, DP to HDMI via USB C.
11. Wireless: Wi-Fi: 802.11ac, Dual-band, 2T2R MU-MIMO (IEEE a/b/g/n compatible); Bluetooth: 5.1 dual mode for LE and Classic
12. Sensors: GPS, RTC, Accelerometer, Compass, Gyroscope
13. Camera: 13 MP Sony internal Camera, External USB camera supported.
14. Interface: USB C x 2, USB A x 2, 1 SD card slot (FAT32 and exFAT supported)
15. Sound: Internal stereo speakers, stereo headphone jack.
16. Voice recording: Internal stereo microphones, external stereo microphone/Line In jack, headset microphone, USB audio supported. 
17. Vibrate motor: installed.

[bookmark: _Toc492453816][bookmark: _Toc26179705][bookmark: _Toc209372112]1.4 Memory on the BrailleSense 6
The BrailleSense 6 has 6GB of RAM (random access memory) and 128GB of flash memory. The RAM is memory reserved for running programs. RAM is a temporary storage area for any program files that are running or any currently open documents. The data in the RAM area disappears if your battery depletes, and the AC adapter is not connected. The RAM data also disappears when BrailleSense 6 reboots for any reason. This means, if you have an open document which you have not saved, the unsaved data disappears.

[bookmark: _Toc492453817][bookmark: _Toc26179706][bookmark: _Toc209372113]2. Basic Functions of the BrailleSense 6
[bookmark: _Toc492453818][bookmark: _Toc26179707][bookmark: _Toc209372114]2.1 How to Enter Commands
The commands used to operate the BrailleSense are comprised of various combinations of the Braille and function keys. In this user manual, the "-" (dash) is used to indicate that keys should be pressed simultaneously. For example, "Space-Z" indicates that the user should press "space" and Z at the same time. This manual also contains expressions like "Space-2-4-6". This means that the spacebar with dots 2, 4, and 6 should be pressed and released simultaneously. 
In a menu or dialog, when your cursor is placed on your desired command, you can execute most commands by pressing "Enter". To cancel a function or close a program or menu, and return to your previous location, press "Space-Z".
· Note: In Android applications, “Space-Z” serves as the “Back” button. You can also use “Space-E” or “F4” as Android “Back” button, used to move back one screen, or exit your current function or application. 

[bookmark: _Toc492453819][bookmark: _Toc26179708][bookmark: _Toc209372115]2.1.1 Basic Alerts and Messages
There are instances where the BrailleSense alerts you to events for which you have asked it to notify you. For example, by default, the BrailleSense checks the Schedule Manager when you power on, and notifies you of any appointments scheduled for that day. When you are notified of an appointment, you can interact with the Schedule Manager as you normally would. To exit the Schedule Manager, press "Space-Z" or "Space-E" and you are returned to your previous location. 
Other BrailleSense system messages are displayed and spoken, and automatically disappear when any key is pressed, or after a set number of seconds. For example, when you connect the AC adapter to the BrailleSense, the BrailleSense speaks the message "AC adapter connected." When you disconnect it, the BrailleSense says, "AC adaptor disconnected."
You will also hear alerts from Android system and applications. You can review Android notifications by pressing “Space-1-2-3-4-5-6”, and can delete most notifications using “Space-D”. Press Enter on the notification to open the associated program. You can control how various notifications and alerts are handled in the Global options. (See Chapter 3)

[bookmark: _Toc492453820][bookmark: _Toc26179709][bookmark: _Toc209372116]2.2 Menu Concepts
Menus on the BrailleSense provide you with a list of programs, actions, or options from which you can select. If a menu item has a sub menu, selecting it brings up another list of choices.
Let's begin exploring the various menus. First, turn the unit on as explained in chapter 1. Now, bring up the "Program" menu by pressing "F1". The "Program" menu is the main menu of the BrailleSense. You can access all of the programming, option settings, utilities, and help from this menu, as well as Google Play and installed apps. 
The "Program" menu consists of the File Manager program at the top, followed by 13 sub menus: office Tools, Media, Library, Organizer, Web Tools, Extras, Utilities, Clock and timer, Settings, Help and Information, Android Apps, optional Add-Ons, and favorite Apps. 
The first item in the "Program" menu is "File Manager". If "Space-4" is pressed, the next menu item is displayed and spoken. Pressing "Space-4" repeatedly, continues your navigational progress down the list of items in the "Program" menu. When you reach the bottom of the list, the "Favorite Apps" menu item is displayed as it is the last item in the "Program" menu. 
You could also jump quickly to the "Favorite Apps" menu item by pressing "Space-4-5-6" when "File Manager" is displayed. Press "Space-1-2-3," and the BrailleSense jumps back to the top. Press "Enter" on an item you want to execute or open. If you are in a submenu, and wish to return to the main "Program" menu, press "Space-E" or F4. 
The ”Office Tools” menu contains the “Word Processor”, “Notepad”, “E-mail” and “Excel viewer”. 
The "Media" menu contains the "Media Player", "FM Radio", "Podcasts", “Web radio”, “Voice Recorder” and “Video search”. 
The “Library” menu contains the “DAISY Player”, “Document Reader”, “Online DAISY”, “BookShare Download” and “Sense Dictionary”, as well as any optional library add-ons you have installed.
The "Organizer" menu contains the "Address Manager", "Schedule Manager", “Database Manager” and “ToDo List”. 
The "Web Tools" menu contains the "Web Browser", “Google Search” and “Wiki search”, as well as the optional Chat GPT add-on should you choose to install it. 
The "Extras" menu contains the “Braille Practice” application as well as the sense Dice Game”, “Sense Brain game” and “Sense Roulette Game”. 
The "Utilities" menu contains the "Calculator", “BrailleSense Math”, "Display Compass Heading", "Terminal for Screen reader", "Display Network Status", "Display Power status", “Backup/Restore Flashdisk”, "Format", “Macro Manager” and "Upgrade BrailleSense Firmware".
The “Clock and Timer” menu contains "Display time and Date", “Set Time and date”, “World Clock”, "Wake Up Alarm", "Stopwatch" and "Sleep Timer".
The "Settings" menu contains “Braille options”, “Voice options”, “General Options”, "Setup Internet", "Bluetooth Manager", “Menu Manager”, "Backup/Restore Settings", "Password Protection", "Initialize BrailleSense Options”, “Re-install default Apps”, “Braille Learning tables”, “Language Profiles”, “Android Backup and reset” and “Android System Settings”.
[bookmark: _Hlk529274190]The "Help and Information" menu contains the “Quick start Guide”, a navigable version of the User Guide, the latest release Note, an option to “View device Name”, and general “Information” about your device. 
The "Android Apps" menu contains The "Play Store" where you can search for and download native Android apps, followed by a list of all apps installed on the unit. When the unit ships, this list contains basic Google apps such as YouTube and YouTube Music, Chrome, photos, Google Meet, and Drive. It also contains an “App Installer” from which you can more easily download and install popular accessible Android applications, as well as a “Shortcuts Manager” where you can assign global hot keys to shortcuts built in to Android apps.
The “Optional Add-Ons” menu contains programs that are written specifically for the BrailleSense, but do not ship on it for any number of reasons, rather, they are available from this menu for convenient download and installation for those who want them. The “Download” area of the Optional Add-Ons menu displays available programs in a list along with the menu they will be installed to. Press “Enter” to download an install the focused application to your BrailleSense.
The ”Favorite Apps” menu contains applications you choose to save to this menu for quicker access. See the section of this manual on the “Menu Manager” for instructions. You can call the “Favorite Apps” list from anywhere on the unit by pressing “Control-F1”.
For more information on a specific menu or program, please see the related section of this user manual. For information on using and installing additional apps, see the chapter on using third party apps and accessories.
The "F1" command for accessing the "Program" menu is an example of a global hotkey. This means that pressing the "F1" key takes you to the "Program" menu immediately from anywhere on the BrailleSense. 
There are also global quick launch commands for most BrailleSense programs, usually comprised of either F1 or F3 and a letter or dot combination. These quick launch commands immediately launch their associated application from anywhere on the BrailleSense. See section 16.2 for a complete list of the quick launch commands. 
You can also search for apps and uninstall non-BrailleSense apps from the Main Menu/Android Apps list. To uninstall any 3rd party app, press “Space-D” when you are focused on it. You are prompted if you are sure you wish to uninstall the app, press “Enter” to confirm.
Searching for apps may be useful if you have many apps installed, or if you want to see which apps you have in a certain category, such as mail or music. Press “Space-F” from the Main Menu/Android Apps list, and you are prompted to enter your search term. Type it, and press Enter, and results matching your search are displayed.
Press “Enter” on an app in the list to execute it. And again, you can Press “Space-D” on any 3rd party app to uninstall it.
When using a program on the BrailleSense, press "Space-M" or F2 to bring up its program specific menu. Press the "Up" scroll key or "Space-1" to move to the previous item, and press the "Down" scroll key or "Space-4" to move to the next item. 
To move to the first item in the menu, press "Space-1-2-3." To move to the last item in the menu, press "Space-4-5-6." When placed on the first item of a sub menu, pressing "Backspace" returns you to the upper Menu. To repeat the current item, press "Space-R". To open a sub menu or execute the current item, press “Enter”. 
You can also quickly jump to and execute a menu item by pressing the menu item's shortcut key, usually the first letter of the item name. 
Often, menu items can also be executed instantly, directly from your current position in the program, with a hotkey. Shortcut keys are displayed in parentheses following the menu names. Hotkeys generally consist of a modifier such as "Enter," "Space," or "Backspace", pressed simultaneously with a letter or dot combination. These are displayed following the shortcut keys.
For example, if you are in the Notepad, and press "Space-M" or "F2," then press "Enter" on "File," you hear "New (n) pull down Enter-n". The word "New" is the menu option. You would press the letter N to jump to "New" from within the "File" menu. Press "Enter-n" to access the "New" document command from anywhere in the Notepad. The n is the shortcut key and "Enter-n" is the hotkey. It is important to note that some hotkey commands are global, thus will work from anywhere on the unit, and some are program specific. For example, if you want to activate the "new document" option in the Notepad, you cannot press "Enter-n" from the "Program" menu to activate this option. You must be in the Notepad for "Enter-n" to activate the "new document" command. However, if you wish to activate the "display time and Date" option in the "Utilities" menu, this can be done from anywhere on the unit using "Space-T" as this is a global hot key. 

[bookmark: _Toc492453821][bookmark: _Toc26179710][bookmark: _Toc209372117]2.2.1 Control Symbols
The BrailleSense 6 uses several control symbols to note the type of information being displayed: examples are list items, menus, and edit boxes. These symbols can appear "Before" or "After" the text, or the appearance of this information may be set to "off", determined by the "Control information" setting in the "Global Options". For example, if "Control information" is set to "before", and you bring up the Word Processor's program menu, The BrailleSense displays, "MN File (f) pull down".
· Note: In the Web Browser, the control symbols are displayed even if the "Control information" is set to "off".
The following table shows the types of controls and the symbols that are used to indicate them.

Name
Symbol
Comments
Menu
MN
A menu that has submenus.
Menu item
MI
A menu that does not have a sub menu.
List item
LI
An item that is part of a list.
Edit box
EB
After this symbol, the edit box name is displayed. You can find the edit box after the edit box name. In the web browser, the symbol "EB" may be followed by an edit box without an edit box name. Edit boxes that begin with the symbol "EB" are one line.
(Ex: "EB Last name: (cursor)" in the address manager program or "EB (cursor)"
Multi edit box
MEB
This indicates a multi-line edit box. 
(Ex: "MEB Message Body: (cursor)" in the e-mail program)
Computer edit box
CE
An edit box requiring ASCII Braille input.
(Ex: "CE To:" in the Email program)
Combo box
CB
Indicates a combo box in which you can choose an item by pressing the up scroll button or the down scroll button.
(Ex: "CB Type:" in the "Open dialog box" of the Word Processor)
Edit combo box
ECB
choose the desired item by pressing the up or down scroll button, or by directly typing in the item name.
(Ex: "ECB File name: (cursor) was in the "Open dialog box" of the word processor program)
Prompt button
PB
PB follows any question in which you have to choose "Yes" or "No." You can toggle between "Yes" and "No" by pressing "Space" or "Backspace" button. 
(Ex: When you exit from the word processor, "PB Save: Yes") 
Static box
ST
ST indicates the current status.
(Ex: "ST noname.hbl/insert mode/write" in the word processor program)
Link
LN
Indicates a link on a web page.
Anchor
ANC
Indicates an anchor on a web page.
Radio button
RB
Indicates a radio button, cycle among items using up scroll button, down scroll button, space, or Backspace. 
(Ex: "RB Attribute: Write" in the "Information dialog box" of the file manager)
Radio button select
SRB
Indicates the currently selected radio button in the web browser
Radio button unselect
URB
It indicates the radio button is not selected.
Check box check
SCHB
Indicates the check box is selected.
Check box uncheck
UCHB
Indicates the check box is not selected. 

· Note: Links, anchors, and radio buttons are controls that are only used in the Web Browser. 
The symbols enable you to understand what type of input control or menu you are working with. For example, if "MN," "MI," or "LI" are displayed, you know you can move from one item to the previous and next items by pressing the "Up" and "Down" scroll keys. If "ECB," "EB," "CB," or "MEB" are displayed, you know you are in an input area where you must type the. If "BT" is displayed, you can press "Enter" to activate the "button".

[bookmark: _Toc492453822][bookmark: _Toc26179711][bookmark: _Toc209372118]2.3 Using the Function Keys
There are four function keys on the BrailleSense. You can use these function keys to open the menus, cancel tasks, and move to other items. 
The "F1" key opens the BrailleSense "Program" menu from anywhere on the unit, and is used in combination with other keys to open various BrailleSense programs. 
From within BrailleSense programs, the "F2" key opens the program specific menu, similar to pressing “Alt” in Windows. 
· Note: you may also use "Space-M" to perform this function. 
The "F3" key functions as "Tab ("Space-4-5")". "Space-F3" serves as "Shift-Tab ("Space-1-2")". F3 is also used together with other keys to open BrailleSense programs.
The "F4" key functions like the "Escape" key on a PC. You can also use "Space-E". Please note that "Escape" does not exit a program, as does "Space-Z" but rather, exits menus, dialogs, or prompt boxes. It also serves as the Back button in apps.
You can use the function keys in combination to perform various other tasks. Pressing "F1" and "F2" at the same time functions as "Page Up". Pressing the "F3" and "F4" keys together serves as "Page Down". "F1" and "F4" together opens the task list. Pressing the "F2" and "F3" keys together cycles through the running programs; similar to pressing "alt-tab" on your PC. The Task List and task switching are explained in greater detail in section 2.8.
The keys to the left and right of the spacebar are referred to as Control and Alt. This is because, in applications, these keys function as Control and Alt on a QWERTY keyboard so that you may take advantage of Android keyboard shortcuts when they are present. When using apps, Backspace, when used in combination with other keys, serves as Shift. In BrailleSense specific applications, Control and Alt operate similarly to "Space-1" and "Space-4" and provide an alternative method for scrolling through menus and lists. 

[bookmark: _Toc492453823][bookmark: _Toc26179712][bookmark: _Toc209372119]2.4 The Power Supply and the Battery Pack
To check the battery power status, press "Space-1-6." The unit displays the following 2 items:
1. Battery power level: expressed as a percentage of the remaining battery power compared to a full charge. 
2. Power source (battery, or AC power [USB C])
If the battery power level drops under 15 percent, the BrailleSense displays the battery status on the Braille display, and it announces that the battery has less than 15 percent of its power remaining. If the battery power level falls below five percent, the BrailleSense gives you a warning indicating that your battery power level is under five percent, and the BrailleSense will be automatically put to sleep in one minute, unless you connect it to a power supply. When the level reaches 2 percent, the unit automatically shuts down.
*Note: if the battery is completely depleted, the unit cannot boot. When you connect the BrailleSense to power in this state, a Braille message appears showing you that the unit is charging, and the percentage of the charge. This is to alert you that you must charge the device for a few minutes before you can boot the device. 
We recommend charging the unit to around 5% before attempting to boot the device. When the charging status appears, hold the Power button for around 5 seconds.
When the BrailleSense is shipped, the battery pack is not installed. This is done to prevent damage during shipping. When you insert the battery in to the BrailleSense for the first time, the unit may display an inaccurate battery power level. Before using the BrailleSense for the first time, please charge the battery for at least 3 hours. You may use the unit during the initial charge, however, it is recommended if you do, that the unit remain connected to power for at least 3 hours to fully charge the battery. 
When you remove the battery from the BrailleSense, make sure your unit is turned off; especially when the power adapter is not connected. If you remove the battery while the unit is on and power is not connected, you will lose all data stored in RAM, including open documents, emails, and contacts or appointments that have not been backed up. 
BrailleSense can be charged via any USB C charger. It is compatible with the PD V2.0 (power delivery) specification, for more rapid charging, and should charge in about 2.5 hours with the included power adapter. However, charging time will vary according to the power specification of the charger being used.
BrailleSense will operate on average for about 18 to 20 hours on a single charge. However, this will also vary greatly if multiple USB devices are connected, if power heavy apps like Zoom or Teams are running, etc.

[bookmark: _Toc492453824][bookmark: _Toc26179713][bookmark: _Toc209372120]2.5 Controlling the Volume, Speed, and Pitch of the TTS
Press "Backspace-F4" to increase the voice volume. Press "Backspace-F1" to decrease the voice volume. Press "Space-F4" to increase the speech rate. Press "Space-F1" to decrease the speech rate. Press "Enter-F4" to raise the pitch and "Enter-F1" to lower it. 
When you press any of the above key combinations, the BrailleSense announces the status of its volume, rate, or pitch. The changes in the characteristics of the voice remain in effect until you change them again, or a hard reset is performed.
· Note: the volume of the voice is controlled independent of the Main Volume on the unit, thus, you can adjust it above or below the volume of the system sounds, media playback, etc. using the Voice volume control described above. You can control the "Main Volume" of the unit using "Backspace-Space-F1" to lower it and "Backspace-Space-F4" to raise it. You can also use the Volume Up and Volume Down buttons on the left side of the BrailleSense to control master volume. 

[bookmark: _Toc492453825][bookmark: _Toc26179714][bookmark: _Toc209372121]2.6 Using Speech and Braille
When using the BrailleSense, you can choose to read using Braille only or speech only. You can also use both Braille and speech simultaneously. However, you cannot turn off both Braille and speech as you would have no method of receiving information from the BrailleSense. Use "Backspace-F2" to toggle the speech on and off. Press "Backspace-F3" to toggle the Braille on and off. You can also control these settings in the Global options.

[bookmark: _Toc492453826][bookmark: _Toc26179715][bookmark: _Toc209372122]2.7 Entering Text
In a document, "edit box" or "multi edit box" on the BrailleSense, you can enter either grade 1 or grade 2 Braille. By default, the unit uses UEB Braille, and you are free to use UEB, even when writing e-mail or Web addresses. However, if using the traditional US Braille code, some areas of the unit, such as the "to" field of the E-mail program, contain a "computer edit box" requiring you to enter text in computer Braille. 
To enter a capital letter in computer Braille, use the upper case indicator (Space-U" before the letter you want capitalized. For example, if you want to enter H in a computer edit box, press "Space-U" then H. If you press "Space-U" twice, caps lock is turned on. Press "Space-U" again to turn off caps lock.
You can also press "Space-Backspace" simultaneously with the letter to capitalize it. To input the "at sign," you may either use "Space-U" followed by dot 4, or "Space-Backspace-dot 4". 
To enter numbers in contracted or uncontracted Braille, use the "number sign followed by the number. However, when using computer Braille, you use no number sign and must enter numbers as "dropped" numbers (Nemeth numbers). 
In document editing areas, including the Word Processor, Notepad, and when writing an e-mail message, you can dictate text using Google’s speech to text function. To activate this function, press “F4-D”. A sound is heard to let you know the device is listening. Speak what you wish to say, along with the punctuation marks where they should be inserted. For example, “However comma, I will enter the terminal anyway period.”
BrailleSense automatically detects when you stop speaking, and plays a sound to let you know it has stopped listening. The text is then inserted as you dictated it. As with most mobile dictation situations, this generally works best when dictating a paragraph or so with each dictation.

[bookmark: _Toc492453827][bookmark: _Toc26179716][bookmark: _Toc209372123]2.8 Multi-Tasking
BrailleSense can run many tasks at once. For example, you can work with the Word Processor while listening to music, and place calculations into a document at the same time. To do this, open the Media Player and play a music file. While the audio is playing, press the "F1" key to bring up the "Program" menu and launch the Word Processor.
If you try to run a program that is currently running, The BrailleSense does not open a new instance of the program, but rather, returns you to the instance of the program that is already running. For example, while working with a document called "Notes" you decide to execute the "File Manager." Next, you navigate to a document called "journal" in the file list and press "Enter." The Word Processor does not load a second time, but rather, "journal" is opened in the same instance of the Word Processor in which "notes" is already loaded. You can switch among multiple open documents in a single instance of the Word Processor or Notepad with F3 and Space-F3. Switching documents is explained in more detail in section 5. 
To switch between currently running programs press "F1-F4" to open the Task List. The Task List shows all the currently running programs in list form. To return to any application, simply navigate to it and press "Enter". To force closing of an application in this list, press "Space-D". To close all applications, press “F3” to tab to the “Close All” button, and press “Enter”, or press “Enter-Space-D”.
If you have pressed "F1" to bring up the "Program" menu, or "F1-F4" to open the Task List and you decide not to access a different application, you can press "escape" ("Space-e" or "F4") to return to your previous location on the unit.
You can use "F2-F3" to immediately cycle among all running programs without opening the Task List. This is similar to using "alt-tab" on your PC. If you are running three programs and are in the second program, pressing "F2" and "F3" moves you to the third program. If you press "F2-F3" again, you are placed in the first program.
In the above case, if you were to press "Space-Z" to close the currently open program, you are then placed in the previous program. However, if there is only one program running, pressing "Space-Z" closes the program and places you in the "Program" menu. 

[bookmark: _Toc492453828][bookmark: _Toc26179717][bookmark: _Toc209372124]2.9 Switching Media Modes
The media buttons on the front panel perform different functions according to the location of the "Media Mode" switch.
If you slide the "Media Mode" switch to the left-most position, the BrailleSense is in "application mode" and the media buttons control operation of the current application. If you place the "Media Mode" switch in the center position, the BrailleSense says, "DAISY mode" and the media buttons control playback of DAISY content. If you slide the "Media Mode" switch to the right-most position, the BrailleSense announces, "media mode" and the media buttons control media playback.
It is very important to pay attention to the position of the "Media Mode" switch to achieve desired operation of the media buttons. For example, if you are using the Media Player, if the "Media Mode" switch is placed in the center position, the media buttons on the front panel control operation of the DAISY Player, even though your focus is in the Media Player. More detailed explanations of the functions of the Media buttons is given in the Mobile Screen Reader, DAISY Player, and Media Player sections in this manual.

[bookmark: _Toc492453829][bookmark: _Toc26179718][bookmark: _Toc209372125]2.10 Switching Key Lock
You can disable the keys on the BrailleSense to prevent the accidental pressing of keys using the "Key Lock" switch on the front panel.
When the "Key Lock" switch is placed in the left-most position, BrailleSense announces, "all keys locked". This means all keys on the unit are disabled including the on/off switch. If the "Key Lock" switch is placed in the center position, BrailleSense says, "top panel locked". This means you can continue to use the buttons and switches on the front panel (media mode switch, media buttons and on/off switch), however, you cannot use any of the keys on the top face of the unit. If the "Key Lock" switch is placed in the right-most position, BrailleSense announces, "unlocked". This indicates all keys are operational.
To lock and unlock only the keys on the front media panel, press the "Back" and "Forward" media buttons simultaneously. The unit announces "Media keys locked". If you press the keys again, the unit announces "Media keys unlocked", and the media buttons are again operational. 

[bookmark: _Toc492453830][bookmark: _Toc26179719][bookmark: _Toc209372126]2.11 One-Handed Mode
BrailleSense provides a One-handed mode for users restricted to the use of one hand for Braille input. To toggle One-handed mode on/off, press “Backspace-1-2-3” from the Main Menu. You can also turn One-handed mode on or off in the "General Options" dialog.
When One-handed mode is on, use the following methods to input text: 
1. To type a character, press the dots in any combination or order. When you have pressed all dots, press "Space" to complete the entry of the character. For example, if you want to type "h," you press "dot 1" and "dot 2" separately or together and then press "dot 5." Finally, press "Space".
2. To press a command that includes "Space," press "Space" both before and after the dot combination. For example, to press "Space-o (dots 1-3-5)," press "Space" then press "dot 1", "dot 3" and "dot 5" separately or together in any order. Then press "Space" again.
3. To press a command that includes "Backspace" or "Enter," press "Backspace" or "Enter" before the dot combination. Then press keys that make up the dot combination. Finally press "Space". For example, to press "Enter-l (dots 1-2-3)", press "Enter", and then press "dots 1-2-3." then, press "Space".
4. To press "Space," "Backspace" and "Enter", press the key twice. For example, to press "Space" to create a space between words, press "Space" twice.
The operation of the scroll keys, function keys, and media buttons remains the same as in normal mode. 
If One-handed mode is on, the BrailleSense announces this each time it is powered on, as well as how to return to normal operation. 

[bookmark: _Toc492453831][bookmark: _Toc26179720][bookmark: _Toc209372127]2.12 Using Typing Mode
While you are typing in a document, you may wish to turn off the navigation keystrokes, especially if you type very fast as you may accidentally navigate when you intend to enter text. To turn on "Typing Mode", press "Backspace-Space-Enter-M" from within a document. "Start typing mode" is announced and displayed.
When using "Typing Mode", if you press "Space-dot 4", instead of moving to the next line, the "Space" and "Dot 4" are entered into the document.
To cancel "Typing Mode", Press "Backspace-Space-Enter-M" once again. "End typing mode" is announced and displayed. After "Typing Mode" is canceled, navigation commands return to normal operation. 

[bookmark: _Toc209372128]2.13 Creating System Logs and Screen Recordings
There may be times when it is necessary to report an issue in detail to support staff in order to clearly demonstrate a problem or process. BrailleSense offers several options for providing a picture of any given situation you may need to tell us about.
· Take a screen shot. Hot-key: F4-S.
i. It is saved in the “Music” folder, as that’s where general media is stored.
ii. A sub folder called “ScreenShots” is created, and each image is saved according to the date and time it was taken.
· Create a screen recording. Start/stop Key: F4-R.
i. It is saved in the “Music” folder.
ii. A sub folder called “ScreenRecording” is created,
· Create a system log and screen recording simultaneously. Start/stop key: F4-L from the Main Menu.
i. A zip file is automatically created containing both the log data and the screen recording.
ii. The zip file is saved to Flashdisk/logData.
· Create a system log only. Start/stop key: Backspace-Space-Enter-2-3-5-6 from the Main Menu.
i. A log file is created and saved to Flashdisk/LogData, named according to the time and date it was created

[bookmark: _Toc492453833][bookmark: _Toc26179722][bookmark: _Toc209372129]3. Customizing your Notetaker
When you receive your notetaker, one of the first things you will want to do is to configure it to act the way you want it to. The " Settings" menu allows you to configure and customize your notetaker to meet your specific needs and preferences. 
To open the "Settings" menu, press "F1" to bring up the main menu. Press "Space-4" until you reach "Settings" and press "Enter". Or, just press S from the main menu to quickly jump to and open the "Settings" menu.
The "Settings" menu contains the following items: “Braille Options”, “Voice Options”, “General Options”, "Setup Internet", "Bluetooth Manager", “Menu Manager”, "Backup/Restore BrailleSense Settings", "Password Protection", "Initialize BrailleSense Options", “Re-install default Apps”, “Braille Learning tables”, “Language Profiles”, “Android Backup & Reset” and “Android System Settings”. The following sections discuss each of these items in detail.
When in a settings dialog, navigate among the options using “Space-1” and “Space-4”. You can toggle an option on or off or cycle through the available values of a setting with the "space" and "Backspace" keys. To save your changes, press "Enter" or tab to the "Confirm" button and press "Enter". The BrailleSense says, "Options Saved”, and you are returned to your previous position on the unit. To cancel without saving changes, press the "F4" key, "Space-E" or "Space-Z". 
Many of the various Options in these menus also have global hotkeys, allowing you to adjust these settings from anywhere on the unit. When focused on an option, press “Space-3-6” to announce the shortcut within the current dialog, as well as the global hotkey if it exists.
You can also access a sub menu of options at any time from anywhere on the unit by pressing “Space-O”. This hot key presents you with a sub menu of the major categories, “Braille Options”, “Voice Options” and “General Options”. No matter your position on the unit, changing these options will affect global change. However, it is also possible to customize reading voice settings specifically for the Notepad, Document Reader and DAISY Player separate from the global system settings. You can access the program specific settings under the “Voice Settings” option in the File menu of each of these programs or by pressing “Backspace-V”.

[bookmark: _Toc492453851][bookmark: _Toc26179744][bookmark: _Toc206982448][bookmark: _Toc209372130]3.1 Braille Options
[bookmark: _Hlk151650586]You can open the “Braille Options” from the “Settings” menu, or by pressing “F3-B” from anywhere on the BrailleSense”.
The "Braille Options" dialog contains the following settings. For each setting, the shortcut key appears in parentheses, and the global hotkey, if available, is shown in quotes. 
1) Braille display: (B). "Backspace-F3". Toggles the Braille display On/Off.
2) Braille Cursor: (C). "F4-Up Scroll". Defines how the Braille cursor appears on the Braille display: "Always Up", "Blinking" or "Off". Note the cursor appears as dots-7-8 in most situations. When selecting text, it notes the end of the selection with blinking dots-1-2-3-4-5-6-7-8.
3)  Eight Dot Mode: (E). "F1-Down Scroll". Toggles Eight Dot Mode on/off for ASCII text entry.
4) View/input Braille Grade: (G). "Space-G". Lets you choose what grade of Braille you want to use when viewing/entering text: Uncontracted Braille, Contracted Braille, or Computer Braille.
5) Use Computer Braille Input: (I). “F2-F3-X”. Allows you to switch to computer Braille input regardless of what the View Grade is set to.
6) Braille Code: (C). "Backspace-Enter-B". Defines the rules by which Braille is translated to text and vice versa: "US", "UK", "UEB", or one of several foreign language Braille codes. When foreign language codes are set, you can read and write Braille according to that language's Braille rules. The Braille language also affects lists, combo boxes, and edit boxes. Prompts, menus, buttons and static boxes remain in English.
7) Message Display Time: (M). defines how the BrailleSense deals with system messages: ignore, stand by until you press a key, or, display for from 1 to 10 seconds before disappearing.
8) Left Scroll Buttons: (L). Defines the operation of the scroll buttons: "Scroll display", "Move by line", "Move by character", "Move by paragraph" and "Move by sentence".
9) Right Scroll buttons: (R). Defines the function of the right Scroll buttons with the same options as above.

[bookmark: _Toc206982449][bookmark: _Toc209372131]3.2 Voice options
You can open the “Voice Options” from the “Settings” menu, or by pressing “F3-V” from anywhere on the unit.
The "Voice Options" dialog contains the following settings. For each setting, the shortcut key appears in parentheses, and the global hotkey, if available, is shown in quotes. 
1) Voice: (V). "Backspace-F2". Toggles the voice output On/Off.
2) Voice Type: (T). Choose between « BrailleSense Vocalizer » and “Android TTS”. Any Android TTS engine you have installed from the Play Store is available when using the android TTS option.
3) Voice Name: (N). Use this option to choose the personality of the reading voice. If Android TTS is selected for the above option, these choices reflect the various Android TTS engines you have installed. Note: Defaults for each, including the voice used, must be set in the individual Android TTS programs.
4) Use secondary Voice: (U). determines whether text in mixed languages use a secondary language voice during continuous reading.
5) Secondary Voice Name: (S). Allows you to choose the voice personality for the secondary voice. * Does not appear if the secondary Voice option is set to off.
6) Scroll Voice: (S) “F3-Up Scroll. Choose whether you want the BrailleSense to speak while using the scroll buttons as you read.
7) Voice Volume: (L). "Backspace-F1 and Backspace-F4". Raises or lowers the volume of the text-to-speech.
8) Voice Rate: (R). "Space-F1 and Space-F4". Controls the rate of the speech.
9) Voice Pitch: (T). "Enter-F1 and Enter-F4". Adjusts the pitch of the BrailleSense voice.
10) Punctuation Level: (P) “Enter-F3”. Use this setting to choose how you want the BrailleSense to read punctuation marks and symbols: "All", "Off", "Punctuation," or "Symbols".
11) Keyboard Echo: (K) “Enter-F2”. Defines how BrailleSense speaks as you type: "On with characters and words," "On with characters," "On with words," or "Off".
12) Capitalization alert: (U). Choose how the BrailleSense alerts you that a character is capitalized, either when typing or when navigating a document or edit box by character: "Off", "Say cap," or "Pitch".
13) Numbers: (N). Defines how BrailleSense speaks numbers: when set to "On", BrailleSense speaks numbers, and when set to "Off", it speaks digits.
· To install additional voices, press “F3” from the Voice Settings list, and press “Enter” on the “Install Voice” button. You are placed in a list of Vocalizer voices that can be installed on the BrailleSense. Use “Space-1” and “Space-4” to navigate the list, and press “Enter” to install the current voice. 
To install multiple voices at once, from the voices list, press “Space” on each of the voices you wish to install to select them, and press “Enter” to install all selected voices.

[bookmark: _Toc206982450][bookmark: _Toc209372132]3.3 General Options
You can open the “General Options” from the “Settings” menu”, or by pressing “F3-O” from anywhere on the unit.
The "General Options" dialog contains the following settings. For each setting, the shortcut key appears in parentheses, and the global hotkey, if available, is shown in quotes. 

1) Main Volume: (V). "Backspace-SPACE-F1 and Backspace-Space-F4", or the Volume Up and Down buttons. Controls the master volume of the unit, including system sounds, audio and speech.
2) Headphone Volume: (V). Allows you to amplify the headphone volume above the master volume for headphones with lower output levels. 
3) LCD: (L). "Enter-4-5-6 from main menu". Turn the LCD On, On with Backlight, or Off.
4) Flip LCD display: (F). Choose whether the LCD shows text in normal or reverse orientation. Reverse orientation can be useful for a sighted person viewing BrailleSense from across a table.
5) LCD Font Size: (F). Adjust the size of the font on the LCD.
6) Show Virtual Braille Display on HDMI: (B). This option determines if, when you are connected to an HDMI monitor, a visual representation of the braille display and its print translation appears at the bottom of the screen.
7) System Alerts: (A). Choose whether the BrailleSense alerts you to various events using audio signals, vibration signals, both, or no signal.
8) Battery Alerts: (B). Choose how you are alerted when your battery is low: "Message", "Beep", "Final Message" or "Final Beep".
9) Progress indicator: (P). Defines how the progress of tasks like opening a document or copying files is indicated: "Silent," (no progress indication) "Beep," (continuous beeps while the task is performed) and "Message" (progress is shown as a percentage).
10) Play Power On/Off Sound: (P). Choose whether you hear a sound when you turn on/off the BrailleSense.
11) Skip Empty Lines: (E). Choose to have the BrailleSense alert you to a blank line by announcing "Blank" or skip empty lines.
12) Hide passwords: (P) “F3-Down Scroll”. Choose whether the characters of a password are hidden as you type them.
13) Index Reporting: (I). determines whether the BrailleSense announces and displays the numeric indexing of list items, such as 5 of 22, etc.
14) Control Information: (I) “F2-Down Scroll. Defines where information is announced regarding the type of control on which you are currently located, a list item, menu, combo box, etc. Choose from Before, After and Off.
15) Hot Key Information: (H). Defines how hot key information is announced and displayed: "Letters," "Dot patterns," “Braille only”, or "Off".
16) Announce shortcut keys: (S). Lets you choose whether the BrailleSense speaks the menu shortcut key for a function as you encounter it.
17) Automatically Open menus with Shortcut: (C). This options lets you determine if, when you press a menu item’s shortcut, whether it automatically opens the sub menu, or just brings focus to it.
18) Power Button Operation: (P) “Backspace-Enter-P”. Choose the state your BrailleSense goes in to when the Power button is pressed: “Screen Off”, as in the case of a normal Android phone or tablet, or “Deep Sleep”, which turns off Bluetooth, Wi-fi, etc., similar to a traditional notetaker sleep mode.
19) Sleep Mode: (P) “Control-Alt-S”. Set BrailleSense to save power by automatically shutting down after a certain period of time: "On", "Off", or "Message". (Only active when using battery power.)
20) Sleep Mode Kick In: (K). Use this option to set the time of inactivity before entering SLEEP Mode: 10 minutes, 40 minutes, or 30 minutes.
21) Enable Spell-check: (C). You may wish to disable spellcheck in educational situations where a student needs to be tested on spelling, etc. Note: If "Enable Spellcheck" is turned off, Automatic Spellcheck cannot be used.
22) Automatic spell-check: (C). Set whether the BrailleSense automatically checks spelling as you type in "multi line edit boxes" in programs such as the Schedule Manager, Address Manager, E-mail messages, the Word Processor, etc. If the option is "On", and you enter a misspelled word, BrailleSense emits a beep sound to indicate the misspelling.
23) Spell Checker Language: (S). determines what language the unit will use when spell checking text.
24) Default notepad Document Type: (Q). Set the default document type for new documents you create using the Notepad: “DOCX document”, "Sense document", "Braille document,", "DOC document" or "Text document".
25) Default Web search: (W) “Control-alt-W”. determines which source is used when activating the Global Web search hot key, or the hot key for searching the word under your cursor. You can choose from Wikipedia, Wiktionary and Google Search.
26) Default Browser: (B). Determines which browser is used for functions like “Space-W” to open a URL: the original browser V1, or the new Browser V2.
27) Check Today's Schedule: (S). Set the BrailleSense to check today's schedule for appointments and tasks in the To do list each time you turn it on.
28) Automatically synchronize with time server: (T). Using this feature, you can ensure the accuracy of the time on the BrailleSense by synchronizing with an atomic clock when BrailleSense is connected to the Internet.
29) Time Announcement: (T). Set the BrailleSense to announce the time every 5 minutes, every 10 minutes, 30 minutes or every hour.
30) Bluetooth: (B). "Backspace-3-4-5-6". Toggles Bluetooth On/Off.
31) Wireless LAN: (W). "Backspace-1-4-5-6". Toggles Wireless LAN On/Off.
32) One-Handed Mode: (H). This option allows users with only the use of one hand to use the BrailleSense in a specific mode adapted for that purpose. For detailed information about one-handed mode, refer to section 2.11.
33) Screen Reader Hints: (H). Set whether to receive spoken hints about how to interact with the screen reader as you navigate the controls of 3rd party programs: "On/Off".
34) Screen Reader Control Information: (I). Determines whether the screen reader speaks the type of control or field as you navigate 3rd party applications: "On/Off".
35) Notification alerts: (N). Set whether you receive push notifications from Android applications.
36) Enable Braille in standby Mode: (N). Set whether status messages, such as when AC power is connected, are shown in Braille while in Sleep Mode.
37) Language: (L). Allows you to easily change the system language of the unit to any open firmware localization. *Several things to note: Currently Braille and TTS need to be changed separately via their respective options. Additionally, any open applications need to be closed and re-opened before they will appear in the changed language.


[bookmark: _Toc492453835][bookmark: _Toc26179724][bookmark: _Toc209372133]3.4 Setup Internet
The "Setup internet" function is used to configure your BrailleSense to use a LAN or Wireless connection to access the Internet. 
· Note: to use a LAN connection, you will need a USB to Ethernet adapter. 
To activate "Setup internet", press "Enter" on "Setup internet" in the "Settings" menu, or press "I". You can open the "Setup Internet" menu from anywhere on the unit by pressing "F3-I". 

[bookmark: _Toc492453836][bookmark: _Toc26179725][bookmark: _Toc209372134]3.4.1 Setup Wireless LAN
Before setting up a Wireless LAN connection, be sure wireless is turned on in the "Global Options" dialog. You can toggle wireless on and off from anywhere on the BrailleSense using "Backspace-1-4-5-6". In addition, when you choose this option, if Wireless is not turned on, BrailleSense automatically activates Wireless LAN. To connect to a wireless network, navigate to the "Wireless LAN" option in the connection types list under "Setup Internet" and press "Enter". 
The "Wireless LAN" dialog consists of the "access points" list, "Advanced" button, "Options" button and "Close" button. You can move among these controls by pressing "F3" or "Space-F3". If wireless is not turned on, the "access points" list displays "no items". 
When wireless is on, this list shows the wireless "access points" (networks) in range of your notetaker. The "Access points" list displays the "access point name", "encryption", and "sensitivity" of each item. (Ex: Linksys, encryption: WEP, sensitivity: good.) If there is more than one access point in the list, you can move among them by pressing "Space-1" or "Space-4". Move to the "access point" to which you want to connect, and press "Enter". If the access point has no encryption, the BrailleSense announces, "Connecting to (access point name)". If connection is successful, the connecting sound is heard. If the network is encrypted and requires a network key, when you press "Enter" on the access point, the "Network key" edit box is displayed. Type the network key in computer Braille in the edit box and press "Enter". If your settings are correct, the unit says, "Completed setting profile" and the connecting sound is heard. 
The "Advanced" dialog is used to modify an existing profile, manually add a new profile, or check the settings of an existing profile. Pressing "Enter" on the "advanced" button, while wireless LAN is turned on, displays a list of the wireless profiles saved on the BrailleSense.
The "Advanced" dialog has 6 controls: the "profile list", "Connect" button, "Add" common dialog button, "Remove" button, "Properties" common dialog button, and "Close" button. You can navigate among these controls by pressing "F3" or "Space-F3". Navigate the items in the Profile list using "Space-1" and "space-4". Press "Enter" to activate one of the buttons.
Use the "Add" button: to manually add a profile, specifically where an SSID is hidden, and thus does not appear in the "access points" list. The "Add" dialog" contains 6 controls.
1) "Network name (SSID)" computer edit box: Type the network ID in the computer edit box.
2) security, Use Space to choose among the security types for your network.
3) As most networks do have some security, the next item in the tab order will likely be “password”. This will not appear if you choose “None”, or “Enhanced Open”. Please enter the password in computer braille, and Tab to the next item.
4) The next item is a check box allowing you to decide whether to access additional advanced options. If you check this, the following will appear in the tab order:
	A) Proxy: the options for which are “Detect Automatically”, “Metered” and “Unmetered”.
	B) Proxy: the options for which are “None”, “Manual” and “Auto-Config”.
	C) Proxy Host name: A computer edit box in which you should type this.
	D) Proxy Host Port: Another computer edit box in to which you should enter the information.
	E) Bypass Proxy for: Enter the relevant info in to the computer edit box.
	F) IP Settings: Use Space to choose between DHCP or Static. Choose Static if you need to set a specific IP address for your device.
	G) Privacy: a combo box from which you can choose between “Use randomized MAC” or “Use device MAC”. If you are connecting to a school network or other professional network that requires your device to be identified by its Mac address, you should choose “Use device MAC”.
	H) Hidden network: A Yes/No combo box with which you identify whether the network is visible or not.
5) Confirm Button: Press Enter on this button to save your settings.
6) "Cancel" button: You can select this button to cancel the setup.
To delete a profile item in the profile list, select the profile item you wish to delete, and press R or "Tab" to the "Remove" button and press "Enter". 
To get information about a selected profile item in the profile list, "Tab" to the "Properties" button and press "Enter". In the "Properties" dialog, you can reconfirm or modify the information for each profile. 
To exit the "Advance" dialog, press "Space-E" or "Space-Z".
The "Options" dialog allows you to set how the BrailleSense scans for and detects wireless networks. Use "Space" to adjust the options in the dialog, and press "Enter" to save your settings.
The first option lets you choose whether Wi-fi is turned on automatically. The second option allows you to choose whether you receive notifications when networks are available.

[bookmark: _Toc492453837][bookmark: _Toc26179726][bookmark: _Toc209372135]3.4.2 LAN Setup
Before attempting to set up a LAN connection, connect one end of a LAN cable to the BrailleSense via a USB to Ethernet adapter, and the other to a router or direct LAN connection to the Internet. From the list of connection options in "Set up Internet", navigate to "LAN" and press "Enter". 
"Setup IP: Automatic" is displayed. If your service provider does not require you to use a static IP address, simply press "Enter" on this option for automatic setup. For the automatic setup, your host server should provide DHCP service (Dynamic Host Configuration Protocol).
To set up your IP configuration manually, move to "Manual" by pressing "Space-1", and press "Enter". The following settings are displayed: "IP", "Gateway", “Network Prefix Length” and " DNS". These settings require specific numeric addresses. Please contact your Internet service provider for the correct addresses. Use computer Braille to type the information for each setting, using "Space-1" and "Space-4" to move among the settings. When you have entered the information for each item, press "Enter" to save the settings. The unit announces, "Setting completed". And you are returned to "Setup internet". Your Internet connection should be active. 

[bookmark: _Toc492453838][bookmark: _Toc26179727][bookmark: _Toc209372136]3.5 Bluetooth Manager
The BrailleSense is Bluetooth capable, or rather, you can connect the BrailleSense to various devices such as keyboards, printers, audio devices, and other computers without the need for cables. You can also use Bluetooth to transfer files, or to connect the BrailleSense as a Braille display with a compatible screen reader. Bluetooth is the latest in wireless technology and enables wireless connectivity via a Personal Area Network (PAN). Unlike a traditional Wireless Local Area Network (WLAN), these networks are limited to approximately 30 feet or less. Bluetooth enables users to exchange various types of information over this wireless connection. 
You can toggle Bluetooth on/off from anywhere on the unit using "Backspace-dots-3-4-5-6". 
To access the Bluetooth Manager from the program menu, navigate to the "Settings" menu, and press "Enter. Then, navigate to "Bluetooth Manager", and press "Enter". You can also press "F3-R" to launch the Bluetooth Manager from anywhere on the unit.

[bookmark: _Toc492453839][bookmark: _Toc26179728][bookmark: _Toc209372137]3.5.1 Bluetooth Device List
When the Bluetooth Manager is activated, you are placed in a dialog with 2 items: a paired devices list, and a "rescan" button to scan for available devices. For example, if you have a computer with Bluetooth enabled nearby, the BrailleSense attempts to find it. It may take 30 to 40 seconds to discover all of the Bluetooth devices in range. The BrailleSense announces and displays, "Scanning for devices. Please wait...” Full cells are filled in on the Braille display to indicate scanning progress. 
When a Bluetooth device is detected, the BrailleSense announces "found (Bluetooth device name)". 
· Note: while the BrailleSense is scanning for Bluetooth devices, it cannot respond to key presses. You can cancel the scan by pressing “F4”.
When the scanning process completes, you are placed in the Bluetooth Device List. If the BrailleSense has found other Bluetooth devices in range, they are displayed as "device name xx/yy" where xx is the number at which the device appears in the list, and yy is the total number of devices. 
If there are no other Bluetooth devices in range, the BrailleSense announces, "no items". You can press "Space-1" or "Space-4" to move through the list. To select a device from the list, press "Enter" on the device name.
If the Bluetooth device is already paired, settings for connecting the device are automatically saved in the BrailleSense. If you want to delete this information, press "Space-D" on the Bluetooth device name in the list. The BrailleSense announces, "Device settings removed". Removal of the settings applies only to the current device.
From the Bluetooth Device List, you can access the menu by pressing "F2". The "Bluetooth Device List menu" contains "Rescan for Devices", "Delete device Pairing", "Options" and "Exit". You can navigate among the menu items using "Space-1" or "Space-4".
The first menu item is "Rescan for Device". This option initiates a new scan for other Bluetooth devices. To activate this item, press "Enter" on "Rescan for Devices" in the menu. Or you can activate it directly from the list by pressing "Enter-R". 
The next menu item is "Delete device Pairing". This item allows you to remove the connection settings for the current device. To activate this item, press "Enter" on "Delete Device Pairing" from the menu, or press “Space-D" to activate it from the Device List. 
The "Options" item lets you determine if the BrailleSense is discoverable to other Bluetooth devices. Press "Space" to check or uncheck the option.
The final item in the Bluetooth Device List menu is "Exit". This option exits the Bluetooth Manager program. To activate this item, press "Enter" on "Exit" from within the menu, or exit the program any time by pressing "Space-Z". 

[bookmark: _Toc492453840][bookmark: _Toc26179729][bookmark: _Toc209372138]3.5.2 Bluetooth Service List
When you locate a Bluetooth device to which you'd like to connect, press "Space-1" or "Space-4" to navigate to the device in the Bluetooth Device List, and press "Enter" on the device name. The unit announces, "Scanning for services. Please wait...” Please note The BrailleSense does not respond to key presses during the scanning process. 
The BrailleSense supports the following Bluetooth services: 
Audio Profiles: A2DP (Advanced Audio Distribution Profile) - High-quality audio streaming to headphones/speakers; AVRCP (Audio/Video Remote Control Profile) - Media playback control; HSP (Headset Profile) - Basic headset functionality; HFP (Hands-Free Profile) - Hands-free calling in cars and headsets
 Input Profiles: HID (Human Interface Device) - Keyboards, mice, game controllers; HOGP (HID over GATT Profile) - Low energy HID devices
 Connectivity Profiles: SPP (Serial Port Profile) - Serial communication
 Data Transfer Profiles: OPP (Object Push Profile) - File transfer between devices; FTP (File Transfer Profile) - Browse and transfer files
· Note: the data profiles are not supported via the BrailleSense interface, however, they can be used via Android applications. 
To access any of these functions, be sure that the remote Bluetooth device is in Discoverable mode, and that the service you wish to access is enabled on that device. It is possible to have certain services enabled on your remote Bluetooth device, while disabling others. The BrailleSense only sees and displays services which are enabled on your remote device, even if others are available. 
When the BrailleSense has found all of the available services, the services are displayed in a list in the following format: "service name xx/yy" where xx is the number at which the service appears in the list, and yy is the total number of available services. You can move through the available services by pressing "Space-1" or "Space-4". Press "Backspace" to return to the Bluetooth Device List.
From the Bluetooth Service List, you can access the menu by pressing "Space-M" or by pressing "F2". The "Bluetooth Service List menu" contains "Open FTP", "Disconnect" and "Exit". You can navigate the menu items using "Space-1" or "Space-4".
The "Open FTP" menu item allows you to quickly open a direct FTP connection with a remote Bluetooth device without accessing the Device and Service lists. However, you must have connected the FTP service previously for the BrailleSense to allow you to transfer files. If you have not connected the FTP service, and you activate this function, the unit announces, "FTP service disconnected". 
You can access "Open FTP” by pressing "Enter" on it from within the menu, or by pressing "Enter-T" directly from the Bluetooth Service List. The BrailleSense says, "Connecting service". Detailed information on connecting various service types is covered later in this chapter.
The "Disconnect" menu item allows you to disconnect services with other Bluetooth devices. You can access this item by pressing "Enter" on "disconnect" from within the menu. Or you can activate it directly from the Bluetooth Service List by pressing "Enter-D". 
If there are no services connected and you activate this function, the unit says, "There is no service connected".

[bookmark: _Toc26179730][bookmark: _Toc209372139]3.5.2.1 Connecting a Service
When you locate a Bluetooth device to which you'd like to connect, press "Space-1" or "Space-4" to navigate to the device in the Bluetooth Device List, and press "Enter" on the device name. The unit announces, "Scanning for services. Please wait...” Please note The BrailleSense does not respond to key presses during the scanning process. 
The BrailleSense supports the following Bluetooth services: FTP, Serial port, USB port, and headset. To access any of these functions, be sure that the remote Bluetooth device is in Discoverable mode, and that the service you wish to access is enabled on that device. It is possible to have certain services enabled on your remote Bluetooth device, while disabling others. The BrailleSense only sees and displays services which are enabled on your remote device, even if others are available. 
When the BrailleSense has found all of the available services, the services are displayed in a list in the following format: "service name xx/yy" where xx is the number at which the service appears in the list, and yy is the total number of available services. You can move through the available services by pressing "Space-1" or "Space-4". Press “Enter” to connect to a service. If a Pin code is required, you are prompted to enter it. Type the numbers in the pin code, and press “Enter”. BrailleSense announces “Connecting Profile”, followed by “Connected” in a few seconds if the connection is successful. If the connection fails, you are alerted that the connection was not successful, and returned to the Service list.
Press "F4" to return to the Bluetooth Device List without connecting to a service.


[bookmark: _Toc26179731][bookmark: _Toc209372140]3.6 Menu Manager
Using the Menu manager on the BrailleSense, you can manage what menus and/or programs are displayed in the Main Menu, sub menus, and Android Apps. You can show or hide almost any program in the Main Menu with a few exceptions. You may not hide the File manager, or the Menu Manager itself. 
You can also use the “Menu Manager” to add applications to the “Favorite Apps” list at the bottom of the Main Menu. This list can also be called from anywhere on the BrailleSense using “Control-F1”.
To execute the "Menu manager", from the "program" menu, press S" to open the "Settings"" menu. Press M to open "Menu manager". The "Menu manager'" dialog is displayed. You can also launch the "Menu Manager" from the Main Menu by pressing "Enter-H". 
The dialog of the "Menu manager" consists of the following items: The menu/program list, Add To/Delete from Favorites, Hide selected Apps button and Cancel button. To navigate among the programs, press "Space-1" or "Space-4". Press "F3" or "Space-F3" to navigate to the various buttons. 
Menus are displayed if they have programs accessible inside them. If you have chosen to hide all the programs in a given menu, this menu is not displayed in the Program menu. 
To hide unused programs on the BrailleSense, press "Space" on each of the programs you wish to hide in the list. Hidden programs will display an Asterisk (*) next to their names. To hide the selected apps, press “Enter” on the “Hide selected Apps” button. After a couple of seconds, you are returned to the program menu, and the programs you chose to hide are no longer displayed. 
To unhide the programs, return to the "Menu Manager" dialog, and press "Space" on the programs you wish to unhide, and press "Enter" to save the settings. 
*Note: Using the “Initialize options” function described later in this chapter, all menu items will return to their default status of being displayed.
You can also press “Space” on any application to add or delete it from the “Favorite Apps” list. If applications are not currently in the “Favorite apps” list, the “Add To favorites” button appears when you Tab from the application name. If they are already in the “Favorite aps” list, the “Delete From Favorites” button appears. If you select a mix of applications, in which some are in the “Favorite Apps” list, and others are not, both buttons appear. Selecting one of them acts only on the applications that apply to the particular button you selected. For example, if you choose “Add To Favorites” on a mixed list, only the applications that are not currently present in the “Favorite Apps List” are added. Those that are already there are not added twice.
You can also remove an item from the “Favorite apps” list by pressing Space-D” when focused on it in the “Favorite Apps” list itself.


[bookmark: _Toc26179732][bookmark: _Toc209372141]3.7 Backup/Restore BrailleSense Settings
If you hard reset your BrailleSense or initialize the BrailleSense Options, the main option settings and settings for each program are initialized to the default values. If you have created a backup of your settings, you can restore the option settings after the hard reset.
You can run this utility by pressing K from the "Settings" menu. You can also launch the "Backup/Restore BrailleSense Settings" dialog from anywhere on the unit by pressing "F3-K". 
The "backup/restore" dialog contains: the "program option check box list", a "Select all" button, a "Backup" button, a "Restore" button, and a "Cancel" button. You can move among the check boxes in the "program option check box list", by pressing "Space-1" or "Space-4". You can move among the controls in the dialog by pressing "F3" or "Space-F3".
The "program option check box list" contains "Global Options”, "File manager options", "Word processor options", “Notepad Options”, "E-mail Options", "Media Player options", "Radio Options", “Podcasts Options”, “Web Radio Options”, “Recorder Options”, "DAISY Player options", “Reader Options”, "Address Manager options", "Schedule manager options", “ToDo List Options”, "Web browser options", “Google Search Options”, “Excel Viewer Options", “World Clock Options”, "Wake Up Alarm Options" and “Bluetooth manager options".
In this list, move to the program options you want to backup or restore and check the item by pressing "Space". You can uncheck a checked item by pressing "Space" again. To select all of the program options in the list, press "Enter" on the "Select all" button. 
After selecting all the options you want to backup or restore, press "Enter" on the "Backup" or "Restore" button, or press "Enter-B" to backup or "Enter-R" to restore. If you select the "Backup" button, you are prompted to select a path for storing the backup file. You can accept the default path, or choose an alternative. Navigate to the folder in which to store the backup files using normal file/folder navigation commands. Select the folder or drive in which to store the backup by pressing "Space", and press "Enter" to start the backup process. If you select the "Restore" button, you are prompted for the path from which to restore backup files. Again, use normal file and folder navigation to select the folder containing your backup files. If you select a folder in which there is no backup, you receive a message indicating there is no backup option file. To restore your settings, select the folder containing the backup files by pressing "Space", then press "Enter" to initiate the restore process.


[bookmark: _Toc492453844][bookmark: _Toc26179735][bookmark: _Toc209372142]3.8 Password Protection
The Password Protection item allows you to set a password that must be entered when the unit is powered on, comes out of Sleep Mode, is upgraded, or the disk is formatted.
WARNING!! It is imperative that you create a password that you can easily remember, or that you store in another location for easy retrieval! Due to Android security safeguards, we are not able to send unlock codes as has been the case with older BrailleSense models. If you set a password using this function, or using Android system settings, and you are not able to remember or retrieve it, it will be necessary to send the unit to HIMS/SELVAS for unlocking, during which, all data will be lost. As remembering and retrieving personal passwords is the responsibility of the customer, any costs associated with transporting and/or unlocking the unit are also the responsibility of the user. 
To open the "Password Protection" settings, from the Main menu, navigate to "Settings" and press "Enter". Press A to jump to and open "Password Protection". You can open "Password Protection" from anywhere on the unit by pressing "F3-N". 
The "Password Protection" dialog consists of 4 items: "set/modify Password" dialog, "Password Configuration" dialog, "Set Password to factory defaults", and a "Close" button. Use "F3" or "Space-F3” to move among the controls in the dialog.

[bookmark: _Toc492453845][bookmark: _Toc26179736][bookmark: _Toc209372143]3.8.1 Setting and Modifying Passwords
When you open the "Password Protection" program, you are placed on the "Set Password" option. Press "Enter" to open the "Set Password" dialog. The "Set Password" dialog consists of 4 controls: "Password" edit box, "Retype Password" edit box, "Confirm" button and a "Cancel" button". 
Type the password you wish to use into the "Password" edit box. Tab to the "Re-type Password" edit box, and type it again. To save the password, press "Enter", or Tab to "Confirm" and press "Enter". To cancel saving the password, press "Space-Z", or Tab to the "Cancel" button and press "Enter".
When a password is saved, the "Set Password" option is replaced with "Modify Password". Once you have entered a password, you can modify in very much the same manner. The "Modify Password" dialog consists of all the same controls, except you must type your current password, before you can type a new one. Once you have typed your current password, then the new password, you must re-type the new password. Press "Enter" on the "Confirm" button to save the new password, or "Enter" on the "Cancel" button to cancel the modification.

[bookmark: _Toc492453846][bookmark: _Toc26179737][bookmark: _Toc209372144]3.8.2 Password Configuration
The "Password Configuration" dialog allows you to define when you are prompted to enter the password. When you press "Enter" to open the "Password Configuration" dialog, you are prompted to enter your password to gain access to this configuration. Type your password, and press "Enter".
The password configuration settings consist of 3 radio buttons: "Prompt for password when in Sleep Mode", "Prompt for password when formatting" and "Prompt for password when upgrading." Use "Space-1" and "Space-4" to toggle these buttons between "Yes" and "no". When you have chosen your options, press "Enter" on the "Confirm" button to save your settings. If you want to cancel the configuration, press "Enter" on the "Cancel" button.

[bookmark: _Toc492453847][bookmark: _Toc26179738][bookmark: _Toc209372145]3.8.3 Reset Password to Factory Defaults
Use this option to reset the password configuration and return your unit to its factory state of no password protection.
When you press "Enter" to open this option, you are prompted, "Do you want to initialize the password settings?". Use "Space-1" and "Space-4" to choose between "yes" and "No". If you choose "yes", you are prompted for your current password. Type it, and press "Enter". The unit announces, "Password settings have been initialized" and you are placed on the "Set Password" option. 

[bookmark: _Toc492453848][bookmark: _Toc26179739][bookmark: _Toc209372146]3.9 Initialize BrailleSense Options
You can use the "Initialize BrailleSense Options" item to restore the BrailleSense 6 to the factory default settings.
To launch this function, navigate to it in the "Settings" menu, and press "Enter", or press C. 
You are prompted, "Do you want to initialize options?" Use "Space" to choose "Yes" or "No". Choosing "Yes" initiates the factory reset process. Choosing "No" cancels the function and returns you to the "Settings" menu. You can also perform this function by holding the Forward Media key while pressing the Power Button. Once you see “HIMS” displayed on the Braille display, you can release the Forward key. 

[bookmark: _Toc209372147]3.10 Re-install Default Apps
This option installs a fresh version of the default applications from the system partition. You can also access this function from the main menu by pressing “Backspace-Space-Enter-F”. 
We recommend you do this after each upgrade, however, you can perform this function at any time if you feel that an app is not performing as it should be, or if an application seems to be missing some functionality you know was added recently. 
When you press “Enter” on this option in the “Settings” menu, or press the hot key above, your BrailleSense announces, “Start recovery of default apps”, then announces each installation as it happens. When the installation is completed, the unit announces, “Finished recovery of default apps”, and returns you to the Main Menu.

[bookmark: _Toc209372148]3.11 Braille Learning tables
This setting allows you to use the UEB Braille Learning tables available in the Duxbury library to translate and back translate Braille in the BrailleSense system, allowing a student to get practice at their current learning level while learning to operate the unit. The Braille Learning tables cover a range of lesson series, and offer tables for various levels of each, so that a student can utilize Braille tables that translate only the contractions they are familiar with as they are learning. By default, this is set to “Off”, which means full grade 2 Braille is used when the Braille grade is set to use Contracted Braille.
*Note: this menu item always appears when the system language is set to English. However, if your Braille code is set to anything other than UEB, trying to activate it will result in an error sound, as Braille Learning tables are only available for the UEB Braille code.
When the Braille Learning tables dialog opens, you are placed in a list of items with an Off choice, as well as the various lesson series available. Use “Space-1” and “Space-4” to choose among the options. Choosing the ‘off” option, as indicated above, means that, if the Braille grade is set to Contracted braille, full, standard UEB grade 2 is used for all Braille translation in the system.
Choosing one of the lesson series allows you to, then, Tab forward to choose the level at which a student has currently reached. In this case, the system will utilize only contractions that have been learned according to that lesson series and level. As a student continues learning, the Braille learning table can continue to be changed to match the student’s learning level. When the student completes their Braille learning lessons, set the Braille learning table to Off, and full grade 2 is again utilized.
 
[bookmark: _Toc209372149]3.12 Language Profiles
Language Profiles allow you to easily set a group of settings for each language you encounter regularly, and instantly and conveniently switch between them.
You can open the Language Profiles by pressing L from the “Settings” menu.
The Language Profiles dialog consists of a Profiles list, an Add button, a Modify button, a delete button and a Confirm button. Press “Space-1” and “Space-4” to move among profiles in the list, and press “Tab” and “Shift-Tab” to move among the controls in the dialog.
The profiles List will always consist of at least 1 item, the “Default” profile. This profile is automatically set using the current Voice Options and Global Options settings, and will be modified as you, either change those settings, or modify this profile in the Language Profiles dialog.
Pressing Enter on a profile in the list will switch to using that profile. You can switch to any profile in the List from anywhere on the unit by pressing F1-L. If you choose Add or Modify, the Language Profile Settings dialog includes the following items:
“Profile Name”, “Language”, “Braille Code”, “View/Input Grade”, “Eight Dot Mode”, “Voice Type”, “Voice Name”, “Use secondary Voice”, “Secondary Voice Name”, “Voice rate”, “Voice Pitch”, and confirm and Cancel buttons.
· Note: If you choose “Android TTS” as your Voice Type, the Secondary Voice options will not appear. If you set the secondary Voice to Off when using BrailleSense Vocalizer, the Secondary Voice Name option does not appear.
· Note: if you change the “Language” option, this changes the operating language for the device, and requires you to close all applications, as each application must be restarted in the new language. If you need only to change your input settings on the fly for switching between languages for entry, change only the TTS and Braille code, and you can instantly switch between input languages in your current position on the unit, while continuing to receive menus and prompts in your default system language.


[bookmark: _Toc26179745][bookmark: _Toc209372150]3.13 Android Backup & Reset
The “Android Backup & Reset” option opens the Restore and Reset options found in Android System Settings in a more convenient location. Here, you can set options for backing up and restoring information related to your Android applications and accounts, and you can factory reset your device. WARNING! Performing a factory Reset in the “Android Backup & Reset” menu erases all personal data, including files, account information, installed applications, etc. This is also a long and involved process and should not be undertaken before consulting with tech support staff, as you will need special instructions to complete it properly.

[bookmark: _Toc26179746][bookmark: _Toc209372151]3.14 Android System Settings
The “Android System Settings” is the final item in the “Settings” menu. You can launch it from anywhere using “F3-E”.
This option opens the standard Android “Settings” dialog found on phones and tablets. While many settings are duplicated in the BrailleSense interface, the “Android System Settings” contains a standard Android interface, and must be navigated in the same manner as Android applications. Use “F3”, and “Space-F3” to move among objects on a screen. Use “Backspace-Space-1” and Backspace-Space-4” to adjust slider controls. Please see the chapter on Using 3rd party apps, and the Commands Summary, for more complete information on navigating Android interface.
[bookmark: _Toc492453852][bookmark: _Toc26179747][bookmark: _Toc209372152]4. File Manager

[bookmark: _Toc492453853][bookmark: _Toc26179748][bookmark: _Toc209372153]4.1 Overview
The functionality and structure of the "File Manager" on the BrailleSense are similar to "Windows Explorer" on a PC. To run the "File Manager", press F from the "Program" menu or press "Enter" when your cursor is placed on "File Manager". You can launch the "File Manager" from anywhere on the unit by pressing "F1-F". Close the "File Manager" by pressing "Space-Z".
The "File Manager" contains 2 basic areas: an "address window" and the content list. You can navigate between them using "F3" and "Space-F3". When you first open the "File Manager", you are placed in the drive list. By default, you are placed on the internal "flashdisk". If an SD card or USB drive is connected, it also appears in the list. 	You can use "Space-1" or "Space-4" or the scroll buttons to navigate the items in the drive list. Press "Enter" on the drive you want to open. The BrailleSense then displays the list of the files/folders on that drive. 
The "address window" contains the path of the current directory or file. 
The "File Manager" contains both menus and hot keys, allowing you to easily activate items in the program with a single keystroke as well as to access functions through the menus for commands you have not memorized. You can bring up the menus by pressing "Space-M" or "F2". For the purposes of the directions in this chapter and the rest of this manual, we will use F2. However, either keystroke will perform this function.
Use Space-1" and Space-4" to navigate among the available menus. To open a menu, press "Enter". Again, use "Space-1" or "Space-4" to navigate among the items in a menu, and press "Enter" to execute a menu item.
The File Manager also contains dialogs. You can navigate among the controls in a dialog box by using the equivalents of "Tab" on a PC. You can use "F3" or "Space-4-5" for "Tab" and "Space-F3" or "Space-1-2" for "Shift-Tab". For the purposes of instructions in this manual, we will use "F3" and Space-F3", or you will be directed to "Tab" or "Shift-Tab".

[bookmark: _Toc492453854][bookmark: _Toc26179749][bookmark: _Toc209372154]4.1.1 Navigating the File List
The "File Manager" contains two kinds of lists: the "file list" and the "menu list", or rather, the list of items contained in the "File Manager" menu. The menus in the BrailleSense wrap. This means, when you reach the end of the list of items in a menu, the BrailleSense automatically brings you back to the top of the list when you press "Space-4". However, when you reach the end of a "file list," the BrailleSense remains at the end of the list, even if you press "Space-4". The following is a list of the keystrokes used for navigating lists:
· Note: the following keystrokes can be used to navigate any list on the BrailleSense.
1. Move to previous item: (Space-1) or up scroll button
2. Move to next item: (Space-4) or down scroll button
3. Move to the beginning of a list: Space-1-2-3
4. Move to the end of a list: Space-4-5-6
The following keystrokes are valid only in a "file list".
1. Jump to folder or file list: Space-5-6
2. Move between file list and address window: (Space-4-5 or F3) / (Space-1-2 or Space-F3)
3. Enter the selected folder or open the selected file: Enter
4. Move back a level in the folder structure: Backspace
5. Jump to the drive list: Space-1-2-5-6
6. Move to the previous group of 32 items: Page up (space 1-2-6 or F1-F2)
7. Move to the next group of 32 items: Page down (space 3-4-5 or F3-F4)
8. Jump to a file or folder by pressing the first character of the folder or file name. You must use ASCII characters.

[bookmark: _Toc492453855][bookmark: _Toc26179750][bookmark: _Toc209372155]4.1.2 Selecting Folders and Files
1. Select individual items "Space": * is displayed in front of the item to denote its selection. Pressing "Space" again on the selected folder or file cancels the selection.
2. Continuous selection "Enter-b": This selects all of the items from the point where this command is executed to the item where the cursor is located. * appears in front of the selected items.
3. Select all "Enter-a": This selects all the files and folders in the current list. You can toggle selection and de-selection of items by pressing "Space". When the "Select All" command is executed, the BrailleSense says the number of selected files, and * appears in front of the selected files on the Braille display. 

[bookmark: _Toc492453856][bookmark: _Toc26179751][bookmark: _Toc209372156]4.2 Working with Files and Folders
When viewing the contents of a drive or folder, the items in quotation marks are folders, and the items without quotation marks are files. 
The items in the list are followed by numbers, such as 1/5 or 2/5. The numbers following the items indicate an item's placement in the list and the total number of items in the list. For example, "database 1/5," indicates "database" is the first folder in a list containing five items.

[bookmark: _Toc492453857][bookmark: _Toc26179752][bookmark: _Toc209372157]4.2.1 Entering and Exiting Folders
There are several ways to open a folder. 
1. Bring up the menu by pressing "F2". Select the "Open" option from the list and press "Enter". 
2. Press the hot key "Enter-O" to activate the "Open" command and open the desired folder.
3. Finally, as described above, you can simply press "Enter" on the selected folder.
To exit the current folder, use the "Backspace" key. You are returned to the previous level in the folder structure. 


[bookmark: _Toc492453859][bookmark: _Toc26179754][bookmark: _Toc209372158]4.3 The File Menu
To open the "File" menu, press "F2" to bring up the menu, and press "Enter" on "File". Use normal list commands to navigate to your desired option and press "Enter".
The BrailleSense supports the following file formats: 
1. Document files: HBL, BRL, TXT, BRF, RTF, DOC/DOCX, XLS/XLSX, PPT/PPTX, PDF and unprotected EPUB.
2. Web formats: URL, and HTML. 
3. Media formats: AC3, ASF, ASX, m3u, MP2, MP3, MP4, OGG, PLS, WAV, WAX, WMA, WMV M4B, M4V, MOV, and FLAC. 
4. DAISY formats: DAISY 2.0, 3.0, BookShare. 
5. Programs: APK, APKS, XAPK. Press “Enter” to install.

The menu contains the following items. Shortcuts are placed in parentheses, and hotkeys are in quotes.
1) Open: (O) "Enter-O". Opens the selected file in the associated application for its file type. 
2) Open in Document Reader: (K) “Backspace-R”. Appears only for supported document types, allowing you to open the file in the read only Document reader as opposed to the default Notepad or Word Processor.
3) Open in second Notepad: (W) “Backspace-O”. Allows you to open compatible documents in a second version of the Notepad for easier switching between 2 files. Appears only when compatible documents are displayed.
4) Open With: (E) "Enter-E". Allows you to choose a compatible application with which to open the selected file.
5) Zip (Z) "Enter-Z". Compresses the current file or folder.
6) Unzip (U) "Enter-U". Appears only for compressed files, extracts the current file. 
7) Send To: (S) "Enter-S". Lets you send the current file or folder to a different location. Targets include any connected local drives, e-mail, and “Android Program, which will allow you to send files to available 3rd party apps according to the file type you are sending.
8) Rename (R) "Enter-R". Rename the current file or folder.
9) New Document: (N) "Enter-N". Create a new document using DOCX, DOC, TXT, BRL, or HBL.
10) New Folder: (F) "Enter-F". Creates a new folder.
11) File Conversion: (T) "Enter-T". Converts selected document files to TXT, BRL, or HBL.
12) Find File: (B) "Space-F". Search the current drive or folder for a specific file by name.
13) Find Text: (C) "Backspace-F". Search Word, Text, and Braille files on the current drive or folder for specific text strings. 
14) Merge Files: (M) "Enter-M". Select 2 or more text or Braille files to merge together.
15) Split Files: (P) "Enter-P". Split text or Braille files by paragraph or word count, by size, or into a certain number of files of equal size. 
16) Information: (I) "Enter-I". Provides basic properties of the current file or folder.
17) Exit: (X) "Space-Z". Closes the File Manager.
 
[bookmark: _Toc492453860][bookmark: _Toc26179755][bookmark: _Toc209372159]4.4 The Edit Menu
The Edit Menu contains the following items:
1) Start selection: (B) “Enter-B”. Starts a continuous file selection. The end of the selection is determined by your position in the file/folder list.
2) Copy: (C) "Enter-C". Copies the selected files or folders to the clipboard.
3) Cut: (X) "Enter-X". Cuts the selected files or folders to the clipboard. 
4) Paste: (V) "Enter-V". Pastes the files or folders on the clipboard to the current location.
5) Delete: (D) "Space-D". Deletes the selected files or folders.
6) Select All: (A) "Enter-A". Selects all the files and folders in the current list.

[bookmark: _Toc492453861][bookmark: _Toc26179756][bookmark: _Toc209372160]4.5 The View Menu
The View Menu contains the following options:
1) Sort Files By: (G) "Enter-G". Determines in what order files and folders are displayed.
2) Set File Info: (L) "Enter-L". Determines what information is displayed about each file or folder in the list. 
3) Display Only Files of Type: (W) "Enter-W". Filters files by file type.
4) Show/Hide System Folders: (H) "Enter-H". Shows or Hides Android system folders that do not contain user content. These are hidden by default.
5) Set Start Folder: (S) “Backspace-S”. Lets you choose the location the File Manager opens to.
6) Document Open Settings: (D) “Enter-D”. This setting lets you determine in which program DOC and DOCX files are opened by default, Word Processor or Notepad. You can also choose to “Always select”, in which case you will be prompted every time.

[bookmark: _Toc26179757][bookmark: _Toc209372161]4.6 Accessing Cloud Drives
You can use the File Manager to interact directly with content stored on several cloud drive services in a similar fashion as you do with the Flashdisk and other drives connected to your unit in terms of selecting and moving files, editing and saving documents, and playing media content. At the time of this writing, Google Drive, OneDrive and Dropbox are supported. 
You can easily transfer files between your Cloud Drive and BrailleSense, using the BrailleSense File Manager interface, Open and edit documents using the Word Processor and Notepad, Read supported files in the Document Reader, attach files using the E-mail program, read spreadsheets using the Excel Viewer, open HTML and HTM files in the Web Browser, and play media content in the Media player. You can also use the “Open With” option to open cloud drive files using other applications, including 3rd party Android apps.
*Note: you must login to your Cloud drive accounts from the file Manager before the content will be available via the other applications mentioned above.
The first time you open any of the cloud drives,, you are placed in a Sign In page. Use “F3” and “Space-F3” to navigate the page, and enter your login information. If you have signed in to your Google or Microsoft account previously, they may appear as options, in which case, you can just press Enter on the correct account.
Once signed in, you must allow BrailleSense File Manager service to access your account. Use “enter-1-2-3-4-5-6” to navigate by form control to quickly locate the Allow Button and press Enter. Once done, you should be able to press Enter on the associated cloud Drive, and load your file and folders structure from the File Manager. The various cloud drives will also appear in the Open/Attach File dialog under the drive list when using the applications mentioned previously, and you will be able to navigate and select files and folders as you would from local drives on the unit.
You can also create links for sharing files with others from any of the various cloud drives by pressing “Backspace-L” when the file is focused, or choosing “Create Share Link” from the File menu.
Please be aware of the following conditions:
Note that the file management functionality is limited to manipulation of files and folders at this time, thus, you will find the menu items are limited to functions like delete, rename, Copy and Paste, as the cloud drive services do not support functions like Zip and Unzip, Braille and TXT File conversion, etc. Please use “Space-H” to get a complete list of the available functions. 
Only supports selecting files or folders for the purposes of copying, opening or saving.
“paste”, “cut” and “new folder” functions are not available in shared directories.
Files must be copied to the my drive area for editing and saving back to Google Drive or OneDrive.
Streaming media files is not supported. We download the file in a temporary folder in the flashdisk before playing.
In general, it should be noted, due to transferring to and from cloud Drives, opening and saving files is a bit slower than when accessing local files and folders.

[bookmark: _Toc492453862][bookmark: _Toc26179758][bookmark: _Toc209372162]4.7 Using the Address Window
This edit box lets you type the direct path of the file name you want to open. This window also contains the history list for easily accessing recently opened files or directories. 
When you are in a file or folder list, you can press "tab (Space-4-5)" to navigate to the address window. The BrailleSense displays the current path including the current drive name, such as "flashdisk/download/". The address window is only visible when you are in a file or folder list. When you are in the drive list, the address window is not available.
You can edit the text by relocating the cursor with a cursor routing key, the BrailleSense inserts the text at the cursor location. If you know the exact path and file name, you can type in the path and file name to open the file with the appropriate application. For example, if you type in "flashdisk/download" in the address window and press "Enter," the BrailleSense displays the list of the files in the download folder. If you type "flashdisk/My Documents/sample.txt" in the address window, and press "Enter," the BrailleSense loads the Notepad, and opens the file "sample.txt". 
Use "Space-1" or "Space-4" in the Address Window to review the history list (a list of file and folder paths you have recently opened). To open a file in the history list, press "Enter". The file opens with the appropriate application. 

[bookmark: _Toc209372163]5. Office Tools
The “Office Tools” menu contains programs geared toward educational and professional productivity, including the “Word Processor”, “Notepad”, “E-mail” and “Excel Viewer”. 

[bookmark: _Toc492453863][bookmark: _Toc26179759][bookmark: _Toc209372164]5.1 Word Processor
The BrailleSense Word Processor supports creation of formatted DOCX and DOC files, as well as opening of DOC/DOCX and PPT/PPTX/PPTM files. All other types should be opened using the notepad, described in the next chapter.
You can launch the "Word Processor" in a couple of ways:
Press "F1" to open the main "Program" menu. Navigate to "Office Tools" using "Space-4" and press "Enter". From there, navigate to “Word Processor”, and press “Enter” to open it. 
You can also launch the "Word Processor" from anywhere on the unit by pressing "F1-W".
When you launch the Word Processor on the BrailleSense, it places you in a new, blank document. You can activate all the functions of the Word Processor via the Word Processor menu or by using hot keys. The menu in the Word Processor consists of File, Edit, Go To, Insert, Mark, Read, and Layout. To access these menus, press "Space-M" or "F2". Select a menu item using "Space-1" or "Space-4", and press "Enter". Or, you can press "Space-M or "F2" followed by the shortcut for the corresponding menu item. 
Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab among controls in a dialog. 
Press "Enter" to execute an item.

[bookmark: _Toc492453864][bookmark: _Toc26179760][bookmark: _Toc209372165]5.1.1 File Menu
The File menu contains the following options:
1) New: (N). Creates a new document, by default named "noname". You can create only DOCX files in the Word Processor. Other file types, like TXT, BRL and RTF can be created in the Notepad described in the next chapter. 
2) Open: (O) "Enter-O". Opens an existing file. Supported file types include DOC, DOCX, PPT, PPTX, PPTM. *Note: all these files can be read, but only DOC and DOCX files can be saved. Password protected word files, such as those used in health professions, can also be read, but cannot be created or saved.
3) Recent File list: (R “Backspace-Enter-H”. Displays files you’ve recently opened in the Word Processor. Press Enter on a file to open it.
4) Opened Documents List: (D) “Backspace-Enter-O”. Displays all the currently open documents. Allows you to choose from a list rather than Tabbing and Shift-Tabbing through all of them.
5) Save: (S) "Enter-S". Save the current file. Tab between name and location. Use normal file management navigation to choose a different folder. 
6) Save As: (A) "Space-S". Save the current file under a different name or in a different location. Note: you can save both DOC and DOCX files once they are opened, but you cannot convert one to the other.
7) Export: (X) “Backspace-Enter-X”. This function exports the current document to BRL, BRF or TXT , useful for translating a DOC or DOCX file, especially useful for saving math files to braille so that they can be embossed via the Notepad, but may also be used to save a document without formatting for automatic opening in Notepad.
8) Close Current document: (Q) “Space-Q”. Appears only if more than one document is currently open, and closes only the current file
9) Print: (P) "Space-P". the document will be printed using the default print service set in Android System Settings.
10) Settings: (E) "Enter-E". Dialog to set various document options. Tab among settings list, location Info check boxes, Default folder, and Confirm and Cancel buttons. Settings list includes View Format Characters, Reading unit (affects functions of “Space-1” and “Space-4” and “Space-2-3” and “Space-5-6”), Read Only On/Off, Automatic Save Interval, Auto Scroll Speed, Apply Settings to All Documents, Home/End movement unit, Math Braille Code, new Document default name, and Layout Measurement Unit. Use “F3” and “Space-F3” to move among the settings in the Settings list, and “Space-1” and “Space-4” to change the value of the setting. This dialog also includes the ability to choose what info is displayed when you query the cursor position, as well as the default save location for documents.
11) File Open Setting: (T) “Backspace-O”. Determines how a document is loaded: Choose “Load completely” to open the document in whole before reading, choose “Load in Background” to start reading after the first page is loaded, and continue loading in the background.
12) Dictionary: (D) "Backspace-Enter-D". Opens the Sense Dictionary installed, and inserts the word under the cursor in the lookup edit box. 
13) Exit: (Z) "Space-Z". Closes the Word Processor.

[bookmark: _Toc492453865][bookmark: _Toc26179761][bookmark: _Toc209372166]5.1.2 Edit Menu
The Edit Menu contains the following items:
1) Start Selection: (B) "Enter-B". Marks the beginning of the selection. The end of the selection is marked by the current cursor position. 
2) Copy: (C) "Enter-C". Copies selected text to the clipboard.
3) Cut: (X) "Enter-X". Cuts the selected text to the clipboard.
4) Paste: (V) "Enter-V". Pastes text from the clipboard to the current location.
5) Delete: (D) "Space-D". Deletes selected text.
6) Delete Blank lines: (L) "Backspace-E". Deletes blank lines from the selected text area.
7) Add to clipboard: (P) "Enter-P". Appends selected text to the clipboard without deleting the prior selection.
8) Clear clipboard: (E) "Enter-D". Empties the clipboard.
9) Select All: (A) "Enter-A". Selects all the text in the document. 
10) Check spelling: (K) "Enter-K". Opens the Check Spelling dialog, and begins checking the document for errors. Use “F3” and “Space-F3” to move among the controls, and “Space-1” and “Space-4” to move through lists of options. You can also use the following hot keys:
	A. Skip Once: Backspace-S.
	B. Skip All: Backspace-I.
	C. Modify Current: Backspace-C.
	D. Modify All: Backspace-M.
	E. Add to User Dictionary: Backspace-A.
[bookmark: _Hlk25239017]You can also check spelling of the current word with “Backspace-K”.

[bookmark: _Toc492453866][bookmark: _Toc26179762][bookmark: _Toc209372167]5.1.3 Insert Menu
1) Insert from File: (I) "Enter-I". Inserts information from another file.
2) Insert Date: (W) "Enter-W". Inserts the current date.
3) Insert time: (T) "Backspace-W". Inserts the current time.
4) Insert Page Break: Backspace-Space-Enter-P. Begins a new page in the document.
5) Insert Tab: Backspace-Space-Enter-I. Inserts a tab character.
6) Insert Footnote: (F) “Backspace-Space-Enter-E”. Opens a dialog where you can name the footnote, then Tab to enter the related content. Press the same keystroke to review or edit an existing footnote.
7) Insert table: (a) “Control-Alt-T”. Opens a dialog where you can define the number of columns and rows. Enter the numbers in the proper edit boxes, and press “Enter” to insert the table. See section 5.1.8 for table navigation commands.
8) delete Table: (D) “Control-Alt-D”. Deletes the table in focus.
9) Set Math Mode: (M) “Backspace-M”. Starts/ends insertion of Nemeth or UEB math content.

[bookmark: _Toc209372168]5.1.4 Mark Menu
1) Set Mark: (M) "Enter-M". Sets a bookmark at the current cursor position.
2) Jump to Mark: (J) "Enter-J". Jumps to a previously set mark.
3) Delete Mark: (D) "Backspace-D". Deletes a previously set mark.
4) Mark List: (L) “Backspace-L”. Opens a list of marks in the current document.

[bookmark: _Toc492453867][bookmark: _Toc26179763][bookmark: _Toc209372169]5.1.5 Go to Menu
1) Find: (F) "Space-F". Opens Find dialog where you can enter a text string to search, choose whether to match case, and choose the search direction. 
2) Find Next: (H) "Enter-F". Finds the next instance of the previously searched string.
3) Find Previous: (V) "Backspace-F". Finds the previous instance of the search string from your current position.
4) Find and Replace: (R) "Enter-R". Dialog to search for a text string and replace with an alternative string. Choose search direction, match case, and whether to replace one instance, from cursor to end, or all.
5) Go To Location: (L) "Enter-L". Go to a location in the document according to page, paragraph, line or percentage.
6) Go To Previous Sentence: (E) "Space-2-3-6". Moves back one sentence.
7) Go To Next Sentence: (X) "Space-3-5-6". Moves forward one sentence.
8) Go To Previous Page: (B) "Space-1-2-6). Moves back one page.
9) Go To Next Page: (G) "Space-3-4-5". Moves forward one page.
10) Go To Previous Document: (P) "Shift-Tab". If multiple documents are open, moves to the previous document in the order the files were opened.
11) Go To Next Document: (N) "Tab". If multiple documents are opened, moves to the next document in the file open order. 

[bookmark: _Toc492453868][bookmark: _Toc26179764][bookmark: _Toc209372170]5.1.6 Read Menu
1) Read Selected Text: (B) "Backspace-B". Reads the selected block of text.
2) Read beginning of Selected Text: (U) "Enter-U". Reads the first line of a selected text block.
3) Read from Beginning to Cursor: (T) "Backspace-G". Reads from the beginning of the document to the current cursor position.
4) Read from Cursor to End: (G) "Enter-G". Reads from the current cursor position to the end of the document.
5) Auto Scroll: (A) "Up/Down Scroll". Starts and stops the auto scroll function. Set the speed of the auto scroll in the Settings under the File menu. 
6) Read Current Sentence (E) "Space-1-4-5-6". Reads the current sentence.
7) Read Current Line: (L) "Space-1-4". Reads the current line.
8) Read Current Word: (W) "Space-2-5". Reads the current word. Press twice to spell.
9) Read Current Character: (C) "Space-3-6". Reads the current character. Press twice to hear the military alphabet equivalent.
10) Read Cursor Position: (R) "Space-1-5-6". Reads current cursor position as page, paragraph, word, and line.
11) Read Status: (S) "Space-3-4". Reads title of document and indicates Insert or Overwrite mode.
12) Read Character Count: (I) "Backspace-I". Reads the current and total character count of the current document.
13) Read Font info: (F) “Backspace-Enter-N”. provides font, style, and formatting information for the text at your current position.
14) Read Paragraph Info: (Y) “Backspace-Enter-Y”. Displays layout and style information for the current paragraph.

[bookmark: _Toc492453869][bookmark: _Toc26179765][bookmark: _Toc209372171]5.1.7 Layout Menu
1) Font: (F) "Enter-backspace-F". Opens the font settings dialog. Acts on selected text. Use “Space-1” and “Space-4” to change the setting values, and “Tab” and “Shift-Tab” to navigate among the various settings. Change the default font by adjusting the setting values and choosing the “Set Current as default” button
2) Style: (S) “Backspace-Space-Enter-S”. Acts on current paragraph or selected text. Use “Space-1” and “Space-4” to change the setting values.
3) Bullets and numbering: (B) “Backspace-Space-Enter-B”. Opens a dialog where you can choose what type of bullets or numbering to use. For each of the options, Bullets, Numbering, and multi Numbering, Tab forward to choose the style to use. When entering text in an outline, press “Control-3” and “Alt-6” to change the level of the current item.
4) Print Document Layout: (T) "Backspace-T". Determines the format of the pages of a printed document. Choose the “Set As default” option to use as a template for all future documents.
5) Print Paragraph Layout: (C) "Backspace-2-3-4-6". Determines the print format and style of the current paragraph. 
*Note: if you find documents use incorrect word wrapping when transferred to computers or other devices, please Select All text with Enter-A, then turn Word Wrap off in the Print Paragraph Layout.

[bookmark: _Toc492453870][bookmark: _Toc26179766][bookmark: _Toc209372172]5.1.8 Miscellaneous Functions
The following commands can also be used in the Word Processor:
1) Center current line: Backspace-Space-Enter-C.
2) Left Justify: Backspace-Space-Enter-J.
3) Right justify: Backspace-Space-Enter-R.
4) Bold on/off: Control-B.
5) italics On/off: Control-I.
6) Underline On/Off: Control-U.
7) Adjust Font Size: Control-2 And Alt-5.
8) Adjust outline level: Control-3 and Alt-6.
9) Start/End Math Mode: Backspace-M.
10) Insert math symbol: Press Space-H in Math Mode, and press Enter on the symbol in the list.
11) Next slide in PowerPoint file: Space.
12) Previous Slide in PowerPoint file: Backspace.
13) Go to slide in Power Point File: Enter-L.
14) Move back by double carriage return: Backspace-Space-2-3.
15) Move forward by double carriage return: Space-Enter-5-6.
16) Move back by heading: Space-dots-2-3-5.
17) Move forward by heading: space-dots-2-5-6.
[bookmark: _Hlk207316086]18) Open Hyperlink in BrailleSense Browser: Control-L.
19) Open Hyperlink in Android browser: Alt-L.
20) Move to previous table: Control-Alt-dots-3-4-5-6.
21) Move to next table: Control-Alt-dots-1-4-5-6.
22) Move up one cell in the Table: Control-Alt-dot 1.
23) Move down one cell in the Table: Control-Alt-dot 4.
24) Move left one cell in the Table: Control-Alt-dot 3.
25) Move right one cell in the Table: Control-Alt-dot 6.
26) Move to first cell in a Table: control-Alt-dots-1-2-3.
27) Move to last cell in a Table: Control-Alt-dots-4-5-6.
28) Move to first cell in row: Control-Alt-dots-1-3.
29) Move to last cell in row: Control-Alt-dots-4-6.

[bookmark: _Toc26179767][bookmark: _Toc209372173]5.2 Notepad
The BrailleSense Notepad supports reading and creation of RTF, TXT, HBL, BRL and BRF files as well as unformatted DOCX files, and will open PDF, EPUB, DOCX and DOC files. To read PowerPoint files, or to create and/or preserve formatting in Word documents, or to create mathematical expressions, please use the Word Processor described in the previous chapter. 
*Note: though you can open Word documents in the notepad, all document formatting will be stripped. Response time for navigation and searching will be reduced in the Notepad, but if a Word document is saved from within it, all formatting will be lost.
You can launch the "Notepad" in a couple of ways:
Press "F1" to open the main "Program" menu. Navigate to "office Tools" using "Space-4" and press "Enter". Navigate to “Notepad”, and press “enter” to open it. You can also launch the "Notepad" from anywhere on the unit by pressing "F1-N".
When you launch the Notepad on the BrailleSense, it places you in a new, blank document. You can activate all the functions of the Notepad via the Notepad menu or by using hot keys. The menu in the Notepad consists of File, Edit, insert, Mark, Go To, Read, and Layout. To access these menus, press "Space-M" or "F2". Select a menu item using "Space-1" or "Space-4", and press "Enter". Or, you can press "Space-M or "F2" followed by the shortcut for the corresponding menu item. 
Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab among controls in a dialog. 
Press "Enter" to execute an item.

[bookmark: _Toc26179768][bookmark: _Toc209372174]5.2.1 File Menu
The File menu contains the following options:
1) New: (N) “Enter-N”. Creates a new document, by default named "noname". You can create a DOCX or DOC file without formatting, or a TXT, BRL or HBL file.
2) Open New Notepad: (W) “Backspace-o”. Opens a second instance of the Notepad, so you can more easily switch between open files.
3) Open: (O) "Enter-O". Opens an existing file. Supported file types include all those listed at the beginning of this chapter.
4) Recent File list: (R “Backspace-Enter-H”. Displays files you’ve recently opened in the Notepad.
5) Opened Documents List: (D) “Backspace-Enter-O”. Displays all the currently opened documents in a list, so that you do not have to Tab and Shift-Tab through all of them.
6) Save: (S) "Enter-S". Save the current file. Tab between name, location and file type. Use normal file management navigation to choose a different folder. 
7) Save As: (A) "Space-S". Save the current file under a different name, as a type or in a different location. You can choose to password protect files by choosing the HPF file format.
8) Close Current document: (Q) “Space-Q”. Appears only if more than one document is currently open, and closes only the current file
9) Print: (P) "Space-P". Supports only Braille embossing: the document will be printed using a connected embosser.
10) Settings: (E) "Enter-E". Dialog to set various document options. Tab among settings list, location Info check boxes, Default folder, Set Password, and Confirm and Cancel buttons. Settings list includes View Format Characters, Reading unit for Space-1 and Space-4, Read Only On/Off, Automatic Save Interval, Auto Scroll Speed, Apply Settings to All Documents, Home/End movement unit, New Document default name and Show Right to Left Braille. Use “F3” and “Space-F3” to move among the settings in the Settings list, and “Space-1” and “Space-4” to change the value of the setting. This dialog also includes the ability to choose what info is displayed when you query the cursor position, as well as the default save location for documents. When a Braille document is opened, an additional setting appears in the Tab order that allows you to choose the Reading Mode between Original and Compressed. You can also toggle this on/off with “Space-1-2-4-6”.
11) Voice Settings: (V) “Backspace-V”. Allows you to choose separate voice settings from your system voice for reading and navigation in the Notepad, including the voice used, pitch, rate, and volume.
12) Dictionary: (D) "Backspace-Enter-D". Opens the Sense Dictionary installed, and inserts the word under the cursor in the lookup edit box. 
13) Exit: (Z) "Space-Z". Closes the Notepad.
* The BrailleSense allows you to encrypt and password protect files which you do not wish for anyone else to be able to open. Before you save a document as a protected file, you must set a password in the "Settings" option under the "File" menu. The "Set Password" dialog consists of 5 items: "Delete the original file" checkbox, ?, a "Password?" edit box, a "Retype Password" edit box, a "confirm" button, and a "cancel" button. Once the password is set, use the save as dialog, and choose HPF as your file type. 

[bookmark: _Toc26179769][bookmark: _Toc209372175]5.2.2 Edit Menu
The Edit Menu contains the following items:
1) Start Selection: (B) "Enter-B". Marks the beginning of the selection. The end of the selection is marked by the current cursor position. 
2) Copy: (C) "Enter-C". Copies selected text to the clipboard.
3) Cut: (X) "Enter-X". Cuts the selected text to the clipboard.
4) Paste: (V) "Enter-V". Pastes text from the clipboard to the current location.
5) Delete: (D) "Space-D". Deletes selected text.
6) Delete Blank lines: (L) "Backspace-E". Deletes blank lines from the selected text area.
7) Add to clipboard: (P) "Enter-P". Appends selected text to the clipboard without deleting the prior selection.
8) Clear clipboard: (E) "Enter-D". Empties the clipboard.
9) Select All: (A) "Enter-A". Selects all the text in the document. 
10) Toggle Insert/overwrite Mode: (I) “Space-I”. determines whether, when you type text, if it is inserted at the current position, or overwrites the current text.
11) Check spelling: (K) "Enter-K". Opens the Check Spelling dialog, and begins checking the document for errors. Use “F3” and “Space-F3” to move among the controls, and “Space-1” and “Space-4” to move through lists of options. You can also use the following hot keys:
	A. Skip Once: Backspace-S.
	B. Skip All: Backspace-I.
	C. Modify Current: Backspace-C.
	D. Modify All: Backspace-M.
	E. Add to User Dictionary: Backspace-A.
You can also spellcheck the current word with “Backspace-K”.

[bookmark: _Toc26179770][bookmark: _Toc209372176]5.2.3 Insert Menu
1) Insert from File: (I) "Enter-I". Inserts information from another file.
2) Insert Date: (W) "Enter-W". Inserts the current date.
3) Insert time: (T) "Backspace-W". Inserts the current time.
4) Insert Page Break: (P) “Backspace-Space-Enter-P”. Inserts a form feed.
5) Insert Tab: (T) “Backspace-Space-Enter-I”. Indents 5 spaces from current position.

[bookmark: _Toc209372177]5.2.4 Mark Menu
1) Set Mark: (M) "Enter-M". Sets a bookmark at the current cursor position.
2) Jump to Mark: (J) "Enter-J". Jumps to a previously set mark.
3) Delete Mark: (D) "Backspace-D". Deletes a previously set mark.
4) Mark List: (L) “Backspace-M”. Brings up a list of marks for the current Notepad session.

[bookmark: _Toc26179771][bookmark: _Toc209372178]5.2.5 Go to Menu
1) Find: (F) "Space-F". Opens Find dialog where you can enter a text string to search, choose whether to match case, and choose the search direction. 
2) Find Next: (H) "Enter-F". Finds the next instance of the previously searched string.
3) Find Previous: (V) "Backspace-F". Finds the previous instance of the search string from your current position.
4) Find and Replace: (R) "Enter-R". Dialog to search for a text string and replace with an alternative string. Choose search direction, match case, and whether to replace one instance, from cursor to end, or all.
5) Go To Location: (L) "Enter-L". Go to a location in the document according to page, paragraph, line or percentage.
6) Go To Previous Sentence: (E) "Space-2-3-6". Moves back one sentence.
7) Go To Next Sentence: (X) "Space-3-5-6". Moves forward one sentence.
8) Go To Previous Page: (B) "Space-1-2-6). Moves back one page.
9) Go To Next Page: (G) "Space-3-4-5". Moves forward one page.
10) Go To Previous Document: (P) "Shift-Tab". If multiple documents are open, moves to the previous document in the order the files were opened.
11) Go To Next Document: (N) "Tab". If multiple documents are opened, moves to the next document in the file open order. 

[bookmark: _Toc26179772][bookmark: _Toc209372179]5.2.6 Read Menu
1) Read Selected Text: (B) "Backspace-B". Reads the selected block of text.
2) Read beginning of Selected Text: (U) "Enter-U". Reads the first line of a selected text block.
3) Read from Beginning to Cursor: (T) "Backspace-G". Reads from the beginning of the document to the current cursor position.
4) Read from Cursor to End: (Q) "Enter-G". Reads from the current cursor position to the end of the document.
5) Auto Scroll: (A) "Up/Down Scroll". Starts and stops the auto scroll function. Set the speed of the auto scroll in the Settings under the File menu. 
6) Read Current Sentence (E) "Space-1-4-5-6". Reads the current sentence.
7) Read Current Line: (L) "Space-1-4". Reads the current line.
8) Read Current Word: (W) "Space-2-5". Reads the current word. Press twice to spell.
9) Read Current Character: (C) "Space-3-6". Reads the current character. Press twice to hear the military alphabet equivalent.
10) Read Cursor Position: (R) "Space-1-5-6". Reads current cursor position as page, paragraph, word, and line.
11) Read Status: (S) "Space-3-4". Reads title of document and indicates Insert or Overwrite mode.
12) Read Character Count: (I) "Backspace-I". Reads the current and total character count of the current document.

[bookmark: _Toc26179773][bookmark: _Toc209372180]5.2.7 Layout Menu
1) Braille Paragraph Layout: (B) "Backspace-1-2-4-6". Determines the Braille format of the current paragraph.
2) Braille Document Layout: (P) "Backspace-P". Determines Braille document format for embossing.




[bookmark: _Toc492453871][bookmark: _Toc26179774][bookmark: _Toc209372181]5.3 E-mail
To use the e-mail program, you must have an e-mail account, provided to you by your Internet service provider or sign up for a free account such as Gmail or Hotmail. Your e-mail account needs to support POP3 (Post Office Protocol 3), IMAP (Internet Message Access Protocol) and SMTP (Simple Mail Transfer Protocol), or a Microsoft Exchange server to be accessed with the BrailleSense. 
Before you use the e-mail program, you must also configure the BrailleSense to access the Internet, (see section 3.2 "Internet Setup").
· Note: The menus in the BrailleSense's e-mail program are specific to the task you are performing: for example, when checking the "Inbox" in the e-mail program, the menu items are different from the available items when you are writing an e-mail or viewing mailboxes. Generally, the available e-mail program menus are "File", "Edit", "Tools" and "Message".
To access these menus, press "Space-M" or "F2". Select a menu item, and press "Enter". Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab among controls in a dialog. 

[bookmark: _Toc492453872][bookmark: _Toc26179775][bookmark: _Toc209372182]5.3.1 Executing E-mail
To use the e-mail program, you must configure the BrailleSense to access each of your e-mail accounts by entering your e-mail account information. 
To execute the e-mail program, navigate to "E-mail" in the "Office tools" menu, by pressing "Space-1" and "Space-4" and press "Enter". You can also launch the "E-mail program from anywhere on the unit by pressing "F1-E". 
When you launch the e-mail program for the first time, the BrailleSense says, "You must create at least 1 mail account from the accounts manager in the Tools menu". Then, the "Inbox" is opened. 
The "Inbox" is the main window of the E-mail program. When you run the e-mail program for the first time, this "Inbox" is empty and the BrailleSense displays "no items".
If there are e-mail messages in the "Inbox", "Opening inbox." is announced; and "xx% processed" is displayed on the Braille display. Once progress has reached 100%, the "Inbox" is opened and displays the received e-mail in the message list. 
Press "Shift-Tab (Space-1-2)", and you are placed in the mailbox list. By default, the BrailleSense contains the following mailboxes: 
1) Inbox: received mail that has not been deleted or saved to a different folder.
2) Sent: sent messages you have chosen to store 
3) Outbox: messages waiting to be sent, either when you save mail in "Outbox" or sending mail fails.

[bookmark: _Toc492453873][bookmark: _Toc26179776][bookmark: _Toc209372183]5.3.2 Setting Up an Account
To access the "Accounts Manager", Open the menu with "F2", navigate to "Tools" and press "Enter". "Accounts Manager" is the first item in the "Tools" menu, thus, you can just press "Enter" again to open it. You can also launch the "Accounts Manager" from anywhere in e-mail by pressing "Enter-M".
"Account name: no items" is displayed. 
The "Accounts manager" dialog contains the following 6 items: "Accounts" list, "Information" button, "Add" button, "Modify" button, "Delete" button and "Close" button.

To add an e-mail account, follow these steps:
1) From the "Accounts Manager", press "F3", to move to "Add" and press "Enter".
2) The dialog is opened and “default Mail Server” is displayed. Press “Space” to choose among POP3, IMAP, Exchange MS, or Exchange Server. * The Exchange MS option should specifically be used for Office 365 accounts or for organizational accounts using the Office 365 protocol. All other Exchange accounts should use the “server” option.
The remaining items in the dialog will somewhat vary depending on your choice.
3) If you choose POP3 or IMAP, "Server Type" is displayed. This is a combo box in which you can choose to manually setup your account, or ask BrailleSense to auto fill in server information from known server types like Gmail and iCloud. Use "Space-1" and Space-4" to navigate the Server types. If your server is not in the list, select "Manual". Press F3 to move to the next control.
4) "Account name:" is displayed. Type the name by which you want to identify the e-mail account: (example, "Gmail" or "work e-mail").
5) Press "F3", to move to "Display name". Type the "Display name" in the edit box. This name is the name people will see when they receive an e-mail from you.
6) Press "F3", to move to "Logon username". Type the "Logon username" in the edit box (using computer Braille if writing in US Braille). (Ex: Sense or sense@himsintl.com).
·  Note: some providers require you to use the entire e-mail address as the username, while others may use the part of the address before the at-sign. BE sure you type the username correctly for your e-mail provider.
*** If you’ve chosen IMAP as your default mail server, and Google as your server type, your next control is a “Sign In with Google” button, which will take you to a Google sign in page, where you will enter your password and accept any permissions Google requests. For all other types, continue with the steps below.
7) Press "F3", to move to "Password". Type the "password" in the edit box ( computer Braille if using US Braille). 
· Note: By default, the password is hidden, and thus displays as asterisks. Be sure to type carefully as you cannot review your password unless you choose not to hide passwords in the "Global Options". 
8) Press "F3", to move to "E-mail address". Type your "E-mail address" in the edit box (again, use computer Braille if entering US Braille). (Ex: sense@himsintl.com)
9) Press "F3", to move to "Incoming Server?". If you have selected "IMAP" as your incoming server type, "Incoming IMAP server?" is displayed. If you have chosen "POP3" as your incoming server type, "Incoming POP3 server" is displayed. Type the "Incoming server" in the edit box (in computer Braille for US Braille). (Ex: imap.himsintl.com, or pop.himsintl.com). Check with your account provider for your specific incoming server name. 
10) Press "F3", to move to "Outgoing SMTP server". Type the "Outgoing SMTP server" in the edit box (computer Braille if using US Braille). Check with your account provider for the exact name of your outgoing SMTP server. 
11) Note that if you have chosen either of the Exchange account types, the process is the same, but the dialog has only “Account Name”, “Exchange Server URL”, “Logon Username”, and “Password”, as this is all the information required for Exchange accounts.
12) When you have filled in all the information, "Tab to the "Confirm" button and press "Enter".
13) The BrailleSense checks the information and tries to connect to your account. If it cannot do so, you are given an error, and asked to modify the information.
14) If connection is successful, it exits to the "Account name list" and shows the added account name (Ex: Account name: BrailleSense 1/1).
15) When you finish adding accounts, press "Space-Z" to return to the "Inbox".
· Note: Many e-mail service providers use secure servers with different port numbers. If your service provider requires you to use encryption, you must set these options in the "Advanced" dialog explained below:
· Note: If you are not using UEB, several of the fields for setting up an e-mail account require you to use computer Braille. To type your ID, Password, and address, 

While adding your account, you can create a signature and set advanced options in the "Advanced" dialog. 
1) Open the "Accounts Manager" as described previously. 
2) If you're creating a new account, "Tab to the "Add" button and Press "Enter". If you need to add advanced settings to an account you've already created, Tab to the "Modify" button and press "Enter".
3) When you have filled in everything in the main account settings list, press "F3" to move to "Advanced" and press "Enter".
4) if you are setting up an Exchange account, this dialog will contain only the signature options. If using IMAP or POP3, everything below is displayed.
5) First, BrailleSense displays "Use secure POP3 (or IMAP) (POP-SSL)". The default value of this check box is unselected. If the POP3 or IMAP server uses "SSL", select the check box by pressing "Space".
6) Press "F3" to move to "POP3 (or IMAP) port number": POP3 is set to 110 by default, and IMAP is set to 143 by default. Type a different POP3 or IMAP port number in the edit box if your provider requires a different port number. 
· Note: if you check "SSL" above, the pop port number is automatically changed to 995 and the IMAP port to 993, as most servers with SSL require. 
7) Press "F3" to move to "SMTP encryption type". The setting values are "None", "SSL" and "TLS". If your Outgoing SMTP server uses "SSL" or "TLS", change the value by pressing "Space".
8) Press "F3" to move to "SMTP port number": set to 25 by default. If you have chosen "SSL" as the encryption type, the default port number is set to 465 as is most commonly used for SMTP servers using SSL. If you have chosen TLS, the default SMTP port number is set to 587. Type a different value in the edit box if your provider uses a different SMTP port number. 
9) Press "F3" to move to "SMTP username". If your Internet account provider requires you to use a different SMTP username, enter it in this edit box.
10) Press "F3" to move to "SMTP password". Type the password that corresponds to the above ID (using computer Braille if entering US Braille). If your SMTP username and password are not different, leave these items blank. 
11) Press "F3" to move to "Use as default send-from account" To use the username and password that were set in steps 7 and 8, select the check box by pressing "Space".
12) Press "F3", move to "Use signature". The default value is "No". To attach a signature to your mail, press "Space" to change "No" to "Yes".
13) If you chose yes, press "F3", to move to "Signature" and press "Enter". 
14) You are placed in the "Signature:" multi edit box. Type the information for the signature you want to attach to your e-mails. 
15) Tab to "Confirm" and press "Enter". 
16) Tab to the "Confirm" button and press "Enter" to save the settings in the "Advanced" dialog.
17) Tab to the "Confirm" button one more time to save the settings in the main "Account information" dialog.

[bookmark: _Toc492453874][bookmark: _Toc26179777][bookmark: _Toc209372184]5.3.3 Managing Accounts
To view the information about a stored e-mail account, open the "Accounts Manager" as described previously. Navigate to the account for which you want information and press "Enter" or Tab to "Information" and press "Enter".
In this dialog you can read all information associated with an e-mail account. Use "Space-1" and "Space-4" to navigate the list of settings for the account. Press "Space-E" to return to the accounts list. 
To modify the information for an e-mail account, open the "Accounts Manager" and navigate to the desired account in the list. When the desired account is displayed, press "F3" to move to the "Modify" button, and press "Enter". Or, press Enter-M to activate the "Modify" button. 
You are placed in the "Account name" edit box. You can now make changes to the information presented. The "Modify" dialog is exactly like the "Account setup" dialog, except that all the information is already filled in. Use normal editing and navigation commands to navigate to the information and make your desired changes. 
When you have finished making modifications, press "F3" to move to "Confirm" and press "Enter". 

Use the following steps to delete an E-mail account.
1) Open the Accounts Manager in the manner previously described.
2) Press "Space-4" or "Space-1" to move to the desired account in the account list.
3) When the desired account is displayed, press "Space-D" Or, press "F3" to move to the "Delete" button, and press "Enter".
4) BrailleSense prompts, "Are you sure you want to delete the (added account name) account? Yes". 
5) Press "enter" To delete it. Press "Space-Z" to cancel the deletion.

[bookmark: _Toc492453875][bookmark: _Toc26179778][bookmark: _Toc209372185]5.3.4 Receiving E-mail
To check for new mail, press "Enter-N". You can also choose "Check for New Mail" from the "Message" menu. For POP3 accounts, the BrailleSense displays "There are xx messages to receive. Now receiving." "x/y mail received;" "Successfully received x out of y message" is displayed. When the e-mail messages are downloaded from the server, the e-mail message list is displayed in the "Inbox". 
To cancel the download, press "F3" to move to the "Cancel" button, and press "enter", or press "Space-E". 
When receiving messages via an IMAP or exchange server, you can both check the newest mail, according to the number of messages you have it set to automatically receive in the "Set options" dialog, or you can ask the BrailleSense to load older e-mail messages. To receive the newest e-mail messages, press "Enter-N" from the message list of the mailbox on which you are located. To receive previous mail, press "Backspace-P". You can also access "Get new mail" and "Get Previous mail" from the "Message" menu. 
In addition, when using IMAP or Exchange, as you navigate the various mail boxes in an account, new mail is automatically received for each mail box as you open it. 

[bookmark: _Toc492453876][bookmark: _Toc26179779][bookmark: _Toc209372186]5.3.5 Reading Messages
E-mail messages are displayed in the Inbox and other mailboxes with the following information: "Subject", "Date", "From" (Sender), "CC", "Message" (main body of the e-mail) and "Attach" (displayed only for an e-mail with one or more attached files). If the Importance level is anything other than “normal”, or rather, if it is identified as either high or low importance, this is also displayed in the Tab order. Flag status appears in the Tab order as a checkbox. You can move among the items by pressing "F3" or "Space-F3".
If there is a file attached to the e-mail, an A is shown before the subject, and the number of attachments is announced as you navigate the message list. The BrailleSense also indicates which e-mail messages have been read, and which e-mail messages are unread. E-mail messages that have not yet been read have a dash placed in front of the subject. In Exchange accounts, the Message List also indicates importance level if it is identified as either “High” (h” or “low” (l). If the Importance level is “normal”, there is no designation in the Message List. If a message is flagged, an F is displayed before the subject in the Message list. To change the flag status of the current or selected message(s), press “Backspace-Enter-F”. *Note: flag status will synchronize for IMAP and Exchange, but not for POP3, as no synchronization occurs for POP3 accounts. 
You may also RSVP to appointment invitations. To do this, press “Backspace-Enter-I”, or press enter on the invitation attachment.
"Date" shows the date and time when the e-mail was received in the following order: day, month, date, and year. The time is displayed in the following order: hour, minute, and second using 24 hour time format. 
"From" shows the sender information; "From: (sender's e-mail address) you can save the e-mail id of the sender to your contacts in the "Address Manager" using the following steps:
1) Press "Enter-I" when the sender is displayed.
2) The "add address" dialog is opened, and "Name: (sender's user name or e-mail address)" is displayed.
3) Type the sender's first and last name, or, if what is automatically filled in is acceptable, press "F3" to move to "confirm", and press "enter". The contact is saved, and you are returned to your previous position in the message list. If the contact already exists, you will be prompted, and given the option to modify the contact.
You can also save the e-mail id of the carbon copy recipient (CC) to the Address Manager using the process described above.
*Note: You can choose the content that is displayed in the Message List as well as the order in which it appears in the options menu described later in this chapter.

You can move to the body of a message by pressing "F3". Or, you can press "enter" when "Subject", "Date", or "From" is displayed. When you press "enter", the entire message is automatically spoken. To interrupt reading, press "Backspace-enter". Navigate the message as you would a document in the "Word Processor". To return to the "Subject", press "Space-E". 
· If you receive an html e-mail, you can access the links and other HTML content by viewing the message in the BrailleSense's Web Browser. Open the message with the Web browser by pressing "Backspace-O", or by selecting "Open Message in Web Browser" from the "Message" menu. 
· You can find and download attached files by tabbing to "Attach" on messages containing attachments. Press “Enter” on an attachment, and you are prompted to “Save” or “Open” it. If you choose to save, you are placed in the Save As dialog, where you can modify the file name, and choose the location. If you choose “Open”, the file is automatically saved to the “Downloads” folder, and opened in the program associated with its file type.
· If you have more than one attachment you want to download, you can press "Enter-A" to select all attachments in the list, or press space on any number of individual files to select them, and all will be saved to the “Downloads” folder, unless you choose a different location. 
To save attachments directly from the Message List, without opening a message, press “Backspace-F” when the message is focused.
To change the download path: When you are prompted, "Attachments will be saved to /flashdisk/download. Do you want to change this location?", navigate to "Yes" and press "Enter". You are placed in the file list of the "Downloads" folder on the "flashdisk". Use normal file and folder navigation to locate the folder into which you want to save the attachments. Press "Space" to select the folder in which to save the attachments, and press "Enter". * Note: when using IMAP, the message must be opened before you can navigate to the attachments. 
You can delete e-mail messages individually, or you can select multiple messages and delete them simultaneously. Press "Space-D" to delete the current message, or select multiple messages with "Space", then press "Space-D" to delete all of them. 
When you delete messages, they are automatically moved to the "Trash" folder, where they remain until you delete them from there, or until you empty the "Trash" folder. You can empty the "Trash" folder at any time by pressing "Enter-Backspace-Q" or choosing 'Empty Trash' from the "Edit" menu. 
If you wish to delete messages immediately, without first sending them to the “trash” folder, press “Backspace-D”, and they are immediately removed from your BrailleSense.
· Note: When messages are deleted from the "Trash" folder, they are permanently disposed of, and cannot be retrieved. The same is true when using the “Backspace-D” function.
You can also archive messages if your server supports this function. To archive the focused message or a group of messages you have selected, press “Backspace-A”. the messages are moved, and the message list is refreshed.

[bookmark: _Toc492453877][bookmark: _Toc26179780][bookmark: _Toc209372187]5.3.6 Writing E-mail
To write a new message, choose "Write New Message" from the "File" menu, or press "Enter-W" from the message list. "To:" is displayed on the Braille display. If you wish to use a different account from the default, Shift-Tab to the "Account" combo box, choose your desired account, and Tab back to the "To" field. 
Type the e-mail address of the recipient, or rather, the person to whom you are sending the message. If using US Braille, you must use computer Braille. To send to multiple recipients, place a semicolon between the e-mail addresses.
You can also add recipients from the address list by selecting "Look up Address" from the "File" menu or pressing "Enter-L". Type the First name, last name or part of the e-mail address of the desired recipient, and press "enter". 
Addresses matching your search are displayed. If you press "enter" without typing in the desired name, all of the addresses in your address list are displayed. If there is no matching address, "No match" is announced. Move to the desired address, and press "enter". You can select more than one address by pressing "Space", then enter to input all of them. 
You can also type any of the information above directly into the To or CC fields, and the first match will automatically be filled in when you Tab to the next field.
When you are finished entering recipients in the "To" field, press "F3" to move to "CC:" and "BCC", and input any copy or blind copy recipients as described above. If you do not need to carbon copy anyone, you can skip to the next step.
Press "F3" to move to "Subject", and type the subject of the e-mail message. Finally, press "F3" to move to "Message body:", and type the text of your e-mail message. Use the same input and editing methods as are used in the Word Processor. 
When you have finished writing your e-mail message, select "Send" from the "File" menu, or press "Enter-S" directly from your message. When the e-mail is finished sending, "Successfully sent new message" is displayed. If sending fails, the BrailleSense displays "Unable to send message", often with a specific error explaining the reason for the inability to send the message. If this occurs, the e-mail is saved in the "Outbox".
To cancel e-mail message creation or sending, press "Space-E" or "Space-Z" and you are returned to the "Inbox".

[bookmark: _Toc492453878][bookmark: _Toc26179781][bookmark: _Toc209372188]5.3.6.1 Attaching a File
To attach a file to a message, select "Attach File" from the "File" menu, or press "Enter-F" while writing an e-mail message. Use normal file and folder navigation keys to locate the file or files you want to attach. 
Press "enter" on the desired file to attach it. To attach more than one file, press "Space" to select each file you want to attach. * is displayed in front of the selected file names. Press "enter" To attach the selected files. Now, the "Attach" item is displayed in the tab order after the "Message body". 

[bookmark: _Toc492453879][bookmark: _Toc26179782][bookmark: _Toc209372189]5.3.6.2 Saving E-mail to the Outbox
Messages are saved in the "Outbox" under 2 conditions:
1. The user manually saves the e-mail to the "Outbox" for later sending.
2. An e-mail is automatically saved to the "outbox" after it fails to send due to a network error or other reason.
While writing a message, you can save by selecting "Save Mail in Outbox" from the "File" menu, or pressing "Space-S". A default file name is shown titled with the subject of the email. Press "Enter" to save the e-mail under the current file name, or type a new file name and change the path where the file is stored using the same method as in the "Save As" dialog of the Word Processor.
· Note: If you choose to save the e-mail in a location other than "flashdisk/email/outbox", you cannot access the e-mail message in the "Outbox". Thus, you cannot send the e-mail unless it is returned to the "Outbox" folder.
While creating a "message", press "Space-E" or "Space-Z" To cancel writing the e-mail. The BrailleSense displays "Currently writing mail. Save? Yes". Press Enter to save the message in the Outbox. To return to the "Inbox" without saving the e-mail, press "Space" to change "Yes" to "No", and press "Enter".
To send a message from the Outbox, "Shift-Tab" to the mailbox list, navigate to the Outbox, and Tab to the message list. Press "Space-1" or "Space-4", to move to the message you want to send.
If you want to send all the e-mails in the list: Press "Enter-a (dot 1) to select all. If you want to send individual messages, use normal selection commands to select them. Press "Enter" on "Send" from the "File" menu, or just press "Enter-S" from the outbox, and the messages are sent. 

[bookmark: _Toc492453880][bookmark: _Toc26179783][bookmark: _Toc209372190]5.3.7 Navigating Accounts and Mailboxes
There are two ways to move to an account or mail box. 
You can access the accounts list or mailbox list by moving through the tab order until you reach "mailboxes" or "Accounts". Use "Space-1" or "Space-4" to move among the items in the list, and press "F3" to open the Account or mailbox. 
You can also use the following hot keys to navigate accounts and mailboxes:
Go to next mailbox: Enter-3-4-5.
Go to previous mailbox: Enter-1-2-6.
Next account: Backspace-dots-3-4-5.
Previous account: Backspace-1-2-6.
· Note: These hot keys are not available from the account list or mail box list.
· Also note: When using exchange, if your mailbox contains subfolders, press Enter to open these, and backspace to return to the parent folder. 

[bookmark: _Toc492453881][bookmark: _Toc26179784][bookmark: _Toc209372191]5.3.7.1 Managing Mailboxes
You can create additional mailboxes in the "E-mail" folder for sorting and storing your messages. 
To create a new mailbox, from the Mailbox list, open the "Edit" menu and select "Create New Mailbox", or press "Enter-N" to activate this function directly. Type the mailbox name you want to create, and press "Enter". 
The BrailleSense does not allow you to delete the "Inbox", "Sent", or "Outbox". However, you can delete folders/mailboxes you have created.
To delete a folder/mailbox, navigate to the mailbox you want to delete in the Mailbox list, open the "Edit" menu and choose "Delete Mailbox". You can also delete the current mailbox in the list by pressing "Space-D". 
You can also rename mailboxes you have created. To do this, from the mailbox list, navigate to the mailbox you wish to rename. Open the Edit Menu and select "Rename mailbox", or press "Enter-R" to open the "rename mailbox" dialog directly. Type the new name for the folder mailbox, and press "Enter". 

[bookmark: _Toc492453882][bookmark: _Toc26179785][bookmark: _Toc209372192]5.3.7.2 Copying and Moving to Mailboxes
You can copy and move e-mails using the "Copy to Mailbox" or "Move to Mailbox" commands in the "Edit" menu.
The "move/Copy dialog" contains the following:
1) "Folder" list.
2) "Create mailbox" Button
3) "Delete mailbox" Button
4) "Rename mailbox" Button
5) "Confirm" Button
6) "Cancel" Button

To copy and move an e-mail to another folder, follow these steps:
1) Select individual e-mails by pressing "Space", select a continuous group with "Enter-B" or select all with "Enter-A". 
2) Open the "Edit" menu, and press "SPACE-4", to move to "Copy to Mailbox" or "Move to Mailbox" and press "Enter". You can activate these functions directly from the message list by pressing "Backspace-C" for "Copy" and "Backspace-X" for "Move to". 
3) BrailleSense displays "Folder list". 
4) Press "Space-4", to move to the folder into which you want to copy or move messages and press "Enter0. 
5) The e-mail is moved or copied to the selected folder, and you are returned to the mailbox from which you activated the "Move" or "Copy" command.

[bookmark: _Toc26179786][bookmark: _Toc209372193]5.3.7.3 Importing Email
You may wish to access e-mail on your BrailleSense from older Braille Sense devices or other units that use EML message files. You can do this using the Import function in the File Menu, or by pressing “Backspace-I” from the message or mailbox list. 
*Note: files and folders selected in this dialog will import to the currently open or focused mailbox. So, if you wish to import to a clean folder, you must create a folder as described previously, and be located within it or focused on it before you start this process.
When you activate the import function, you are placed in an “Open File” dialog. Use normal file and folder navigation to locate the folder where you’re messages are stored. Use File management selection commands to select the folders and files you want to import, and press Enter. Import progress is shown as a percentage.

[bookmark: _Toc492453883][bookmark: _Toc26179787][bookmark: _Toc209372194]5.3.8 Advanced Message Features

[bookmark: _Toc492453884][bookmark: _Toc26179788][bookmark: _Toc209372195]5.3.8.1 Reply and Reply All
When you reply to an e-mail, you can edit or add a message to the original message, or add another recipient. Choosing "Reply" sends an e-mail to only the original sender. Choosing "Reply To All" sends an e-mail back to the original sender as well as all other recipients of the original e-mail. 
 1) From "Subject", "Date", or "Message body" of a message in the "Inbox", select "Reply" or "Reply All" from the "Message" menu, or press "Enter-R" or "Backspace-R" respectively.
2) You are placed in the message body, which already contains the original message body of the received e-mail; below "--- Original Message ---". 
3) You can type additional text, edit the original message, and/or edit any of the fields associated with the message including the subject and recipient fields.
4) When you have finished, press "Enter-S" to send the e-mail.
You can save replies just as you can save new messages in the "Outbox" for sending later.

[bookmark: _Toc492453885][bookmark: _Toc26179789][bookmark: _Toc209372196]5.3.8.2 Forwarding a Message
"Forwarding" refers to sending an e-mail you received to another person. 
1) From the "Subject", "Date", or "Message body", open the "Message" menu and select "Forward", or press "Enter-F".
2) BrailleSense displays "To:". Input the e-mail address of the new recipient, or multiple recipients, using computer Braille.
3) Press "F3", to move to "CC", "BCC", and "Subject" and edit them as you wish. The subject will appear as "FW: (original subject)".
4) "Tab" to the message body. The original e-mail message is shown following, "----- Forwarded Message -----".
5) Type any additional text you wish to add to the message, or make any edits to the forwarded text, and press "Enter-S" to send. 
If you don't want the e-mail to appear in the same message body as the e-mail you are writing, you can also forward the current e-mail as an attachment. Use "Backspace-W" to send the current e-mail as an attachment, then use the process described above.

[bookmark: _Toc492453886][bookmark: _Toc26179790][bookmark: _Toc209372197]5.3.8.3 Saving an E-mail
There may be times when you wish to save a received message as a file. Please note that there is a small difference between IMAP and POP3. 
1) Using Pop3: when placed on one of the fields of an e-mail message you want to save, select "Save as Text" from the "File" menu, or press "Space-S".
2) BrailleSense displays "File name: (subject of e-mail being read.txt". 
3) Press "Enter" to save the message under the current file name. If you wish, you can rename the file using the same method as in the "Save As" dialog of the "Word Processor". 
If you are using IMAP or Exchange, you must first navigate to and open the message before you can save it. Otherwise the steps are exactly as those above.

[bookmark: _Toc492453887][bookmark: _Toc26179791][bookmark: _Toc209372198]5.3.8.4 Finding Messages
The "Find" command is used to search for messages in the current mailbox. The "Find" function looks for text that matches the text you enter in "Subject", "Date", and/or "From". This function only works in the "Subject", "Date", or "From" controls. Use "Space-F" to open the "Find" dialog, or open the "Edit" menu and press "Enter" on "Find". 
Use "F3" and "Space-F3" to move among the controls. Type the text to search in the Edit box. Choose what parts of the message to "Search". Choose the direction to search, and press "Enter". 
The "Find Again" command finds the next occurrence of the text according to the search text and direction specified in the "Find" dialog. As with "Find", the "Find Again" function only works in the "Subject", "Date", or "From" fields. Open the "Edit" menu and press "Enter" on "Find Again", or press "Backspace-F" from the message list.

[bookmark: _Toc492453888][bookmark: _Toc26179792][bookmark: _Toc209372199]5.3.8.5 Move to Next Unread Message
The "Move To Next Unread Message" command allows you to move to the next unread message. If you use this function on the last unread message in a list, you are taken to the first unread message in the list. 
To activate this function from the "Subject", "Date", or "From" field, open the "Edit" menu and select "Move to next Unread Message" or press "Enter-U" to activate this function directly. 

[bookmark: _Toc209372200]5.3.8.6 Activating Links
Many e-mail messages contain web links, either to general websites, or to calendar/online events.
You can open a link in the BrailleSense Browser by pressing “Enter-L” when your cursor is placed on the Web address.
If you are activating a link to a Zoom meeting, Google Meet invitation, a Teams live event, or other item that requires launching of an installed app, you must open this link in an Android browser, as the BrailleSense browser does not automatically launch other programs. 
To open a link located in the current paragraph in the default Android browser, press “Backspace-L”. The browser will launch, which will then, in turn, activate the associated Android program, provided that program is installed on your BrailleSense. For example, if you want to launch a Zoom meeting, you need to install the Zoom application on your BrailleSense installed on Google Play.

[bookmark: _Toc492453889][bookmark: _Toc26179793][bookmark: _Toc209372201]5.3.9 Using the Tools Menu
In addition to the "Accounts Manager", the "Tools" menu contains options for setting the save path, spam filters and other e-mail options. 

[bookmark: _Toc492453890][bookmark: _Toc26179794][bookmark: _Toc209372202]5.3.9.1 Set Path
"Set Path" sets the default download path where file attachments and e-mail are stored. To set the download path, open the "Tools" menu and press "Enter" on "Save Path", or press "Enter-T" from the message list.
The "Set Path" dialog contains three settings:
1) Save attachments path
2) Send attachments path
3) Disk to save mail in

You can move among these items by pressing "Space-4" and "Space-1". Each item consists of "Path", "Modify", and "Close". At "Path", the default path is displayed. You can move among this information by pressing "F3" or "Space-F3". If you choose to modify any path, use normal file management navigation to locate your desired folder, and press "Enter".

[bookmark: _Toc492453891][bookmark: _Toc26179795][bookmark: _Toc209372203]5.3.9.2 Set Options
To open the "Set options" dialog, press "Enter" on "Options" from the "Tools" menu, or press "Enter-O" to activate this item directly.
The first item in the "Set options" dialog is "Default server?” You can set the default server to any of your established accounts, or to “Off”. If you set the default server to off, when the E-mail program is opened, you are placed in your accounts list. Setting it to any of your accounts will display the inbox for that account when E-mail is launched. Use "Space" to change the value of the setting.
The next item in the Set Options dialog is “Use as default send From Account”. Press “Space to choose among the accounts you have set up.
The next option in the dialog is "Number of Messages to receive.” This applies to the number of messages retrieved with a refresh of an IMAP or Exchange mailbox. The default is set to 32. Use "Space" or "Backspace" to cycle through the various options. The available values are All, 32, 64, 96, and 128.
The next option in the dialog is an option for choosing the "Exchange Message List Type".
This is related to the speed at which e-mail messages are received. If you choose to display less header information, e-mail is received faster. The settings are "Detailed" and "Simple".
The "Detailed" setting displays the Attachment count, title, sender name, sender email, and the date. The "Simple" view displays the Attachment count, title, sender name, and the date.
This setting also affects the Spam Settings in the "Tools" menu. If you select the "Detailed" option, you can add the subject, address or host to the spam filter. If you select the "Simple" option, you can add only the subject to the spam filter. 
The next 5 options relate to how information appears in the Message List. 
The “Display Header Labels” option lets you choose whether field titles such as “subject”, “Date”, appear when messages are displayed. When this is set to off, the specific e-mail addresses of senders and recipients are not displayed, only their names.
For each of the 4 message headers, you can choose to display the sender, (From, the recipient (To), subject of the message (Subject), or the date and time the message was received (Date). For the 2nd, 3rd and 4th headers, you also have the option not to display them at all (Off). This option is not available for the 1st header as, if all headers were turned off, the Message list would display no content. This allows you to show only the content you want to see in the Message list, as well as to determine in what order it appears.
As you make choices for each header, these disappear from the options for the remaining headers. For example, if you choose “Subject” for the 1st header, you will not see this as an option for your 2nd, 3rd and 4th headers. But, if you change the first header to “From”, the “Subject” option will re-appear, and the “From” option will not appear for the rest of the headers. 
The option below the headers is “Sort Order”. This allows you to choose whether messages appear in ascending or descending order in the Message List.
The final option is “Browser to Open Messages”. This setting allows you to determine whether, when using the “Backspace-O” command, the message opens in the “BrailleSense Browser” or your default “Android Browser”.
When you have finished adjusting the settings, press "Enter" to save the options, or tab to the "Confirm" button and press "Enter". If you do not wish to save your changes, tab to the "cancel" button and press "Enter" or press "Space-Z". 

[bookmark: _Toc492453892][bookmark: _Toc26179796][bookmark: _Toc209372204]5.3.9.3 Spam Settings
When the BrailleSense downloads e-mail from the e-mail server, there may be a number of e-mail messages that are spam. In this case, you can avoid downloading these spam e-mail messages by identifying specified words in the subject or specifying e-mail addresses you know are from spammers.
The spam e-mail messages that are identified by your "Spam Settings" are not downloaded into the BrailleSense, and remain on the e-mail server.
Use the following steps to set spam e-mail filters:
1) Open the "Tools" menu and select "Spam Settings", or press "Enter-E" to activate this item without accessing the menus.
2) The "Spam Settings" dialog contains 6 items: "Type" combo box, "List", "Add" button, "Modify" button, "Delete" button, and a "Close" button.
3) "Type" can be set to 1 of 3 options: "Subject", "E-mail address string", and "Host". You can move among these options by pressing "Space-1" or "Space-4". The "list" is displayed according to the "Type" you choose.
— If you have selected "Subject", the list is displayed as "Subject: (Registered word) 1/xx". If you selected "E-mail address string", it is displayed as "E-mail address string: (Registered e-mail address string) 1/xx". It is displayed as "no items" if there is no registered word or e-mail address string.

How to register Spam Settings:
1) Press A when "Type: Subject 1/3" is displayed. Or, press "F3" to move to the "Add" button, and press "enter".
2) The "add dialog" is opened and "Subject add:" is displayed.
3) Type the words, by which you want to identify spam messages and press "Enter". Or, "Tab" to the "Confirm" button, and press "enter". 
4) "Successfully added spam data". is announced and you are returned to the "list". "Subject: (registered word) 1/1" is displayed.
By adding the word in the manner just described, if there are e-mail messages that include the words you entered in the subject of the message, the BrailleSense downloads those e-mails from the e-mail server, but deletes them automatically. 
You can also avoid receiving e-mail messages from a specific sender or host by registering it in the same manner.
To cancel setting spam filters from the "Add dialog", press "F3" to move to the "Cancel" button, and press "Enter". Or, press "Space-E" or "Space-Z". 

To modify a spam filter you have set, do the following:
1) Access the "Spam Settings" dialog as described previously, and navigate to the "Type" of spam setting you want to modify by pressing "Space-1" or "Space-4". 
2) Press "F3" to move to the list of registered items in that category. 
3) Navigate to the item you want to modify using "Space-1" or "Space-4". 
4) Press M, or press "F3" to move to the "Modify" button, and press "Enter". 
5) Make the modifications in the edit box.
6) Press "F3" to move to the "confirm" button, and press "Enter" to save the changes. 

You can also delete an item that has been registered in the spam list. 
1) Access the "Spam Settings" dialog as described previously, and navigate to the "Type" of spam setting you want to delete by pressing "Space-1" or "Space-4". 
2) Press "F3" to move to the list of registered items in that category. 
3) Navigate to the item you want to delete using "Space-1" or "Space-4". 
4) Press D or press "F3" to move to the "Delete" button, and press "Enter".
[bookmark: _Toc492453946][bookmark: _Toc26179862][bookmark: _Toc209372205]5.4 Excel Viewer
The "Excel Viewer" allows you to read and navigate XLS and XLSX files by cell, column, row, group, worksheet, etc. To open the "Excel Viewer", from the Main menu, press T to open the "office Tools" menu, then press X to open the "Excel Viewer". You can launch the "Excel Viewer" from anywhere on the unit by pressing "F1-X". 
When the "Excel Viewer" is launched, you are placed in an "Open File" dialog. Use normal "File List" navigation commands to locate the XLS or XLSX file you wish to open, and press "Enter". When the file is loaded, you are placed at the top of the first worksheet. Cells are displayed with the coordinates followed by the text of the cell. For example, the first cell in a column containing the date might appear as "a1 Date". 

[bookmark: _Toc492453947][bookmark: _Toc26179863][bookmark: _Toc209372206]5.4.1 General Navigation
Use the following commands to navigate an Excel file in the "Excel Viewer". 
Move to next row: Space-Dot-4 
Move to previous row: Space-Dot-1 
Move to next column: Space-Dot-6 
Move to previous column: Space-Dot-3 
Move to beginning of row: Space-Dots-1-3 
Move to end of row: Space-Dots-4-6 
Move to top of column: Backspace-Dot-2 
Move to bottom of column: Backspace-Dot-5 
Move to top of worksheet: Space1-2-3 
Move to bottom of worksheet: Space-4-5-6 
Move to next worksheet: Space-3-4-5 
Move to previous worksheet: Space-1-2-6 
Move to next group: Backspace-Dot-5-6 
Move to previous group: Backspace-Dot-2-3 
Move to next group in row: Space-Dot-5 
Move to previous group in row: Space-Dot-2 
Move to next group in column: Space-Dot-5-6 
Move to previous group in column: Space-Dot-2-3 
You can access functions of the Excel Viewer using hot keys, or via its menus. To access these menus, press "Space-M" or "F2". Select a menu item using "Space-1" or "Space-4", and press "Enter". Or, you can press "Space-M or "F2" followed by the shortcut for the corresponding menu item. 
The Excel Viewer also utilizes lists and dialogs. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab and shift-tab among controls in a dialog. For the purposes of these instructions, we will generally refer to this as "Tabbing". 
Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate menus, settings or file lists. Press "Enter" to execute an item.

[bookmark: _Toc492453948][bookmark: _Toc26179864][bookmark: _Toc209372207]5.4.2 The File Menu
1) Open: (O) "Enter-O". Open Excel Viewer compatible files.
2) Open Hyperlink: (H) "Enter-H". Open a link contained in an Excel file in the Web Browser.
3) Set User Table: (T) "Enter-T". Set the parameters for columns and rows in order to get accurate information for headers and rows of sub tables.
4) Cell Properties: (I) "Enter-I". View format information for the cell. 
5) Quick Setup: (Q) "Enter-X". Operates similar to the "Set User Table" function, except instead of defining the boundaries manually, the beginning cell is automatically set as the cell at your current cursor position, and the end cell is automatically set as the last cell containing data.
6) Save As: (S) "Space-S". Lets you save an Excel file as a CSV or TXT separated by tabs or commas.
7) Exit: (Z) "Space-Z". Close the Excel Viewer.

[bookmark: _Toc492453949][bookmark: _Toc26179865][bookmark: _Toc209372208]5.4.3 The Edit Menu
1) Start Selection: (B) "Enter-B". Begin selection of a text block. The end of the selection is determined by your current cursor position.
2) Select All: (A) "Enter-A". Select all the data on the current sheet.
3) Copy: (C) "Enter-C". Copy the selected text to the clipboard.

[bookmark: _Toc492453950][bookmark: _Toc26179866][bookmark: _Toc209372209]5.4.4 The Go To Menu
1) Find: (F) "Space-F". Search for text on the current sheet.
2) Jump to Cell: (G) "Space-J". Move to a cell using its coordinates.
3) Next Sheet: (N) "Space-Dots-3-4-5". Move to the next sheet in the workbook.
4) Previous Sheet: (P) "Space-Dots-1-2-6". Move to the previous sheet in the workbook.
5) Sheet List: (L) "Enter-L". Bring up a list of all the sheets in the workbook.
6) Set Mark: (M) "Backspace-M". Bookmark your current position.
7) Jump to Mark: (J) "Backspace-J". Move to a previously marked position.
8) Delete Mark: (D) "Backspace-D". Delete a previously set mark.
9) Move to Previous Group: (R) "Space-dots-2-3". Move to previous data filled area.
10) Move to Next Group: (E) "Space-dots-5-6". Move to next data filled area.

[bookmark: _Toc492453951][bookmark: _Toc26179867][bookmark: _Toc209372210]5.4.5 The Read Menu
1) Sheet Title: (T) "Space-Dots-1-5-6". Read the name of the current sheet.
2) Read from Beginning of Row to cursor: (P) "Backspace-Dot-3". Read from the left most cell to the current position.
3) Read from cursor to end of Row: (N) "Backspace-Dot-6". Read from your current position to the right-most cell.
4) Read from Top of Column to Cursor: (U) "Backspace-Dot-1". Read from the top of the column to the current cursor position.
5) Read from Cursor to Bottom of Column: (D) "Backspace-dot-4". Read from your current position to the bottom of the column.
6) Read Current Row: (C) "Space-dots-1-4". Read all cells in the current row from left to right.
7) Read Current Column: (R) "Space-Y". Read all cells in the current column from top to bottom.
8) Read Header Cell of Row: (Y) "Backspace-Y". Read the title of the current row.
9) Read Header cell of Column: (X) "Backspace-C". Read the title cell of the current column.
10) Read File Name: (F) "Space-dots-3-4". Read the name of the workbook.

[bookmark: _Toc492453952][bookmark: _Toc26179868][bookmark: _Toc209372211]5.4.6 The View Menu
1) Set Time and Date: (D) "Enter-D". Determine how time and date are displayed.
2) Show Hide Hidden sheets: (S) "Enter-S". Toggle whether hidden sheets are viewable.
3) Show Hide Hidden Rows: (R) "Enter-R". Toggle whether hidden rows are viewable.
4) Show Hide hidden Columns: (Y) "Enter-N". Toggle whether hidden columns are viewable.
5) Cell Activation: (A) "Enter". Opens the cell as a static box so you can review or select text.


[bookmark: _Toc492453893][bookmark: _Toc26179803][bookmark: _Toc209372212]6. Media
The "Media" menu on the BrailleSense 6 consists of programs related to media playback, streaming, and recording: specifically music, videos, and Podcasts. The "Media" menu contains 6 items: "Media Player", "FM Radio", "Podcasts", “web radio”, “Voice Recorder” and “Video Search”. 
You can open the "Media" menu by pressing "F1" to bring up the main "Program" menu, then navigating to "Media" using the DOWN scroll key and pressing "Enter". Or, you can quickly jump to and open the "Media" menu by pressing M from the main menu.

[bookmark: _Toc492453894][bookmark: _Toc26179804][bookmark: _Toc209372213]6.1 Media Player
You can use the Media Player to play audio and video files, playlists, and Internet media streams. The Media Player supports the following formats, AC3, ASF, ASX, m3u, MP2, MP3, MP4 , MPG, OGG, PLS, WAV, WAX, WMA, FLAC, MIDI, WMV and MOV. 
You can control the playing of media files using either Braille keyboard commands or the media buttons on the front panel of the BrailleSense. To launch the "Media Player", navigate to it in the "Media" menu and press "Enter". Or, launch it from anywhere on the unit by pressing "F1-M".

[bookmark: _Toc492453895][bookmark: _Toc26179805][bookmark: _Toc209372214]6.1.1 Using the Media Buttons
Near the center of the front panel on the BrailleSense is a group of 5 buttons. These buttons can be used to control the Media Player. Moving from left to right, the buttons are: "Back", "Record", "Stop", "Play/Pause", and "Forward". 
The media buttons can control media playback, DAISY content playback, or application operation, depending on the position of the Media Mode switch, located to the left of the media buttons. Slide this switch to the right-most position, "Media Mode", to control media playback. 
If the "Play/Pause" button is pressed while you are using another program on the BrailleSense, the unit opens the Media Player and begins playing the files in the most recently played list. If there are no files in the playlist, the BrailleSense says, "There are no items to display". "Back", "Stop", and "Forward" are available after audio playback is started. 
· Note: As the BrailleSense is able to multi-task, initiating audio playback with the "Play/Pause" button does not close the program you were running when you pressed it. To return to your former position, press "F2-F3" to cycle through the running programs until you reach your former location. 
A playlist can contain only 1 file, or many files. If there is more than one file in the playlist when you press the "Play/Pause" button, the BrailleSense plays all the files in the list one after another. If you press the "Play/Pause" button during playback, audio playback is paused. To resume playing, press the button again. 
If you press the "Forward" button, the next file in the playlist is played, and pressing the "Back" button plays the previous file. If you press the "Forward" button (while the last file in the list is playing, (or the "Back" button (while the first file in the list is playing), it has no effect, as there is no file to navigate to. 
You can use the "Record" button to launch the Voice Recorder and create a recording using the internal microphone or an external microphone from anywhere on the unit provided the Media Mode switch is set to the right-most position. Pressing the "Record" button once opens the "Record" dialog. Press the "Record" button again to start recording. Press the "Record" button while you are recording to pause recording. Resume recording by pressing the "Record" button one more time. Press the "Stop" button to stop and save your recording. The recorded file is saved in the "flashdisk/music/record" folder. 
The "Stop" button is located in the center of the group and has a dot on it. It is used to stop playback or recording. If you press "Stop" during audio playback, the next time media playback is launched, the BrailleSense starts playing the first file in the playlist. If you press this button while recording, the BrailleSense stops and saves the recording. If you press the "Stop" button in the "Record" dialog when not recording, the dialog closes.

[bookmark: _Toc492453896][bookmark: _Toc26179806][bookmark: _Toc209372215]6.1.2 Media Player Layout
You can use the Braille keyboard to perform the same functions as the media buttons as well as more advanced features in the Media Player. 
The playback dialog contains two information tabs: "playback information" and "playlist". Press "F3" or "Space-F3" to move between these tabs.
The "playback information" tab displays the track number, the file name, and the current playback status: (play, pause, or stop). If there are no files in the playlist, the BrailleSense displays "Title: There are no items to display". If you press "Space-4", the BrailleSense displays playback time information. 
When in the Playback tab, you can use the cursor routers to jump to specific areas of the media file. For example, if you want to move to a place near the middle of the file, press cursor router 16 or 17. If you want to move to a place near 75%, press cursor router 24 or 25.
The "playlist" tab displays all the files in the playlist. For each file in the playlist, it displays the track number, file name, the location of the file in the list, and the total number of files in the list. If there is no file in the playlist, the BrailleSense displays the message "no items".
The BrailleSense's Media Player supports the viewing of lyrics for MP3 files which contain them. The "Lyrics tab appears in the tab order only if the file you are playing contains lyrics in its file information. The lyrics are displayed in a multi edit box which you can read and navigate using normal document navigation commands. 
The Media Player menu contains five items: "File", "Play", "Position", "Mark" and "Settings". 
To open the Media Player menu, press "Space-M" or "F2". Select a menu item using "Space-1" or "Space-4" and press "Enter". Or, you can press "Space-M or "F2" followed by the shortcut for the corresponding menu item. For example, to open the Play menu, press "Space-M" or "F2" to open the menu, and press P. 
The Media Player also contains various lists and dialog boxes. Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab among controls in a dialog. For the purposes of these instructions, we will generally refer to using "F3" and "Space-F3" or simply "Tab". However, in these instances, "Space-4-5" and "Space-1-2" can also be used. Press "Enter" to execute an item.

[bookmark: _Toc492453897][bookmark: _Toc26179807][bookmark: _Toc209372216]6.1.3 The File Menu
1) Open File: (O) "Enter-O". Opens a media file and creates a new playlist.
2) Open Folder: (F) "Enter-F". Creates a new playlist with all the media files in the selected folder.
3) Add File: (A) "Backspace-O". Adds the selected files to the current playlist.
4) Add Folder: (I) "Backspace-F". Adds all the media files in the selected folders to the current playlist.
5) Save Playlist: (S) "Space-I". Saves the current playlist.
6) Save As Playlist. Saves the currently playing files as a playlist.
7) Delete Item: (D) "Space-D". Deletes the current item from the playlist.
8) Tag Information: (T) "Enter-T". Opens the properties for the current media file.
9) Open URL: (U) "Enter-U". Opens a website for streaming playback.
10) Exit: (Z) "Space-Z". Exits the Media Player.

[bookmark: _Toc492453898][bookmark: _Toc26179808][bookmark: _Toc209372217]6.1.4 The Play Menu
1) Play (P) "Enter". Initiates playback. You can also press the "Play" button.
2) Previous Track: (B) "Dot-3". Moves back 1 track. You can also press the "Back" button.
3) Next Track: (N) "Dot-6". Moves forward 1 track. You can also press the "Forward" button.
4) Back 5 Tracks: (D) "Dots-2-3". Moves back 5 tracks.
5) Forward 5 tracks: (U) "Dots-5-6". Moves forward 5 tracks.
6) First Track: (T) "Dots-1-3". Moves to the first track in the playlist.
7) Last Track: (E) "Dots-4-6". Moves to the last track in the playlist.
8) Volume Up: (H) "Space-Up Scroll". Increases the volume.
9) Volume Down: (L) "Space-Down Scroll". Decreases the volume.
10) Speed Up: (K) "Dots-3-4-5". Increases the playback speed.
11) Slow Down: (M) "Dots-1-2-6". Decreases playback speed.
12) Pause: (A) "Space". Pauses playback. Press again to resume. You can also use the "Play" button.
13) Stop: (S) "Backspace". Stops playback. You can also use the "Stop" button.

[bookmark: _Toc492453900][bookmark: _Toc26179810][bookmark: _Toc209372218]6.1.5 The Position Menu
1) Mark Position: (M) "Enter-M". Marks the current position for later use.
2) Delete marked Position: (D) "Enter-D". Unmark the marked position.
3) Jump to Marked Position: (J) "Enter-J". Go to the position previously marked.
4) Go to Time: (G) "Enter-G". Go to a specific time in the file. 
5) Go to Percent: (E) "Backspace-P". Move to a place in the file according to its percentage.
6) Go to Number: (N) “Enter-N”. Takes you to the file with the associated number in the current playlist.
7) Set Start Point: (L) "Enter-P". Set a start point for repeat play.
8) Release Point: (R) "Space-E". Set the end point for repeat playback.
9) Chapter List: (C) “Enter-L”. Opens a list of chapters if chapter markup exists in the file. During playback, press “Space-2-3-6” to move back by chapter, and “Space-3-5-6” to move forward a chapter.

[bookmark: _Toc492453901][bookmark: _Toc26179811][bookmark: _Toc209372219]6.1.6 The Mark Menu
1) Set Mark: (S) "Backspace-M". Bookmark a specific point the media file. 
2) Jump to Mark: (M) "Backspace-J". Move to a previously set mark.
3) Previous Mark: (P) "Backspace-dot-3". Moves back one mark from your current position.
4) Next Mark: (N) "Backspace-dot-6". Moves to the next mark after your current position.
5) Delete Mark: (D) "Backspace-D". Deletes a mark.
6) Mark Manager: (K) "Backspace-K". View and modify all marks in the current file.

[bookmark: _Toc492453902][bookmark: _Toc26179812][bookmark: _Toc209372220]6.1.7 The Settings Menu
1) Configuration: (C) "Backspace-C". Lets you configure file information display, mark alerts, and exit position saving.
2) Playback Settings: (P) "Enter-S". Settings for Repeat Shuffle and other playlist settings. Also allows you to choose whether to show progress of file playback position with dots-7-8 on the Braille display, and whether video is displayed for supported files.
3) Effect Settings: (E) "Enter-E". Set Equalizer and bass boost.

[bookmark: _Toc209372221]6.1.8 Playing Audio Books
When playing an audio book, it is likely you will want files and folders that make up the book to be treated differently than a music playlist, both in terms of navigation and marked positions. For this reason, files and folders that are placed in the “Audiobooks” folder on your flashdisk, SD card, or connected USB drive are handled in a different manner from audio files in any other location on your device.
Firstly, regardless of how you’ve set the “save marked position” setting, exit marks are saved for all files and folders in the Audiobooks folder, as it’s likely you will wish to return to your former position the next time you open content from that location. In addition, if you open a folder from within the Media player using the “Enter-F” command, these marks apply to the folder as a whole, rather than each individual file. * Note: if you open an individual file in the Media Player, or from the File Manager, the marked position can apply only to that file.
In the same manner, when accessing a folder within the “Audiobooks” folder, any bookmarks you set apply to the book as a whole., Additionally, the “Go To Time”, and “Go To Percentage” commands also apply to the entirety of the folder rather than the current file as is normally the case.
To play any folder of audio files as an audio book, copy it to the “Audiobooks” folder of the flashdisk or any connected drive. In the Media Player, use the “Open folder” command to open the folder as an audio book. By default, Android should automatically create the “Audiobooks” folder on any connected drive, however, there are some instances where this does not happen. If this folder is not automatically created on your connected drive, you may create it, and the Media Player will recognize it, and act on it as described above.

[bookmark: _Toc492453903][bookmark: _Toc26179813][bookmark: _Toc209372222]6.2 FM Radio
To use the "FM Radio" on the BrailleSense, you must connect headphones to the headphone jack on the unit, as the headphone cord serves as the antenna, and without it, radio reception will be poor to nonexistent. 
From the Media menu, use the scroll buttons to navigate to "FM Radio" and press "Enter". You can also press R to quickly jump to and launch the "FM Radio". You can launch the "FM Radio" from anywhere on the unit by pressing "F1-R". 
When the FM Radio is launched, your BrailleSense announces the radio frequency. If you have used the FM Radio program previously, the BrailleSense tunes to the frequency that you last listened to.
· Note: the frequency range of the FM Radio is 87.5MHz to 108MHz.

[bookmark: _Toc492453904][bookmark: _Toc26179814][bookmark: _Toc209372223]6.2.1 Listening to FM Radio via the Internal Speakers
When you execute the FM Radio after connecting headphones, sound from the radio is directed through the headphones. As previously explained, it is necessary to connect the headphones to provide an antenna for radio reception. However, there may be times when you wish for the sound from the radio to output through the speakers on the BrailleSense. To listen to the radio through the internal speakers, press X, to toggle internal speaker output on/off. 
You can adjust the radio volume using Space with the Up and Down scroll buttons. 

[bookmark: _Toc492453905][bookmark: _Toc26179815][bookmark: _Toc209372224]6.2.2 Frequency Control
To tune to another frequency, use the following commands:
Press "dot 5" to scan forward for the next radio station, and "dot 2", to auto scan backward. Press "dot 6", to increase the frequency by0.1MHz, and "dot 3", to decrease the frequency by0.1MHz. Press "Space-F" to input the frequency directly. Type the frequency in numbers in the edit box and press "Enter". 
You can also use the media buttons on the front panel to control the FM Radio. The Media mode switch should be moved to the left-most position, "Application Mode." Pressing the "Back" button scans backward, and pressing the "Forward" button scans forward.
You can also activate frequency movement commands from the "Frequency" menu.

[bookmark: _Toc492453906][bookmark: _Toc26179816][bookmark: _Toc209372225]6.2.3 Adding and Navigating Presets
To add the currently selected frequency as a preset, select "Add Preset" from the "Presets" menu, or press "Enter-S". 
The "add preset" dialog is opened and "Frequency: (current frequency)" is announced. "Tab" to the "Label" edit box. Type the name by which you want to identify the preset. Press "Enter" to save the preset.
To add a frequency other than the one you're currently listening to, you may type the number of the frequency you wish to add in the "Frequency" edit box of the "add preset" dialog. 
You can navigate your presets by using "dot 1" to move back, and "dot 4" to move forward a preset. 
To delete a preset, navigate to the preset and press "Space-D". 
· Note: when this command is executed, the preset is deleted instantly without any warning or verification. 
You can also add and delete presets using the Preset Manager dialog. Select "Preset Manager" from the "Presets" menu, or press "Enter-M". 
The Preset Manager dialog contains the "Preset list", an "Add" button, a "Delete" button, a "Modify" button and a "Close" button. 
Pressing "Enter" on the "add" button opens the "add preset" dialog explained above. The "Modify" dialog lets you change the label of the current preset in the list. Use the "Delete" button to delete a preset from the preset list. To exit the Preset Manager" dialog navigate to the "Close" button and press "Enter" or press "Space-E". 
You can also use the media buttons on the front panel to add and move among presets. Press the "record" button for more than 2 seconds, to open the "add preset" dialog. To move to the previous preset, press the "Back" button for more than 2 seconds. Pressing the "Forward" button for more than 2 seconds moves to the next preset. Pressing the "stop" button for more than 2 seconds deletes the selected preset.

[bookmark: _Toc492453907][bookmark: _Toc26179817][bookmark: _Toc209372226]6.2.4 Recording from the FM Radio
To record the audio of the radio station to which you are currently listening, Select "Record" from the radio's menu, or press "Enter-R". The "record" dialog is opened and the BrailleSense begins recording.
While recording the radio, "Tab" to the "Pause" button and press "Enter", or press A to pause recording. The name of this button is changed to "Continue". Activate the "Continue" button or press G, recording resumes. To stop the recording, press S. Or, "Tab" to the "Stop" button and press "Enter". 
To check the duration of the current recording press "Space-4". The unit announces the current recording run time and total possible recording time. 
Recorded files are saved in the "flashdisk/music/radio" folder. The files are named according to the preset label and frequency. If you are recording a radio station that is not in your preset list, the recording is named "radio" followed by the frequency. 
You can also instantly start recording by pressing the "record" button on the front panel. Press the "Stop" button to stop and save the recording. Press the "Record" button again to pause and resume recording. Pressing the "Back" and "Forward" buttons moves among the controls in the "record" dialog. 

[bookmark: _Toc26179818][bookmark: _Toc209372227]6.2.4.1 Changing record folder
To change the folder where recorded files are saved, select "Recording Settings" from the "File" menu or press "Backspace-S".
You are placed in the "Recording Settings" dialog on the first item, "Recording type: mp3". "Tab" to the "Record folder" setting.
"Record folder: /flashdisk/music/radio" is displayed. Press "Enter". Use normal folder navigation to locate your desired folder for storing recorded files. Press "Space" to select it and press "Enter", and you are returned to the "Record Settings" dialog. Press "Enter" again to save the settings and exit the dialog. 
In the Record Settings dialog, you can also set recording type, sample rate, and bit rate. To change the recording type, press "Space" to toggle between "wav" and "mp3".

[bookmark: _Toc492453908][bookmark: _Toc26179819][bookmark: _Toc209372228]6.2.5 Additional Features
Mute
While listening to the radio, press "Space" to mute the audio. Pressing "Space" once again unmutes the radio. You can also mute the radio by pressing the "stop" button on the front panel, and unmute by pressing the "play" button. 

[bookmark: _Toc209372229][bookmark: _Toc492453909][bookmark: _Toc26179820]6.3 Podcasts
Podcasts are audio files published by individuals or organizations via a method called RSS (Really Simple Syndication). Podcasts are available on any number of topics including news, politics, music, books, technology, cooking, and an unlimited number of individual casts covering very specific personal interests. Anyone with the know-how and the right equipment can publish a podcast, thus, the selections are virtually unlimited.
You can launch the “Podcasts” app by pressing “Enter” on it from the Media Menu, or from anywhere on the unit by pressing “F2-P”.

[bookmark: _Toc396812245][bookmark: _Toc456604243][bookmark: _Toc209372230]6.3.1 Subscribing to Podcasts.
So that you can easily explore the potential of the “Podcasts” application and the variety of content available, several podcast feeds are pre-loaded on BrailleSense, including HIMS international’s SenseCast. However, you may add your own favorite feeds, or delete those that do not appeal to you. To delete a podcast, press “Space-D” when focused on it.
You can search for and subscribe to podcasts directly on the BrailleSense in several ways. 
When the Podcasts application is opened, press “Enter-S” to open the search dialog.
You are placed in a combo box in which you can choose to search 1 of 2 directories: iTunes, or Podcast Index, an AI powered podcast search engine. If you choose to search iTunes, you can search either by category, or “Word input mode”, in which you can type a search term. Use “Space-1” and “Space-4” to choose the mode, and press “F3”.
If you choose “Word input mode”, type your search term and press F3again to perform the search. If you choose “Category Mode”, use “space-1” and “Space-4” to choose your category, and press “F3” to initiate the search.
*Note: the Podcast Index directory only offers searching by keyword.
When the search is complete, you are placed in a list of results. Use “space-1” and “Space-4” to navigate among the podcasts that matched your search. Tab forward from an item in the Results list to get a description of that particular podcast feed. Press “”Enter” to add the current feed to your feed list. To select multiple items, press “Space” on each of the items you want to select, and press “OK” to add all the selected items to your feed list.
When you are finished adding feeds, press “F4” to return to your feed list.
You may also import feeds from an OPML file using the “Import from OPML” option in the File menu. Use normal file/folder navigation to choose your OPML file, and press “Enter”. You are presented with a list of available podcast feeds in the OPML file. Use normal selection commands to choose the feeds you want to import, and press “Enter” to add them to your feed list.
Additionally, if you know the URL of the feed you want to subscribe to, you can use the “Insert Feed” option to enter the name of the feed and the URL directly. Choose “Insert Feed” from the Edit menu, or press “enter-I” from the feed list.
Finally, if you are on a website with a feed you wish to subscribe to, press “Enter-J” from the web browser, and you are presented with a list of available podcast feeds from the site. Press “Enter” to subscribe to a feed.

[bookmark: _Toc396812247][bookmark: _Toc456604245][bookmark: _Toc209372231]6.3.2 Navigating Feeds and Episodes 
From the podcast feed list, use “Space-1” and “Space-4” to navigate among the podcast feeds. To view the content for a feed, press”F3”. The feed is refreshed, and the available episodes for the podcast appear in a list.
Use “Space-1” and “Space-4” to navigate among the episodes in a list. As you navigate, the title of the episode is announced as well as its status, "Not downloaded", "Not Played", "Partially played" or played. 
To get a description of the current episode, press “F3”.
If the podcast has not been downloaded, press “Enter” on it to begin downloading. Progress indicators are displayed. When the download is complete, it will either play in the podcasts program’s player, play in the media Player, ore return to the feed list. This behavior is defined in the ‘Options” dialog in the File menu. By default, the episode downloads and plays in the podcast player.
The “Podcasts” program’s embedded player allows you to listen to podcasts while continuing to explore and do other things in the app, by embedding the controls in to the feed/episode list dialog. The elapsed and total time are displayed, and a “Play/Pause” button is added to the tab order. You can navigate to various parts of the podcast using the cursor routers as you can do when playing files in the Media Player. You can also change the playback speed with “dots-3-4-5” and “dots-1-2-6” as you can in the Media Player. Additionally, you can choose to show Braille progress on the Braille display in the elapsed time area. You can turn this on or off in the “Options” dialog of the File menu.
If the episode is marked up with chapters, you can navigate to the previous chapter with “Space-2-3-6”, and to the next chapter with “Space-3-5-6”. You can get a list of chapters in the episode with “Enter-L”.
The embedded player is convenient and will fit most user’s needs. However, if you need more detailed control of podcast playback, you can choose to have the episodes automatically play in the Media Player as described above. 
To close the playback control area, press F4. Playback stops, and these controls no longer appear.
If you have already listened to part of the podcast, the next time you play it, it will resume playback at the position at which you last stopped playing it. 

[bookmark: _Toc396812248][bookmark: _Toc456604246][bookmark: _Toc209372232]6.3.3 Deleting Content. 
As previously mentioned, you can delete a podcast feed from the list by pressing “Space-D” when focused on it. You may also need to clear episode content, as, if you subscribe to many podcasts, these files will accumulate quickly.
You can access all podcast episode files from the File Manager in a folder called “podcasts”, which will contain subfolders for each podcast feed with the files you have downloaded. You can also clear downloaded content from within the “Podcasts” program itself using the “Clear downloaded Files” option in the File menu. You are prompted, “Files to delete?”, and can choose to clear content for “all files” or “this feed only”.

[bookmark: _Toc209372233]6.4 Web Radio
The Web Radio application allows you to easily access and play radio broadcast streams from the Web. You can access your channel list, search a database of channels to add, and add URL'S directly to your channel lists or other play lists.

[bookmark: _Toc209372234]6.4.1 the Web Radio Dialog
The web Radio opens in your channel list. By default, this is pre-loaded with several popular stations among many genres. However, you can add to or remove from this list as you like.

The channel list dialog contains 4 items: the list of channels, an “Add Channel” button, a “Delete Channel button” and a “Modify Channel” button. Use “F3” and “Space-F3” to move among the controls.
In the Web Radio’s menu are located “RadioSure search”, “Radio Browser search”, “Update Channel database”, and “Playback Settings”.
 Choosing either of the search options from the menu allows you to search a database of Web Radio channels to add to your channel list. 
When you select a search option for the first time, " the unit announces, "Downloading Database", then places you in the "Search" dialog.
The BrailleSense offers 2 Web Radio databases for searching. The Radio Browser database is an open source database used in many android Web Radio applications. Users can easily add stations to this database on the Radio Browser website. And, because it is easy for anyone to add stations, we recommend you update it often on the BrailleSense. You may sometimes find duplicate channels on this database, as multiple streaming links for the same channel are sometimes submitted. But it contains a wide variety of options from around the world.
The RadioSure database has less offerings, but allows you to search by genre, which can be helpful when trying to narrow your search. And, although Radio Browser generally has a wider variety, you sometimes find that RadioSure offers stations Radio Browser does not.
The "Search" dialog contains The Search Mode" combo box, a "Search" button and a "Close" button. If you choose "Search Word", after the Search Mode combo box is an edit box into which you can type your search term. If you choose "Search Category" in the Search Mode combo box, there are 3 subsequent combo boxes for searching by "Country", "Language" and "Genre" for “RadioSure, or 2 combo boxes, “Country” and “Language”, for Radio Browser. 
Use "F3" and "Space-F3" to move among the controls in the dialog. Use "Space-1" and "Space-4" to choose an item from the combo box.
When you have typed your search term, or chosen your search criteria in the category combo boxes, press "F3” to access the results list. 
Use "Space-1" and "Space-4" to navigate the channel list. To add a channel to your personal channel list, press "Enter" on the "Add Channel" button. 
When you are finished searching the database, press "Enter" on the "Close" button, or press "Space-E" and you are returned to the Channel list.
The “update Channel Database” item refreshes the database with any updates to its content since the last time it was downloaded.
The Channel list contains stations you have chosen to add from searching the database, or manually entering address and title information for the channel. Use "Space-1" and "Space-4" to navigate the Channel list, and press "Enter" on a station you want to play.
During playback, the Title of the playing channel also appears in the dialog, as well as the playing track if auto display is set to On. You can live tune to your previous and next station in the Channel list using Dot-3 and Dot-6 respectively. Press F4 to close playback.
You can manually add channels to your personal channel list if you know the URL and other information about the channel.
From the Channel list, press "F3" to move to "Add Channel" and press "Enter". You are placed in a dialog with 3 edit boxes into which you can type the title, URL, and description of the Web Radio channel you want to add. Use "F3" and "Space-F3" to move among the controls. Press "Enter" to add the channel, and the Braille Sense searches for the URL you typed. If it locates it, the channel is added to your channel list.
You can also modify information for a channel already in your channel list. This may be necessary if the URL has changed. 
From the Channel list, press "F3" to move to "Modify channel information", and press "Enter", or press "Enter-M" directly from the list. You are placed in a dialog similar to the "Add URL" dialog, but with the information already filled in. Retype or edit the information in any of the edit boxes, and press "Enter" to save your changes. Press "Space-e" to exit the dialog without saving changes.
To delete a channel from the list, Tab to the "Delete Channel" button, or press "Space-D" when the channel you want to delete is in focus.

[bookmark: _Toc209372235]6.4.2 The play Menu
During playback of a Web Radio stream, the menu contains 
the following:
1. Previous: (B) “Dot-3”. Moves to the previous station in the Channel list.
2. Next: (N) “Dot-6”. Moves to the next station in the Channel List.
3. Play/Pause: (a) “Space”. Toggles playing or pausing the stream.
4. Stop: (s) “Backspace”. Stops playback of the current stream.
5. Record: (R) “Enter-R”. Starts/stops recording of the current stream.
6. Volume Up: (h) “Space-Up Scroll button”. Increases playback volume.
7. Volume Down: (I) “Space-Down Scroll Button”. Decreases playback volume.
8. Playback Settings: (P) “Enter-S”. let’s you set whether to auto display the titles of tracks during playback.

[bookmark: _Toc209372236]6.4.3 Recording the Web Radio
You can make high quality MP3 recordings of the web Radio channel you are currently listening to by pressing “Enter-R” during Web Radio Playback. Press “enter-R” once more to stop the recording. The resulting recordings are saved to flashdisk/Web Radio/Record.
*Note: Recording Web Radio channels should only be carried out for personal and non-commercial purposes. HIMS does not condone or promote the use of this function for the purposes of rebroadcasting or redistributing captured content.

[bookmark: _Toc209372237]6.5 Voice Recorder
The Voice Recorder application allows you to create MP3 or WAV individual recordings, or record DAISY books using WAV or MP3 from the internal stereo microphones, an external stereo microphone source , a 4-pole headset, a stereo line in source, or an Android compatible USB audio device. 
You can launch the Voice recorder by navigating to the Media Menu, and pressing “V”, or by pressing the “Record” media button when the Media buttons are set to Media Mode. 
The “Record” dialog contains the “Record” button”, the “Record Settings” button, a “Recordings” button, an “exit” button, and a status area. Use “F3” and “Space-F3” to move among the controls.

[bookmark: _Toc492453899][bookmark: _Toc26179809][bookmark: _Toc209372238]6.5.1 Making Recordings
When you launch the Voice Recorder, the device prompts you to record, and displays the source from which you will be recording: “Microphone Record”, “USB Record”, etc. You can set the recording source using the “Record Settings” dialog described later, or connect a USB source, and the BrailleSense will automatically use it.
When you see the “record” prompt, you are placed in standby mode. Press “Enter” to initiate recording. Press "Space-Z" when finished. You can also use the "Record" button to start recording and the "Stop" button to finish. Use the “Record” button or “Space” during a recording to pause and resume recording.

*Note: The BrailleSense 6 supports recording and playback through generic plug and play USB audio devices, including mixers, USB headsets, USB microphones, and other generic USB sound card devices. While many devices are supported, be aware that devices that require specialized drivers or apps are not likely to work. Nor can you use multi-track recording devices, as they generally require a digital audio work station to operate. However, most plug and play audio devices that mix down to stereo output will work beautifully.
When using external devices, there are a few things to be aware of:
i. If a USB source is connected, it will always take priority.
ii. If more than one USB source is connected, as in the case of a camera and second separate audio device, the most recently connected source will take precedence.
iii. USB audio sources completely ignore the Recording Source setting, this applies only to internal sources, and connecting a USB source makes it irrelevant, as the USB source automatically takes over, and cannot be chosen using this setting.
iv. If you connect any headphones, 4 pole or otherwise, while a USB source is connected, the USB audio connection is canceled, and the recorder will use the internal recording source setting. 
v. By default, BrailleSense audio is silenced during recording to avoid loop back issues with some headsets. If you want to loop back BrailleSense audio using a mixer, please be sure to turn the “Headphone Monitoring” setting and “Mute System Audio While recording” setting to off, and use the mixer itself to monitor the output.

[bookmark: _Toc209372239]6.5.2 Making DAISY Recordings
You can use the Braille Sense's Record function to record DAISY files as well as simple WAV and MP3 recordings. To record in DAISY format, set the recording method to "DAISY" in the "Record Settings" dialog. 
When you initiate DAISY recording, you are prompted, "Start title recording", after which time the Braille Sense gives you about 10 seconds to record a title before automatically moving to recording heading 1. 
You can manually insert navigation points in to your DAISY books as you record. Type “Backspace-H” to insert a heading. Type “Backspace-P” to insert a phrase. Type “Backspace-G” to insert a page. Each time you press one of these keys, Braille Sense displays the start of the navigation point: for example, "Starting page 8" or "Start heading 3".
When you stop recording, the unit announces, "building" to let you know the DAISY book is being created. Recorded DAISY files are saved to flashdisk/DAISY/Record, and can be played in the DAISY Player. You can, of course, also locate the individual recordings using the File Manager and play them in the Media Player.

[bookmark: _Toc209372240]6.5.3 Playing individual Recordings
When you finish creating an individual recording, you are placed on a “Play” button so that you can hear what you just recorded. Press “Enter” on this button to start playback. Alternatively, you can press “Enter-P” to play the currently focused recording.
To hear previously recorded files, Tab to the “Recordings” button and press “Enter”. You are placed in the folder you have set to store recorded files, by default, this is set to flashdisk/music/record. You can use normal file/folder navigation to access any WAV or MP3 file on the unit, and press Enter to start playback.
During playback, press “Space” to toggle Pause/play, and “Backspace” to stop playback. Adjust the volume with “Space-Up/Down Scroll”, and adjust the speed with “dots-3-4-5” and “dots-1-2-6”. Use the cursor routers to move to various positions in the file, just as you do in the Media Player.

[bookmark: _Toc209372241]6.5.4 Record Settings
The “Record Settings” dialog contains the following options:
1) Recording Type: choose between WAV or MP3.
2) Sample Rate: choose from several increments ranging from 8000 to 48,000 HZ. 
3) Bitrate: determines the quality of an MP3 recording, does not appear when type is set to WAV. Choose from increments ranging from 64K to 320K which is CD quality.
4) Mic Volume: determines the gain of the microphones, Set to High, Medium or Low.
5) Recording Source: microphone will use an external mic if plugged in, and the built-in mics if not; Headset will use a 4-pole headset if connected and the built-in mics if not; Line In will use a stereo line in source if connected and the built-in mics if not. *Note that, if a USB device is connected, it will take precedence no matter which option is chosen here.
6) File name Type: determines whether recordings are named by number, or by the time and date they were created.
7) Earphone monitoring: On/Off. Determines whether you hear what is being recorded through headphones as you are recording. Note that, if earphone monitoring is on, system audio will be muted during recording regardless of how that option is set.
8) Mute System Audio While Recording: on/Off. By default, this is turned on so that system audio and TTS do not interrupt what you are recording. System prompts are still displayed in Braille. If you wish to record system audio for a demonstration, or to record a stream, etc, set this setting to off, and use a mixer that offers Loop Back or USB Return to send the system audio through to your recording.
9) Recording Method: Normal or DAISY. The normal Recording method creates individual WAV or MP3 files, while the DAISY method builds several recordings in to a DAISY audio book as specified by the navigation points you create as you record.
10) Set Folder: determines where individual or DAISY recordings are stored. If you choose the Normal Recording method, the default folder is flashdisk/music/record. If you choose the DAISY Recording method, the default folder is flashdisk/daisy/record.
11) Record File Name: determines the base file name for recordings. By default, this is set as “record”, however, you can edit it to your liking. The rest of the file name is determined by the “File Name Type” setting described above.

[bookmark: _Toc209372242]6.6 Video search
The “Video search” application provides a BrailleSense interface for searching YouTube videos, channels and playlists, as well as for managing your own playlists, subscriptions, and favorites.
You can launch the “Video search” app by locating it in the “Media” menu and pressing “Enter”, or by pressing “F3-Y” from anywhere on the unit.
The app opens in the “Search” dialog, from which you can choose among 3 options: Videos, Channels, or playlists. Use “Space-1” and “Space-4” to move among the options, and Tab forward to type your search term in the edit box. Press “Enter” to initiate the search.
If you Tab forward from the Search edit box, there is a “Sign in with Google” button, which takes you to a typical Google sign-in and approval page. Signing in to Google grants you access to playlists you have created on YouTube as well as your subscribed channels. If you have not yet created playlists or subscribed to channels, signing in will allow you to do so.
Once you have signed in to Google, the search dialog contains the additional 4th and 5th options of “My Playlists”, and “My Subscriptions”. Tabbing forward on either of these options loads the resulting list.
From any results list, navigate the items using “Space-1” and “Space-4”. Tab forward to receive a more specific designation of results, such as playlists in a channel, or videos in a playlist. Shift-Tab to move back to a more general designation. Press “Enter-N to access the next page of results.
Press “Enter” to play the current video. * Note: although search and playlist/subscription management are controlled via the BrailleSense interface, Google requires that we use the native YouTube player for playback. Thus, navigation during video playback utilizes the Mobile Screen reader, and the native YouTube app. Please see the chapter on using third party programs for detailed information on how to navigate the native Android app interface.
As the Mobile screen Reader supports first letter navigation, this is often the easiest way to get you quickly to items of interest, such as the “skip” button for adds, or the “close” button for playlist controls. Press F4 to stop playback, and return to the search area.
By default, the “Video search” application menu contains only two items: “Favorites” and “Exit”. If you are signed in to Google, “Playlists” and “Subscriptions” menus also appear.
The “Favorites” menu is managed on BrailleSense itself, and allows you to add the current video to your favorites with “Backspace-A” and open the list of favorites you have added with “Backspace-L”.
The Playlists menu gives you options for adding to a playlist, which can also be initiated with “Backspace-I”, and the Playlist Manager, which can also be opened with “Enter-M. The Playlist Manager allows you to create, modify and delete your own personal playlists.
The “Subscriptions” menu gives you options for subscribing to the currently focused channel with “Enter-S”, and deleting the subscription with “Space-D”. * Note: as subscriptions are tied to your Google account, channels you have subscribed to on other devices appear in your subscriptions list, and any modifications you make on BrailleSense apply to other devices accessing your YouTube account. The same is true for playlist management
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Using the DAISY Player on the BrailleSense, you can listen to files and read books that use the DAISY format. DAISY is an acronym for (DIGITAL ACCESSIBLE INFORMATION SYSTEM). One advantage to DAISY books is that you can listen to the audio as well as read the associated text with the audio in DAISY books where both text and audio are present. 
The BrailleSense supports DAISY books that are version 3.0 or earlier. The DAISY Player supports the following book types:
DAISY 2.0/2.02/3.0, DAISY XML/Digital Talking Book.
ANSI/NISO Z39.86 2002, 2005.
Bookshare.org DAISY content, 
NIMAS 1.1 
DRM: supports 2006 PDTB2 authentication. 
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To launch the DAISY Player, press "Enter" on "DAISY Player" in the BrailleSense "Library" menu. You can also launch the DAISY player from anywhere on the unit by pressing "F1-D". 
When you launch the DAISY Player, you are placed in BrailleSense's drive list. Press "Enter" on the drive containing the DAISY book you want to open.
Use normal folder navigation to locate the folder containing a DAISY book you want to open. Press "Space" to select it, then press "Enter" to open it. You must first select the folder containing the book, because a DAISY book contains multiple files, thus, BrailleSense needs to know exactly from which folder to get all the book text and information. 
If you replay a book that you have listened to before, playback resumes from the location where you last exited. To stop playing a DAISY book, press "Space-Z". A prompt box appears asking if you would like to exit the DAISY Player. Select "Yes" or "No" with "Space" or "Backspace" and press "Enter". 
You can also control DAISY playback using the media buttons on the front panel. The Media Mode switch must be set to the center position, "DAISY Mode". Start DAISY playback by pressing the "play" button on the front panel. Press "play" again to pause playback. Press the "Back" button to move back 1 navigational element, and press the "Forward" button to move forward by1 navigational element. Use the "Record" button to set the navigational element by which the "Back" and "Forward" buttons move. 
Open the DAISY Player menu by pressing "Space-M" or "F2". The menu contains "File", "Document", "Mark", and "Heading". You can navigate the menu items using "Space-1" and "Space-4". To activate a menu item, press "Enter". 
Or, you can press "Space-M or "F2" followed by the shortcut for the corresponding menu item. For example to open the "Heading" menu, press "Space-M" or "F2" to open the menu, and press H. 
The DAISY Player also contains various lists and dialog boxes. Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab among controls in a dialog. For the purposes of these instructions, we will generally refer to using "F3" and "Space-F3" or simply "Tab". However, in these instances, "Space-4-5" and "Space-1-2" can also be used. Press "Enter" to execute an item.
While playing DAISY content, you are placed in a dialog in which four controls/components are available: "heading", "Information", "Play" and "Pause". "Tab" through this information using "F3". 
"Heading" shows you a prefixed heading or navigation element as well as the text under that element if text exists. In "information", you can find the current page, level, phrase, elapsed time, and running time. You can move among these items with "Space-1" or "Space-4". You can press "Enter" on "Pause" or "Play", to pause or play the audio. From anywhere in the dialog, you can also toggle play/pause with "Space".
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1) Open DAISY: (O) "Enter-O". Calls the "Open DAISY" dialog.
2) Recent Books: (R) “Backspace-enter-H”. lists the most recent DAISY books you’ve opened. Press “Enter” to re-open the focused title.
3) Voice Settings: (S) "Enter-S". Set auto playback settings, mark Alerts, and rate, pitch and volume of the reading voice. You can also set your reading voice from among any of the BrailleSense Vocalizer voices you have installed.
4) Book Info: (I) "Enter-I". Obtain information about the currently playing DAISY book.
5) Exit: (Z) "Space-Z". Closes the DAISY Player.
6) Exit and delete Bookmark: (Q) “Enter-Z”. exits and deletes any existing exit mark.
7) Exit Without Bookmark: (C) “Backspace-Z”. Closes without marking your exit position.
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1) Play/Pause: (P) "Space-P". Pause and resume playback. You can also use the "Play" button.
2) Previous Page: (U) "Dots-1-2-6". Moves back one page.
3) Next Page: (D) "Dots-3-4-5". Moves forward one page.
4) Go To Page: (G) "Enter-G". Enter the number of the specific page you want to go to.
5) Go To Percent: (R) “Enter-E”. Go to a specific position in the book according to percentage.
6) Go To Time: (T) “Backspace-T”. Available only in DAISY audio: go to a position in the book according to the elapsed time.
7) Move by Previous Movement Unit: (H) "Dot-3". Move back by specified movement type.
8) Move by Next Movement Unit: (L) "Dot-6". Move forward by specified movement type.
9) Change to Previous Movement Unit: (I) "Dots-2-3". Cycle backward one movement type. 
10) Change to Next Movement Unit: (E) "Dots-5-6". Cycle forward one movement type.
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1) Set Mark: (M) "Enter-M". Bookmark a position.
2) Jump to Mark: (J) "Enter-J". Move to a previously set mark.
3) Delete Mark: (D) "Space-D". Delete a previously set mark.
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1) Headings List: (L) "Enter-H". Open the list of headings in the book.
2) Scan for Next Heading: (N) "Enter-N". Move to the next available heading.
3) Read Current Heading: (W) "Enter-W". Read the heading under which the current text is located.
4) First Heading: (T) "Dots-1-3". Move to the first heading.
5) Last Heading: (B) "Dots-4-6". Move to the final heading of the book.
6) Find: (F) "Space-F". Search for text.
7) Find Again: (R) "Enter-F". Find the next instance of the search string you specified in the "Find" dialog.
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1) Insert Memo: (M) "Backspace-M". Insert an annotation.
2) Read Memo: (R) "Backspace-R". Read the current memo.
3) Previous Memo: (P) "Backspace-P". Move back one memo from your current position.
4) Next Memo: (N) "Backspace-N". Move to the next memo from your current position.
5) Delete Memo: (D) "Backspace-D". Delete the current memo.

[bookmark: _Toc209372251]7.2 Document Reader
The Document Reader allows you to open files in most supported text-based formats in a Read Only environment with special navigation features. In general, it allows you to read and interact with the elements of these files in a fashion similar to the DAISY Player, or a file opened in Read Only mode.
The Document Reader supports the following file types: Txt, RTF, BRL, BRF, Doc, DOCX, PDF, EPUB, XML, HTM and HTML. 
You can activate all the functions of the Document Reader via the menu or by using hot keys. The menu consists of File, Edit, Go To, Read, and Mark. To access these menus, press "Space-M" or "F2". Select a menu item using "Space-1" or "Space-4" , and press "Enter". Or, you can press "Space-M or "F2" followed by the shortcut for the corresponding menu item. For example to open the edit menu, press "Space-M" or "F2" to open the menu, and press E. 
The Document Reader also contains various lists and settings dialogs. Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab among controls in a dialog. 
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When you first launch the Document Reader, by default, you are placed in the "Open" dialog. You can change the Document Reader's start position using the "Start Settings" described later. You can also access the Open File" dialog any time by selecting "Open" from the "File" menu, or pressing "Enter-O". 
You are placed in the list of folders and files in your "DOCUMENTS" folder. Use normal File and folder navigation to locate the file you want, and press "Enter".
By default, when you press "Enter" to open a document, BrailleSense places you at the position at which you last exited the file. If you wish to have the document automatically start reading aloud, you can change this behavior in the "Voice Settings" described in section 7.2.2.
You may navigate as the file reads aloud (continuous Reading Mode) or you may press "enter" to toggle to "Manual Mode" in which case, text is only read as you navigate to it, and only the selected element is read. 
In addition to the navigation keys described in the remaining sections of this chapter, you may use normal document navigation commands to read documents in the Document Reader as described in chapter 5 of this manual.
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1) Open: (O) "Enter-O". Brings up the "Open File" dialog from which you can open any of the supported file types listed above.
2) Recent Documents: (R) "Enter-R". Shows documents recently opened in the Document Reader in a list. Press "Enter" on a document you want to read. 
3) Page Settings: (P) "Backspace-P". The page settings allow you to define how the document reader determines the amount of text to move by when navigating by page. The "Page Settings" dialog contains 4 items: an edit box in which you can "Set lines per page", edit box in which you can "Set characters per line", a "Confirm" button and a "Cancel" button. 
4) Voice Settings: (S) "Enter-S". The "Voice Settings" let you define how the document is read when using speech, including the ability not to use speech at all. The "Voice Settings" list includes the following: Voice: (On/Off), Default Reading Mode: (Continuous or Manual), Set Volume, Set Speed and Set Pitch. You can also set the reading voice from among any of the BrailleSense Vocalizer voices you have installed.
5) Document Information: (I) "Enter-I". The "Document Information" option provides information on your current position in the document relative to the whole. The information includes the current and total page, paragraph, sentence and line, as well as the title of the document you are currently reading. 
6) Start Setting: (E) "Enter-E". The "Start setting" determines where you are placed when the Document Reader is launched. The options in the "Start Setting" combo box are "Open File dialog", "Recent Documents", and "No Startup Action", in which case, the unit simply lands on a blank screen, from which you can choose what function to perform.
7) Exit with Bookmark: (Z) "Space-Z". Use this to close the "Document Reader and save the position in your current document.
8) Exit and delete all marks: (Q) "Enter-Z". This option closes the Document Reader and deletes any existing marks in the current document.
9) Exit without bookmark: (C) "Backspace-Z". This option closes the Document Reader, but does not save your position in the current document.
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1) Start Selection: (B) "Enter-B". Allows you to select a certain portion of text that you would like to copy to the clipboard. The end point of the selected text is determined by the location at which you place the cursor after setting the start point with "Enter-B". 
2) Copy: (C) "Enter-C". After selecting text, activate "Copy" from the "Edit" menu, or press "Enter-C" while in a document. 
3) Add to Clipboard: (P) "Enter-P". To add selected text to the clipboard, select "Add to Clipboard" from the "Edit" menu, or press "Enter-P" while in a document. 
4) Clear Clipboard: (E) "Enter-D". To delete the text in the clipboard, select "Clear Clipboard" from the "Edit" menu, or press "Enter-D" while in a document. 
5) Select All: (A) "Enter-A". Selects all the text in your current document.
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1) Find: (F) "Space-F". The find function allows you to search for text in a document. The Find dialog consists of "Text to find", "Search direction", "Match case", a "Confirm" button, and a "Cancel" button. 
2) Find Next: (H) "Enter-F". "Find Again" looks for additional instances of the text that was searched for in the previous "Find". 
3) Find Previous: (V) "Backspace-F". The "Find Previous" function works the same ways the 'Find Again" function described above, however, searches the document in the backward direction.
4) Go to Location: (G) "Enter-L". The "Go to Location" command moves quickly to a specific page, paragraph, or line. 
5) Go to Headings List: (T) "Enter-T". The "Go to Headings List" function only appears when you are reading HTML, XML, or EPUB documents, and brings up a list of headings in your current document. Use "Space-1" and "Space-4" to move among the headings, and press "Enter" to jump to the current heading in the list. 
6) Go to Previous Heading: (P) "Backspace-space-2-3-5". Moves to the previous heading in an EPUB, XML, HTM, HTML or DOCX document.
7) Go to Next Heading: (N) "Backspace-Space-2-5-6". Moves to the next heading in an EPUB, XML, HTM, HTML, or DOCX document.
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1) Read Selected Text: (B) "Backspace-B". Speaks the text you currently have selected. Note: this option is only available in "Manual Reading Mode". 
2) Toggle Reading Mode: (G) "Enter". The "Toggle Reading Mode" option allows you to toggle between "Continuous" and "Manual" reading modes. Press "Enter" while reading a document to toggle between Manual and Continuous reading.
3) Read Current Page: (C) "Backspace". Speaks the current page. Read the prior page using "dots-1-2-6", and read the next page using "dots-3-4-5". 
4) Read Current Paragraph: (P) "Space-2-3-5-6". Speaks the current paragraph. Read the prior paragraph using "Space-2-3", and read the next paragraph using "Space-5-6".
5) Read Current Line: (L) "Space-1-4". Speaks the current line. Read the prior line using "Space-1", and read the next line using "Space-4".
6) Read Current Sentence: (S) "Space-1-4-5-6". Speaks the current sentence.
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1) Set Mark: (M) "Enter-M". You can set marks while playing a file to note positions you would like to return to later. You may set up to 1000 marks per document. 
2) Jump to Mark: (J) "Enter-J". You are prompted for the "Mark name to move to:". Type the mark name in the edit box and press "Enter". 
3) Delete a Mark: (D) "Space-D". You are prompted to "Enter mark name to delete". Type it and press "Enter". 
4) Next Mark: (N) "Enter-N". The "Next Mark" function allows you to move to a marked location ahead of your current position. 
5) Previous Mark: (B) "Backspace-M". The "Previous Mark" function allows you to move to a marked location before your current position. 
6) Mark List: (K) "ENTER-K". Use "Space-1" and "Space-4" to navigate the list, and press "Enter" on a mark to go to its location in the document.
7) Mark Alert Options: (O) "Backspace-O". You can use the Mark Alert Options" setting to configure how you want to be alerted when marks appear in your document as you read. The alert options are "Beep", "Message" and "No alert". 
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The Online DAISY program allows patrons of the Canadian National Institute for the Blind and Vision Australia libraries to access and download DAISY books available through their online bookshelf. 
To execute the Online DAISY program, Open the "library" menu, navigate to "Online DAISY" and press "Enter". 
When you execute the Online DAISY program for the first time, you are asked for your login information. Use "Space-1" and "Space-4" to navigate to the server you wish to log in to. Once done, Tab to the ID field and enter it in computer Braille. If accessing the CNIB library, type "CNIB_" followed by your user number in the ID field. For Vision Australia, type just your user ID number. Tab to the "Password" field and type it in computer Braille. Press "Space" to toggle the check boxes for "Remember Me", and "Save password". When you have chosen your login settings, Tab to "Login" and press "Enter".
You are presented with a combo box with 3 items: "Expired", "New", and "Issued". Press "Tab (F3 or Space-4-5)" to access the list in your desired category. You can navigate the book list using "Space-1" and "Space-4".
To download a book, navigate to it and press "Enter". The unit announces "Download start" and shows progress indicators to let you know the progress of the download process. When the book is finished downloading, you may play it using the DAISY Player. 
Books downloaded using the Online DAISY program are available in the "Online DAISY" folder from the "Open DAISY" dialog of the DAISY Player. For reasons of copy protection, these books are only visible from the DAISY Player and cannot be accessed from the File Manager.
Vision Australia users can also download BRF books. When a BRF book is downloaded, you have the option of opening it in the Word Processor, from which you can copy the text to another document, or save it to a different location where it can be more easily accessed.
When you wish to return a book, navigate to it in the list, and press "Enter-R" This returns the book to the virtual library so that others can be issued to you.
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The "BookShare Download" program provides direct search and download access to the repository of books and periodicals available from www.bookshare.org.
BookShare is a repository of books and periodicals in accessible formats, made available through the work of volunteers who scan and proofread books, federal grants funding the purchasing and digitizing of material, and contributions from book publishers of electronic versions of their texts.
BookShare titles are available in various formats including DAISY, BRF, EPUB, Word , and audio. The BrailleSense supports access to most of the available formats via the "BookShare Download" program and reading in it’s DAISY Player, Document Reader, Notepad and word Processor. 
To become a BookShare member, you must complete BookShare's application process, including providing proof of reading disability, and pay the associated yearly membership fees. Payment can be monetary, or users can earn credit toward their membership fees by scanning or proofreading material for the collection. While the majority of the BookShare titles require you to have a membership to access them, several thousand titles in the collection are public domain works, and thus, can be accessed by anyone, regardless of whether you have a BookShare membership.
For more information about BookShare, the application process, or the collection, please visit www.bookshare.org.
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To open the "BookShare Download" program, from the Main Menu, use "Space-4" to navigate to "Library" and press "Enter". In the "Library" menu, use "Space-4" to navigate to "BookShare Download" and press "Enter". You can launch "BookShare Download" from anywhere on the unit by pressing "F1-K". 
The BookShare Download program makes extensive use of dialog boxes. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to Tab and Shift-Tab among controls in a dialog. For the purposes of these instructions, we will generally just refer to "Tab". 
Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate settings or lists. Press "Enter" to execute an item.
When you open "BookShare Download", you are taken to a webpage in which you can enter your BookShare account information. If you wish to use “Anonymous Mode”, or rather, if you do not have a BookShare account, and want to access only the public domain works, press “Space-Z” to exit the web view, and you are taken to the main BookShare program without logging in.
After entering your login information, you are asked to approve the BrailleSense BookShare program for use with your account. You can use first letter navigation to jump to the “approve” button and press enter.
Once approved, you are placed in the main "BookShare Download" dialog on the "Search content" combo box. Each subsequent time you open the program, you are taken to the “Search Content” combo box.
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The "BookShare Download" dialog initially contains 3 items:
1) "Search Content" combo box: you can choose to search "Books", "periodicals", “Reading Lists”, or your download "History". Use "Space" to change the value of the setting.
2) "search Type" combo box: (only appears when "Books" is chosen from the "Search Content" combo box. You can choose to search BookShare's book collection by Title, Author, ISBN, Keyword or category. Use "Space" to change the value of the setting.
3) Search term Edit box: If you have chosen to search by periodical, you are asked to enter the "periodical ID". If you have chosen to search the book collection for a title, author, or ISBN, etc,the edit box asks for that item. 
Pressing Enter or Tab will initiate the search and place you in the list of results.
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When the search is complete, you are placed in a list of results that match your search. Navigate the list using "Space-1" and "Space-4". 
The "BookShare Download" dialog now contains 3 additional items: the "Search Results" list you are now in, a "Download Book" button, and a “Book Detail” button. 
If the results list contains more than 50 items, when you reach the bottom of the list, the next page of results automatically loads. If you are quite sure there are more than 50 items, you can press Enter-N to load the next page at any time. If there are no more results to be loaded, BrailleSense announces, “No more results found”.
If you press "Enter on the "Book Detail" button, or press its shortcut, "Enter-I", you are placed in a dialog providing more information about the book. The "Details" list contains the following items:
1) "Title" shows the complete title of the book.
2) "author" lists the author or authors of the work.
3) "ISBN" lists the International Standard Book Number.
4) " Synopsis" gives a short overview of the work.
5) "Category" lists the category the book is logged under in the BookShare library.
6) "Language" lists the language in which the book is printed.
7) "Publisher" lists the publisher of the book.
8) "publish date" lists the copyright date of the work.
9) “Format” lists all the available formats in which you can download the current book. 
You can download a book in the "search Results" list either by pressing "Enter" on the book title in the list, or by navigating to the "Download" button and pressing "Enter". If you are logged in in "anonymous Mode" and press "Enter", and the book is not part of the public domain collection, the Braille Sense announces and displays, "This content is not free" and returns you to the "Search Results" list.
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If you select "periodicals" from the "Search Content" combo box, the next item in the dialog is an edit box in to which you can enter all or part of the title of the periodical. Enter your search term in the edit box, and press "Enter" or “Tab” to initiate the periodical search. When the search is complete, a list of available periodicals that matched your search is displayed. Locate the periodical you want, and press “Tab” or “Enter” again to get a list of available issues for that periodical. 
If you do not know the name of the periodical you wish to find, simply leave the edit box blank and press "Enter". If you have typed nothing in to the edit box, the entire list of available periodicals is displayed in alphabetical order. Press "Enter" on your desired periodical, and the list of available issues for that periodical is displayed.
The issues list also contains a "detail Information" button for each item. The "Detail information" for periodical issues contains the following information:
1. “ID:” The ID number BookShare gives to the periodical.
2. "Title": the title of the periodical issue.
3. "Category": the type of periodical (newspaper, magazine, etc).
4. "Revision": the number of the revision of the online version of the periodical posted to BookShare.
5. "Revision time": the time the most current revision was posted to BookShare. (Useful if a revision contains errors in DAISY structure or text, as you can determine whether you have downloaded the most recent version)
As with a book, to download an issue of a periodical in the list, simply press "Enter" on it, or Tab to the "Download" button, and press "Enter".
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To search reading lists that you, or your school has created for your account in BookShare, choose “My Reading lists” from the “Search Content” combo box. Press “Tab” or “Enter” to get a list of the available reading lists, and “Tab” again to get a list of books in the currently focused reading list.
You can get details for, or download a book in the list in the same way that you can from a Results list in the “Books” search mode.
You may also view reading lists created by others that are shared with the public. To search the available public reading lists, choose “Public Reading Lists” from the Search Content area. There are many public reading lists available. To make it easier for you to locate ones you want to follow, you may wish to subscribe to a public reading list, after which, it will appear in the “My Reading Lists” area for easier retrieval. To subscribe to a public reading list, press “Enter-S” when focused on it. To unsubscribe from a public reading list, press “Space-D” when focused on it in the “My Reading Lists” area.
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To search your download history, choose "History" from the "Search Content" combo box, and press “Tab” or “enter”. You are presented with a book list just like the one that appears when you receive results in the "Books" search mode. The book list contains the list of books you've previously downloaded from any device you have connected to BookShare. The books are listed in the order you downloaded them, beginning with the most recent. As with the results from the "Books" search, you can get detailed information for a book and download it. 
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The BookShare download program contains 2 menus, “File” and “Reading list”.
The “File” menu contains the following items:
1)  Options: (O) “Enter-O”. Opens the "Options" dialog where you can set default download format, download location, and whether the BrailleSense automatically unpacks and/or opens BookShare books.
2) Sign Out: (X). Signs you out of the current BookShare account, after which time you can sign in to a different account via the web view, or operate in Anonymous mode.
3) Exit:: (Z) “Space-Z”. Exits the "BookShare Download" program. 

The “Reading list” menu contains the following options:
1) Create reading List: (C) “Enter-R”. Opens a dialog where you can name the reading list, write a description, and determine whether the access is private, shared, or organizational.
2) Edit Reading list: (E) “enter-E”. Allows you to edit the information for the currently focused reading list.
3) Add title to a reading list: (A) “Enter-A”. opens a dialog from which you can choose which reading list to add the current title to.
4)  Delete title from reading List: (D) “Space-D”. When viewing a reading list, deletes the focused title from the list.

[bookmark: _Toc492453954][bookmark: _Toc26179870][bookmark: _Toc209372267]7.5 Sense Dictionary
The Sense Dictionary is provided free of charge on the BrailleSense 6. The basic package includes an English dictionary and Thesaurus, and an English/Spanish bilingual dictionary. Other dictionaries may be installed from within the Sense Dictionary program by pressing Enter-I. To install an additional dictionary, just press Enter on your desired addition.
Available dictionaries are as follows:
US English Dictionary: Webster's New World College Dictionary
US English Thesaurus: Collins Thesaurus A-Z 3rd
UK English Dictionary: Collins Comprehensive English Dictionary
Spanish/English Dictionary: Collins Spanish Dictionary – Complete and Unabridged
Italian/English Dictionary: Collins Italian Dictionary 
French/English Dictionary: Collins English French Electronic Dictionary
· Note: You can remove a dictionary at any time by deleting its associated files from the “flashdisk/HanDictionary” folder.

[bookmark: _Toc209372268]7.5.1 What is the Sense Dictionary?
The "Sense Dictionary" enables you to look up the definitions of English words as well as access synonyms and antonyms of English words via the included Thesaurus. With the optional additional bilingual dictionaries, you can also look up Spanish, French, and Italian words and their definitions, as well as their English translations; or discover the Spanish, French, or Italian equivalent to a meaning you want to convey, but for which you know only the English word.
You can use the "Sense Dictionary" independently via the Extra's Menu, or access it from anywhere on the notetaker with a single keystroke, and instantly search the word under your cursor. In addition, you can insert information from the "Sense Dictionary" directly in to your Word processor documents or e-mail messages. 

[bookmark: _Toc315788747][bookmark: _Toc209372269]7.5.2 Executing the "Sense Dictionary"
You can access the "Sense Dictionary" in 3 ways: via the Extra's Menu, via the "File" menu in an open document or e-mail message, or by using a single keystroke to globally access individual references offered by the "Sense Dictionary".

To access the sense Dictionary from the extras Menu, do the following:
1. Navigate to the main menu by pressing "F1". 
2. Type "x" to enter the "Extras" menu.
3. Type "D" or navigate to Sense Dictionary and press Enter'

You may also execute the "Sense Dictionary" from the "File" menu when in the Word Processor or the body of an e-mail message: 
1. Press "F2" to open the program menu.
2. Press "Enter" on the "File" menu. 
3. Type "D" or navigate to "Dictionary" and press "Enter". 
 
Use the following Hot keys to access the various reference sources in the Sense Dictionary from anywhere on the notetaker.
English Dictionary: "Enter-Backspace-D 
English Thesaurus: "Enter-Backspace-T 
Spanish Dictionary: "Enter-Backspace-L 
Italian Dictionary: “Enter-Backspace-Y 
French Dictionary: “Enter-Backspace-F 
when any of the “Sense Dictionary” edit boxes are displayed, you can move among the available dictionaries using “Space-1” and “Space-4”. 
You can exit the Sense Dictionary with Space-Z. After exiting you are returned to the program in which you were located when you executed the Sense Dictionary. 

[bookmark: _Toc315788752][bookmark: _Toc209372270]7.5.3 Choosing a Reference and Performing a Search
The Sense Dictionary, when executed, opens an Edit Combo Box containing the following options: 
English Dictionary Key word
English Thesaurus Key word
Foreign Language Key word
Foreign language to English Key word

Note: the Foreign Language Key word Edit boxes only appear if you have installed one or more of the optional bilingual dictionaries. If you have installed more than one bilingual dictionary, key word edit boxes appear for each of the bilingual dictionaries you installed.
You can move among the items in the combo box by pressing "Space-dot 4" and "Space-dot 1". When your cursor is placed on the dictionary you want to use, type the word for which you wish to search in the edit combo box and press "enter".
When the search is complete, you are placed in a dialog containing 3 controls: A definitions text box containing 1 or more definitions of the searched word, the same keyword edit combo box as is available when the dictionary is launched, and an entries list comprised of all words containing the characters you typed. You can Tab through the controls by pressing "F3" and "Space" with "F3". If the word has multiple definitions, you can navigate the list of definitions by pressing "Space-dots-5-6" and "Space-dots-2-3". The syllable division and phonetic pronunciation are also shown. 
If you type a letter in the Definition text box, you are automatically returned to the keyword edit combo box. 

[bookmark: _Toc315788754][bookmark: _Toc209372271]7.5.4 Abbreviations Guide
The Sense Dictionary uses letters and abbreviations to identify parts of speech and other various parts of a definition. Refer to the below abbreviations guide for interpreting the various items in the Definitions text box.

Abbreviations for the English Dictionary:
n: noun
abbr.: abbreviation.
exclam: exclamation; exclamatory
adj.: adjective; adjunct; adjustment
adv.: ad valorem; advance; advent; adverb; adverbial(ly); advertisement; advocate
very.: verb
prep.: preparation; preparatory; prepare; preposition
comb. form: combining form.
conj.: conjugation; conjunction; conjunctive
pron.: pronominal; pronoun; pronounceable; pronounced; pronunciation

Abbreviations for Italian Dictionary:
m.: masculine noun, masculine (sostantivo maschile, maschile)
f.: feminine noun, feminine (sostantivo femminile, femminile)
Inv.: invariable (invariabile)
prep.: preposition (preposizione)
tr.: transitive verb (verbo transitivo)
pronom.: pronominal verb (verbo pronominale)
pass.: past (passato)
agg.: adjective (aggettivo)
intr.: intransitive verb (verbo intransitivo)
inter.: interjection (interiezione)
avv.: adverb (avverbio)
n.: noun (nome)
pl.: plural (plurale)
agg.: adjective (aggettivo)
impers.: impersonal verb (verbo impersonale)
cong.: conjunction (congiunzione)
pron.: pronoun (pronome)
indef.: indefinite (indefinito)
poss.: possessive (possessivo)
aus.: auxiliary (ausiliare)
superl.: superlative (superlativo)
pers.: personal (personale)
rel.: relative (relativo)
interr.: interrogative (interrogativo)
esclam.: exclamatory (esclamativo)
dimostr.: demonstrative (dimostrativo)
mod.: modal verb (verbo modale)
artc.: article (articolo)
art det.: definite article (articolo determinativo)
sing.: singular (singolare)
attrib.: attributive (attributivo)
artc indet: indefinite article (articolo indeterminativo)

Abbreviations for French Dictionary:
nm: masculine noun (nom masculin)
inv: invariable (invariable)
nf: feminine noun (nom féminin)
vtr: transitive verb (verbe transitif)
vpr: reflexive verb (verbe pronominal)
pp: past participle (participe passé)
adj: adjective (adjectif)
nmpl: noun, masculine plural (nom masculin pluriel)
vi: intransitive verb	(verbe intransitif)
loc: phrase (locution)
adv: adverb (adverbe)
nmf: masculine and feminine noun (nom masculin et féminin)
ind: industroy (industrie)
f: feminine (féminin)
nfpl: noun, feminine plural (nom féminin pluriel)
prep:preposition (prép préposition)
conj: conjunction (conjonction)
impers: impersonal verb (verbe impersonnel)
excl: exclamation (exclamation)
v: verb (verbe)

Abbreviations for Spanish Dictionary:
indef art: indefinite article
def art: definite article
n: noun
adj: adjective
adv: adverb
vt: transitive verb
vi: intransitive verb
v refl: verb reflexive
prep: preposition
interj: interjection
pron: pronoun
conj: conjunction
suff: Suffolk; suffragan
pref: preface; prefatory; prefecture; preference; preferred; prefix
etc: et cetera
pl: plural

[bookmark: _Toc315788757][bookmark: _Toc209372272]7.5.5 The Entries list
The entries list consists of all words containing the characters you typed in the search box. For example, if you search for the word "stuff", the Entries list contains "stuff" as well as "stuffy", "stuffing", and "stuffed shirt" The Entries List can also be useful when searching for words you don’t know how to spell.
If you are not certain of the spelling of a word, but you know its length, you can use question marks as wild card characters. For example, if you are searching for the word "adapter" and you are not sure if it is spelled "adapter" or "adaptor", you can type "adapt?r". Note: when using a Perkins keyboard, to type the question mark, you must use the "dot-4" followed by the computer Braille symbol for the question mark, "Dots 1-4-5-6".
As described above, the Entries List is comprised of all items containing the characters for which you searched. Thus, in addition to providing variations on whole words, you can also type the first few letters of a word and obtain a list of words in the Dictionary that begin with those letters. To browse the word list, press SPACE-Dot 1" or "Space-Dot 4". Once you find the word you are looking for, press "Enter".
For example, if you are writing about a legal matter and want to know how to spell the word "plaintiff", you can search for "plaint" and your list includes, "plaintiff", and "plaintive". 
If you perform a search and there are no matching words in the dictionary, the Sense Dictionary' gives you a suggestion list of possible words based on the letters you typed. 
For example, if you type dictionory' instead of dictionary', the suggestion list contains dictionary'. 

[bookmark: _Toc315788762][bookmark: _Toc209372273]7.5.6 Working with Definitions
If you are reading the definition of a word, and come across a word within the definition for which you'd like the meaning, you can place your cursor on the word you'd like to look up, and press "Enter". The "Sense Dictionary" then initiates a search for the highlighted word. 
 You can navigate the definitions of a searched word by character, word, line or phrase. You can also easily navigate to the origin or part of speech. 
Use the following hot keys in the Definitions list:
(1) Switch between previous and most recently searched words: "Backspace"
(2) Move to next line: "Space-4" 
(3) Move to previous line: "Space-1" 
(4) Move to next definition or phrase: "Space-5-6" 
(5) Move to previous definition or phrase: "Space-2-3" 
(6) Move to previous origin or part of speech: "Space-2-3-6" 
(7) Move to next origin or part of speech: "Space-3-5-6" 
(8) Move to previous character: "Space-dot-3" 
(9) Move to next character: "Space-dot-6" 
(10) Move to previous word: "Space-dot-2" 
(11) Move to next word: "Space-dot-5" 

[bookmark: _Toc315788765][bookmark: _Toc209372274]7.5.7 Accessing your Search History.
 The sense notetaker recalls up to 32 previous dictionary searches. 
Use the following hot keys to interact with the history list:
(1) Bring up the history list: "Enter-H” 
(2) Clear the history list: "Backspace-D” 
(3) Move to next item in the history list: "Space-dot 4" 
[bookmark: _Toc492453916][bookmark: _Toc26179827](4) Move to previous item in the history list: "Space-dot-1"

[bookmark: _Toc209372275]8. Organizer.
The "Organizer" menu contains items to help you organize and synchronize appointments and contacts. It contains the "Address Manager", and the "Schedule Manager". 
Open the "Organizer" menu by navigating to "Organizer" in the main "Program" menu, or just by pressing "O from the main menu.

[bookmark: _Toc492453917][bookmark: _Toc26179828][bookmark: _Toc209372276]8.1 Address Manager
The "Address Manager" is a program you can use to keep track of your contact information for friends and colleagues, such as company addresses, home addresses, e-mail addresses, as well as other information. You can also synchronize your contacts with your Google Account under Accounts in the Settings menu of All Apps.
The "Address Manager" consists of two main dialogs: "Add Address" for entering contact information, and "Search Address" for retrieving this information. 
In the "Organizer" menu, you can quickly jump to an open the "Address Manager" by typing "a" or by navigating to the "Address Manager" and pressing "Enter". 
When the "Address Manager" is opened, the "Search Address" dialog is displayed. The BrailleSense prompts, "Last name:" 
You can use the menus to conveniently browse and execute all of the available commands. To open the menu, press "Space-M" or "F2". Select a menu item using "Space-1" or "Space-4”, and press "Enter". Or, you can press "Space-M or "F2" followed by the shortcut for the corresponding menu item. Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab and Shift-Tab among controls in a dialog. 

[bookmark: _Toc492453918][bookmark: _Toc26179829][bookmark: _Toc209372277]8.1.1 Adding an Address
This dialog allows you to enter new contacts. Select "Add Address" from the menu, or press "Enter-I" directly from in the "Address Manager".
The "Add address" dialog contains An Account Name combo box, a list of 22 input fields, the "Memo" field, a "Confirm" button, and a "Cancel" button. Use the Account Name combo box to choose the account to which you want to add this particular contact. In the input fields, enter the information corresponding to the 22 fields of a record. You can move from one field to the next using "Space-1" and "Space-4" or the up and down scroll keys. You do not have to fill in all the fields, simply leave blank those you do not need to use. 
If using US Braille, you can enter telephone numbers using computer Braille (without a number sign) or regular grade 1 Braille (with or without a number sign). To enter a dash, press "Space" or "dots 3-6". To put an extension number after any phone number, enter the phone number as described above, and then type a comma (,), followed by the extension number, as in "000-000-0000,100." In this case, Press "dot 6" to enter the comma in computer Braille or "dot 2" in grade 1 Braille. When you enter a home page address or an e-mail address, you should also use computer Braille. 
After filling in the desired information, Tab to the "Memo" field. You can type in multiple lines of text in the "Memo" field. If you do not wish to enter a memo, leave it blank. 
When you have entered all the relevant information, Tab to the "Confirm" button and press "Enter". Or, just press "Enter" from any field. To cancel the contact entry, Tab to "Cancel" and press “Enter". After canceling or adding an entry, you are placed in a new blank record. 

[bookmark: _Toc492453919][bookmark: _Toc26179830][bookmark: _Toc209372278]8.1.2 Setting Add Address Fields
There are 22 fields in a record, but you may not want to enter information in every one of the 22 fields. You can use "Set Address Fields" to select only the fields that you need.
To use this function, Select "Set Address Fields" from the menu, or, press "Enter-O" from the "Add Address" dialog. On the right side of each field name, "used" or "unused" is displayed. The default value is set to "used". To toggle the value, press "Space".
After setting all the fields you want to change, Tab to "Confirm" and press "Enter". To cancel changes, press "Space-E". 

[bookmark: _Toc492453920][bookmark: _Toc26179831][bookmark: _Toc209372279]8.1.3 Searching For an Address
The "Search Address" dialog enables you to search for specific records in the "Address Manager". The "Search Address" dialog is opened automatically when the "Address Manager" is launched. To open "Search Address" from "Add Address", you can either select it from the menu, or press "Enter-S" from the "Add Address" dialog. "Last name" is displayed as this is the first field in the address data. 
Type a last name to search for and press "Enter". Press "Enter" without entering text to search, and all records are shown. To search by a different field, navigate to it using "Space-4", type the search text in the edit box, and press "Enter". 
You can move among found records using "Space-1" and "Space-4". Press F3 on the record you wish to view. The information appears in a multi-line read box which you can navigate using normal text navigation commands.
If a record contains an e-mail Address, you can press "Enter" to launch the e-mail program and send an e-mail to that person. If a field contains a web page, you can press "Enter" on it to open the page in the Web browser. 
When you enter text to be searched, you do not have to type the entire content of a field. For example, to find a record about "Edward", type in "ed" in the "search name" field. Then, all the records whose name field contains "ed" are found.
You can choose whether or not records are sorted by first or last name using the “Sort Options” setting, either by choosing it from the menu, or by pressing “Backspace-S” from the “Search address” dialog. Use “Space” to change the radio button.

[bookmark: _Toc492453921][bookmark: _Toc26179832][bookmark: _Toc209372280]8.1.4 Setting Searching Address Fields
This option enables you to select the fields that you want to search. Select "Set Address Search Fields" from the menu, or press "Enter-O" from the "Search Address" dialog.
All the address fields are displayed. Press "Space", to toggle the value of a field between "used" and "unused". 
You may do the same with the address fields you want to save to a file or print. To do this, choose “Set save Address Fields” from the menu, or press “Backspace-V” from the “Search Address” dialog.

[bookmark: _Toc492453922][bookmark: _Toc26179833][bookmark: _Toc209372281]8.1.5 Backing up and Restoring the Address List
If you perform a hard reset, or if your battery dies, all of the data in the "Address Manager" is lost. Thus, it is very important that you make a backup file every time you make a change to the address list. Select "Backup Address List" from the menu, or press "Enter-U" from anywhere in Address Manager. 
If you already have a backup file, you are prompted, "Backup file already exists. Continue to backup? Yes". If you have made changes to your address list, press "Enter" to create a new backup file. To keep the previous backup file press "Space-4", to move to "No", and press "Enter". When you create a backup file in your address list, you will have a new backup file in the database folder on the Flashdisk.
To restore the address list after a hard reset, select "Restore Address List" from the menu, or press "Enter-R" from anywhere in Address Manager.
If you already have an address list, you are prompted, "Address file already exists. Which do you prefer? Append". If you press "Enter", the backup address list is appended to the current address list. If you press "Space-4" once and press "Enter" on "Overwrite", the new backup file is restored, erasing the old backup file.
You can backup your address list automatically using the "Set Backup Options". Select "Set Backup Options" from the menu, or press "Enter-E". 
The "Backup mode" has three radio buttons: "Always backup changes when exiting", "Manual backup", and "Prompt backup changes when exiting". Move through the radio buttons using "Space" and "Backspace". Press "Enter" to save your setting.

[bookmark: _Toc492453923][bookmark: _Toc26179834][bookmark: _Toc209372282]8.1.6 Importing from CSV
"CSV" is the acronym for Comma Separated Value. A CSV file is used for the digital storage of data structured in a table form, with the information in the various columns separated using commas. The "Address Manager" can import a CSV contact file created using MS outlook or some cell phones. You can also export a CSV file of your contacts for use on other devices.
To import the data from a CSV file, select "Import from CSV" from the menu, or press "Backspace-I" from anywhere in the Address Manager. Type the name of the file you want to import in the edit box. To browse for a file, "Shift-Tab to the path search list, and use normal file navigation commands to choose your file and press "Enter". 
When the CSV file is imported, "Last name: unused 1/xx" is displayed. You can choose whether the data from the CSV file for each field should be imported. Some CSV files may contain data that is not equivalent to any of the fields in the "Address Manager", or you may simply not wish to import certain pieces of information.
This dialog contains all the fields in the "Address Manager", a check box for allowing fields in the first record, and "Confirm" and "Cancel" buttons. Tab and Shift-Tab among these items. For each "Address Manager" field, there is a list box containing "Unused" and all of the fields of the CSV file being imported. Use "Space-1" and "Space-4" to move among the fields. If there is no equivalent field in the CSV file for an "Address Manager" field, select "unused".
Often, the first set of fields in a CSV file represent field titles. For this reason, there is a check box for allowing fields in the first record to be imported or not. If the first set of fields does contain title data, make sure that the "allow fields in first record" item is not checked. 
To complete the import, Tab to "Confirm" and press "Enter". You are prompted, "Address file already exists. Which do you prefer?" The default value is "Overwrite". The setting values are "Overwrite" and "Add". You can either replace the existing file with the data imported from the CSV file, or you may add it to the existing address list. To change the setting value, press "Space", and press "Enter" to save the data.

[bookmark: _Toc492453924][bookmark: _Toc26179835][bookmark: _Toc209372283]8.1.7 Exporting to CSV
To export address data to CSV, select "Export to CSV" from the menu, or press "Backspace-X". Type a file name for the exported data and press "Enter". To change the location where the file is stored, Shift-Tab to the file list and use normal file and folder navigation to select the location. 

[bookmark: _Toc492453925][bookmark: _Toc26179836][bookmark: _Toc209372284]8.1.8 Editing, Saving, and Deleting Addresses
To edit information in a record, find the desired address by using the "Search Address" function. Select "Modify Address" from the menu, or press "Enter-M" to activate this command directly. You can now enter new information in any of the fields. When you have modified the information, press "Enter". The BrailleSense saves the changes, and you are returned to your previous position. You can press “Space-E” to cancel the modification.
To delete the record you are currently reading, select "Delete Address" from the menu, or press "Space-D" while viewing the record. You can also delete more than one record at a time by first selecting individual records with "Space", or by selecting all records with "Enter-A".
You can also save selected records to a file. Select "Save addresses As File" from the menu, or press "Enter-T" from the "Search Address" dialog. The "file save" dialog is displayed and you are asked to enter the file name and select a file format. After you type the file name, and select one of the available file formats, press "Enter" on "Confirm", and the selected records are saved. 

[bookmark: _Toc26179837][bookmark: _Toc209372285]8.1.9 Syncing Contacts
Contacts entered or imported into the BrailleSense can be synchronized with your Google Account, and thus also, any other accounts that synchronize with your Google Account.
You can set your sync preferences in Android System Settings, under the accounts item, then Google. All of your Google Accounts are listed and identified whether Sync is enabled. Press Enter to open a dialog in which you can choose what items you would like to have synced. If you choose to sync your contacts, they are automatically synchronized when you make changes. You can also manually “Sync Now” in the More options menu of the Accounts dialog.
Note: if you make too many changes, such as when importing a CSV, or synchronizing many new contacts, you may receive “Sync Errors”. If this occurs, press Space-1-2-3-4-5-6 to open the Notification Shade, and press Enter to open the error. From there, you are given options as to how you would like to handle the errors.

[bookmark: _Toc492453926][bookmark: _Toc26179838][bookmark: _Toc209372286]8.2 Schedule Manager
The "Schedule Manager" is a program used to manage information about appointments, anniversaries, and events. It can also inform you of appointments at a specified time using alarms. You can start the "Schedule Manager" from the "Organizer" menu, by navigating to it with "Space-4" and pressing "Enter". You can launch the "Schedule Manager" from anywhere on the unit by pressing "F1-S". 
The "Schedule Manager" has two main dialogs: "Add appointment" and "Search appointments". In "Add appointment", you can enter information for a new appointment. Using "Search appointments", you can look for information about a specific appointment and edit or delete the information. 
When the "Schedule Manager" is opened, the "Search appointments" dialog box is displayed. You are prompted for a "Find date:" with the current date filled in as the default. To add a new appointment, select "Add appointment" from the menu, or press "Enter-I" from the "Search appointments" dialog.
· Note: Due to the nature of appointments, it is very important that dates and times are entered correctly to ensure that your schedule is accurate and you are alerted to your appointments at the proper times through the "Check Today's SCHEDULE" option as well as the alarms that can be associated with appointments. Please be sure your time and date are set correctly. (See section 3.1) 

[bookmark: _Toc492453927][bookmark: _Toc26179839][bookmark: _Toc209372287]8.2.1 Adding an Appointment
To add a new appointment, press "Enter-I" from the "Search appointments" dialog. The "Add appointment" dialog has a set of input fields, a "Confirm" button, and a "Cancel" button. Use "F3" and "Space-F3" to move through the controls.
When you start "Add appointment", you are prompted to choose the appointment type. Use Space-1 or Space-4 to choose between “Anniversary” or “Appointment”.
The next field is the "Start date" edit box. To use the date displayed, Tab to the next field. To enter a new date, type month/day/year. 
· Note: If you have not searched for an appointment, or have searched by subject, the default "Start date" is today's date. If you have searched appointments by date, it is the last date for which you searched.
Tab to the "Start Time" field. By default, this field shows the current time. Enter the time as hhmm or use navigation keys to select your appointment time. If you're using "12 hour" format, press "Space-X" to change between am and pm.
The next field is the end date. By default, the end date is the same as the "Start date". To use this date, Tab to the next field. To enter a new date, type month/day/year.
By default, the end time is the same time as you set in the "Start time" field. To change the time, type the time as hhmm.
The next field is the subject of the appointment. If you do not enter anything in this field, you cannot save the record. If you press "Enter" after typing in the subject, the record is saved, leaving the "Location" and "Memo" field empty, and the "Alarm time" field set to its default value ("Off"). Type your subject and Tab to the next field.
Type the location of your appointment. Press “Enter" to save the appointment, or Tab to the next field.
In the "Memo" field, you can enter detailed information about an appointment. This is a multi-line edit box, meaning you can type more than one line of text. You can use most of the editing commands that are used in the "Word processor". You can leave this field blank if you wish.
The "Alarm time" function allows you to set when you are reminded about an appointment. The alarm is set relative to the appointment time. For example, you may want the alarm to sound 30 minutes before your appointment, so that you are not late. The default value for this field is set to "Off". 
The time can be set anywhere from one minute to two weeks before the appointment. Use the same navigation keys as when setting the time and date. If you do not wish to have an alarm reminder, press "Space-1" to "Alarm off". After setting the "Alarm time", press "Enter" to save the appointment. 

[bookmark: _Toc492453928][bookmark: _Toc26179840][bookmark: _Toc209372288]8.2.2 Setting a Recurring Appointment
Set this option when the appointment you are creating recurs at regular intervals. If it is unchecked, the appointment is set to occur once. To set a recurring appointment, check this box with "Space", then Tab to the resulting combo box for setting the recurrence pattern. You can select from "Daily", "Weekly", "Monthly" and "Yearly".
If you select "Daily", Tab to the "Recurring interval of day" edit box. You can type a number between 1 and 999 to represent the number of days between recurrences. If you enter 1, the appointment recurs every day, and if you enter 2, it recurs every other day. Be sure the difference between the start and end date is shorter than the recurring interval value. 
Tab to the "Set recurrence end date" check box. By default, it's unchecked, which indicates that the appointment recurs indefinitely. If you check this box, an edit combo box for entering the end date appears in the tab order.
If you set the "Recurrence" to weekly, Tab to the "Recurring interval" edit box, and type the number of weeks between appointments in numbers from 1 to 999. As with daily, the appointment duration should be shorter than the recurring interval. 
Tab to a list box where you can select the day of the week on which the appointment recurs. To select or unselect the current item, press "Space". You can make more than one selection, thus the appointment recurs on more than one day during the week. If you don't select a day, it is set to the today's week day. 
If you set the "Recurrence to monthly", Tab to the "Recurring type" combo box. You can set the recurring type as "Date" or "Day of the week". "Date" is used when you want to set an appointment recurring on the same day of a month, for example, on the 17th of every month, or every other month. On the other hand, "Day of the week" is used when you want to set an appointment recurring on the same week and day of the week of a month, for example, on Wednesday of the second week of every month. After selecting the "Recurring type", Tab to the "Recurring interval", and type a number of months between appointments in numbers from 1 to 999. 
Different fields are shown in the Tab order depending on what you have selected in "Recurring type". If you set the "Recurring type" to "Date", an edit box appears for typing the day of the month for the recurrence. By default the "Start date" is shown. Tab to "Set recurrence end date" and make your choices.
If you set the "Recurrence" to "Yearly", Tab to the "Recurring type" combo box. Select either "date" or "day of the week". If you set the "Recurring type" to "Date", you can set the month and the day of the month when the appointment recurs. If you set it to "Day of the week", you can set the month, the week, and the day of the week when the appointment recurs every year. After setting "Recurring type", Tab to the "Month for recurrence" combo box. Select the month of the year using "Space-1" or "Space-4". From here, different fields appear in the tab order depending on how you have set the "Recurring type". 
If you have set the "Recurring type" to "Date", the focus moves to "Day of recurrence" edit box. You can type a number between 1 and 31. Then, Tab to the "Set recurrence end date" check box. If the "Recurring type" is set to "Day of the week", you have to set "recurring week" and "Day of week for recurrence". 

[bookmark: _Toc492453929][bookmark: _Toc26179841][bookmark: _Toc209372289]8.2.3 Search Appointments
When you start "Schedule Manager", the "Search appointments" dialog is opened. You can also open this dialog from the "Add appointment" dialog, by pressing "Enter-S" or selecting "Search appointments" from the menu. There are two methods for searching an appointment: "searching by subject" and "searching by date". 
When "searching by subject", you can find an appointment using keywords in the subject field. When "searching by date", you can find appointments according to a specified date. To toggle the search mode, Select "Toggle Search Mode" from the menu, or press "Enter-F". The last search mode you used is saved when you exit the Schedule Manager. 
You can also determine how searches are done by default using the “Search options” item from the menu. This allows you to choose your default search mode, as well as whether to search the entire calendar, or to search from the current date forward when searching by subject.
When you search by date, by default, the BrailleSense searches for appointments occurring today. To search for another date, type the date in the format "mm/dd/yyyy", or use the "move by date" hotkeys. Press "Enter", and the appointments occurring on the chosen day are shown. If there is no appointment on that day, the unit announces, "There is no appointment registered". 
The first appointment is announced in the form of "date, time, and subject". If the appointment lasts for more than one day, "continuous schedule" is announced. If the appointment recurs, "recurring schedule" is announced. If you scheduled more than one appointment for that day, move among the appointments using "Space-1" or "Space-4". To move to the first appointment, press "Space-1-3", and to move to the last appointment on that day, press "Space-4-6". 
To move to the appointments on another day, press "Space-2" or "Space-5". The previous/next appointment occurring within four months is displayed. To move to the first appointment stored in the Schedule Manager, press "Space-1-2-3", and to move to the last appointment stored in the Schedule Manager, press "Space-4-5-6". To obtain details on an appointment, press "Enter". 
To search by subject, type in the keywords to search and press "Enter". All appointments with the keywords are displayed. If you press "Enter" without typing text, BrailleSense displays all appointments in the “Schedule Manager".
To move to the next or previous appointment, press "Space-4" or "Space-1" respectively. Pressing "Space-1-3" and "Space-4-6" move to the first and last items in the appointment list.
For recurring appointments and multiple day appointments, the BrailleSense only shows the appointments of the first day if you search the schedule by subject. Press "Enter" on an appointment to read the details. Press "Space-E" to return to the appointment list. To search other keywords, Tab to the "Search subject" edit box, and type new search text.
Some appointments you enter or receive may contain links to a Zoom meeting, Google Meet invitation, a Teams live event, or other item that requires launching of an installed app. These are generally located in the Memo or location fields. You can open these links in an Android browser, as the BrailleSense browser does not automatically launch other programs. 
To open a link located in the current paragraph in the default Android browser, press “Backspace-L”. The browser will launch, which will then, in turn, activate the associated Android program, provided that program is installed on your BrailleSense. For example, if you want to launch a Zoom meeting, you need to install the Zoom application on your BrailleSense on Google Play.

[bookmark: _Toc492453930][bookmark: _Toc26179842][bookmark: _Toc209372290]8.2.4 Editing, Saving, and Deleting Appointments
To modify an existing appointment, move to the appointment and select "Modify Appointment" from the menu, or press "Enter-M" from the search results list. If the appointment is a recurring schedule, a prompt, displaying "Recurrence appointment. Open type?" appears. Choose whether you want to modify the recurring appointment or the appointment for a specific day. If you select "This occurrence", your changes affect the appointment of the day, but the recurring appointments on other days are not changed. If you select "The series", your changes affect all the recurrences. 
The "Modify appointment" dialog contains the same controls as in the "Add appointment" dialog. The only difference is that each field has the value entered previously. If you have made changes you wish to save, tab to "Confirm" and press "Enter". 
To delete an appointment, move to the appointment in the search results list. Select "Delete Appointment" from the menu, or press "Space-D" from the search results list. If the selected appointment is a recurring appointment, you are prompted, "Recurring appointment. Delete type?" is displayed. You can choose whether you want to delete the recurring appointment, or just the appointment for that day. If you select "This occurrence", only the current appointment is deleted. If you select "The series", all recurrences of the appointment are deleted. 
To completely initialize the Schedule Manager, select "Delete All Appointments" from the menu, or press "Backspace-Enter-q" from anywhere in the Schedule Manager. 
You can also save selected appointments as a document. Select "Save Appointments as File" from the menu, or press "Enter-T" from the search results list. The BrailleSense asks you to specify the beginning and end dates of the appointments to be saved. After setting the beginning and end dates, press "Enter", and you are prompted to enter the name and the format of the file to be saved. This dialog is the same as the "Save As" dialog in the "Word processor". 

[bookmark: _Toc492453931][bookmark: _Toc26179843][bookmark: _Toc209372291]8.2.5 Backing up and Restoring Your Appointments
If you perform a hard reset, or your battery dies, all of the data in the Schedule Manager is lost. Thus, it is very important to create a backup file each time you change your schedule. To backup your schedule, Select "Backup Appointments" from the menu, or press "Enter-U" to activate this function directly.
If you already have a backup file, you are prompted, "Backup file already exists. Backup anyway? Yes". If you have made changes to your schedule, press "Enter" to create a new backup file. To keep the previous backup file, press "Enter" on no. If you make a backup file again in the Schedule Manager, a new backup file is created with the extension DAT, and another file is created with the extension BAK containing your previous backup file. 
To restore your schedule after a hard reset, Select "Restore Appointments" from the menu, or press "Enter-R" to activate this function directly.
If you have an existing schedule, you are prompted, "Schedule file already exists. Which do you prefer? Append" or, press "Space-4" to move to "Overwrite". If you choose to append, and the backup file contains appointments that also exist in your current file, you will have redundant appointments. If you choose to overwrite and your current schedule contains appointments the backup file does not, these appointments are lost. 
You can back up the schedule automatically by activating the "Set Backup Options" function. Select "Set Backup Options" from the menu, or press "Enter-E". 
The "backup Options" dialog has three controls, "Backup mode" radio button, a "Confirm" button, and a "Cancel" button. To move between the radio buttons, press "Space and Backspace".
The options are: "Always backup changes when exiting", "Manual backup", and "Prompt backup changes when exiting".
If you select the "Always backup changes when exiting", a new backup file is created automatically if you have modified or added to your schedule. 
If you select the "Manual backup", a new backup file is not created, even if there are changes to your schedule. If you select this option, you can only create a new backup file by using the "Backup Schedule" function.
If you select "Prompt backup changes when exiting", you are prompted, "Backup changes? Yes" if you have modified or added to your schedule. Press "Enter" on "Yes", and a new backup file is created before exiting the Schedule Manager. 
Choose your setting, and press "Enter".

[bookmark: _Toc492453932][bookmark: _Toc26179844][bookmark: _Toc209372292]8.2.6 Multiple Accounts and Syncing
BrailleSense 6 allows you to use multiple calendars, and automatically makes associations with any Google Account connected to BrailleSense. To view available calendars, choose the “Calendar Settings” option from the Schedule Manager menu.
By default, there is an account called “BrailleSense 6”. In addition, any Google Account you have signed in to with BrailleSense is also available in this list.
The dialog contains three settings: “calendar to add appointment”, “Calendar to show appointments”, “Calendar Type”, and “Search Mode”. This allows you to set appointments in multiple calendars, and view, add and output appointments from your chosen calendars. This can be useful for creating separate calendars for work and personal use.
[bookmark: _Hlk25261248]Use the “Calendar Type” setting to determine whether the Calendar view shows the Solar Calendar, lunar Calendar, or both. By default, this is set to show the Solar calendar only. If both are shown, use “F3” and “Space-F3” to toggle the dates between lunar and Solar on the current day.
The “Search Mode” setting allows you to choose what search mode will be used by default for the current calendar, “Date” or “Subject”. This sets the default search mode, however, regardless of the setting, you can switch between search modes as normal.
In addition, you can synchronize these calendars with Google using the “Accounts” dialog of Android Settings under All Apps. See section 8.1.9 for more information on syncing using Android System Settings.
You can also sync directly with the cloud from the BrailleSense Schedule Manager, using the “Refresh” command in the menu, or by pressing “Backspace-R”.
Note: as with the Address Manager, if too many items are changed, added or deleted, you may experience sync errors. If you receive a Sync Error notification, press Space-1-2-3-4-5-6 to open the Notification Shade, and press Enter on the Sync Error to see your options.

[bookmark: _Toc492453933][bookmark: _Toc26179845][bookmark: _Toc209372293]8.2.7 Setting Alarm Options
You can open the "Set Alarm Options" dialog by pressing "Enter-O" or by pressing "Enter" on "Set Alarm Options" in the menu. Alarm option fields include "type of echo", "Alarm duration", "Alarm repeat interval" and "Repeat". You can move between these fields using "Space-1" or "Space-4". 
The "type of echo" option lets you set what type of alarm you would like to use to alert you to your appointment: Choose from several audio alarm types, including a media file, the FM Radio, or 1 of 3 alarm melodies. You can also choose a vibration, or both (All). Press "Space" to cycle among the options.
You can change the duration of the alarm sound. You can set this option to a value that is between 5 and 600 seconds. The default value is set to 30 seconds. 
When the alarm goes off, if you do not stop it with "Backspace-Enter", the BrailleSense keeps giving you a notice about the appointment after a specified time interval. The "Alarm repeat interval" option allows you to change this interval. You can set the value anywhere from 1 to 60 minutes, the default value is set to 5 minutes. 
The "Repeat" field allows you to decide how many times the alarm will sound. You can set the value from 1 time to 10 times; the default value is set to 3. To change the value, type a number between 1 and 10. 
Press "Enter" on the "Confirm" button to save your settings. Cancel saving the alarm options by pressing "Enter" on "Cancel" or pressing "Space-e".

[bookmark: _Toc209372294]8.3 Database Manager
The "Database Manager" is a program which can be used to create a database in the form that you specify. You can use the "Database Manager" to add records and search for data in your records. 
To launch the "Database Manager", navigate to it in the "Organizer" menu, and press "Enter". Or, launch the "Database Manager" from anywhere on the unit by pressing "F3-D". 
Database Terminology
A table contains at least one record, and a record consists of at least one field. You can specify attributes for each of the fields. In other words, a record is made up of a group of one or more fields, and a table is made up of one or more records.
When the "Database Manager" is started, it checks whether or not a table has been created. If no table has been created, a "Table Manager" dialog appears to take you through the process of creating a new table. If there is at least one table created, the "Search Records" dialog appears and the "Search" edit box is focused, so that you can search for data. To close the program while adding or searching a table, press "Space-Z". 
The general navigation keys for the ""Database Manager"" are as follows.
1. Moving among controls in a dialog.
Move to the previous control: Shift-Tab (Space-1-2) or Space-F3
Move to the next control: Tab (Space-4-5) or F3
2. Moving in a list box
Move to the previous list item: Space-1 or up scroll button
Move to the next list item: Space-4 or down scroll button
3. Changing the selection in a prompt box
Select the next value: Space-4, Space or down scroll button
Select the previous value: Space-1, Backspace or up scroll button
Open the menu by pressing "Space-M" or F2.

[bookmark: _Toc397448566][bookmark: _Toc428447852][bookmark: _Toc209372295]8.3.1 Table Manager
Use the "Table Manager" dialog to create, delete, or modify a table. This dialog contains the following controls.
1. Table name list: Displays the name of created tables, and their order in the list.
2. Add table button: Use this option, to create a new table.
3. Modify table button: Use this option, to change the name of a table, or modify the structure of the table, by adding or deleting fields.
4. Delete table button: Use this option, to delete the table that you have selected in the table name list.
5. Set default table button: Use this option, to set the table that opens by default when you run the program.
6. Close button: After closing the "Table Manager" dialog, BrailleSense returns you to your previous position in the program. When there is no table created, if you press "Enter" on the "Close" button, the "Database Manager" program is closed.

[bookmark: _Toc209372296]8.3.1.1 Add Table
The "Add Table" dialog contains "Table name" edit box, "created fields" list, "Add field" button, "Modify field" button, "Delete field" button, "Previous field" button, "Next field" button, "Confirm" button and "Cancel" button. 
Suppose you want to create a table called "address book" which contains 4 fields: name, telephone, address, and memo. Create this table as follows.
1. In the "Table Manager" dialog, Tab to the "Add table" button, and press "Enter". 
2. The "Add Table" dialog appears, and the "Table name" edit box is focused.
3. Type "address book". 
4. Tab to the "created fields" list. As you have not yet added fields, "no items" is displayed in the list. As you add fields to this table, they are added to this list box.
5. Tab to the "Add field" button, and press "Enter". 
6. The "Add field" dialog is opened, and the "Field name" edit box is focused.
7. Type "name" in the edit box as this is the field title.
8. Tab to the "Field type" combo box. Choose "edit box" from the list as the name field is an edit box.
9. TAB to the "Set primary key" check box. To set the current field as the primary key, press "Space" to check it.
10. Tab to the "Confirm" button, and press "Enter". Now, the "name" field has been added to the "address book" table.

To cancel adding the field, Tab to the "Cancel" button, and press "Enter". If you have added a new field, you get a message saying that a new field has been added. The "created fields" list is shown again. Now, "name" field appears in the list, with the form, "name (edit box, pri) 1/1". Since only one primary key exists in a table, if you have set a field as the primary key, the "Set primary key" check box is not shown in the "Add field" dialog when you add another field. 
Add the "telephone", "address", and "memo" fields by repeating steps 5 through 10 above. Note that you will likely want to set the "Field type" of the "telephone" field to "number", "address" to "edit box", and "memo" to "multi line edit box". 
To change the name of a created field, move to the field in the "created fields" list. Press “Enter-M” or Tab to "Modify field" and press "Enter". "Field name: (selected field name)" is displayed. Type the new name for the field and press "Enter". Though you can change the name of a field, it is not possible to change the properties of a field once it is created.
To delete a created field, navigate to it in the list and press “Space-D” or Tab to "Delete field" and press "Enter". 
To change the placement of a field in your table, navigate to it in the list and press “Enter-P” or “Enter-N” for "Previous" or "Next" field. Or Tab to the "Previous field" or "Next field" button and press "Enter".
Once you have added all of the fields you wish to add, Tab to the "Confirm" button of the "Add Table" dialog, and press "Enter". The "Add Table" dialog is closed, and the "table name" list box is shown again. The newly created table is added to this list, and "address book 1/1" is shown in the list. To close the "Table Manager" dialog, press "Enter" on the "Close" button, Or press "Space-Z". The "Search Records" dialog is opened, and the "name" field, the first field of the "address book" table, is shown. 

[bookmark: _Toc209372297]8.3.1.2 Modify Table
"Modify table" is used to modify the name or structure of a created table. To modify a table, select "Table Manager" from the menu, or press "Enter-T". When the "Table Manager" dialog is opened, Move to the table that you want to modify, and press “Enter-M” or Tab to the "Modify table" button, and press "Enter". 
The "Modify Table" dialog is the same as the "Add Table" dialog. The only difference is that the "Table name" edit box, and "created fields" list contain the information already stored in the table. You cannot change the name of a table.
To add additional fields, Tab to "Add field" and press "Enter". You can also delete fields, modify field names, and change the position of fields as previously described. 

[bookmark: _Toc209372298]8.3.1.3 Delete table
Open the "Table Manager" from the menu, or press "Enter-T". Move to the table you want to delete, and press “Space-D” or Tab to the "Delete" button and press "Enter". You are prompted, "Delete table? Yes". To delete press "Enter". To cancel, press "Space" to select "No", and press "Enter".

[bookmark: _Toc209372299]8.3.1.4 Set Default Table
When you set a table as the default table, each time the "Database Manager" is started, this table is displayed and you are placed in the search dialog. If you have created more than one table and you use one of them more frequently than the others, it may be convenient for you to set this table as the default table. If no table is set as the default table, the last table used is displayed when opening the "Database Manager". 
To set a table as the default table, open the "Table Manager, and the "table name" list is focused. Move to the name of the table you want to set as the default. Press “Enter-D” or Tab to the "Set default table" button and press "Enter". Or simply press "Enter" on the name of the table in the "table name" list. The BrailleSense announces that the table is set as the default table, and the "Table Manager" dialog is closed.

[bookmark: _Toc397448567][bookmark: _Toc428447853][bookmark: _Toc209372300]8.3.2 Add Record
Use this option to add information to a table that you have created. When the "Database Manager" is started, the "Search Records" dialog is opened. Select "Insert a New Record" from the menu, or press "Enter-I" from the Search dialog. 
Let's consider the "address book" table you created in the previous section. YOU can add records to this table using the method described below:
1. Open the Insert A New Record" dialog as just described.
2. The "name" field, the first field in the "address book" table, is shown. Type the name of the person for whom you want to create a record. 
3. TAB to the "telephone" field. Type the person's phone number. Since this field is a "number" field, a limited set of characters including numbers and hyphen is available. Enter a number without the number sign. If you press "Space" instead of "(hyphen), the hyphen is entered.
4. Tab to the "address" field. Type the address.
5. Tab to the "memo" field. Since this field is a "multi edit box", you can type multiple lines of text. 
6. Tab to the "Confirm" button and press "Enter" to save the record. Press "Space-e" or press "Enter" on the "Cancel" button to cancel the record creation.
The "name" field is focused again so you can add another record. 
To return to the "Search Records" dialog, press “F4".
To access the Table Manager, press “Space-F3” from the search area to access the Table list, then press “Enter-T”. 

[bookmark: _Toc397448568][bookmark: _Toc428447854][bookmark: _Toc209372301]8.3.3 Search Records
To search for information in your records, use the "Search Records" dialog. When you Tab forward on a table in the list, The "Search Records" dialog is opened, and the first field of the table is focused. Type the text that you want to search for and press "Enter". If you press "Enter" without typing text, all the records in the database are displayed. 
Using the Address Book example, the focused field is the "name" field. Thus, type a person's name in the edit box to look up "/her record and press “Enter”. 
The "List of records that matched your search, is opened. In the "List of Records Found", each record is shown in the following form. "(the name of the first field) : (other information in the record) xx/yy". "yy" is the total number of records found, and "xx" is the order of the current record in the list. If no record is found, you are informed, "No records found", and the current field is shown again, so you can type another search queery. Navigate records as follows.
Move to the next record: Space-4 or down scroll button
Move to the previous record: Space-1 or up scroll button
Move to the last record: Space-4-5-6
Move to previous same field different record: Space-3
Move to next same field different record: Space-6
Move to the first record: Space-1-2-3
Move to the next field: Space-5
Move to the previous field: Space-2
Move to the last field: Space-4-6
Move to the first field: Space-1-3
To get a random record, such as in the case of picking tarot cards, etc, press “Backspace-Enter-R”.
To delete a record, move to the record, and press "Space-D". You are asked if you really want to delete the record. Select "Yes" or "No" by pressing "Space" or "Backspace". If you press "Enter" after selecting "Yes", the record is deleted, and if you select "No", the deletion is canceled. 
To change the content of a record, move to the record, and press "Enter-M" from any field in the record. A dialog similar to the "Insert a New Record" dialog is opened. To change the content of a field, Tab to the field, and type the new content. To save the modifications, press "Enter" after typing new content for all the fields you want to change. Or Tab to the "Confirm" button and press "Enter". 

[bookmark: _Toc397448570][bookmark: _Toc428447856][bookmark: _Toc209372302]8.3.4 Setting Backup Options
You can backup your database file, manually using the "Backup Database" function. You may also backup your database file automatically by using the "Set Backup Options". Select "Set Backup Options", or press "Enter". Or, press "Enter-E" to activate this function directly. 
The "Backup Options" dialog has three controls: "Backup mode" radio button, a "Confirm" button, and a "Cancel" button. There are 3 Backup modes: "Manual backup", "Always backup changes when exiting", and "prompt to backup changes when exiting". Use "Space" and Backspace" to cycle through the settings. Press "Enter" to save the option. 
1.  If you select the "Manual backup", it does not create a new backup file even if there are changes in the database. In this case, you can only create a new backup file by using the "Backup Database" menu.
2.  If you select the "Always backup changes when exiting", a new backup file is automatically created on exit if you modify or add to the database. 
3.  If you select the "Prompt to backup changes when exiting", if you have modified or added to the database, you are prompted, "Backup changes? Yes" when you exit the "Database Manager". If you press "Enter" on "Yes", it automatically creates a new backup file and exits the "Database Manager". If you press "Space-4" once and press "Enter" on "No", it exits without creating a new backup file.

[bookmark: _Toc397448571][bookmark: _Toc428447857][bookmark: _Toc209372303]8.3.5 Backup Database
If a hard reset is performed, or if your battery dies, all of the data in the "Database Manager" is lost. Thus, it is very important that you create a backup file every time you make a change to the Database file. Select "Backup Database" from the menu, or, press "Enter-U" to activate this function directly.
If you already have a backup file, you are prompted, "Backup changes? Yes". Press "Enter" to create a new backup file. To keep the previous backup file, navigate to "No", and press "Enter". When you create a backup file in your "Database Manager", a file called "BrailleSense_Database_bak.db" is saved in the “Database” folder of the flashdisk.

[bookmark: _Toc397448572][bookmark: _Toc428447858][bookmark: _Toc209372304]8.3.6 Restore Database
To restore the database file after a hard reset, Select "Restore Database" from the menu, or press "Enter-O" to activate this function directly.
If you already have a database file, you are prompted, "Database file already exists. Restore? Yes". Press "Enter" to continue with the restore.  To cancel, navigate to "No" and press "Enter". 

[bookmark: _Toc397448573][bookmark: _Toc428447859][bookmark: _Toc209372305]8.3.7 Importing and Exporting CSV
"CSV" is the acronym for Comma Separated Value. A CSV file is used for the digital storage of data structured in a table form, with the information in the various columns separated using commas. The "Database Manager" can import a CSV file created using Excel or other programs and can also output data to a CSV file.

[bookmark: _Toc209372306]8.3.7.1 Import from CSV
You can only execute this function, when you are in "Add mode", or rather, when you are in the process of adding records.
To import the data from a CSV file in to an existing database, select "Import from CSV" from the menu, or press "Backspace-I" from anywhere in the Database Manager. The "Import from CSV" dialog has the following controls:
1) "File name" edit combo box
2) "Confirm" Button
3) "Cancel" Button
4) "Path search" list
Type the name of the file you want to import in the edit box. To browse for a file, "Shift-Tab to the path search list, and use normal file navigation commands to choose your file and press "Enter". 
To cancel the import, Tab to "Cancel" and press "Enter", or press "Space-E" or "Space-Z". 

[bookmark: _Toc209372307]8.3.7.2 Adding the data from the CSV file to the "Database Manager"
When the CSV file is imported, "First field: unused 1/xx" is displayed. You can choose whether the data from the CSV file for each field should be imported. Some CSV files may contain data that is not equivalent to any of the fields in the existing database, or you may simply not wish to import certain pieces of information.  
You are presented with a dialog that contains all the fields in the database into which you are importing, a check box for allowing fields in the first record, and "Confirm" and "Cancel" buttons. Tab and Shift-Tab among these items.  For each database field, there is a list box containing "Unused" and all of the fields of the CSV file being imported. This allows you to choose which field of the CSV file should be imported into each field of the current database. Use "Space-1" and "Space-4" to move among the fields. If there is no equivalent field in the CSV file for a given field in the current database, select "unused".  
Often, the first set of fields in a CSV file represent field titles rather than actual data. For this reason, there is a check box for allowing fields in the first record to be imported or not. If the first set of fields does contain title data, make sure that the "allow fields in first record" item is not checked. 
To complete the import, Tab to "Confirm" and press "Enter" to import the data. If you search for records in the current database, the data from your CSV file should now appear in your results.

[bookmark: _Toc209372308]8.3.7.3 Exporting CSV
You can export the data from the "Database Manager" as a CSV file, using this function. 
· Note: You must be in a list of found records to export to CSV.
Select "Export to CSV" from the menu, or press "Backspace-X". The "Export to CSV" dialog contains the following controls: 
1) "File name" edit combo box
2) "Confirm" Button
3) "Cancel" Button
4) "File storage" list
Type a file name for the exported data and press "Enter". To cancel this function, press "Space-Z". 
To change the location where the file is stored, Shift-Tab to the file list and use normal file and folder navigation to select the location. 

[bookmark: _Toc397448574][bookmark: _Toc428447860][bookmark: _Toc209372309]8.3.8 Creating a table from CSV
In addition to importing CSV data into existing tables, you can create a table from a CSV file. You can activate this function from anywhere in the "Database Manager". 
Select "Create Table from CSV" from the menu, or press "Enter-X".
You are prompted for the file name of the CSV you wish to use to create the table. Type it in the edit box, or "Shift-Tab" to the File List and use normal file navigation commands to select the file and press "Enter".
Braille Sense announces, "File successfully loaded" and displays the "Table creation" dialog. This dialog consists of a "Table name" edit box" followed by combo boxes for each of the fields in the CSV file, "Allow fields in first record" check box, a "Confirm" button, and a "Cancel" button. 
Type your desired name for the table in the edit box. Tab to the first field in the CSV file, and use "Space-1" and "Space-4 to move among your options for defining this field. 
· Note: field titles are determined by information from the first line of the CSV file. Be sure the first line contains field information for correct and sensible importing of the data.
The options in the field definition combo box are: "Unused", "Edit Box", "Number", "Computer Edit Box", "Multi-Line Edit Box", "Date", "Time" and "Check Box". If you do not wish to import the information in the current field as part of the data set, choose the "Unused" item. If you wish to import the information, navigate to the type of form control most appropriate for the information in that field. For example, if the field contains a serial number or phone number, choose "Number". If the field contains e-mail addresses or web addresses, choose "Computer Edit Box". Tab to each of the fields in your CSV file and repeat this process.
When you finished defining the characteristics of the fields, Tab to the "Allow fields in first record" and press "Space" to toggle the check box to your desired setting. Because the first line of a CSV file often contains field titles rather than actual data, this option is unchecked by default.
When you have finished defining how your table should be created, Tab to the "Confirm" button and press "Enter". If you wish to cancel the table creation, "Press "Enter" on the "Cancel" button.

[bookmark: _Toc209372310]8.4 To Do List
The To Do List helps you keep track of your various tasks, when they are due, their priority, and any associated notes, calendar appointments, or other documentation related to them. To open the To Do List application, press "Enter" on it from the "Organizer" menu, or press "F3-D" from anywhere on the unit.
When you first open the To Do List, there are only 2 items in the dialog, an empty task list, and the "New Task" option. When tasks are added, this dialog will contain more functions. Move among controls in the dialog with "F3" and "Space-F3".

[bookmark: _Toc209372311]8.4.1 Adding a new task
To add a new task, press "Enter" on the "New Task" option, or press the hotkey "Enter-N". The "New Task" dialog is opened, and you are placed in the "Title" edit box.
Type a desired title for the task, and Tab forward to the "Description" edit box and enter it as well. Tab once again to reach the "Due Date" edit combo box. As with other time and date input areas on the BrailleSense, you can either type the date directly, or use normal calendar navigation to move to your desired date.
After entering or choosing the due date, Tab to the "Reminder" combo box. This lets you determine how you are notified or reminded about when the task is due. By default, this is set to "None". You can use "Space-1" or "Space-4" to choose to set a reminder from 1 to 6 days before, or 1 or 2 weeks before the task is due.
Tab forward to the "Current Status" combo box to set whether the task is "Not Started", "In Progress", or "Completed". Tab once again to set the priority of the task as "None", "Low", "Medium" or "High". 
Once you've set all the parameters for the task, you have the option of adding any number of related attachments to it. To add an attachment, press "Enter" on "Add Attachment", or press the hotkey "Enter-I" from anywhere in the New Task dialog. The Attachment dialog is opened.
You can choose among several attachment types, and can add multiple attachments of any or all of the available types. Use "Space-1" and "Space-4" to move among the various attachment types: "Memo", "URL", "File/Folder", "Contact", "Current Location", or "Calendar Appointment".
Tabbing forward on the various types will result in specific controls related to each type of attachment. For the Memo and URL options, tabbing forward will place you in an edit box in which you can enter a title for the item, followed by another edit box into which to enter the information of the memo or address of the URL. Tabbing forward on the Contacts or Calendar Appointment options will provide a list of available items from which you can select the ones you want to add. Tabbing forward on the File/Folder option gives you an "Add button, which will open a file management dialog, from which you can select files or folders to attach to the task. Finally, if you tab forward on the Current Location item, your current address is shown in the edit box. This may be useful in cases where completing the task requires you to return to the current location.
When attachments are added, several items are added to the "New Task" dialog. Before the "Add Attachment" button, you'll now find an attachments list, which will show all of the attachments associated with your task. You will also have options for modifying and deleting attachments.
Once you've set all the parameters for the task, and added any attachments you want to ad, press "Enter" on "Save" to save and add the task to your task list.
The main dialog now contains additional items related to managing tasks in your task list. You can modify, delete, or Archive a task, and you can change the progress status. 
Use the "Modify Task" option if you need to change any of the task parameters, or later need to add an additional attachment, such as the creation of a memo containing meeting notes related to your task, or a related file from a colleague. Deleting a task removes it from the Task list, even if it has not been marked as completed. Archiving a task moves it from your main task list, and places it in an archive list, retrievable from the To Do List menu.

[bookmark: _Toc209372312]8.4.2 The To Do List Menu
The To Do List menu contains the following items. Menu shortcuts are shown in parenthesis, and hotkeys in quotes.
1) Search Tasks: (F) "Space-F". Opens a "Find" dialog allowing you to search the tasks' titles, descriptions, or both by keyword. 
2) Show Archive List: (A) "Alt-A". Retrieves and displays the tasks you've archived.
3) Backup To Do List: (U) "Enter-u". Manually initiates a backup of the content of your to Do List. 
4. Restore To Do List: (R) "Enter-R". Restores your tasks from a backup.
5) Set Backup Options: (E) "Enter-E". Lets you set whether you are prompted to backup changes when exiting, whether it always backs up when you exit, or backs up your task list only when you initiate it using the backup option.
6) Options: (O) "Backspace-O". Lets you set several specifications for how your task list is displayed, including how to sort tasks and whether they appear in ascending or descending order, whether to display the due date and modification date, and which calendar to use when adding appointments. 
7. Exit: (Z) "Space-Z". Closes the To Do List program.


[bookmark: _Toc492453934][bookmark: _Toc26179846][bookmark: _Toc209372313]9. Web Tools
The "Web Tools" menu consists of programs used to assist in the searching and downloading of web content., This menu contains the Web Browser and Google and Wiki Search applications. 

[bookmark: _Toc492453935][bookmark: _Toc26179847][bookmark: _Toc209372314]9.1 Web browser
You can use the "Web Browser" to read pages on the web, as well as to read html documents you have saved to disk. You can also download files and stream audio content. 
To launch the "Web Browser, from the "Web Tools" menu, navigate to "Web Browser" and press "Enter". Or, press B. You can launch the "Web Browser" from anywhere on the unit by pressing "F1-B". The BrailleSense opens the "Web Browser" and connects to the "home page". 
You can also launch the Web Browser" by using the global hot key for opening a web page: Press "Space-W" from anywhere on the unit. The BrailleSense, opens up a computer edit box into which you can type in the URL you want to go to and press "Enter". The Browser is launched, and takes you to the web page you requested.
You can access the Web Browser's functions using hot keys, or via its menus. To access these menus, press "Space-M" or "F2". Select a menu item using "Space-1" or "Space-4", and press "Enter". Or, you can press "Space-M or "F2" followed by the shortcut for the corresponding menu item. Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab among controls in a dialog. For the purposes of these instructions, we will generally refer to using "F3" and "Space-F3" or simply "Tab". Press "Enter" to execute an item.

[bookmark: _Toc492453936][bookmark: _Toc26179848][bookmark: _Toc209372315]9.1.1 The File Menu
1) Open URL: (U) "Enter-U". Type the web address of the page you wish to go to and press "Enter".
2) Open: (O) "Enter-O". Open an HTML file or URL stored on your BrailleSense.
3) Open New Web session: (S) “Backspace-O”. Opens a second instance of the web browser so that you can browse in two different windows.
4) Save As: (A) "Space-S". Save the current webpage to your BrailleSense.
5) File Download Dialog: (L) “Backspace-3-4”. Opens a dialog to show current download progress as well as file download history.
6) Refresh: (R) “Space-Enter-R”. Refreshes the current Web page.
7) Exit: (Z) "Space-Z". Closes the Web Browser.

[bookmark: _Toc492453937][bookmark: _Toc26179849][bookmark: _Toc209372316]9.1.2 The Edit Menu
1) Select All: (A) "Enter-A". Select all the text on the current page.
2) Start Selection: (B) "Enter-B". Begin selecting a block of text. The end of the selection is determined by your cursor position.
3) Copy: (C) "Enter-C". Copy selected text to the clipboard.
4) Copy Address Bar: (D) "Backspace-D". Copy the URL of the current page to the clipboard.
5) Copy Focused Link: (L) "Enter-L". Copy the address of the focused link to the clipboard.
6) Add to clipboard: (P) "Space-P". Append selected text to the clipboard.

[bookmark: _Toc492453938][bookmark: _Toc26179850][bookmark: _Toc209372317]9.1.3 The Go To Menu
1) Go To Home page: (S) "Backspace-Enter-H". Return to your home page.
2) Go To Previous Page: (P) "Backspace-P". Go to the page you were viewing before the current one.
3) Go To Next Page: (N) "Enter-P". Move forward one page in your viewing history.
4) Go To Previous Heading: (U) "Backspace-H". Move back one heading.
5) Go To Next Heading: (D) "Enter-H". Move forward one heading.
6) Go to Headings list: (E) “Backspace-Space-H”. Brings up a list of headings on the current page.
7) Go to Previous link: (B) “Backspace-K”. Moves back one link on the page.
8) Go to Next Link: (f) “Enter-K”. moves forward one link on the page.
9) Go to Links List: (L) “Backspace-Space-K”. Brings up a list of links on the current page.

[bookmark: _Toc209372318]9.1.4 The Navigation Menu
1) Go to Previous Element: (B) “Space-B”. Moves to the previous element of any type.
2) Go to Next Element: (F) “Space-4-5”. Moves to the next element of any type.
3) Go to Previous Form control: (P) “Backspace-1-2-3-4-5-6”. Moves to the previous entry field or choice control.
4) Go to Next Form control: (N) “Enter-1-2-3-4-5-6”. Moves to the next entry field or choice control.
5) Go to Previous Text chunk: (R) “Backspace-Q”. moves to the previous block of text.
6) Go to Next Text Chunk: (E) “Enter-Q”. Moves to the next block of text on the page.
7) Go to Previous Table: (V) “Backspace-T”. Moves back one table in a Web page.
8) Go to Next Table: (x) “Enter-T”. Moves to the next table on the page.
9) Go to previous Visited link: (I) “Backspace-V”. Moves to the last previously visited link on the current page.
10) Go to Next visited Link: (T) “Enter-V”. moves to the next previously visited link on the current page.

[bookmark: _Toc209372319]9.1.5 The Search Menu
1) Find: (F) "Space-F". Find text on the current page.
2)  Find Previous: (B) “Backspace-F”. Find the previous instance of your search string on the page.
3) Find Next: (E) "Enter-F". Search for the next instance of the text string you entered in the "Find" dialog.
4) Open History: (H) "Space-Enter-H". Open a list of pages you have recently viewed. Press “Space-D to delete the current item, or use the Clear All button to clear the entire history.

*Note: you can also navigate headings by level using the Control and Alt keys with dot numbers. For example, to move forward by heading level 2, type Alt with dot-2. To move back by heading level 4, type Control with dot-4.

[bookmark: _Toc492453939][bookmark: _Toc26179851][bookmark: _Toc209372320]9.1.6 The Read Menu
1) Read from Beginning to Cursor: (T) "Backspace-G". Reads the text from the top of the page to your current position.
2) Read from Cursor to End: (G) "Enter-G". Reads the text from your current position to the bottom of the page.
3) AutoScroll: (A) "Up and Down Scroll". STARTS and stops the auto scroll function. 

[bookmark: _Toc492453940][bookmark: _Toc26179852][bookmark: _Toc209372321]9.1.7 The Favorites Menu
1) Set Current as Home Page: (S) "Enter-S". Set the current page as your home page.
2) Add to Favorites: (A) "Backspace-A". SAVE the current page as a favorite.
3) Favorites List: (L) "Backspace-L". Open the list of favorites you have saved previously.
4) Import Favorites: (I) “Backspace-I”. Lets you import favorites that were exported to an HTML file from another browser.

[bookmark: _Toc492453941][bookmark: _Toc26179853][bookmark: _Toc209372322]9.1.8 Settings
Use the "Settings" dialog to manage Web browser preferences. Navigate the settings with "F3" and "Space-F3".
1) Show visited links: Use "Space" to choose On or Off.
2) Show images: Use “Space” to choose On or Off.
3) Show cell information: (in tables) Use “Space” to choose On or Off.
4) Set start Page: choose between Home Page or last Visited.
5) Default Download Folder: Press Enter to open folder list and choose desired download folder.
6) Clear Cookies: press "Enter" to clear all cookies.

[bookmark: _Toc492453942][bookmark: _Toc26179854][bookmark: _Toc209372323]9.1.9 Navigating Page Elements
On a web page, there are links, controls, and other various elements, as well as text. To read web pages properly, the "Web Browser" should classify each element, and notify the user with its information.
When reading a web page by moving with "Space-4" or "Space-1", one element is displayed on one line. The links and controls are displayed with their respective symbols so the user can distinguish each element. To move among controls without viewing the text between them, use "F3" and "Space-F3".
A control is a link, an edit box, a radio button, or a combo box. Each control has different purposes. Therefore, the user has to know exactly what type of control is being used. 
When you find controls in web pages, the BrailleSense displays control symbols ahead of the contents of the control. The following is a list of control symbols.
Control name
Symbol
Link
LN
Visited link
LNV
Anchor
ANC
Edit box
EB
Multi edit box
MEB
List Box
LB
Combo box
CB
Radio button select
SRB
Radio button unselect
URB
Check box check
SCHB
Check box uncheck
UCHB
Button
BT
To change a selection in the combo box, press “Enter” to open it, and use “Space-1” and “Space-4” to move among the choices. You can move to the next item by pressing "Space-4". The page is renewed automatically when you change a selection in a combo box.
To select or unselect a checkbox or radio button, press "Space".
Move to Top of Page: Space-1-2-3.
Move to End of page: Space-4-5-6.
Go to previous heading level 1-6: Control-1 to Control-6.
Go to Next Heading Level 1-6: Alt-1 to Alt-6.
Move to previous general item: Space-1.
Move to Next General item: Space-4
Move to previous word in Text control: Space-2.
Move to Next Word in Text Control: Space-5.
Move to Previous Character in Text Control: Space-3.
Move to next Character in Text Control: Space-6.
Move up one cell in the Table: Control-Alt-dot 1.
Move down one cell in the Table: Control-Alt-dot 4.
Move left one cell in the Table: Control-Alt-dot 3.
Move right one cell in the Table: Control-Alt-dot 6.
Move to first cell in a Table: Control-Alt-dots-1-2-3.
Move to last cell in a Table: Control-Alt-dots-4-5-6.
Move to first cell in row: Control-Alt-dots-1-3.
Move to last cell in row: Control-Alt-dots-4-6.

[bookmark: _Toc26179857][bookmark: _Toc209372324]9.2 Google Search
The Google Search program allows you to easily perform a search using Google's Internet search service. To Open Google Search, from the "Web Tools" menu, move to "Google Search" and press "Enter", or press G". You can launch Google Search from anywhere on the unit by pressing "F1-G". 
 
[bookmark: _Toc397448594][bookmark: _Toc428447880][bookmark: _Toc26179858][bookmark: _Toc209372325]9.2.1 The Search Dialog
The "Search" dialog contains 3 items: a "Search Term" edit box, a "Search" button, and a "Close" button. To move through the items in the dialog, press "Tab (F3) or "Shift-Tab (Space-F3). 
When the Google Search application is launched, you are placed in the "Search Term" edit box. Type the term you wish to search for, and press "Enter" to launch the search; or Tab to the "Search" button and press "Enter". 
To exit the program, Tab to the "Close" button and press "Enter", or press "Space-Z". 

[bookmark: _Toc397448595][bookmark: _Toc428447881][bookmark: _Toc26179859][bookmark: _Toc209372326]9.2.2 The Results Dialog
After a search is performed, you are placed in the "Results" dialog. The "Results" dialog contains 5 items: the "Search Term" edit box, the "Title" list, the "Contents" text box, a "Search" button, and a "close" button. When the Braille Sense has finished searching the term you entered, you are placed in the "Title" list. 
The "Title" is the name of the web result that matches your search term. The "Title" list can contain up to 64 items. To go to the current search result on the web, simply press "Enter" and the webpage for the current title is opened in your chosen Browser. When you have finished viewing the webpage, press "Space-Z" to close the Browser, and return to your results list in the Google Search program.
The "Contents" text box contains information about the current title, just as you would receive if you were performing a search on the Google website. This information usually includes a quick preview of the content on the web page, and the URL of the web result. 
Use the "Search term" edit box, and "Search" button to launch a new search as described in the previous section.

[bookmark: _Toc26179860][bookmark: _Toc209372327]9.2.3 Choosing your Browser
When the Google Search program is opened, press F2 to open the menu. It contains only “Settings”, and “Exit”.
Press Enter on “Settings” to choose which browser to use when opening Google results. By default, Google Search uses the BrailleSense Web browser. However, you may also choose to use the “Default Browser”, which will open results in the default Android browser as set in Android System Settings.
Use “Space-1” and “Space-4” to move between the browser options, and press “Enter” to save your choice.
You can also choose to control this via hot keys. If you set the browser to the BrailleSense “Web Browser”, results will be launched in that browser when you press “Enter”. You can then use “Backspace-L” to open the focused result in the default Android browser.

[bookmark: _Toc209372328]9.3 Wiki search
The Wiki Search program allows you to easily search for and save content from Wikipedia and Wiktionary on your Braille Sense. You can execute Wiki Search by navigating to it in the Web Tools menu and pressing "Enter", or by pressing "F1-I" from anywhere on the BrailleSense.
You are placed in the "Reference" combo box from which you can choose to search either Wikipedia or Wiktionary. Use "Space-1" and "Space-4 to move between the choices.
When you have made your choice, Tab forward to an edit box into which you can enter your search term. Once done, press "Enter", or Tab to the Search" button and press "Enter".
The Results list adds several more items to the Tab order. Use "Space-1" and "Space-4" to navigate the results list box. Press Enter on an entry you want to read. When reading an entry, press Tab to move through the various sections of the entry, and normal document reading commands to navigate the text. Press "F4" to return to the Results List.
If you want to save the file offline, from the Results List, Tab to the "Save as File" option and press "Enter". You are presented with a "File Save" dialog from where you can choose the name and location. By default, the files are named with the reference and entry title, and are saved in a "Wiki Searches" folder on the root of the flashdisk.
If there is more than one page of results, this dialog also contains a "Next" button. 
Use the "Settings" dialog to choose to search in a different language as well as the number of results per page. By default, searches are in English, and the BRAILLESENSE displays 10 results per page. You can also choose which browser BrailleSense uses when you activate the “Open in Browser” button.

[bookmark: _Toc209372329]9.4 System wide Web searching
BrailleSense offers several options for accessing web content from anywhere on the unit.
You can open a URL directly from anywhere on the unit by pressing “Space-W”. You can perform a Web search from anywhere on the unit by pressing “Control-Alt-W”.
You can define the source of the search using the “default Web Search” option in the “Global Options”. The choices are Google Search, Wikipedia or Wiktionary.
You can use this same source to look up a word under your cursor in a similar way that you can use the sense Dictionary. To search your default Web source for the focused word, press “Backspace-Space-Enter-W”.

[bookmark: _Toc492453945][bookmark: _Toc26179861][bookmark: _Toc209372330]10. EXTRAS
[bookmark: _Toc209372331]10.1 Braille Practice
The “Braille Practice” application provides general practice for letters, signs and punctuation, numbers, contractions, and various levels of vocabulary words in the UEB Braille code.
You can practice the following 12 categories: letters, Signs and Punctuation, UEB/literary numbers, Nemeth Numbers, Single Character Word Signs, Two Character Short forms, Word Parts (Contractions), Advanced Short Forms, Elementary Words, Secondary Words, Professional Words, and Practice All.
Punctuation, numbers and contractions offer uncontracted Braille renderings for clarification, as the TTS can sometimes be difficult to understand. This also helps a new learner review a bit of reading as they go.
Word practice prompts are speech only, and allow for practice at individual contracted Braille learning levels, as correctness is based on spelling.
To choose a practice category, press “Space-1” or “Space-4” and press “Enter on your desired practice module. When prompted, type the response in Braille for the question asked by the program, and press “Enter” to submit. You are given 3 chances to answer correctly before the application counts it as a wrong answer, and shows you the correct one in Braille.
Press “F4” to exit your current module, and your score is provided for the current category. You may press “Enter” to return to the categories list, or “Space-Z” to exit.

[bookmark: _Toc209372332]10.2 Sense Brain Game
The Sense Brain Game contains 4 different games. You can play anywhere, any time and train your brain to be sharper and quicker. Have fun and be smarter.

[bookmark: _Toc209372333]10.2.1 Executing the Sense Brain Games 
Select the "Sense Brain Game" from the "Extras" menu. 
There are 5 items in the Sense Brain Game menu: 4 games (Memory game, Reverse game, Chase a criminal, and Multiplication table) and "View ranking". To start playing a game, press enter on a game you want to play. If you want to view your past scores, you can access them under "View ranking".
When you start each game, an opening song is played followed by instructions for playing. Press "Enter" to start the game or press space to repeat the instructions.

[bookmark: _Toc209372334]10.2.2 Memory game
When the game starts, a group of numbers and letters is announced. For example, at level 1, groups of 3 letter-number combinations are spoken. Make sure to memorize these letters and numbers in the order they are spoken.
You are then prompted, "Type the answer", at which time you must write the numbers in the order they were given to you and press enter. If the answer is correct, The BrailleSense applauds you, and you are allowed to proceed to the next set of letters and numbers. If the answer is incorrect or you take too long to enter the answer, the buzz of failure sounds and the game is over. You must type the answer within 10 seconds to avoid the despicable buzz and a constructive warning that you may be losing your mind. 
When the game is over, your score is announced. If your score ranks between 1 and 5, you are asked to "Type your ID". Write your name and press enter to record your score. Or press "Space-E" to ignore this dialog.
Finally, you are asked, "Do you want to play again?" Press enter on "Yes" to play the game again. Or press enter on "No" to return to the game menu.

[bookmark: _Toc209372335]10.2.3 Reverse game
This game is similar to the memory game, but as its name denotes, in "reverse". When you are prompted to "Type the answer", write the numbers and letters in reverse order and press "Enter". If the answer is correct, you are applauded and honored with a new challenge. If the answer is incorrect or you're too slow, the buzz of shame sounds and the game is over. 

[bookmark: _Toc209372336]10.2.4 Chase a criminal
When the game starts, you hear the sound of footsteps. A thief is hidden in a 10-story building. A policeman says on which floor the thief is hiding. But, any smart thief won't stay in one place too long, and your job is to catch him. As the criminal runs up and down the stairs, the policeman says, "Up" and "down" repeatedly to let you know how many floors the criminal is traversing. Listen carefully and type the floor on which the thief has chosen to hide again. When you are asked to type the answer, type the number of the floor on which the thief stowed himself within 10 seconds. Be sure to think fast, or that droning buzz reminds you that your brain is failing and the patronizing policeman complains that you are interrupting his inspection. 

[bookmark: _Toc209372337]10.2.5 Multiplication table
When the game starts, you are given a set of numbers. Level 1 starts you off with two. Multiply these numbers. 
When you are prompted to, "Type the answer", type the result and press "Enter". If the answer is correct, your math genius continues to be challenged. If the answer is incorrect, or you take too long to enter it, the pretentious buzz is heard, and the BrailleSense helpfully suggests you may wish to master the simplicity of addition before attempting the complexity of multiplication.  

[bookmark: _Toc209372338]10.2.6 View ranking 
Enter the "View Ranking" menu to view your scores for any of the brain games described above. Press "Space-dot-1" or "Space-dot-4" to navigate among the games, and press enter on the name of the game on which you want information.
The ranking list is displayed. It shows rank, name and score. Press space to view the next record. To return to the "View ranking" menu, press enter.

[bookmark: _Toc209372339]10.3 Sense Dice game
Ever been at a party and wanted to play "Quarters", but had no dice? You don't need to worry about such things anymore. With BrailleSense, you always have virtual dice with you anywhere, any time!
Launch the "Sense Dice" game by pressing "enter" on it from the "Extras" menu. 

[bookmark: _Toc209372340]10.3.1 How it works
When the game starts, a cute little tune is played followed by the announcement, "Select the number of dice". You can select 1, 2, or 3 dice using "Space-1" and "Space-4" and press "Enter". 
The number of dice selected is announced, and a popping sound is heard for each die you selected.
Press "Enter" to roll the dice, or gently shake your BrailleSense, and the accelerometer recognizes your motions and activates the dice roll. A sound is heard to indicate the rolling of the dice, and after a couple of seconds, the result is displayed.
After the result is displayed, the BrailleSense announces, "Press Space to go on". If you press "Space", you will hear the dice selection announcement and sound once again, and you can repeat the dice roll. You can also press "Space-e" to return to the "Dice Selection" list and choose a different number of dice to roll.
Press "Space-Z" to exit the game. 

[bookmark: _Toc209372341]10.4 Sense Roulette Game
The Roulette game dialog contains 2 items, "Start" and "Settings. Use "F3" and "Space-F3" to navigate between them.
Press "Enter" on "Start" to spin the ball in the roulette wheel. You will hear an audible sound as the ball spins, followed by the announcement of where it lands, and whether you won or lost. Press "Enter" again to spin the ball in the wheel another time.
Use the "Settings" dialog to set the number of slots you want to bet on, and Tab forward to select the number of each slot. Type your desired numbers in the associated edit boxes, and press "Enter" to confirm.
Press "Space-Z" to exit the game.
 


[bookmark: _Toc492453955][bookmark: _Toc26179871][bookmark: _Toc209372342]11. Utilities
The "Utilities" menu provides several special functions and settings for the BrailleSense. Move among the items in the "Utilities" menu using "Space-1" and "Space-4" and press "Enter" to open an item. 
You can access functions for each program using hot keys, or via that program's menus or dialogs. If a program has menus, press "Space-M" or "F2" to open the menu. Select a menu item using "Space-1" or "Space-4", and press "Enter". Or, you can press "Space-M or "F2" followed by the shortcut for the corresponding menu item. 
In dialogs, use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab and shift-tab among controls. For the purposes of these instructions, we will generally refer to this as "Tabbing". 
Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate menus, settings or file lists. Press "Enter" to execute an item.

[bookmark: _Toc492453956][bookmark: _Toc26179872][bookmark: _Toc209372343]11.1 Calculator
Using the calculator on the BrailleSense, you can do simple math equations as well as complex scientific calculations. The results and expressions are displayed in Braille, and spoken by the BrailleSense. 
To use the calculator, press C from within the "Utilities" menu. You can launch the "Calculator" from anywhere on the unit by pressing "F3-C". When the calculator is opened, 0 is displayed in computer Braille.
You may type using computer Braille, UEB, or Nemeth Braille when inserting expressions. Press "Backspace-G" to cycle the Braille codes. Clear the calculator with "Backspace-C". If you insert numbers or a function into a result, the result disappears; and if you enter operators, you move to the next step. In addition, you can keep your result in the calculator's memory, and recall it later. You can activate the functions and operators via the calculator menu or you can use the hot keys associated with the various functions. 

[bookmark: _Toc492453957][bookmark: _Toc26179873][bookmark: _Toc209372344]11.1.1 General Functions
To access general mathematical operations, open the menu by pressing "Space-m or "F2" and press "Enter" on "General Functions". From the calculation line, access the "General Functions" by pressing "Enter-G". 
"General functions" is a dialog box that contains the "general function list", a "Confirm" button, and a "Cancel" button. You can navigate the operators using "Space-1" or "Space-4". Or, you can press the first letter of the operator you want to access. 
Select your desired operation and press "Enter" to perform it. You can also use hot keys to quickly execute operations. Press "Space-H" for a list of hot keys in the Calculator. 
To enter negative numbers type minus (dots 3-6) and the number in parentheses. For the percent operation, type the numbers first followed by the percent sign. Immediately after you type the percent sign (%), the number you have typed in is converted into a percent value. 

[bookmark: _Toc492453958][bookmark: _Toc26179874][bookmark: _Toc209372345]11.1.2 Fractional Arithmetic
The BrailleSense can perform fractional operations such as simplifying and multiplying fractions as well as converting fractions to decimals. 
You can also convert fractions to decimals, decimals to fractions, improper fractions to mixed numbers, or mixed numbers to improper fractions. When your result is fractional, you can bring up the "fraction options" by pressing "Space-3-4". Press "Space-1" and "Space-4" to move among the available options. If the fraction is a simple fraction, your options are ""fraction to decimal" and "return original fraction". If the fraction is an improper fraction, you also have an option to return "improper fraction to mixed number". If your fraction is a mixed number, the "mixed number to improper fraction" appears. Finally, if your result is a decimal and you press "Space-3-4", the decimal is converted to a fraction. 

[bookmark: _Toc492453959][bookmark: _Toc26179875][bookmark: _Toc209372346]11.1.3 Memory Functions
The "Memory Functions" act on stored answers and calculations in memory. To access these functions, press "F2" to open the menu, and press "Enter" on "Memory Functions". 
"Recall Items" is a dialog, containing "Variable list", "Delete", "Display detail", "Confirm", and "Cancel". You can access the dialog by pressing "Backspace-R" in the calculation line or by selecting it from the "Memory Functions" menu... 
The "Variable list" displays "item name: value". Insert the value into your calculation by pressing "Enter" on the item name. You can also copy items in the "Variable list". Press "Space" to select an item in the "Variable list". Then, press "Enter-I" to copy the selected items to the clipboard. 
The "Display detail" shows the item name and its result with the default set to "No". To review the detailed information, press "Space" to switch to "Yes". Then, it displays "item name: the expression = its result value" in Braille. 
"Delete" is used to remove a variable item from the list. 
You can delete all of the saved items stored in the "Recall Items". Select "Delete All Saved Items" from the "Memory Functions" menu, or press "Enter-D" from the calculation line.
"Save Items" is a dialog that allows you to define variables according to the current expression or result in the calculator and save them for future use. The dialog contains an edit box for typing in the variable name, a "Confirm" button and a "Cancel" button. SELECT "Save Items" from the "Memory Functions" menu, or press "Backspace-S" from the calculation line. 
When the dialog is opened, the "item name" edit box is focused. Type a name for the variable, and press "Enter" or move to "confirm", and press "Enter". The current expression or result is then saved under the variable name you just specified.
If you type names under variables which have already been created, you are prompted, "Replace variable xx with current value? Yes". If you type function names like "sin", "cos", or "pi" as a variable name, you are warned, "Invalid item name", as you cannot use these functions in variable names. 
You can also define variables directly from the calculation line by typing "variable=expression" and press "Enter" to save the variable. 

If you select the Statistics function, a dialog opens, which consists of a list box containing all the stored variables and their values, a list box displaying the results of several functions, and a "Close" button. Press "Backspace-T" to activate this function from the calculation line, 
Press "Space" to select each variable in the list that you want included in the data set for which the statistics are calculated. TAB to the "result" list to view the sum, average, variance, and standard deviation of the selected variables. You can also select items from the result list and copy them to the clipboard. 

[bookmark: _Toc492453960][bookmark: _Toc26179876][bookmark: _Toc209372347]11.1.4 Sine Functions
Select "Sine Functions" in the Calculator's menu, or press "Enter-S" in the calculation line. The "sine function" list consists of "Sine", "Arc sine", and "Hyperbolic sine". If you press "Enter" on one of the three functions you can insert it into your calculation. 

[bookmark: _Toc492453961][bookmark: _Toc26179877][bookmark: _Toc209372348]11.1.5 Cosine Functions
Select "Cosine Functions" from the Calculator's menu, or press "Enter-I" from the calculation line. The "cosine function" list consists of "Cosine", "Arc cosine", and "Hyperbolic cosine". If you press "Enter" on one of the three functions, the calculation is performed. Or, you can activate one of the three cosine functions by pressing the first letter of each from the list.

[bookmark: _Toc492453962][bookmark: _Toc26179878][bookmark: _Toc209372349]11.1.6 Tangent Functions
You can open the "Tangent Functions" by pressing "Enter-T" from the calculation line, or by selecting "Tangent Functions" from the Calculator's menu. The "tangent functions" list consists of "Tangent", "Arc tangent", and "Hyperbolic tangent". If you press "Enter" on one of the three functions, the calculation is performed. 

[bookmark: _Toc492453963][bookmark: _Toc26179879][bookmark: _Toc209372350]11.1.7 Logarithm Functions
You can open the "Logarithm Functions" by pressing "Enter-L" from the calculation line, or by selecting "Logarithmic Functions" from the Calculator's menu.
The "Logarithm Functions" is a dialog, which contains a "function list", a "Confirm" button, and a "Cancel" button. The function list consists of "Common logarithm" and "Natural logarithm". If you press "Enter" on one of the logarithm functions, the calculation is inserted into your calculation line. 

[bookmark: _Toc492453964][bookmark: _Toc26179880][bookmark: _Toc209372351]11.1.8 Convert Unit
The "Convert Unit" dialog allows you to convert measurements of mass, area, volume, distance, and temperature from metric measure to imperial measure as well as other standards of measurement and units of measurement within the same system. It also converts several units of measurement related to programming and computers.
To open the "Convert Unit" dialog, Select "Convert Unit" from the Calculator's menu, or press "Enter-U" from anywhere in the Calculator. 
The "Convert Unit" dialog contains the following items: "Unit Category" combo box, "Current Unit" combo box, "Change Unit" combo box, "Input Number" edit box, "Convert" button, "Cancel" button and the "Result" static box. You can move among the controls in the dialog using "Tab (F3 or Space-4-5)" or "Shift-Tab (Space-F3 or Space-1-2)". Use "Space-1" or "Space-4" to move among the items in the combo boxes. 
The available unit categories are Distance, Area, Mass, Volume, Temperature, Data, numbers and Text. When you have chosen your measurement category, the "Current Unit" and "Change Unit" combo boxes will contain measurement units according to your chosen category. The available distance units are: Millimeters, Centimeters, Meters, Kilometers, Inches, Feet, Yards, and Miles. The available units of area are: Square Meters, Are, Square feet, Square Yards, Acres, and Hectares. The available units of mass are: Grams, Kilograms, Tones, Grains, Ounces, and Pounds. The available units of volume are: Deciliter, Milliliter, Liter, Cubic Centimeter, Cubic Meter, Cubic Inch, Cubic Foot, Cubic Yard, Gallon, Fluid oz, Cups and Quarts. The available units of temperature are: Celsius, Fahrenheit and Kelvin. 
The available data units are bit, byte, kilobyte, megabyte and gigabyte. The available numeric units are Hex, Dec and binary. Finally, the text conversion allows you to discover the ASCII equivalent to any text character.
Choose your unit to convert from in the first combo box. Choose your unit to convert to in the "Change" combo box. Type the number of the measurement you want to convert in the "Input Number" edit box. Finally, to convert the measurement, Tab to the "Convert" button and press "Enter". If you wish to cancel the conversion, Tab to the "Cancel" button and press "Enter". When you activate the "Convert" button, the conversion result is displayed in the "Result" static box. 

[bookmark: _Toc492453965][bookmark: _Toc26179881][bookmark: _Toc209372352]11.1.9 Copy to Clipboard
The "Copy to Clipboard" function is used to copy your expression or result to the clipboard for pasting your expression or result in a document. You can also access up to 20 lines of calculation history and copy them as well. Press "Enter" on the "Copy to Clipboard" option in the menu, or press "Enter-C" in the calculation line to copy the current expression. You can now paste the calculation to a document in the Word Processor or to another application on the unit. 
To access the cumulative calculation history, press "Enter-H". You can then use normal selection commands to select the lines of the history you wish to copy. Press “Space-D” to delete an item from the cumulative history.

[bookmark: _Toc492453966][bookmark: _Toc26179882][bookmark: _Toc209372353]11.1.10 Return Formula
There may be times, after viewing a result, that you wish to be reminded what expression you used to obtain that result. The "return formula" function allows you to return the expression you just entered
When your result is displayed, press "Enter-R", or select "Return Formula" from the menu. 
The expression you entered to obtain your current result is displayed.

[bookmark: _Toc492453967][bookmark: _Toc26179883][bookmark: _Toc209372354]11.1.11 Option Settings
You can activate the "Option Settings" by pressing "Enter" on the menu option, or from your calculation line, press "Enter-O". 
The "Option Settings" dialog contains combo boxes for changing various settings, an "OK" button, and a "Cancel" button. The "available settings are "Angle Unit", "Calculator Braille Code", “decimal places to display” and “Display Using Scientific notation”. You can navigate among the controls using “F3” or “Space-F3”. Use "Space" to change the value of each setting.
When setting the angle unit, if you select "Radian", you can get the PI value while using the trigonometric function. If you select "Degree" and activate PI, you will get a wrong answer as this is not a valid calculation. 
You can set the Calculator Braille code to computer Braille, Nemeth or UEB math Braille as described previously. You can use "Space-G" to change this setting from anywhere in the calculator.

[bookmark: _Toc26179884][bookmark: _Toc209372355]11.2 BrailleSense Math
This program allows you to create equations, or lists of equations, and perform advanced graphing functions. Be aware, because this program needs to do specific math related functions, it does break some of the usual interface rules.
When you first open it, you see an empty list, with the index 1/1. We use a list view here for the purposes of being able to select math problems in the same way you can select files or folders in a list, so that you can perform a single action on all selected items. One difference though, because you will use Space when writing math expressions, you will use Space-Enter to select the current item.
To enter a math problem, simply begin typing. When you press Enter after completing it, you will see an empty list item labeled 2/2. This will continue happening as you enter subsequent math expressions and press enter.
As you enter math expressions, graphs are automatically created when you press Enter, navigate away from the edit box, etc.
As you add expressions and graphs, they are added to the same image, the same x and y axis, with each subsequent graph appearing in a different color. If you graph more than 6 expressions, colors will be repeated, as there are only 6 different colors.
From the Word Processor, you can press Backspace-Enter-G to open the graphing function, this automatically opens BrailleSense Math, and inserts the current equation in to the list.
As with most other programs on BrailleSense, press F2 or Space-M to open the menus. Menu functions are outlined below:

[bookmark: _Toc26179885][bookmark: _Toc209372356]11.2.1 The File Menu
1) Export: (E) “Enter-E”. Saves the current BrailleSense math file (.mth). You are not able to export this to other formats, just save it for later use, or for sharing with another BrailleSense user.
2) Import: (I) “Enter-I”. Allows you to open a previously saved BrailleSense Math (.mth) file.
3) Save to History: (S) “Space-S”. Saves the current selection to your history. 
4) History: (H) “Enter-H”. Opens a list of equations you saved to your history. You can save an expression to your history by pressing Space-S. 
5) Save Graph As Braille: (F) “Enter-F”. Saves the tactile rendering of your currently selected graph as a Braille file.
6) Exit: (Z) “Space-Z”. Performs the obvious function.

[bookmark: _Toc26179886][bookmark: _Toc209372357]11.2.2 The Edit Menu
1) Copy: (C) “Enter-C”. Copies the current or selected math expressions to the clipboard. This function does not copy graphical images. Use the copy Graph function to do this.
2) Cut: (X) “Enter-X”. Cuts the current selection to the clipboard.
3) Paste: (V) “Enter-V”. Pastes clipboard content can currently paste only from other BrailleSense Math areas, such as the history or a math file.
4) Delete: (D) “Space-D”. Deletes the current or selected expressions.
5) Select All: (A) “Enter-A”. Selects all expressions in the current list.
6) Start Selection: (B) “Enter-B”. The same Start selection command that exists in File Manager and other list areas, selects continuously to your current cursor position.
7) Copy Graph: (G) “Enter-G”. Copies the graph image and associated equations to the clipboard.
8) Symbol picker: (S) “Backspace-S”. Allows you to search for and select math symbols to enter into your math expression.
9) Set Math Code: (M) “Backspace-G”. Choose between UEB and Nemeth.

[bookmark: _Toc26179887][bookmark: _Toc209372358]11.2.3 The Graph Menu
1) Axis: (X) “Backspace-X”. Allows you to set the limits of the axes, label them, and set the value each point represents.
2) Graph label: (L) “Backspace-L”. Lets you label the graph as a whole.
3) Graph Style: (C) “Backspace-C”. Lets you set color and shape of the graph. 
4) Show/Hide graph: (H) “Backspace-H”. This allows you to hide the graph for the equation on which you are focused. This menu item will then become “Show Graph” which will restore its view.

[bookmark: _Toc26179888][bookmark: _Toc209372359]11.2.4 The Output Menu
1) Display Tactile Graph: (T) “Enter-T”. Renders a tactile representation of the current graph on the Braille display. Scroll Quickly to easily determine its shape. Start and stop quick auto scroll by pressing the Up and Down Scroll keys simultaneously.
2) Send to Embosser: (P) “Enter-P”. Does just what it implies, allows you to emboss a tactile version of the graph.

[bookmark: _Toc492453968][bookmark: _Toc26179889][bookmark: _Toc209372360]11.3 Display Compass Heading
Use this option to display the direction of the compass on the BrailleSense. You can display the compass heading from anywhere on the unit.
To display the compass heading, press "Space-F3-F4" from anywhere on the BrailleSense.
The current status of the compass is displayed.
You can also access compass status in the "Utilities" menu. Move to "Display Compass Heading" with "Space-4" and press "Enter". 
As you change direction, to check the current compass status, press "Space". The current direction is announced. To exit this function, press "Space-E" or Space-Z". 
· Note: It will take about 15 minutes to initialize the unit should the following situations occur:
1. The unit discharges a great distance from the location where the compass was last used.
2. The unit remains discharged for more than a month.

[bookmark: _Toc492453969][bookmark: _Toc26179890][bookmark: _Toc209372361]11.3.1 Options of Gyrocompass
There are 2 option settings available when viewing compass status: "Refreshing time" and "Compass display type". 
Refreshing time is the interval of the automatic announcement of the compass status. To set this option, from the compass status, "Tab" to the "Refreshing time" edit box. Type the number of seconds between compass status announcements. By default, it is set to 0. You may type a number between 0 and 120.
You can set the Compass Display Type by tabbing to this option from the compass status. The setting values are "cardinal and degrees", "cardinal only" and "degrees only". By pressing "Space", you can change the value of the setting. By default, it is set to "cardinal and degrees".

[bookmark: _Toc492453973][bookmark: _Toc26179894][bookmark: _Toc209372362]11.4 Terminal for Screen Reader
The "Terminal for screen reader" function allows the BrailleSense to be used as a Braille display when connected to a computer or cell phone that uses a compatible screen reader such as JAWS, Supernova, Android’s TalkBack or Apple's VoiceOver. Before using this function, make sure that the BrailleSense is connected to your personal computer or smart phone via a Bluetooth serial connection, or to the USB client port. To turn on this function, from the "Utilities" menu, navigate to "Terminal for screen reader", and press "Enter". To launch "Terminal for Screen Reader" from anywhere on the unit, press "F3-S". 
The list of connection options is displayed: "Bluetooth serial port" and "USB port". Press "Enter" on your desired connection type, and the unit announces, "Terminal mode". If you are connecting using the Bluetooth serial connection and Bluetooth has not been activated, the unit automatically activates Bluetooth before entering terminal Mode.
Once in Terminal Mode, the BrailleSense no longer speaks as it is now simply acting as a Braille display for your computer or smart phone. If the connection fails, you are returned to the list of connection methods.
You can connect a Bluetooth and USB device to the Terminal for Screen Reader simultaneously. Once you have established the first connection, press Backspace-Space-Enter-P to initiate the second connection. When 2 devices are connected, press Backspace-Space-Enter-C to toggle between the connections.
To exit the "Terminal for Screen reader" press "Backspace-Space-Z". 

[bookmark: _Toc492453974][bookmark: _Toc26179895][bookmark: _Toc209372363]11.4.1 Terminal Clipboard
Terminal Clipboard allows you to create and edit text on the notetaker before sending it via the Terminal for Screen Reader to the connected device. This can be useful in instances like when using VoiceOver on an i-device, in which characters are translated as they are sent to the IPhone or iPad. Or, you may simply find it more comfortable to edit in the notetaker environment.
As explained above, the Terminal Clipboard allows you to create and edit text on the notetaker, and send the completed text to the connected computer or Smartphone via the Terminal for Screen reader.
To enter "Terminal Clipboard", press "Space-Enter-I". The BrailleSense announces, "Terminal Clipboard". Type and edit your text using normal text entry and edit commands. In "Terminal Clipboard", the Braille display and keyboard are temporarily disabled from sending/receiving information to/from your connected computer or i-device, so that you may use them for creating/editing your text. For more information on text entry and editing, please see section 5 of this manual on the Word Processor. When you are finished typing the text you wish to send to your computer or mobile device, press "Enter-S" and the text is quickly inputted to the device via the Terminal for Screen reader, and your BrailleSense returns to sending/receiving information to and from the connected device.
"Terminal Clipboard" can also be useful for transferring text from a document or e-mail in your notetaker, to a document or e-mail you are creating on your connected computer or Smartphone. As the "Terminal Clipboard" is a standard edit box on the notetaker, you can paste text in to it from the notetaker's clipboard. (see the sections of this manual regarding selecting text as it applies to supported programs such as the Word Processor, E-mail, Web Browser, etc.)
To send text from your notetaker: 
1) Press "Space-Enter-I" to activate "Terminal Clipboard".
2) Press "Enter-V" to paste the text from the notetaker's clipboard to the edit box.
3) Press "Enter-S" to send the text via the Terminal for Screen Reader.

[bookmark: _Toc492453975][bookmark: _Toc26179896][bookmark: _Toc209372364]11.5 Display Network Status
This utility provides information about the current network connection type and status, the current IP of the unit, subnet mask, gateway, and MAC address. To check network status, press "Enter" on "Display Network Status". You can also query network status from the "program" menu by pressing "Space-N". 
The information about the current connection is displayed. You can Tab to a "Renew" button and a "Close" button.
The first item in the information list (status) indicates whether the BrailleSense is currently connected to the Internet (online/offline), and if so, the current connection type (LAN, Modem, ADSL, or Wireless LAN). The next item is the "current IP address", followed by "Subnet mask", and "Gateway", and finally "MAC address". You can move among these items by pressing "Space-4" or "Space-1". If the BrailleSense is not currently connected to the Internet, the status information shows "offline", and the IP address, subnet mask, and gateway display 0's. 

[bookmark: _Toc492453976][bookmark: _Toc26179897][bookmark: _Toc209372365]11.6 Display Power Status
Press "Enter" on "Display power status" from the "Utilities" menu. Or, query power status from anywhere on the BrailleSense by pressing "Space-1-6". Two pieces of information are displayed: the percentage of charge remaining in the battery, and whether the BrailleSense is using the AC adapter or the battery to receive power. Exit by pressing "Space-Z". And you are returned to your previous location on the unit. 

[bookmark: _Toc209372366]11.7 Backup/Restore Flashdisk
The Backup/Restore Flashdisk utility lets you create a password protected zip backup of your flashdisk data to an SD card or connected USB drive. You can execute this utility by pressing “K” from within the Utilities Menu, or “F3-P” from anywhere on the unit
You are placed on the “Backup” button, which also announces the amount of data to be backed up. You can press “f3” or “Space-F3” to access the “Restore” and “Close” buttons.
Pressing “Enter” on the “Backup” button places you in a list of available drives to which you can save the backup, each announcing the amount of free space available. Press “Enter” on the drive you wish to use.
*Note: We recommend using ExFat SD cards or drives 64GB and above. It is not possible to create a zip file of more than 4 GB of data to a FAT32 drive or card, and most backups will be larger than 4 GB, as the user flashdisk can hold nearly 100 GB of data. 
When you have chosen your drive, you are asked to create a password. If you wish to password protect your zip backup, type a password of no more than 8 characters in the computer edit box. Press F3 to re-type the password. If you do not wish to use a password, Tab once more to “Don’t use password”, and press “Enter”.
BrailleSense creates a compressed backup, announcing the progress as a percentage. When finished, the unit then updates the file system. This may take a few minutes. Finally, you are asked whether you want to unmount the disk. If you want to disconnect the drive immediately, please choose yes, or the file system may not remain intact. If you intend to leave the disk connected for a time, you can say no. When you disconnect later, the system should be fine.
When the backup is complete, a folder called “BrailleSense Backup” appears on the root of the backup drive, containing a zip file with the BrailleSense device name and the time and date.
To restore a backup, choose the drive, then the backup file from the restore dialog. If you password protected your backup, you are prompted to enter the password before the restoration begins.

[bookmark: _Toc492453977][bookmark: _Toc26179898][bookmark: _Toc209372367]11.8 Format
WARNING!! The BrailleSense makes it possible to format the flashdisk to solve corruption problems and/or start over with a clean internal drive. Formatting the flashdisk erases everything on the flashdisk. Be extremely cautious when executing this command. If you execute this command, you will lose all of your data. You will NOT be able to retrieve this data once the command is executed. To format the flashdisk, press and hold "Space-1-2-3". While holding down "Space-1-2-3," quickly press and release the reset button. Continue holding "Space-1-2-3" until you hear the "format start" announcement.
You can also access the "format" function by pressing F from the "Utilities" menu. Or, you can launch it from anywhere on the BrailleSense by pressing "F3-F". 
When you format any disk on the BrailleSense, all information is erased. Therefore, before you format, you are advised to backup any important data if possible.

1) From the Utilities menu, press "Enter" on "Format" and "flashdisk" is focused. Press "Enter", or choose another disk from the list, and press "Enter". *Note: the disk will be formatted according to its current file system, FAT32 or ExFat.
2) You are prompted, "Format flashdisk?" Yes". Press "Enter"
3) You are prompted, "All data will be lost. Continue? Yes". Press "Enter". 
4) The unit announces, "Now formatting flashdisk" and the format is started.
5) When the format is complete, you are returned to the "Disk" list.
To cancel the format, press "Space", or press "Enter" on "No" in step 2 or 3.

[bookmark: _Toc397448712][bookmark: _Toc428448006][bookmark: _Toc26179900][bookmark: _Toc209372368]11.9 Using Macros
Macros allow you to automate functions of the Braille Sense for ease of use and efficiency, especially in cases where you perform a similar action often. For example, you may wish to set a macro to open a set of programs and documents when you come to work each morning. Or, perhaps, you want to set a macro to automate insertion of text and formatting of a document. You may even want to create a macro to automatically set an alarm for 6 in the morning the next day.

[bookmark: _Toc397448713][bookmark: _Toc428448007][bookmark: _Toc26179901][bookmark: _Toc209372369]11.9.1 Recording a macro.
To create a macro, you simply ask the unit to record a set of functions as you perform them, and save it. To begin recording a macro, press "F2-R" from anywhere on the unit. Perform all the functions you wish to automate later, then press "F2-R" again to stop recording. For example, if you wish to set a macro to set an alarm, press "F2-R", go to the Utilities menu, and the Wake Up Alarm function. Go through the process of setting the alarm. After you have pressed "Enter" to complete the alarm setting, press "F2-R" to stop macro recording. You are asked to enter a name under which to save the macro. Type it in the edit box, and press "Enter". If you have made a mistake, and do not wish to save the macro, press "Space-Z" to cancel saving the macro.
There may be times when it is necessary to insert some wait time in your macro to account for loading time of a file or website, etc. You can insert delay time while recording a macro by pressing “F2-D”. Type the delay time in milliseconds and press “Enter”. Continue recording your macro as normal.

[bookmark: _Toc397448714][bookmark: _Toc428448008][bookmark: _Toc26179902][bookmark: _Toc209372370]11.9.2 Executing a Macro.
To execute a previously created macro, press "F2-E" from anywhere on the Braille Sense. You are prompted for the macro name, and the last macro you created is automatically displayed. Type the macro name and press "Enter". The unit announces, "Executing macro, please wait,,,". The macro takes several seconds to execute as it must perform all the functions you previously recorded. When the macro is finished running, you are placed in the position you would normally be placed in if you had performed the functions manually. For example, if you set a macro to open your e-mail and check for new mail, when it has finished executing, you are placed in your inbox with the focus on the first unread message.
You may also create a macro to define a task you wish to perform multiple times. You can set the macro to repeat any number of times from the “Execute Macro” dialog. After pressing “F2-E”, press “Space-4” to navigate to the “Repeat” edit box, and type the number of times you wish for the macro to repeat. The repeat count is remembered until you change it again or reset the unit.

[bookmark: _Toc397448715][bookmark: _Toc428448009][bookmark: _Toc26179903][bookmark: _Toc209372371]11.9.3 The Macro Manager
The "Macro Manager" allows you to execute and manage macros you have previously created. It is located in the "Utilities" menu, just above the "Upgrade" option. Navigate to "Macro Manager" and press "Enter". You can also open the "Macro Manager" from anywhere on the unit using "F2-L". 
The "Macro Manager" dialog contains: Macro Name List, “Repeat Macro”, "Delete Macro", "Rename Macro", "Execute Macro", “Import Macro”, “Export Macro”, and a "Close" button.
The Macro Name List is a list of all the macros you have created. To execute a macro, press "Enter" on the macro name, or Tab to "Execute Macro" and press "Enter". As previously described, you can also execute a macro from anywhere on the unit by pressing "F2-E". To delete a macro, navigate to the macro you wish to delete in the list, Tab to "Delete Macro" and press "Enter", or press "Space-D". You can rename a macro by focusing the macro you wish to rename, and selecting the "Rename Macro" option. You are placed in an edit box in which you can type the new macro file name, with the current name displayed. To rename the macro, edit the current name or type a new one, and press "Enter".
You can also import and export your Macro list from the Macro Manager, either to share with others, to backup Macros you have created, or to share among multiple units.

[bookmark: _Toc492453979][bookmark: _Toc26179904][bookmark: _Toc209372372]11.10 Upgrade BrailleSense 6 Firmware
Using this utility, you can update the BrailleSense either via an Internet connection or from external media containing the upgrade files. If you choose the "Online" method, be sure you have an active Internet connection before attempting the upgrade. When you update the BrailleSense, settings are usually maintained. However, if there are changes to setting values in the firmware, all settings will be initialized. Therefore, it is recommended that you back up your settings using the backup/restore utility in the “Settings” menu. Data in the flashdisk is protected. However, we recommend you backup your files before updating the BrailleSense Firmware as unexpected problems can occur.
· Note: You cannot cancel the update once it has started. You must not reset the unit during an upgrade. You must keep the unit connected to AC power throughout the upgrade process. We recommend you do not touch the BrailleSense while it is updating. It may take up to 60 minutes to update the BrailleSense, possibly even longer depending on the speed of your Internet connection and how many apps you have installed. 
· Also note: the upgrade files are temporarily stored on the flashdisk for installation. If you do not have enough memory available on the flashdisk, the BrailleSense is unable to update until you make room for the upgrade files.
You can access the "Upgrade Firmware" option via the "Utilities" menu, or launch it from anywhere on the unit using "F3-U". 
When you have chosen your upgrade method, and the upgrade files are downloaded or detected, BrailleSense will extract all of the necessary program files. Progress is announced every few seconds.
Once done, the BrailleSense will reboot, and the system files will be upgraded. During this process, there is no speech, but the progress will be shown in Braille as a percentage.
Once this has completed, all the applications will be upgraded.
When the system files have been upgraded and the applications initialized, the software will load and boot. During this process, the BrailleSense displays “Starting BrailleSense” in Braille, and a progress indicator of changing dots appears on the right. 
When the system reboots, if there are no new or changed setting values in the firmware, the Main Menu loads, and your settings are restored. If setting values have been changed, all Settings are initialized, and the system boots and runs the Quick Guide.
When the system boots for the final time after the upgrade, the release Note is displayed. Press “F4” to exit to the Main Menu. If you want to save the release Note to the Documents folder, Tab to save and press “Enter”. To display it again at any time, press “F2-F3-R” from the main Menu.


[bookmark: _Toc492453980][bookmark: _Toc26179905][bookmark: _Toc209372373]11.10.1 Upgrading the BrailleSense Firmware Using the Internet
To upgrade the BrailleSense Firmware via the Internet, follow these steps:
1) Make sure you are connected to the Internet and plugged into AC power. Press "Enter" on "Upgrade BrailleSense Firmware" in the "Utilities" menu. 
2) Press "Enter" on "Upgrade: Online". The BrailleSense connects to the HIMS server, and your current software version is compared to the HIMS server version. You are prompted to continue with the upgrade.
3) The BrailleSense begins downloading the upgrade files. The upgrade is around 1.3 GB. Thus, depending on the speed of your Internet connection, it may take a long time to download. If the upgrade fails, you may receive the message, "Internet connection is not available. To try the upgrade again, press "Space-Z" to cancel, and activate "Upgrade BrailleSense Firmware" again. If the connection is successful, the upgrade files are downloaded.
4) After downloading the upgrade files, BrailleSense automatically starts the upgrade process. Please remember you must not touch the BrailleSense until the upgrade is complete, as pressing keys, resetting, or unplugging the unit can interrupt the upgrade process, thus resulting in an incomplete installation. When the upgrade is complete, you are returned to the "program" menu, and the unit announces, "File manager".
5) After the upgrade is complete, check the software version by pressing "Space-V" while in the "program" menu.

[bookmark: _Toc492453981][bookmark: _Toc26179906][bookmark: _Toc209372374]11.10.2 Upgrading the BrailleSense Firmware from a Disk
To upgrade the BrailleSense Firmware from a disk, follow these steps:
1) Download the upgrade file from the HIMS website. Note: the file is a .bin file, however, some versions of Windows may rename it as a .zip file. Do not extract this file. Simply rename the extension back to .bin. Copy the file to the root of an external storage device such as an SD card or USB thumb drive. 
2) Connect the SD card or USB drive to the BrailleSense, and be sure the BrailleSense is connected to AC power. Then, press "Enter" on "Upgrade BrailleSense Firmware" from the "Utilities" menu.
3) "Upgrade: Online" is displayed. Press "Space-4" to go to the "Upgrade: Offline" option. Press "Enter". 
4) If you are already running the latest version of the software, you are asked to continue with the upgrade. If you press "Enter" on "No", the upgrade is cancelled. Press "Space" to toggle between "Yes" and "No". 
5) The BrailleSense starts the upgrade process. Please remember you must not touch the BrailleSense until the upgrade is complete. When the upgrade is complete, you are returned to the "program" menu, and "File manager" is displayed.
6) When the upgrade is complete, check the software version by pressing "Space-V" while in the "program" menu.


[bookmark: _Toc209372375][bookmark: _Toc492453982][bookmark: _Toc26179907]12. Clock and Timer

[bookmark: _Toc492453970][bookmark: _Toc26179891][bookmark: _Toc209372376]12.1 Display Time and Date
Use this function to check the current date and time. Navigate to "Display Time and Date" in the "Clock and timer" menu, and press "Enter". You can also query the time and date from anywhere on the BrailleSense with "Space-T". You can Tab to display today's date.

[bookmark: _Toc492453834][bookmark: _Toc26179723][bookmark: _Toc209372377]12.2 Set Time and Date
To set the BrailleSense's internal clock, press "Enter" on "Set Time and Date" in the "Clock and Timer" menu. Or press T to open the "set time and date" dialog from the menu. You can launch the "Set Time and Date" dialog from anywhere on the unit by pressing "F3-T". 
The set time and date is a dialog, consisting of the following: "Time zone", "Time format", "Time", "Date Format", "Date", "Synchronize with time server", a "Confirm" button, and a "Cancel" button. You can move among these items by pressing “F3” or “Space-F3”.
When you activate "Set Time and Date", "Time zone?" appears followed by the default time zone. You can choose your desired time zone by navigating to it using "Space-1" or "Space-4" or by typing the first letter of the time zone. Once done, move to the next item using "F3".
The next item is "Time format", the options for which are 12 hour and 24 hour time. You can toggle between the two using "Space-1" or "Space-4". 
The next item is "Time". When typing the time, separate the hour and minute using a space or a colon. 
If you select 12 hour clock in the "Time format", A.M. or P.M. is displayed after the hour and minute. In the 12 hour clock, you can toggle A.M. it P.M. by pressing "Space-X". 
Tab to "Date format". You can choose to display the date in either the "short" or "long" format. The short format displays the date numerically, while the long format displays the Month spelled out and shows the date as it would appear in literary form. Toggle between the two using "Space-1" and "Space-4". 
The next item is "Date". Type the "Date" month, date, and year as mm/dd/yyyy. Use 2 digits for the month, 2 digits for the day, and 4 digits for the year, separating them by a space or a slash. 
The next item is "Synchronize with time server", used to synchronize time and date with a time server on the Internet. This function is extremely useful when the date and time of BrailleSense is faster or slower than the current time. To execute this function, your BrailleSense must be connected to the Internet. When connected, press "Enter" on the "Synchronize with time server" button. After synchronization, it displays the synchronized time in the "Time" edit combo box. The synchronized date is also displayed in the "Date" edit combo box.
If you do not wish to enter date and time information directly, you can navigate using the following commands:
When setting time:
Move forward 1 hour: Space-4
Move back 1 hour: Space-1
Move forward 10 minutes: Space-5
Move back 10 minutes: Space-2
Move forward 1 minute: Space-6
Move back 1 minute: Space-3
When setting date:
Move to the next day: Space-6
Move to the previous day: Space-3
Move to the next week: Space-5
Move to the previous week: Space-2
Move to the next month: Space-4
Move to the previous month: Space-1
Move to the next year: Space-5-6
Move to the previous year: Space-2-3
When you have completed entering all of the information, press "Enter" to save your settings, or "Tab to "Confirm" and press "Enter", and you are returned to the "Settings" menu.


[bookmark: _Toc209372378]12.3 World Clock
The “World Clock” is a very simple application that lets you easily keep track of and check the time for places you specify around the world.
 You can open the “World Clock” application from the “Clock and timer” menu, or by pressing “F3-L” from anywhere on the unit.
By default, the World Clock contains one entry which matches your Time and date setting. You can navigate all entries in the list using “Space-1” and Space-4”.
To navigate the controls in the dialog, use “F3” and “Space-F3”. The World Clock dialog contains the entries list, an add button, a delete button, and an Exit button.
To add an entry to the list, press Enter on the Add button. You are presented with a list of time zones. Choose the time zone you wish to add, and press Enter. It is now added to your list of entries for easy checking.

[bookmark: _Toc492453971][bookmark: _Toc26179892][bookmark: _Toc209372379]12.4 Wake Up Alarm
You can use this function to set multiple alarms to remind you of recurring events, or wake you up at different times on varying days of the week. To open "Wake up alarm", from the "Clock and timer" menu, use "Space-1" or "Space-4" to navigate to "Wake up alarm", and press "Enter". You can launch the "Wake Up Alarm" from anywhere on the unit by pressing "F3-A" If you have not yet set the time or date in the BrailleSense, the unit prompts, "Set time:" After you set the time, the BrailleSense displays the "Wake up alarm" dialog. 
The “Wake Up Alarm” dialog contains 5 items: Alarms list, an “Add” button, “Modify” button, “Delete” button, and a “Close” button. Use “F3” and “Space-F3” to move among the controls. Use “Space-1” and “Space-4” to navigate the Alarms list. You can also add an alarm by pressing “Enter-A”, modify with “Enter-M”, and delete an alarm with “Space-D”.
The "Add alarm" dialog contains: "Set time", "Bell", "Term", "Alarm duration", "Repeat interval", "Wake up call times", a "Confirm" button, and a "Cancel" button. 
When the alarm sounds, the Braille display displays the message "Wake up alarm. Press Escape to stop the alarm". 
When you open the "Wake up alarm" dialog, the BrailleSense displays the "Set time" field. The value is set to the current time or the time specified previously. Here you can directly type the time, or set the time using the shortcut keys, as explained in section 6.1.3. 
Tab to the next field and select from one of 3 alarm sounds, a vibration, a media file or an FM Radio frequency for the wake up alarm. Press "Space-1" or "Space-4" to change the alarm sound. As you move among the sounds, the various alarm sounds are played. When you reach the 4th option, "Vibrate motor", the BrailleSense produces a long vibration representing the one you would feel should you choose to use this option to alert you of your alarm. 
If you choose "Media File", Tab to the "File Name" button and press "enter" to browse for the file you wish to use as your alarm sound. You are placed in a File Manager control with the focus inside the 'Media" folder. Locate the file you wish to use, and press 'Enter". If you choose "FM Radio", tabbing once places you in an edit box in to which you can type the frequency of the radio station you wish to wake up to. 
When you have selected your desired alarm type, Tab to the next field.
In the term field, you can set which days of the week the alarm sounds. There are four options: "Off", "Once", "Week days", and "Every day". If the "Term" is set to "Off", the alarm does not go off at the specified time, no matter how the other options in the dialog are set. 
The duration option sets the amount of time that the alarm sounds. The options are 1 minute, 2 minutes, or 3 minutes. If you set the ringing duration to "1 minute", the alarm sounds for one minute, and then is silent. To stop the alarm before a minute has passed, press "Backspace-enter".
The repeat interval defines the amount of time that is between the times that the alarm sounds. For example, if you set the repeat interval to three minutes, after the alarm has stopped sounding, it rings again in 3 minutes. The available settings are 1, 3, 5, 10, 15, or 20 minutes. 
If the alarm is not turned off by pressing "Backspace-enter", it repeats according to the number of times you set the Wake Up Call Time option. The available settings are 1 to 10. 
Press "Enter" to save your setting, or "Space-Z" to cancel setting the alarm.

[bookmark: _Toc492453972][bookmark: _Toc26179893][bookmark: _Toc209372380]12.5 Stopwatch
You can launch the "Stopwatch" from anywhere on the unit by pressing "F3-W". Or, you can navigate to it in the "Clock and timer" menu and press "Enter".
"00:00:00" is displayed. Press "Enter", to start the stopwatch running. Press "Enter" again, to pause, and the BrailleSense announces the elapsed time, and displays it in Braille. Pressing "Enter" again restarts the stopwatch running.
If you press "Backspace" while the stopwatch is paused or running, The BrailleSense announces the elapsed time and clears to "00:00:00". While the stopwatch is running, pressing "Space" gives you the elapsed time. As the stopwatch is still running, the Braille display continues displaying the time second by second as it passes. 
Press "Space-F2" to stop displaying the time. If you press "Space-F2" once more, the time is displayed again.
Tab to switch to the "Countdown timer". You are asked to type hours, minutes, and seconds. Type a two-digit number for the hour, minute, and the second using Computer Braille or grade 1. You do not need to use a number sign. If you press "Enter" without typing any numbers, the "Countdown timer" starts counting down by the default time, which is set to one minute. When started, the "Countdown timer" displays "countdown xx minute", and begins running.
Press "Enter" on the "Countdown timer", and the BrailleSense tells you the remaining time, and pauses countdown. Press "Enter" again to restart the timer. Pressing "Backspace" clears the "Countdown timer". If the timer reaches zero, a 10-second alarm sounds, and the "Countdown timer" clears. If you press "Backspace-enter" while the alarm is sounding, the alarm stops and your timer clears, and is ready to accept a new time.
To exit the "Stopwatch" program, press "Space-Z". 

[bookmark: _Toc492453978][bookmark: _Toc26179899][bookmark: _Toc209372381]12.6 Set Sleep Timer
You can set the sleep timer to turn the BrailleSense off after a specified amount of time regardless of what you are doing.
To set the Sleep Timer, navigate to "Sleep Timer" in the Clock and timer" menu and press "Enter". Or press "Space-J" from anywhere on the unit. 
You are prompted, "Sleep timer: 0". Enter the number of minutes for the sleep timer in the edit box. The available settings range from 0 to 180. Press "Enter".
When the sleep timer is set, even if the device is active, it powers off after the specified amount of time. If you set the sleep timer for "5" minutes and press "Space-J (dots 2-4-5)" after 2 minutes, "3" is displayed in the edit box, indicating the time remaining before the sleep timer powers the unit off. 


[bookmark: _Toc209372382]13. Using Third Party Apps and Accessories

[bookmark: _Toc209372383]13.1 Installing and using Android Apps
While the BrailleSense has many powerful programs created specifically for the visually impaired, one of its most powerful features is the ability to install and use applications installed from Google Play. Before you can install applications, you must have a Google Account. 
You can access Google Play by navigating to “Android Apps” from the Main Menu, then pressing “Enter” on the top item, “Play store”. 
When you first open Google Play, you will need to sign into your Google Account. It is important to note: when you use Google Play and other Android apps, you are no longer accessing the BrailleSense interface, and interaction and navigation is slightly different.
BrailleSense 6 contains a mobile screen reader that is automatically executed when you use any app. It is somewhat similar to TalkBack for Android with some notable enhancements. Because you must navigate the graphical Android screen, it can sometimes be difficult to locate what you need efficiently. For this reason, the BrailleSense screen reader allows you to locate icons according to their first letter. So, if you're looking for a Search icon, press the letter S. Pressing a given letter will take you to the first icon that matches. Subsequent presses of the same letter will jump to additional icons on the screen beginning with that letter.
Use "F3" and "Space-F3" to move among individual objects on the screen. The Control and Alt keys will often take you to different content areas on the screen. In programs like Google Docs, Google Sheets, and Google Slides, keyboard shortcuts are available for QWERTY keyboards, and the Control and Alt keys allow you also to utilize these functions. Use Backspace when Shift is required.
Use "Space-1-2-3" to move to the top of the current content area, and "Space-4-5-6" to move to the bottom of the current content area. Use "Enter" to select or run the current item, and “F4” or “Space-E”, to move back one screen. Use “Space-Z” to completely close an application.
To type in some edit boxes, you must press "Enter" to activate Edit Mode before you can input text. To adjust slider controls, press “Backspace-Space-4” to increase the slider value, and “Backspace-Space-1” to decrease a slider value”.
You can also navigate HTML content more easily with a few helpful shortcuts. Use “F3” and “Space-F3” to navigate back and forward by link/controls. Use “Backspace-H” and “Enter-H to move back and forward by heading. Use “Backspace-1-2-3-4-5-6” and “Enter-1-2-3-4-5-6” to move back and forward by form control. And, you can use “Backspace-I” and “Enter-I” to move back and forward by list item.
In addition, you can navigate Android apps using the Media keys on the front panel. Use “Back” and “Next” to move to the previous and next object. “Record” serves as the Android Back button. “Play” opens Recent Apps, and “Stop” returns you to the main Menu. When playing media with an Android app such as Apple music or Spotify, hold the “Back” button to move to the previous item, hold the “Play” button to play/pause, and hold the “Next” button to move to the next item or track.
To emulate a Double tap directly, press “Space-Enter”. This is useful in apps like Tap Tap See, where some buttons have no keyboard equivalents. To emulate Double Tap and Hold, press “Backspace-Space-Enter”. This is useful in apps like Amazon, that offer additional menus of functions when you are placed on a shopping item, a song in Amazon Music, etc. Finally, to emulate a hold, you can use “Backspace-Space-Dot-2” to start and stop the hold. This is necessary in apps like WhatsApp Messenger for activating certain functions.
For apps where you might swipe down to refresh a list on a mobile phone, such as when refreshing a list of RSS feeds, press “Enter-R” when focused on the list you want to refresh.
It is also possible to operate Android apps in a more traditional manner using a keyboard and/or mouse, or portable touch monitor. You can turn accessibility features on and off by pressing the “Stop” and “Next” media buttons together on the front panel of the device. When the Mobile Screen Reader is on, these accessories will operate similar to how they would when using TalkBack. When the mobile Screen Reader is off, they will operate as they would traditionally operate in Android. 
Once you have signed into your Google Account, you may search for applications using the "Search" function. If you have other Android devices, and have already purchased apps on Google Play, open the Navigation drawer, and choose the "My Apps" option. By default, Google Play displays only what is currently installed on this unit. Select the "Library" button, then “Not on this device” to show all apps you have purchased or downloaded. 
From an Apps list, press "Enter" to view the details of an app. If you wish to install it, locate the "Install" button and press "Enter". 
When apps are installed, they will appear in the "All Apps" list at the end of the main program menu. When BrailleSense ships, this list contains Google basics such as Chrome, drive, , Maps, Meet and YouTube. The list is displayed in alphabetical order and can be navigated with first letter navigation.
Near the bottom of the Apps list is an "App Manager. The App Manager allows you to uninstall any app on your BrailleSense. You can also access the traditional Android Actions Menu for each app by pressing “Enter-I” when focused on the app you want to act on.
The final item in the All Apps menu is an App installer. This installer contains a limited list of apps we know to be popular among our users, and that we also know to be accessible, most often, even if you don’t have a Google Play account, though it does tend to further the functionality of many of the included applications. When you open the Installer, you will see the apps arranged in a list, and can press “Enter” on any of them to install them to your BrailleSense. To get more information about the focused app in the App Installer list, press “F3”. Once you have finished reading the associated information for the current app, press “Space-F3” to return to the Apps list.
When you install Android apps, you may begin to hear sounds and announcements related to these apps. Many apps send “Notifications” to your BrailleSense in real-time, just as happens on smartphones and tablets. Press “Space-1-2-3-4-5-6” from anywhere on the unit to see a list of these notifications.
Press “Space-1” and “Space-4” to navigate the list, and press “Enter” on a notification to launch its associated application. Press “Space-D” to delete a notification from the list. Press “Space-Enter-D” to clear all notifications. * Note: Google does not allow the deletion of some notifications. 
· Note: While there are many apps that work well, HIMS cannot and does not guarantee the accessibility or usability of any application that is not developed specifically for BrailleSense. Apps should generally work well if they meet Google accessibility standards, however many apps are not made to meet these standards and are not easily usable on any Android device running a screen reader. 
· You can often increase the accessibility of an app by labeling unlabeled buttons. To do this, press “Enter-L” on an unlabeled button. You are placed in an edit box wherein you can type the label name, and the internal program ID for the function is announced. Press “F3” if you need to hear this again or want to see it on the Braille display. Type your label in the edit box, and press “Enter” to save it. *Note: this will work for most unlabeled content, however, if a button is not a standard android control, , it may not be possible to label it.

[bookmark: _Toc209372384]13.1.1 Using Shortcuts
As you navigate the list of applications in the All Apps menu, you’ll notice a double dash in Braille in front of some of the app names. The presence of this symbol indicates that the focused app has shortcuts available. These are quick methods that the developer has built in to the app for accessing specific, commonly used functions for the app. 
When you encounter the double dash, you can press “Backspace-I” to display a list of shortcuts for the current application. Press “Enter” on any shortcut in the list to immediately activate it.
In addition, the BrailleSense allows you to save any available shortcut to a Shortcuts Manager where you can easily access a single list of shortcuts you use often, regardless of the associated app, and, for which, you can also create a Global hotkey. When focused on the shortcut you want to save, press “F3” to move to the “save” button, and press “Enter”.
You are then asked to choose a hotkey modifier. In order to avoid conflicts with BrailleSense hotkeys, we allow you to choose from one of 3 modifier options, “Control-Space”, “Control-Backspace” or “Alt-Enter”. There are a few pre-existing hot keys that use “Control-Backspace”, and if you encounter one of these, the unit will prompt you. However, most keys are open, and “Control-Space” and “Alt-Enter” are not used anywhere on the unit at this time. 
Once you have chosen your modifier, Tab to the “Keystroke” edit box. Type a Braille dot combination to be used with the chosen modifier to create the Global hotkey. Once done, you are able to activate your shortcut in its associated application from anywhere on the BrailleSense. For example, you could create a shortcut to activate the Short Text function in the Seeing AI app, to start a new personal meeting in Zoom, to check your Amazon cart, or to call a specific contact in Skype. 
*Note: available shortcuts are determined by the developer of each individual application. You can view, modify, or delete the saved shortcuts and associated hotkeys in the “Shortcuts Manager” near the bottom of the All Apps list. 

[bookmark: _Toc209372385]13.2 Using Compatible Accessories
The BrailleSense 6, with its 3 USB host ports and Android 10 operating system, has the capability of supporting a wide variety of USB accessories that may enhance your productivity, including drives, keyboards, mice, remote controls, USB hubs, external monitors, USB cameras, and USB audio devices. And with the use of USB hubs, as well as the 3 host ports, it is possible to connect a number of devices at once.
*Note that, the more devices you have connected to the unit, the more quickly your battery will drain. It is recommended that, if you intend to connect multiple devices for a long period of time, that you also connect AC power. You may also experience performance or connectivity issues if you connect more than 5 or 6 devices.
In this section, we will provide a few tips and guidelines for choosing compatible devices. 
The most general rule to follow when choosing compatible devices is to determine if they are using generic USB Plug and Play protocols. Even if they do not specifically say they are Android compatible, if they are Plug and Play generic USB devices, it is likely they will be compatible with BrailleSense 6.
When searching for a USB C monitor, it is important to know that the power consumption should be 5V 1.5A, though we have found that some 5V 2A monitors will work. Monitors that require 3 amps cannot be supported unless additional power is provided to the monitor via a battery pack or USB charger.
It should also be noted that, when connecting to a monitor, if you are not using a headphone jack or USB audio source, the audio is sent to the monitor as well as the internal speakers. You can mute and unmute the internal audio by pressing “F4-A” from the Main Menu. If using an external audio output source, the audio will only be sent to the external source.
When using USB audio sources, they will always take priority over other audio sources, unless headphones are connected to the BrailleSense 6’s headphone jack, in which case, the internal source chosen in the Recording Settings will take precedence. For more information, please see the section on Recording in the Media Player chapter. When you are not recording, perhaps in a Zoom or Teams meeting, etc, you can mute your microphone at any time by pressing “F4-M”.
When choosing compatible audio devices, be sure to choose devices that do not require drivers, and avoid devices that are meant for multi-track production, as these often require the use of a digital audio work station. Devices that mix down to a single stereo or mono input, and do not require drivers should generally work well, including USB microphones like the Blue Yeti, USB mixers like the Alesis and Rockville models, USB headsets and sound cards, USB cassette and record players, etc. 
Choosing a camera is a very similar process. Most generic USB web cams should work well, including Logitech, NexiGo and Sony models. However, it is wise to stay away from those that require specific editing software, or driver installation, even if they claim to be Android compatible. Document cameras seem to be the least compatible, though we’ve discovered some that work. 
*Note: if a camera includes microphones, the BrailleSense 6 will also recognize it as a USB audio device. If you wish to use both an external camera, and an external audio device, connect the camera first, then the audio device, as the BS6 will use the most recently connected device for audio.

[bookmark: _Toc492453983][bookmark: _Toc26179908][bookmark: _Toc209372386]14. Help and Information
[bookmark: _Hlk529273337]
[bookmark: _Toc492453843][bookmark: _Toc26179734][bookmark: _Toc209372387]14.1 Quick Start Guide
The Quick Start Guide runs a getting started wizard that introduces you to BrailleSense and its functions, and lets you set basic preferences. This guide automatically launches the first time you start your unit. You can relaunch it at any time by selecting the “Quick Start Guide” option in the “Help and Information” menu.
This guide gives you a physical tour of the unit, provides general keystrokes, and takes you through setting the Time and Date as well as the Global Options.


[bookmark: _Toc209372388]14.2 Using Help
The help section consists of a navigable version of the BrailleSense 6 user Manual. To access this help file, press "F1" to go to the "program" menu, and press the letter h to quickly jump to and open "Help and Information". Press “enter” on the “User Guide” option to open the manual. You can also launch "Help from anywhere on the unit using "F1-H". 
The User Manual will load, and you will be placed in the Navigation menu. Use "Space-dot-1” and “Space-dot-4" to navigate to the section you wish to read. To navigate to sub sections for the focused section, press F3. Then, use “Space-1” and “Space-4” once again to navigate the sub sections. To move back a level in the structure, press “Space-F3”.
Press "Enter" on the focused section to open the manual at that location and start reading. Keys for navigating are the same as those in the Notepad. For a list of navigation keys, please see chapter 5.2. You can return to the Navigation menu at any time by pressing “Space-N”. 
As you read the manual on the BrailleSense 6, you can search for text by pressing "Space-F". Type the text you wish to find, and press "Enter". You can find the next occurrence of the particular text you searched for by pressing "Enter-F". 
The Introduction section gives a physical orientation to the BrailleSense 6 and an overview of its functionality. 
The section, "Basic Functions", gives a basic overview of the programming and operation of the BrailleSense 6 
The section, "Customizing your notetaker" provides an explanation of time and date setup, internet Setup, Bluetooth connectivity, and the "Global Options" and how to use them to configure your BrailleSense 6 according to your preferences. 
Most of the remaining sections cover each of the functions of the BrailleSense 6 in detail. 
The "Commands Summary" section is a quick reference of hot keys for all the programs on the BrailleSense 6, useful when you simply want to know the keystroke for performing an action without reading the entirety of the instructions on a given program.
You can also get help related to the specific task you are performing. Use "Space-H" within any program to get a list of keystrokes available in that program.

[bookmark: _Toc492453842][bookmark: _Toc26179733][bookmark: _Toc209372389]14.3 view Device Name
The "View device Name" function allows you to view the Bluetooth/network name of your unit, so that you can appropriately identify it when connecting to a screen reader or pairing with other Bluetooth devices. 
The BrailleSense is named something like "BrailleSense035", the numbers used will match the key number of your device. 
You can access the "View device Name" dialog by navigating to the "Help and Information" menu, then to "View Device Name". You can also launch the "View device Name" dialog from anywhere on the unit by pressing "Backspace-Enter-E". 
The "View device Name' dialog consists of 2 controls: a "Device Name" static box, and a “Close” button. 

[bookmark: _Toc209372390]14.4 device information
The “Information” dialog provides the copyright and version of the BrailleSense 6, as well as the operating system version, the version of the BrailleSense 6 firmware, and other useful items such as Mac address and Key number. When the "information" dialog is open, you can save the information about the BrailleSense 6 by pressing "tab (Space-4-5 or F3)", to navigate to the "Save" button and press "Enter". The unit displays "Successfully saved", and returns you to the "Save" button. The saved file is named "bs-information.txt", and is stored in "flashdisk" for easy access.

[bookmark: _Toc492453984][bookmark: _Toc26179909][bookmark: _Toc209372391]15. Troubleshooting Guide
If you are encountering problems with the BrailleSense 6, please take a look at the following suggestions for solving many common problems: 

[bookmark: _Toc492453985][bookmark: _Toc26179910][bookmark: _Toc209372392]15.1 The BrailleSense 6 Will Not Turn On
1) Check to make sure that the battery is inserted in to its compartment properly.
2) If the battery is inserted properly, connect the AC adapter, and plug the AC adapter in to an electrical outlet. The battery may need to be charged.
3) Or, Check the location of the keyboard lock switch. If this switch is placed in the "lock" position, the power switch is not functional.

[bookmark: _Toc492453986][bookmark: _Toc26179911][bookmark: _Toc209372393]15.2 The Voice Cannot Be Heard
1) Make sure the volume is loud enough to be heard. Press "backspace-F4" to raise the volume.
2) Make sure the voice is turned on. Press "Backspace-F2" to toggle the voice on/off.

[bookmark: _Toc492453987][bookmark: _Toc26179912][bookmark: _Toc209372394]15.3 The Voice is Too Fast to Understand
1) Press "space-F1" to lower the voice rate.

[bookmark: _Toc492453988][bookmark: _Toc26179913][bookmark: _Toc209372395]15.4 The Voice Pitch Is Too Low or Too High to Understand
1) Press "enter-F1" to lower the pitch, or press "enter-F4" to raise the pitch of the voice.

[bookmark: _Toc492453989][bookmark: _Toc26179914][bookmark: _Toc209372396]15.5 You Don't Know Where You Are
1) If you have become disoriented as to your location on the BrailleSense 6, and cannot remember where you are, press "F1" to access the "program" menu. Then, press "F2-F3" to switch among the open programs. If you are in the Word Processor, pressing "space1-5-6" gives you your current location in the open document.

[bookmark: _Toc492453990][bookmark: _Toc26179915][bookmark: _Toc209372397]15.6 No Internet Connection
1) If you are using a Wi-Fi connection, ensure wireless is turned on. Use "Backspace-dots-1-4-5-6" to toggle wireless on/off. 
2) If using an Ethernet connection, check to ensure that the Ethernet cable is connected securely with the USB to Ethernet adapter, and that the network settings are correct. 

[bookmark: _Toc492453991][bookmark: _Toc26179916][bookmark: _Toc209372398]15.7 E-mail
1) If you are having trouble downloading email, please contact your Internet service provider to make sure that you have the correct POP3/IMAP and SMTP settings.
2) If you cannot send or receive mail, make sure you have an active connection to the Internet.

[bookmark: _Toc492453992][bookmark: _Toc26179917][bookmark: _Toc209372399]15.8 The Braille display Does Not Display Braille
1) If the Braille display does not display Braille, make sure that the Braille display is turned on. Use "Backspace-F3" to toggle the Braille display on/off.
[bookmark: _Toc492453993][bookmark: _Toc26179918][bookmark: _Toc209372400]15.9 The BrailleSense 6 Does Not Speak when using Google Play or Apps
If you do not have speech when you open Google Play, or an app in your All Apps list, make sure the Mobile Screen Reader is on. You can toggle the mobile Screen Reader on and off by pressing the “Stop” and “Next” media buttons on the front panel of the unit. 

[bookmark: _Toc492453994][bookmark: _Toc26179919][bookmark: _Toc209372401]15.10 The BrailleSense Menus are Not Displayed or Spoken
At times, you may receive a prompt to set the default launcher between Google Now and the BrailleSense Launcher. If it is accidentally set to use the Google Now Launcher, the BrailleSense menus are not displayed, and accessibility features are not activated. In this case, System notifications may still be heard, but no Braille will appear, and no speech is heard.
To reset the BrailleSense Launcher, press “F2-F3-1-2-3-4-5-6-7-8”. 

[bookmark: _Toc492453995][bookmark: _Toc26179920][bookmark: _Toc209372402]15.11 The BrailleSense 6 Does Not Respond
1. If the BrailleSense 6 does not respond to keystrokes or commands, it may be necessary to reset the unit. To reset the BrailleSense 6, press "1-2-3-4-5-6-F2-F3." 
2) if the above keystroke does not initiate the reboot process, press and hold the Power Button for more than 10 seconds, even after it announces, “Do you want to Power Off?”. After 10 seconds, the unit will automatically reboot.
3) If the soft reset does not revive the BrailleSense 6, you may need to completely shut down the unit. The easiest way to do this is to remove the battery, leave it out for a few seconds, re-insert it, and power on the unit. 
4) Initializing BrailleSense Options: if you are not able to solve your problem with the above methods, you may need to reset your BrailleSense options back to factory defaults. You can do this in two ways: if your unit is operational, you can launch the “Initialize BrailleSense options” item in the “Settings” menu. You may also hold the Forward Media key while pressing the Power On Button. Continue to hold Forward until “HIMS” is displayed on the braille display.
5: Hard resetting Android system: In very serious cases, it may be necessary to perform a full system reset. However, this should not be attempted unless all other options have been exhausted, or unless you wish to completely erase all data, applications and settings. In addition, this process is complex and unique, and should only be done under the direction of an authorized support staff member. If you believe a system reset is necessary, please contact technical support for consultation and full instructions. 

[bookmark: _Toc492453996][bookmark: _Toc26179921][bookmark: _Toc209372403]15.12 The LCD Does Not Come On
1) If the LCD screen does not come on, make sure that it is turned on. Press "space-o (dots 1-3-5)" to open "Global Options". Press "F3-F4" twice. Press "space" to turn the LCD screen option on, and press "enter" to save the option settings.

[bookmark: _Toc492453997][bookmark: _Toc26179922][bookmark: _Toc209372404]15.13 USB or SD Files Seem to Contain 0 Bytes
The Android operating system requires that drives are ejected properly before removing them. If not done, inserting them in to the BrailleSense or other devices may result in all files appearing as though they have no data, or have a size of 0 bytes. Before disconnecting a USB drive or SD card, press “Backspace-Enter-U” or “Backspace-Enter-3-6” to unmount it properly. If your drive is showing files with no data, please re-insert it in to the BrailleSense, and press the Unmount key.

[bookmark: _Toc492453998][bookmark: _Toc26179923][bookmark: _Toc209372405]16. Command Summary

[bookmark: _Toc492453999][bookmark: _Toc26179924][bookmark: _Toc209372406]16.1 Common Combination Keys
[bookmark: _Toc207602207][bookmark: _Toc209372407]16.1.1 navigation and information keystrokes
Open the main program menu: F1
Open the Running Tasks list: F1-F4
Switch to next running task: F2-F3
Switch to previous running task: Space-F2-F3
Open program specific menu: Space-m (dots 1-3-4) or F2
Exit: Space-z (dots 1-3-5-6)
Escape: Space-e (Space-1-5) or F4
Move to the next control in a dialog box: Tab (Space-4-5 or F3)
Move to the previous control in the dialog box: Shift-tab (Space-1-2 or Space-F3)
Move to the previous line/item: Space-1
Move to the next line/item: Space-4
Move to the beginning of line/item: Space-1-3 
Move to the end of line/item: Space-4-6 
Move to the top of a document or list: Space-1-2-3 
Move to the bottom of a document or list: Space-4-5-6 
Move to the previous page or to the first item of the previous 32-item group: Space-1-2-6 or F1-F2
Move to the next page or to the first item of the next 32-item group: Space-3-4-5 or F3-F4
Repeat current item: Space-r (dots 1-2-3-5)
Scroll back: Up scroll button
Scroll forward: Down scroll button
Move the cursor to a specific cell or list item: press the corresponding cursor routing key
Enter Upper case: Space-u (dots 1-3-6)
Find: Space-f (dots 1-2-4)
Display time and date: Space-t (dots 2-3-4-5)
Display compass heading: Space-F3-F4
Display network status: Space-n (dots 1-3-4-5) from Main Menu
Display power status: Space-dots-1-6 from Main Menu
Display Flashdisk Empty Space: Space-I (dots-2-4) from Main Menu
Check Software version: Space-V (dots-1-2-3-6) from Main Menu
View device name: Backspace-Enter-e (dots 1-5)
Context help: Space-h (dots 1-2-5)
Open Sense Dictionary: Backspace-Enter-d (dots 1-4-5)
Open Web search: Control-Alt-W (dots-2-4-5-6)
Web Search focused word: Backspace-Space-Enter-W (dots-2-4-5-6)
Open URL: Space-W (dots-2-4-5-6)


[bookmark: _Toc207602208][bookmark: _Toc209372408]16.1.2 System Adjustment
Voice on/off: Backspace-F2
Increase voice volume: Backspace-F4
Decrease the voice volume: Backspace-F1
Increase the voice rate: Space-F4
Decrease the voice rate: Space-F1
Increase the voice pitch: Enter-F4
Decrease the voice pitch: Enter-F1
Increase the main volume: Backspace-Space-F4
Decrease the main volume: Backspace-Space-F1
Keyboard Echo: F2-Enter
Punctuation Level: F3-Enter
Braille on/off: Backspace-F3
Change Braille Code: Backspace-Enter-b (dots 1-2)
Change Braille grade: Space-G (dots-1-2-4-5)
Scroll voice on/off: F3-up scroll button
Eight dot mode on/off: F1-down scroll button
Select Braille cursor type: F4-up scroll button
LCD On/Off: Enter-4-5-6 from Main Menu
Typing mode on/off: Backspace-Space-Enter-M (dots 1-3-4)
One-handed mode on/off: Backspace-1-2-3 from Main Menu
Bluetooth on/off: Backspace-3-4-5-6
Wireless LAN on/off: Backspace-1-4-5-6
Select display of control information: F2-down scroll button
Toggle Hide Passwords On/Off: F3-Down Scroll button
Turn Sleep Mode On/Off: Control-Alt-S (dots-2-3-4)
Power Button Operation: Backspace-Enter-P (dots-1-2-3-4)
Open Menu Manager: From Main Menu, Enter-H (dots-1-2-5)
Open sleep Timer: Space-j (dots 2-4-5)
Open Global Options: Space-o (dots 1-3-5)

[bookmark: _Toc207602209][bookmark: _Toc209372409]16.2 Quick Launch Commands
Use the following commands to launch their associated applications and functions from anywhere on the BrailleSense 6 MINI.

[bookmark: _Toc207602210][bookmark: _Toc209372410]16.2.1 F1 Commands
Use F1 in combination with each letter to launch the associated applications:
Address Manager: A (dot 1)
Web Browser: B (dots 1-2)
DAISY Player: D (dots 1-4-5)
Email: E (dots 1-5)
File Manager: F (dots 1-2-4)
Google search: G (dots-1-2-4-5)
User Manual/Help: H (dots 1-2-5)
Wiki Search: I (dots-2-4)
BookShare Download: K (dots-1-3)
Language Profiles: L (dots-1-2-3)
Media Player: M (dots 1-3-4) 
Notepad: N (dots-1-3-4-5)
Notepad 2: Backspace-N (dots-1-3-4-5)
Document Reader: O (dots-1-3-5)
Podcasts: P (dots-1-2-3-4)
Database Manager: Q (dots-1-2-3-4-5)
FM Radio: R (dots 1-2-3-5)
Schedule Manager: S (dots 2-3-4)
Web radio: U (dots-1-3-6)
Voice recorder: V (dots-1-2-3-6)
Word Processor: W (dots 2-4-5-6)
Excel Viewer: X (dots 1-3-4-6)
Online DAISY: Z (dots 1-3-5-6)
Favorite Apps: Control

[bookmark: _Toc207602211][bookmark: _Toc209372411]16.2.2 F2 Commands
Use F2 in combination with each letter to launch the associated applications and functions below:
Optional BARD mobile: A (dot-1)
Optional Sense Bible: B (dots-1-2)
Optional Chat GPT: C (dots-1-4)
Execute Macro: E (dots-1-5)
Sense Brain Game: G (dots-1-2-4-5)
Sense dice game: I (dots-2-4)
Macros List: L (dots-1-2-3)
Optional NFB Newsline: N (dots-1-3-4-5)
Braille Practice: P (dots-1-2-3-4)
Record Macro: R (dots-1-2-3-5)
Shortcuts Manager: S (dots-2-3-4)
Sense roulette game: T (dots-2-3-4-5)

[bookmark: _Toc207602212][bookmark: _Toc209372412]16.2.3 F3 Commands
Use F3 in combination with each letter to launch the associated applications:
Wake up alarm: A (dot 1)
Braille Options: : B (dots 1-2)
Calculator: C (dots 1-4)
To Do List: D (dots-1-4-5)
Android System settings: E (dots-1-5)
Format: F (dots 1-2-4)
Setup Internet: I (dots 2-4)
Backup/Restore Personalized Settings: K (dots 1-3)
World Clock: L (dots-1-2-3)
BrailleSense Math: M (dots-1-3-4)
Password Protection: N (dots 1-3-4-5)
General Options: O (dots-1-3-5)
Backup/Restore Flashdisk: P (dots-1-2-3-4)
Bluetooth Manager: R (dots-1-2-3-5)
Terminal for Screen Reader: S (dots 2-3-4)
Set Time & Date: T (dots 2-3-4-5)
Upgrade BrailleSense: U (dots 1-3-6)
Voice Options: V (dots-1-2-3-6)
Stopwatch: W (dots 2-4-5-6)
Video Search: Y (dots-1-3-4-5-6)

[bookmark: _Toc207602213][bookmark: _Toc209372413]16.2.4 F4 commands
Use F4 in combination with each letter to execute the associated functions:
Mute Internal Audio: A (dot-1)
Dictate text where supported : D (dots-1-4-5)
Create log and screen recording: L (dots-1-2-3)
Mute Microphone: M (dots-1-3-4)
Toggle Screen Recording: R (dots-1-2-3-45)
Take Screenshot: S (dots-2-3-4)

[bookmark: _Toc492454001][bookmark: _Toc26179926][bookmark: _Toc209372414]16.3 File Manager
[bookmark: _Toc492454002][bookmark: _Toc26179927][bookmark: _Toc209372415]16.3.1 Navigation Keys for the File and Menu List
Move to previous item: Space-1 or up scroll button
Move to next item: Space-4 or down scroll button
Move to the beginning of the list: Space-1-2-3 or Space-1-3
Move to the end of the list: Space-4-5-6 or Space-4-6

[bookmark: _Toc492454003][bookmark: _Toc26179928][bookmark: _Toc209372416]16.3.2 Navigation Keys for the File List
Jump to folder list or file list: Space-5-6
Move between file list and address window: Tab (Space-4-5 or F3) / shift-tab (Space-1-2 or Space-F3)
Enter selected folder or open selected file: Enter
Move up one folder level: Backspace
Jump to the top level of the disk: Space-1-2-5-6
Move up 32 items: Space-1-2-3 or F1-F2
Move down 32 items: Space-3-4-5 or F3-F4

[bookmark: _Toc492454004][bookmark: _Toc26179929][bookmark: _Toc209372417]16.3.3 Selection Commands
Select individual item: Space
Continuous selection: Enter-b (dots 1-2)
Select all: Enter-a (dot 1)

[bookmark: _Toc492454005][bookmark: _Toc26179930][bookmark: _Toc209372418]16.3.4 File Menu Commands
Open: Enter-o (dots 1-3-5)
Open in Document Reader: Backspace-R (dots-1-2-3-5)
Open with: Enter-e (dots 1-5)
Open in Second Notepad: Backspace-O (dots-1-3-5)
Zip: Enter-z (dots 1-3-5-6)
Unzip: Enter-u (dots 1-3-6)
Send To: Enter-s (dots 2-3-4)
Rename: Enter-r (dots 1-2-3-5)
New document: Enter-n (dots 1-3-4-5)
New folder: Enter-f (dots 1-2-4)
File conversion: Enter-t (dots 2-3-4-5)
Find file: Space-f (dots 1-2-4)
Find Text: Backspace-f (dots 1-2-4)
 Merge files: Enter-m (dots 1-3-4)
Split files: Enter-p (dots 1-2-3-4)
Information: Enter-i (dots 2-4)

[bookmark: _Toc492454006][bookmark: _Toc26179931][bookmark: _Toc209372419]16.3.5 Edit Menu Commands
Copy: Enter-c (dots 1-4)
Cut: Enter-x (dots 1-3-4-6)
Paste: Enter-v (dots 1-2-3-6)
Delete: Space-d (dots 1-4-5)
Select all: Enter-a (dot 1)

[bookmark: _Toc492454007][bookmark: _Toc26179932][bookmark: _Toc209372420]16.3.6 View Menu Commands
Sort files by: Enter-g (dots 1-2-4-5)
Set file info: Enter-l (dots 1-2-3)
Display only files of type: Enter-w (dots 2-4-5-6)
Hide system folders: Enter-h (dots-1-2-5)
Set start Folder: Backspace-S (dots-2-3-4)
Document Open Settings: Enter-D (dots-1-4-5)

[bookmark: _Toc209372421][bookmark: _Toc492454008][bookmark: _Toc26179933]16.4 Office Tools
[bookmark: _Toc209372422]16.4.1 Word Processor
[bookmark: _Toc492454009][bookmark: _Toc26179934][bookmark: _Toc209372423]16.4.1.1 File Menu Commands
New document: Enter-n (dots 1-3-4-5)
Open: Enter-o (dots 1-3-5)
Recent File List: Backspace-Enter-H (dots-1-2-5)
Opened Documents List: Backspace-Enter-O (dots-1-3-5)
Save: Enter-s (dots 2-3-4)
Save as: Space-s (dots 2-3-4)
Export: Backspace-Enter-X (dots-1-3-4-6)
Close current document: Space-q (dots 1-2-3-4-5)
Print: Space-p (dots 1-2-3-4)
Settings: Enter-e (dots 1-5)
Set File open method: Backspace-O (dots-1-3-5)
Dictionary: Backspace-Enter-d (dots 1-4-5)
Exit: Space-z (dots 1-3-5-6)

[bookmark: _Toc492454010][bookmark: _Toc26179935][bookmark: _Toc209372424]16.4.1.2 Edit Menu Commands
Start selection: Enter-b (dots 1-2)
Copy: Enter-c (dots 1-4) 
Add to the clipboard: Enter-p (dots 1-2-3-4)
Clear clipboard: Enter-d (dots 1-4-5)
Delete: Space-d (dots 1-4-5) 
Cut: Enter-x (dots 1-3-4-6) 
Paste: Enter-v (dots 1-2-3-6)
Delete blank lines: Backspace-e (dots 1-5)
Select all: Enter-a (dot 1)
Check spelling: Enter-k (dots 1-3)
Check spelling of the current word: Backspace-k (dots 1-3)

[bookmark: _Toc492454011][bookmark: _Toc26179936][bookmark: _Toc209372425]16.4.1.3 Insert Menu Commands
Insert from file: Enter-i (dots 2-4)
Insert date: Enter-w (dots 2-4-5-6)
Insert time: Backspace-w (dots 2-4-5-6)
Insert Page Break: Backspace-Space-Enter-p (dots-1-2-3-4)
Insert Tab: Backspace-Space-Enter-I (dots-2-4)
Insert Footnote: Backspace-Space-Enter-e (dots-1-5)
Insert Table: Control-Alt-t (dots-2-3-4-5)
Delete Table: Control-Alt-D (dots-1-4-5)


[bookmark: _Toc209372426][bookmark: _Toc492454012][bookmark: _Toc26179937]16.4.1.4 Mark Menu Commands
Set Mark: Enter-m (dots 1-3-4) 
Jump to mark: Enter-j (dots 2-4-5)
Delete Mark: Backspace-d (dots 1-4-5)
Mark List: Backspace-l (dots-1-2-3)

[bookmark: _Toc209372427]16.4.1.5 Go To Commands
Find: Space-f (dots 1-2-4) 
Find next: Enter-f (dots 1-2-4)
Find previous: Backspace-f (dots-1-2-4)
Find and Replace: Enter-r (dots 1-2-3-5) 
Go to location: Enter-l (dots 1-2-3)
Go To Previous Sentence: Space-2-3-6
Go To Next Sentence: Space-3-5-6
Go to previous page: Space-1-2-6 or F1-F2
Go to next page: Space-3-4-5 or F3-F4
Go to previous document: Tab (Space-1-2 or Space-F3)
Go to next document: Shift-tab (Space-4-5 or F3)
 
[bookmark: _Toc492454013][bookmark: _Toc26179938][bookmark: _Toc209372428]16.4.1.6 Read Commands
Read selected text: Backspace-b (dots 1-2) 
Read beginning of selected text: Enter-u (dots 1-3-6)
Read from beginning to cursor: Backspace-g (dots 1-2-4-5)
Read from cursor to end: Enter-g (dots 1-2-4-5)
Auto scroll: up-down scroll buttons
Read current paragraph: Space-2-3-5-6
Read Current Sentence: Space-1-4-5-6
Read current line: Space-1-4
Read current word: Space-2-5
Read current character: Space-3-6
Read status: Space-3-4
Read current cursor position: Space-1-5-6)
Read character and space count: Enter-3-4
Read Font info: Backspace-Enter-N (dots-1-3-4-5)
Read Paragraph Info: Backspace-Enter-Y (dots-1-3-4-5-6)

[bookmark: _Toc492454014][bookmark: _Toc26179939][bookmark: _Toc209372429]16.4.1.7 Layout Commands
Set font: Enter-backspace-f (dots 1-2-4)
Set Style: Backspace-Space-Enter-S (dots-2-3-4)
Bullets and Numbering: Backspace-Space-Enter-b (dots-1-2)
Print document layout: Backspace-t (dots 2-3-4-5)
Print paragraph layout: Backspace-2-3-4-6

[bookmark: _Toc492454015][bookmark: _Toc26179940][bookmark: _Toc209372430]16.4.1.8 Miscellaneous Hot Keys
Move forward by heading: Space-dots-2-5-6
Move backwards by heading: Space-2-3-5
Move forward by double Enter: Space-Enter-5-6
Move back by Double Enter: Backspace-Space-2-3
Open Link in BrailleSense Browser: Control-L (dots-1-2-3)
Open link in Android Browser: Alt-L (dots-1-2-3)
Delete current paragraph: Backspace-2-3-5-6
Delete current line: Backspace-1-4
Delete current word: Backspace-2-5
Delete current character: Space-d (dots 1-4-5)
Set view format characters: Space-1-4-6
Set reading unit: Space-2-4-6
Set read only: Space-3-4-6
Move back one slide in PPT: Backspace
Move forward one slide in PPT: Space
Go to Slide: Enter-L (dots-1-2-3)
Insert page break: Backspace-space-Enter-p (dots 1-2-3-4)
Insert tab: Backspace-Space-Enter-I (dots 2-4)
Center line: Backspace-Space-Enter-c (dots 1-4)
Left justify: Backspace-Space-Enter-J (dots-2-4-5)
Right justify: Backspace-Space-Enter-R (dots-1-2-3-5)
Bold On/off: Control-B (dots-1-2)
Italics On/off: Control-I (dots-2-4)
Underline On/Off: Control-U (dots-1-3-6)
Toggle Math Mode on/off: Backspace-m (dots 1-3-4) 
Adjust Outline Level: Control-dot-3 and alt-dot-6
Adjust font size: Control-dot-2 and Alt-dot-5
Move to previous table: Control-Alt-dots-3-4-5-6.
Move to next table: Control-Alt-dots-1-4-5-6.
Move up one cell in the Table: Control-Alt-dot 1.
Move down one cell in the Table: Control-Alt-dot 4.
Move left one cell in the Table: Control-Alt-dot 3.
Move right one cell in the Table: Control-Alt-dot 6.
Move to first cell in the Table: Control-Alt-dots-1-2-3.
Move to last cell in the Table: Control-Alt-dots-4-5-6.
Move to first cell in row: Control-Alt-dots-1-3.
Move to last cell in row: Control-Alt-dots-4-6.
Dictate text in document: F4-d (dots-1-4-5

[bookmark: _Toc26179941][bookmark: _Toc209372431]16.4.2 Notepad
[bookmark: _Toc26179942][bookmark: _Toc209372432]16.4.2.1 File Menu Commands
New document: Enter-n (dots 1-3-4-5)
New Notepad: Backspace-O (dots-1-3-5)
Open: Enter-o (dots 1-3-5)
Recent File List: Backspace-Enter-H (dots-1-2-5)
Opened Documents List: Backspace-Enter-O (dots-1-3-5)
Save: Enter-s (dots 2-3-4)
Save as: Space-s (dots 2-3-4)
Close current document: Space-q (dots 1-2-3-4-5)
Print to embosser: Space-p (dots 1-2-3-4)
Settings: Enter-e (dots 1-5)
Dictionary: Backspace-Enter-d (dots 1-4-5)
Exit: Space-z (dots 1-3-5-6)

[bookmark: _Toc26179943][bookmark: _Toc209372433]16.4.2.2 Edit Menu Commands
Start selection: Enter-b (dots 1-2)
Copy: Enter-c (dots 1-4) 
Add to the clipboard: Enter-p (dots 1-2-3-4)
Clear clipboard: Enter-d (dots 1-4-5)
Delete: Space-d (dots 1-4-5) 
Cut: Enter-x (dots 1-3-4-6) 
Paste: Enter-v (dots 1-2-3-6)
Delete blank lines: Backspace-e (dots 1-5)
Select all: Enter-a (dot 1)
Check spelling: Enter-k (dots 1-3)
Check spelling of the current word: Backspace-k (dots 1-3)

[bookmark: _Toc26179944][bookmark: _Toc209372434]16.4.2.3 Insert Menu Commands
Insert from file: Enter-i (dots 2-4)
Insert date: Enter-w (dots 2-4-5-6)
Insert time: Backspace-w (dots 2-4-5-6)
Insert Page Break: Backspace-Space-Enter-P (dots-1-2-3-4)
Insert tab: Backspace-Space-Enter-I (dots-2-4)

[bookmark: _Toc209372435][bookmark: _Toc26179945]16.4.2.4 Mark Menu Commands
Set Mark: Enter-m (dots 1-3-4) 
Jump to mark: Enter-j (dots 2-4-5)
Delete Mark: Backspace-d (dots 1-4-5)
Mark List: Backspace-M (dots-1-3-4)

[bookmark: _Toc209372436]16.4.2.5 Go To Commands
Find: Space-f (dots 1-2-4) 
Find next: Enter-f (dots 1-2-4)
Find previous: Backspace-f (dots-1-2-4)
Find and Replace: Enter-r (dots 1-2-3-5) 
Go to location: Enter-l (dots 1-2-3)
Go To Previous Sentence: Space-2-3-6
Go To Next Sentence: Space-3-5-6
Go to previous page: Space-1-2-6 or F1-F2
Go to next page: Space-3-4-5 or F3-F4
Go to previous document: Tab (Space-1-2 or Space-F3)
Go to next document: Shift-tab (Space-4-5 or F3)
 
[bookmark: _Toc26179946][bookmark: _Toc209372437]16.4.2.6 Read Commands
Read selected text: Backspace-b (dots 1-2) 
Read beginning of selected text: Enter-u (dots 1-3-6)
Read from beginning to cursor: Backspace-g (dots 1-2-4-5)
Read from cursor to end: Enter-g (dots 1-2-4-5)
Auto scroll: up-down scroll buttons
Read current paragraph: Space-2-3-5-6
Read Current Sentence: Space-1-4-5-6
Read current line: Space-1-4
Read current word: Space-2-5
Read current character: Space-3-6
Read status: Space-3-4
Read current cursor position: Space-1-5-6)
Read character and space count: Enter-3-4

[bookmark: _Toc26179947][bookmark: _Toc209372438]16.4.2.7 Layout Commands
Braille document layout: Backspace-p (dots 1-2-3-4)
Braille paragraph layout: Backspace-1-2-4-6

[bookmark: _Toc26179948][bookmark: _Toc209372439]16.4.2.8 Miscellaneous Hot Keys
Delete current paragraph: Backspace-2-3-5-6
Delete current line: Backspace-1-4
Delete current word: Backspace-2-5
Delete current character: Space-d (dots 1-4-5)
Set reading unit: Space-2-4-6
Set read only: Space-3-4-6
Compressed mode in Braille: Space-dots-1-2-4-6
Dictate text in document: F4-d (dots-1-4-5

[bookmark: _Toc492454016][bookmark: _Toc26179949][bookmark: _Toc209372440]16.4.3 E-mail
[bookmark: _Toc492454017][bookmark: _Toc26179950][bookmark: _Toc209372441]16.4.3.1 Hot Keys for the Inbox
Open "Accounts Manager”: Enter-m (dots 1-3-4)
Switch from Offline to Online mode (IMAP): Enter-dots1-2-3
Check for new mail: Enter-n (dots 1-3-4-5)
Receive old mail (IMAP): Backspace-p (dots1-2-3-4)
Move to previous account: Backspace-dots 1-2-6
Move to next account: Backspace-dots 3-4-5
Check current account: Space-3-4
Move to previous mailbox: Enter-dots 1-2-6
Move to next mailbox: Enter-dots 3-4-5
Write new message: Enter-w (dots 2-4-5-6)
Reply: Enter-r (dots 1-2-3-5)
Reply all: Backspace-r (dots 1-2-3-5)
Forward: Enter-f (dots 1-2-4)
Forward as attachment: Backspace-w (dots 2-4-5-6)
Open Set Path: Enter-T (dots 2-3-4-5)
Open Set Options: Enter-o (dots 1-3-5)
Open Set Spam: Enter-e (dots 1-5)
Find: Space-f (dots 1-2-4)
Find again: Backspace-f (dots 1-2-4)
Move to unread message: Enter-u (dots 1-3-4)
Move to mailbox: Backspace-x (dots 1-3-4-6)
Copy to mailbox: Backspace-c (dots 1-4)
Import messages: Backspace-I (dots-2-4)
Add a sender to the address list: Enter-i (dots 2-4) (This is valid only at the "from" item of the "inbox")
Delete current message: Space-d (dots 1-4-5) (valid only from the Subject and Date fields of the Inbox.
Delete current message permanently without moving to Trash: Backspace-D (dots-1-4-5)
Empty Trash: Enter-Backspace-q (dots 1-2-3-4-5)
Archive selected messages: Backspace-A (dot-1)
Set flag status: Backspace-Enter-F (dots-1-2-4)
Save current message as text file: Space-s (dots 2-3-4)
Save Attachment: Backspace-F (dots-1-2-4)
Print e-mail: Space-p (dots 1-2-3-4)
Cancel: Space-e (dots 1-5)
Cancel and exit e-mail program: Space-z (dots 1-3-5-6)

[bookmark: _Toc492454018][bookmark: _Toc26179951][bookmark: _Toc209372442]16.4.3.2 Hot keys for Sending E-mail
 Search address list: Enter-l (dots 1-2-3)
Attach file: Enter-f (dots 1-2-4)
Send e-mail: Enter-s (dots 2-3-4)
Save to Outbox: Space-s (dots 2-3-4)
Cancel: Space-e (dots 1-5)
Cancel and exit e-mail program: Space-z (dots 1-3-5-6)

[bookmark: _Toc492454019][bookmark: _Toc26179952][bookmark: _Toc209372443]16.4.3.3 Hot Keys for Reading/Writing an E-mail Message
RSVP to invitation: Backspace-Enter-I (dots-2-4)
Open Message in Web Browser: Backspace-O (dots-1-3-5)
Open link in message body: Enter-L (dots-1-2-3)
Open Link in Android Browser: Backspace-L (dots-1-2-3)
Start selection: Enter-b (dots 1-2)
Select all: Enter-a (dot 1)
Copy to the clipboard: Enter-c (dots 1-4)
Cut to the clipboard: Enter-x (dots 1-3-4-6) (Only available when writing a message)
Paste from the clipboard: Enter-v (dots 1-2-3-6) (only available when writing a message)
Delete selection/delete current character: Space-d (dots 1-4-5) 
Cancel selection: Space-e (dots 1-5)
Dictate text in document: F4-d (dots-1-4-5

[bookmark: _Toc492454030][bookmark: _Toc26179976][bookmark: _Toc209372444]16.4.4 Excel Viewer

[bookmark: _Toc26179977][bookmark: _Toc209372445]16.4.4.1 Navigation Commands
Move to next row: Space-Dot 4
Move to previous row: Space-Dot 1
Move to next column: Space-Dot 6
Move to previous column: Space-Dot 3
Move to beginning of row: Space-Dots 1-3
Move to end of row: Space-Dots 4-6
Move to top of column: Space-Dots 2-3
Move to bottom of column: Space-Dots 5-6
Move to top of worksheet: Space-1-2-3
Move to bottom of worksheet: Space-4-5-6
Move to next worksheet: Space-3-4-5
Move to previous worksheet: Space-1-2-6
Move to next group: Backspace-Dots 5-6
Move to previous group: Backspace-Dots 2-3
Move to next group in row: Space-Dot 5
Move to previous group in row: Space-Dot 2
Move to next group in column: Space-Dots 5-6
Move to previous group in column: Space-Dots 2-3

[bookmark: _Toc26179978][bookmark: _Toc209372446]16.4.4.2 File Commands
Open: Enter-o (dots 1-3-5)
Open Hyperlink: Enter-h (dots 1-2-5)
Open Hyperlink in Android browser: Backspace-l (dots-1-2-3)
Set User table: Enter-t (dots 2-3-4-5)
Cell properties: Enter-i (dots 2-4)
Quick Setup: Enter-x (dots 1-3-4-6)
Save as: Space-s (dots 2-3-4)

[bookmark: _Toc26179979][bookmark: _Toc209372447]16.4.4.3 Go To Commands
Find: Space-f (dots 1-2-4)
Find Next: Enter-f (dots 1-2-4)
Find Previous: Backspace-f (dots 1-2-4)
Move to cell: Enter-j (dots 2-4-5)
Next sheet: Space-3-4-5
Previous sheet: Space-1-2-6
Sheet list: Enter-l (dots 1-2-3)
Set Mark: Backspace-m (dots 1-3-4)
Go to Mark: Backspace-j (dots 2-4-5)
Delete Mark: Backspace-d (dots 1-4-5)

[bookmark: _Toc26179980][bookmark: _Toc209372448]16.4.4.4 Read Commands
Set Options: Backspace-o (dots 1-3-5)
Sheet title: Space-1-5-6
Read from top of column to cursor: Backspace-Dot 1
Read from cursor to bottom of column: Backspace-Dot 4
Read from beginning of row to cursor: Backspace-Dot 3
Read from cursor to end of row: Backspace-Dot 6
Read current row: Space-c (dots 1-4)
Read current column: Space-y (dots 1-3-4-5-6)
Read header cell of row: Backspace-c (dots 1-4)
Read header cell of column: Backspace-y (dots 1-3-4-5-6)
Read from beginning to cursor: Backspace-g (dots1-2-4-5)
Read from cursor to end: Enter-g (dots 1-2-4-5)
Read One character (When in Cell Activation): Space-Dots 3-6
Read Current Cell: Space-Dots 3-6
Read File Name: Space-Dots 3-4
Read Selected Text: Backspace-b (dots 1-2)

[bookmark: _Toc26179981][bookmark: _Toc209372449]16.4.4.5 View Commands
View Hide Sheet: Enter-s (dots 2-3-4)
View Hide Row: Enter-r (dots 1-2-3-5)
View Hide Column: Enter-y (dots 1-3-4-5-6)
Cell Activation: Enter 
Activation Cancel: Backspace
Set Time and Date: Enter-d (dots 1-4-5)

[bookmark: _Toc26179982][bookmark: _Toc209372450]16.4.4.6 Edit Commands
Start Selection: Enter-b (dots 1-2)
Select All: Enter-a (dot 1)
Copy Selected Text: Enter-c (dots 1-4)

[bookmark: _Toc492454020][bookmark: _Toc26179953][bookmark: _Toc209372451]16.5 Media
[bookmark: _Toc492454021][bookmark: _Toc26179954][bookmark: _Toc209372452]16.5.1 Media Player

[bookmark: _Toc26179955][bookmark: _Toc209372453]16.5.1.1 File Commands
Open file: Enter-o (dots 1-3-5)
Open folder: Enter-f (dots 1-2-4)
Add file: Backspace-o (dots 1-3-5)
Add folder: Backspace-f (dots 1-2-4)
Save playlist: Enter-i (dots 2-4)
Save as playlist: Space-s (dots 2-3-4)
Delete item: Space-d (dots 1-4-5)
Open URL: Enter-u (dots 1-3-6)
Get tag information: Enter-t (dots 2-3-4-5)

[bookmark: _Toc26179956][bookmark: _Toc209372454]16.5.1.2 Playback Commands
Play: Enter, Play button
Pause/play: Space, Play button
Stop: Backspace, Stop button
Previous track: Dot 3, Previous button
Next track: Dot 6, Next button
Back 5 tracks: Dots 2-3
Forward 5 tracks: Dots 5-6
First track: Dots 1-3
Last track: Dots 4-6
Volume up: Space-Up Scroll button
Volume down: Space-Down Scroll button
Speed up: Dots 3-4-5
Slow down: Dots 1-2-6
Toggle Video display: v (dots-1-2-3-6)
Change time index: Dot 2 or Dot 5
Move to next position by time index: Dot 4
Move to previous position by time index: Dot 1
Move to previous chapter: Space-2-3-6
Move to next chapter: Space-3-5-6
Open chapter list: enter-L (dots-1-2-3)
Delete playlist: Space-d (dots 1-4-5)
Set marked position: Enter-m (dots 1-3-4)
Delete marked position: Enter-d (dots 1-4-5)
Jump to marked position: Enter-j (dots 2-4-5)
Go to position: Enter-g (dots 1-2-4-5)
Set mark: Backspace-m (dots 1-3-4)
Move to mark: Backspace-j (dots 2-4-5)
Move to previous mark: Backspace-dot 3
Move to next mark: Backspace-dot 6
Delete mark: Backspace-d (dots 1-4-5)
Mark manager: Backspace-k (dots 1-3)
Configuration dialog: Backspace-c (dots 1-4)
Playback settings dialog: Enter-s (dots 2-3-4)
Record settings dialog: Backspace-s (dots 2-3-4)
Effect settings dialog: Enter-e (dots 1-5)

[bookmark: _Toc26179958][bookmark: _Toc209372455]16.5.1.3 Hot Keys in the Play Information Tab
Move to the next item: Space-dot-4
Move to the previous item: Space-dot-1
Open menu: F2 or Space-m (dots 1-3-4)
Open help: Space-h (dots 1-2-5)
Move to Playlist tab: Space-4-5/Space-1-2
Exit Media Player: Space-z (dots 1-3-5-6)

[bookmark: _Toc26179959][bookmark: _Toc209372456]16.5.1.4 Hot Keys in the Playlist Tab
Move to the next file: Space-4
Move to the previous file: Space-1
Move to the last file: Space-4-6
Move to the first file: Space-1-3
Play current file: Space
Start file selection: Enter-b (dots 1-2)
Start playing the selected files: Enter
Stop playing: Backspace
Delete the selected files from the playlist: Space-d (dots 1-4-5)
Move to "playback information" tab: Space-4-5/Space-1-2


[bookmark: _Toc492454022][bookmark: _Toc26179960][bookmark: _Toc209372457]16.5.2 FM Radio
Open the Presets dialog: Enter-e (dots 1-5)
Open the menu: Space-m (dots 1-3-4) or F2
Internal speakers on/off: Space-x (dots 1-3-4-6) 
Move to next frequency: Dot 6
Move to previous frequency: Dot 3
Autoscan backward: Dot 2, short press Previous button
Autoscan forward: Dot 5, short press Next button 
Go to frequency: Space-f (dots 1-2-4)
Move to previous preset: Dot 1, long press Previous button 
Move to next preset: Dot 4, long press Next button
Save preset: Enter-s (dots 2-3-4) or long press Record button
Delete preset: Space-d (dots 1-4-5) or long press Stop button
Open Record dialog: Enter-r (dots 1-2-3-5)
Record pause/resume: short press Record button
Stop recording: short press Stop button
Mute on: short press Stop button, Space
Mute off: short press Play button, Space
Volume up: Space-Up Scroll button
Volume down: Space-Down Scroll button

[bookmark: _Toc209372458]16.5.3 Podcasts
Move among items in a list: Space-dot-1 and Space-dot-4
Move between content areas: F3 and Space-F3
Search for podcasts: Enter-S (dots-2-3-4)
Import OPML: Enter-O (dots-1-3-5)
Export OPML: Enter-X (dots-1-3-4-6)
Clear Downloaded Files: Backspace-C (dots-1-4)
Options: Backspace-O (dots-1-3-5)
Insert Feed: Enter-I (dots-2-4)
Delete feed: Space-D (dots-1-4-5)
Subscribe from browser: Enter-J (dots-2-4-5)
Play/Download Current episode: Enter
Increase Playback Speed: dots-3-4-5
Decrease Playback Speed: dots-1-2-6
change playback position: press cursor router
[bookmark: _Hlk145083782]Move to previous chapter: Space-2-3-6
Move to next chapter: Space-3-5-6
Open chapter list: Enter-L (dots-1-2-3)
Close Playback Controls: F4

[bookmark: _Toc96521593][bookmark: _Toc209372459]16.5.4 Web Radio Commands
Open RadioSure Search: Backspace-E (dots-1-5)
Open Radio browser search: Backspace-o (dots-1-3-5)
Play Channel in Channel List: Enter.
Pause/Play: Space
Stop Playback: F4
Start/Stop Recording current channel: Enter-R (dots-1-2-3-5)
Volume Up: Space-Up Scroll button
Volume Down: Space-Down Scroll button
Playback Settings: Enter-S (dots-2-3-4)

[bookmark: _Toc209372460]16.5.5 Voice Recorder commands
Open the Record dialog: Record button or Enter-r (dots 1-2-3-5) 
Record: Record button or Enter
Pause/Continue recording: Record button or Space
Cancel Recording: F4 or Space-E (dots-1-5)
Stop: stop button or Enter-S (dots-2-3-4)
Play: Play button or Enter-P (dots-1-2-3-4)
Volume up: Space-Up Scroll button
Volume down: Space-Down Scroll button
Speed up: Dots 3-4-5
Slow down: Dots 1-2-6
Record settings: Backspace-S (dots-2-3-4)

[bookmark: _Toc209372461]16.5.6 Video search Commands
Go to Next page of Results: Enter-N (dots-1-3-4-5)
Add to favorites: Backspace-A (dot-1)
Favorites List: Backspace-L (dots-1-2-3)
Add to Playlist: Backspace-I (dots-2-4)
Playlist Manager: Enter-M (dots-1-3-4)
Subscribe to Channel: Enter-S (dots-2-3-4)
Delete Subscription: Space-D (dots-1-4-5)

[bookmark: _Toc209372462]16.6 library

[bookmark: _Toc492454023][bookmark: _Toc26179961][bookmark: _Toc209372463]16.6.1 DAISY Player
Read title: Space-dots 1-2-5-6
Open DAISY book: Enter-o (dots 1-3-5)
Recent Books: Backspace-Enter-H (dots-1-2-5)
Voice settings: Enter-s (dots 2-3-4)
Check book-info: Enter-i (dots 2-4)
Exit: Space-z (dots 1-3-5-6)
Play/Pause: Space
Go to beginning: Space-1-3 or Space-1-2-3
Go to end: Space-4-6 or Space-4-5-6
Increase volume: Backspace-dot-4
Decrease Volume: Backspace-dot-1
Increase Speed: Backspace-dot-5
Decrease Speed: Backspace-dot-2
Increase Pitch: Backspace-dot-6
Decrease Pitch: Backspace-dot-3
Move to the next page: Space-3-4-5
Move to the previous page: Space-1-2-6
Go to page: Enter-g (dots 1-2-4-5)
Select previous text/time unit: Dot 1
Select next text/time unit: Dot 4
Move to previous text/time unit: Dot 2
Move to next text/time unit: Dot 5
Select previous movement unit: Dots 2-3
Select next movement unit: Dots 5-6
Move to the previous unit: Dot 3 or short press Previous button
Move to the next unit: Dot 6 or short press Next button
Move to the next heading: Space-5 or long press Next button
Move to the previous heading: Space-2 or long press Previous button
Move to the last heading: Space-4-6
Move to the first heading: Space-1-3
Check the current-reading level and heading: Enter-w (dots 2-4-5-6)
Scan the heading list from the present to the end: Enter-n (dots 1-3-4-5)
Find heading: Space-f (dots 1-2-4)
Headings list: Enter-h (dots 1-2-5)
Find again: Enter-f (dots 1-2-4)
Set mark at current position: Enter-m (dots 1-3-4)
Move to the next mark: Space-dot 6
Move to the previous mark: Space-dot 3
Delete mark: Space-d (dots 1-4-5)
Create memo: Backspace-m (dots-1-3-4)
Read memo: Backspace-r (dots-1-2-3-5)
Read previous memo: Backspace-p (dots-1-2-3-4)
Read Next Memo: Backspace-n (dots-1-3-4-5)
Delete Memo: Backspace-d (dots-1-4-5)
Exit and erase position without prompt: Enter-z (dots-1-3-5-6)
Exit and erase marks without prompt: Backspace-z (dots-1-3-5-6)

[bookmark: _Toc209372464]16.6.2 Document Reader
File commands:
Open File: Enter-O (dots-1-3-5)
Recent Documents list: Enter-R (dots-1-2-3-5
Page Settings: Backspace-P (dots-1-2-3-4)
Voice Settings: Enter-S (dots-2-3-4)
Start Setting: Enter-e (dots-1-5)
Document information: Enter-I (dots-2-4)
Exit and Save Bookmark: Space-Z (dots-1-3-5-6)
Exit and remove bookmark: Enter-Z (dots-1-3-5-6)
Exit without saving bookmark: Backspace-Z (dots-1-3-5-6)

Edit Commands:
Start Selection: Enter-B (dots-1-2)
Copy: Enter-C (dots-1-4)
Add to Clipboard: Enter-P (dots-1-2-3-4)
Clear Clipboard: Enter-D (dots-1-4-5)
Select All: Enter-A (dot-1)

Read Commands:
Toggle Manual/continuous Read Mode: Enter.
Pause/resume reading: Space
Read Selected Text: Backspace-B (dots-1-2)
Read current page: Backspace.
Read current paragraph: Space-2-3-5-6.
Read current line: Space-1-4.
Read current sentence: dots-2-3-5-6.

Go To Commands:
Find: Space-F (dots-1-2-4)
Find Next: Enter-F (dots-1-2-4)
Find Previous: Backspace-F (dots-1-2-4)
Go to location: Enter-G (dots-1-2-4-5-
Go to Headings list: Enter-T (dots-2-3-4-5)
Go to Previous Heading: Backspace-Space-2-3-5
Go to Next heading: Backspace-Space-2-5-6
Move back by double Enter: Backspace-Space-2-3.
Move forward by Double Enter: Space-Enter-5-6.

Mark Commands:
Set Mark: enter-M (dots-1-3-4)
Move to Mark: Enter-J (dots-2-4-5)
Delete Mark: Space-D (dots-1-4-5)
Next Mark: Enter-N (dots-1-3-4-5)
Previous Mark: Backspace-M (dots-1-3-4)
Mark Manager; enter-k (dots-1-3)
Mark Alert options: Backspace-O (dots-1-3-5)

[bookmark: _Toc492454031][bookmark: _Toc26179983][bookmark: _Toc209372465]16.6.3 Online DAISY
Move between category and booklist: F3 and Space-F3
Move among list items: Space-1 and Space-4
Download book: Enter
Return book: Enter-r (dots 1-2-3-5)

[bookmark: _Toc209372466]16.6.4 BookShare Download
Move to next Control: F3
Move to previous control: Space-F3
Move to next item in list: Space-dot-4
Move to Previous item in List: Space-dot-1
Subscribe to reading list: Enter-S (dots-2-3-4)
Unsubscribe from reading list: Space-D (dots-1-4-5)
Options: Enter-O (dots-1-3-5)

[bookmark: _Toc209372467]16.6.5 Sense Dictionary
Install Dictionary Data: enter-I (dots-2-4)
Listen to pronunciation: Space 
Move to next line: Space-4 
Move to previous line: Space-1 
Move to next definition or phrase: Space-5-6 
Move to previous definition or phrase: Space-2-3 
Move to previous origin or part of speech: Space-2-3-6
Move to next origin or part of speech: Space-3-5-6 
Move to previous character: Space-dot-3 
Move to next character: Space-dot-6 
Move to previous word: Space-dot-2 
Move to next word: Space-dot-5 
Switch between previous and most recently searched words: Backspace
Bring up the history list: Enter-H (dots-1-2-5)
Clear the history list: Backspace-D (dots-1-4-5)
Move to next item in the history list: Space-dot 4 
Move to previous item in the history list: Space-dot-1

[bookmark: _Toc492454024][bookmark: _Toc26179962][bookmark: _Toc209372468]16.7 Organizer
[bookmark: _Toc492454025][bookmark: _Toc26179963][bookmark: _Toc209372469]16.7.1 Address Manager

[bookmark: _Toc26179964][bookmark: _Toc209372470]16.7.1.1 Navigation When Adding an Address
Move to the previous field or menu item: Space-1 or Up Scroll button
Move to the next field or menu item: Space-4 or Down Scroll button
Move to the first field or menu item: Space-1-2-3
Move to the last field or menu item: Space-4-5-6

[bookmark: _Toc26179965][bookmark: _Toc209372471]16.7.1.2 Navigation in Search Results List
Move to the previous record: Space-1 or Up Scroll button
Move to the next record: Space-4 or Down Scroll button
Move to the first record: Space-1-2-3
Move to the last record: Space-4-5-6
Move to Record information: F3
Sort Options: Backspace-s (dots-2-3-4
Set Search Fields: enter-o (dots-1-3-5)
Set save Fields: Backspace-v (dots-1-2-3-6)


[bookmark: _Toc26179966][bookmark: _Toc209372472]16.7.1.3 General Commands
Add address: Enter-i (dots 2-4)
Find address: Enter-s (dots 2-3-4)
Edit address: Enter-m (dots1-3-4)
Delete address: Space-d (dots 1-4-5)
Select all: Enter-a (dot 1)
Save as a file: Enter-t (dots 2-3-4-5)
Print address: Space-p (dots 1-2-3-4)
Backup address list: Enter-u (dots 1-3-6)
Restore address list: Enter-r (dots 1-2-3-5)
Set backup options: Enter-e (dots 1-5)
Setting add/searching address fields: Enter-o (dots 1-3-5)
Import from CSV: Backspace-i (dots 2-4)
Export to CSV: Backspace-x (dots 1-3-4-6)

[bookmark: _Toc492454026][bookmark: _Toc26179967][bookmark: _Toc209372473]16.7.2 Schedule Manager

[bookmark: _Toc26179968][bookmark: _Toc209372474]16.7.2.1 General Commands
Move to the next field: Space-4-5 or F3
Move to the previous field: Space-1-2 or Space-F3
Add appointment: Enter-i (dots 2-4)
Search appointments: Enter-s (dots 2-3-4)
Modify appointment: Enter-m (dots 1-3-4)
Delete appointment: Space-d (dots 1-4-5)
Delete all appointments: Backspace-Enter-q (dots1-2-3-4-5)
Backup appointments: Enter-u (dots 1-3-6)
Restore appointments: Enter-r (dots 1-2-3-5)
Set backup options: Enter-e (dots 1-5)
Alarm options: Enter-o (dots 1-3-5)
Save appointments as file: Enter-t (dots 2-3-4-5)
Print appointments: Space-p (dots 1-2-3-4)
Refresh sync with cloud: Backspace-R (dots-1-2-3-5)
[bookmark: _Toc26179969][bookmark: _Toc209372475]16.7.2.2 Navigating Search Results
Move to the previous appointment: Space-2
Move to the next appointment: Space-5
Move to the first appointment: Space-2-3 or Space-1-2-3
Move to the last appointment: Space-5-6 or Space-4-5-6
Move to the previous appointment on the same day: Space-1 or Up Scroll button
Move to the next appointment on the same day: Space-4 or Down Scroll button
Move to the first appointment on the same day: Space-1-3
Move to the last appointment on the same day: Space-4-6
Open Link in Android Browser: Backspace-L (dots-1-2-3)
Open Link in BrailleSense Browser: Enter-L (dots-1-2-3)

[bookmark: _Toc209372476]16.7.3 Database Manager
Move to the next control: Tab (Space-4-5 or F3)
Move to the previous control: Shift-Tab (Space-1-2 or Space-F3)
Move to the next list item: Space-4 or down scroll button
Move to the previous list item: Space-1 or up scroll button 
Table Manager: enter-T (dots-1-2-4-5)
Create New Table from CSV: Enter-X (dots-1-3-4-6)
Add Table: Enter-A (dot-1)
Modify Table: (Enter-M (dots-1-3-4)
Delete Table: Space-D (dots-1-4-5)
Set as Default Table: Enter-D (dots-1-4-5)
Insert New Record: Enter-I (dots-2-4)
Import Records from CSV: Backspace-I (dots-2-4)
Search records: Enter-s (dots 2-3-4)
Move to the next record: Space-4 or down scroll button
Move to the previous record: Space-1 or up scroll button
Move to the last record: Space-4-5-6 
Move to the first record: Space-1-2-3
Move to the next field: Space-5
Move to the previous field: Space-2
Move to previous same field different record: Space-3
Move to next same field different record: Space-6
Move to the last field: Space-4-6 
Move to the first field: Space-1-3
Set backup options: Enter-e (dots 1-5)
Backup database: Enter-u (dots 1-3-6)
Restore database: Enter-o (dots 1-3-5)

[bookmark: _Toc209372477]16.7.4 ToDo List Commands
New Task: Enter-n (dots-1-3-4-5)
Modify Task: Enter-m (dots-1-3-4)
Delete Task: Space-d (dots-1-4-5)
Archive Task: Backspace-a (dot-1)
Mark as Not Started: Backspace-n (dots-1-2-4-5)
Mark as In Progress: Backspace-p (dots-1-2-3-4)
Mark as Completed: Backspace-c (dots-1-4)
Search Tasks: Space-f (dots-1-2-4)
Show Archive List: Alt-a (dot-1)
Backup ToDo List: Enter-u (dots-1-3-6)
Restore ToDo List: Enter-r (dots-1-2-3-5)
Set Backup Options: Enter-e (dots-1-5)
Options: Backspace-o (dots-1-3-5)

[bookmark: _Toc492454027][bookmark: _Toc26179970][bookmark: _Toc209372478]16.8 Web tools
[bookmark: _Toc492454028][bookmark: _Toc26179971][bookmark: _Toc209372479]16.8.1 Web Browser

[bookmark: _Toc26179972][bookmark: _Toc209372480]16.8.1.1 General Commands
Open URL: Enter-u (dots 1-3-6)
Open: Enter-o (dots 1-3-5)
Open New web Session: Backspace-o (dots-1-3-5)
Save as: Space-s (dots 2-3-4)
File Download Dialog: Backspace-3-4
Refresh: Space-Enter-r (dots 1-2-3-5)
Exit: Space-z (dots 1-3-5-6)
Select All: a (dot-1)
Start selection: Enter-b (dots 1-2)
Copy: Enter-c (dots 1-4)
Copy Address Bar: Backspace-d (dots 1-4-5)
Copy link: Enter-l (dots 1-2-3)
Add to clipboard: Space-p (dots 1-2-3-4)
Read from beginning to cursor: Backspace-g (dots 1-2-4-5)
Read from cursor to end: Enter-g (dots 1-2-4-5)
Auto scroll: Up Scroll button-Down Scroll button
Go to home page: Backspace-Space-h (dots 1-2-5)
Go to previous page: Backspace-p (dots 1-2-3-4)
Go to next page: Enter-P (dots-1-2-3-4)
Go to previous heading: Backspace-h (dots 1-2-5)
Go to next heading: Enter-h (dots-1-2-5)
Go to Headings List: Backspace-Space-h (dots-1-2-5)
Go to Previous Link: Backspace-k (dots-1-3)
Go to Next Link: Enter-k (dots-1-3)
Go To Links list: Backspace-Space-K (dots-1-3)
Go to Previous Element: Space-b (dots-1-2)
Go to Next Element: Space-4-5
Go to Previous Form control: Backspace-dots-1-2-3-4-5-6
Go to Next Form Control: Enter-dots-1-2-3-4-5-6
Go to previous text chunk: Backspace-q (dots-1-2-3-4-5)
Go to next text chunk: Enter-q (dots-1-2-3-4-5)
Go to Previous Table: Backspace-t (dots-2-3-4-5)
Go to Next Table: Enter-t (dots-2-3-4-5)
Go to previous visited link: backspace-v (dots-1-2-3-6)
Go to next visited link: Enter-v (dots-1-2-3-6)
Open the history list: Space-Enter-h (dots 1-2-5)
Find: Space-f (dots 1-2-4)
Find Previous: Backspace-f (dots-1-2-4)
Find Next: Enter-f (dots 1-2-4)
Set current as your home page: Enter-s (dots 2-3-4)
Add to favorites: Backspace-a (dot 1)
Favorites list: Backspace-l (dots 1-2-3)
Import from Favorites: Backspace-I (dots-2-4)
settings: Backspace-s (dots2-3-4)

[bookmark: _Toc26179974][bookmark: _Toc209372481]16.8.1.2 Hot Keys for Reading Web Pages
Move to Top of page: Space-1-2-3.
Move to End of page: Space-4-5-6.
Go to previous heading level 1-6: Control-1 to Control-6.
Go to Next Heading Level 1-6: Alt-1 to Alt-6.
Move to previous general item: Space-1.
Move to Next General item: Space-4
Move to previous word in Text control: Space-2.
Move to Next Word in Text Control: Space-5.
Move to Previous Character in Text Control: Space-3.
Move to next Character in Text Control: Space-6.
Move up one cell in the Table: Control-Alt-dot 1.
Move down one cell in the Table: Control-Alt-dot 4.
Move left one cell in the Table: Control-Alt-dot 3.
Move right one cell in the Table: Control-Alsst-dot 6.
Move to first cell in a Table: Control-Alt-dots-1-2-3.
Move to last cell in a Table: Control-Alt-dots-4-5-6.
Move to first cell in row: Control-Alt-dots-1-3.
Move to last cell in row: Control-Alt-dots-4-6.

[bookmark: _Toc492454032][bookmark: _Toc26179984][bookmark: _Toc209372482]16.9 Utilities
[bookmark: _Toc492454033][bookmark: _Toc26179985][bookmark: _Toc209372483]16.9.1 Calculator
Clear calculator: Backspace-c (dots 1-4)
Delete numbers or operators: Backspace
Calculation history: Enter-h (dots 1-2-5)
General functions: Enter-g (dots 1-2-4-5)
PI: Enter-p (dots 1-2-3-4)
Exp: Enter-e (dots 1-5)
Trigonometric Functions: Enter-s (dots 2-3-4)
Sine: Enter-s (dots 2-3-4), s (dots 2-3-4)
Arc Sine: Enter-s (dots 2-3-4), a (dot 1)
Hyperbolic Sine: Enter-s (dots 2-3-4), h (dots 1-2-5)
Cosine: Enter-i (dots 2-4), i (dots 2-4)
Arc Cosine: Enter-i (dots 2-4), a (dot 1)
Hyperbolic Cosine: Enter-i (dots 2-4), h (dots 1-2-5)
Tangent: Enter-t (dots 2-3-4-5), t (dots 2-3-4-5)
Arc Tangent: Enter-t (dots 2-3-4-5), a (dot 1)
Hyperbolic Tangent: Enter-t (dots 2-3-4-5), h (dots 1-2-5)
Logarithm Function: Enter-l (dots 1-2-3)
Natural Logarithm: Enter-l (dots 1-2-3), e (dots 1-5)
Common Logarithm: Enter-l (dots 1-2-3), n (dots 1-3-4-5)
Recall Items: Backspace-r (dots 1-2-3-5)
Delete all saved items: Enter-d (dots 1-4-5)
Save Items: Backspace-s (dots 2-3-4)
Convert Unit: Enter-u (dots 1-3-6)
Copy to Clipboard: Enter-c (dots 1-4)
Option Settings: Enter-o (dots 1-3-5)
Fraction options: Space-dots 3-4
Return formula: Enter-r (dots1-2-3-5)
Change Math Braille code: Backspace-g (dots1-2-4-5)

[bookmark: _Toc26179986][bookmark: _Toc209372484]16.9.2 BrailleSense Math

[bookmark: _Toc26179987][bookmark: _Toc209372485]16.9.2.1 File Menu Commands
Export: Enter-E (dots-1-5)
Import: “Enter-I (dots-2-4)
Save to History: “Space-S (dots-2-3-4)
History: “Enter-H (dots-1-2-5)
Save Graph As Braille: “Enter-F (dots-1-2-4)
Exit: “Space-Z (dots-1-3-5-6)

[bookmark: _Toc26179988][bookmark: _Toc209372486]16.9.2.2 The Edit Menu
Copy: “Enter-C (dots-1-4)
Cut: “Enter-X” (dots-1-3-4-6)
Paste: “Enter-V (dots-1-2-3-6)
Delete: “Space-D (dots-1-4-5)
Select All: “Enter-A (dot-1)
Start Selection: “Enter-B (dots-1-2)
Copy Graph: “Enter-G (dots-1-2-4-5)
Symbol picker: “Backspace-S (dots-2-3-4)
Set Math Code: “Backspace-G (dots-1-2-4-5)

[bookmark: _Toc26179989][bookmark: _Toc209372487]16.9.2.3 The Graph Menu
Axis: “Backspace-X (dots-1-3-4-6) 
Graph label: “Backspace-L (dots-1-2-3)
Graph Style: Backspace-C (dots-1-4) 
Show/Hide graph: “Backspace-H (dots-1-2-5) 

[bookmark: _Toc26179990][bookmark: _Toc209372488]16.9.2.4 The Output Menu
Display Tactile Graph: Enter-T (dots-2-3-4-5) 
Send to Embosser: Enter-P (dots-1-2-3-4) 

[bookmark: _Toc492454034][bookmark: _Toc26179991][bookmark: _Toc209372489]16.9.3 Display Compass Heading
Open Display Compass Heading: Space-F3-F4
Move to the next control: Space-4-5 or F3
Move to the previous control: Space-1-2 or Space-F3
Change compass display type: Backspace or Space
Exit: Space-z (dots 1-3-5-6) or Space-e (dots 1-5)

[bookmark: _Toc492454036][bookmark: _Toc26179994][bookmark: _Toc209372490]16.9.4 Terminal for Screen Reader
Enter terminal Clipboard: Space-Enter-i (dots 2-4) 
Send Terminal Clipboard content: Enter-s (dots 2-3-4) 
Exit terminal for Screen reader: Space-Backspace-z (dots 1-3-5-6) 

[bookmark: _Toc26179995][bookmark: _Toc209372491]16.9.5 Macro Commands
Start/stop recording Macro: F2-R (dots-1-2-3-5)
Insert Delay Time: F2-D (dots-1-4-5)
Execute Macro: F2-e (dots-1-5)
Macro Manager: F2-L (dots-1-2-3)

[bookmark: _Toc26179996][bookmark: _Toc209372492]16.9.6 Other Utility Commands
Display network status: Space-n (dots 1-3-4-5)
Display power status: Space-1-6
Format: Space-1-2-3 on startup
Check upgrade download progress: Space-i (dots 2-4)

[bookmark: _Toc209372493]16.10 Clock and Timer
[bookmark: _Toc492454038][bookmark: _Toc26179998][bookmark: _Toc209372494]16.10.1 Setting Time and Date
Move to the next day: Space-6
Move to the previous day: Space-3
Move to the next week: Space-5
Move to the previous week: Space-2
Move to the next month: Space-4
Move to the previous month: Space-1
Move to the next year: Space-5-6
Move to the previous year: Space-2-3
Move to 1 hour after: Space-4
Move to 1 hour before: Space-1
Move to 10 minutes after: Space-5
Move to 10 minutes before: Space-2
Move to 1 minute after: Space-6
Move to 1 minute before: Space-3
Switch between A.M. and P.M.: Space-x (dots 1-3-4-6)

[bookmark: _Toc26179992][bookmark: _Toc209372495][bookmark: _Toc492454035]16.10.2 Alarm
Add Alarm: Enter-A (dot-1)
Modify Alarm: Enter-M (dots-1-3-4)
Delete Alarm: Space-D (dots-1-4-5)

[bookmark: _Toc26179993][bookmark: _Toc209372496]16.10.3 Stopwatch
Stopwatch start, pause, restart: Enter
Check the elapsed time: Backspace
Stop and restart Braille display: Space-F2
Switch between stopwatch and countdown timer: Space-4-5 or Space-1-2
Count down timer pause or restart: Enter
Count down timer Initialize: Backspace
Exit stopwatch or countdown timer: Space-z (dots 1-3-5-6)

[bookmark: _Toc209372497]16.10.4 Other Clock and Timer Commands
Set Sleep Timer: Space-j (dots 2-4-5)
Check date and time: Space-t (dots 2-3-4-5)

[bookmark: _Toc492454037][bookmark: _Toc26179997][bookmark: _Toc209372498]16.11 Settings
[bookmark: _Toc492454039][bookmark: _Toc26179999][bookmark: _Toc209372499]16.11.1 Bluetooth Manager
Rescan for Bluetooth devices: Enter-r (dots 1-2-3-5)
Connect device: enter on the device name
Connect service: enter on the service name
Disconnect the service in Bluetooth service list: Enter-d (dots 1-4-5)
Move to Bluetooth device list in service list: Backspace
Remove device settings in Bluetooth device list: Space-d (dots 1-4-5)

[bookmark: _Toc492454040][bookmark: _Toc26180000][bookmark: _Toc209372500]16.11.2 Backup/Restore Personalized Settings
Move to previous item: Space-1 or up scroll button
Move to next item: Space-4 or down scroll button
Move to previous control: Shift-tab (Space-1-2 or Space-F3)
Move to next control: Tab (Space-4-5 or F3)
Select/unselect check box: Space
Backup: Enter-b (dots 1-2)
Restore: Enter-r (dots1-2-3-5)

[bookmark: _Toc492454041][bookmark: _Toc26180001][bookmark: _Toc209372501]16.11.3 Password Protection.
Set password: Enter-i (dots 2-4)
Modify password: Enter-m (dots 1-3-4)
Password configuration: Enter-c (dots 1-4)
Reset to factory defaults: i (dots 2-4)

[bookmark: _Toc492454042][bookmark: _Toc26180002][bookmark: _Toc209372502]16.12 Screen Reader Commands
[bookmark: _Toc492454043][bookmark: _Toc26180003][bookmark: _Toc209372503]16.12.1 Moving Focus
Move to next object: Space-4-5 or F3
Move to previous object: Space-1-2 or Space-F3
Move to object directly above: Space-2-3
Move to object directly below: Space-5-6
Move to previous heading: Backspace-H (dots-1-2-5)
Move to next heading: Enter-H (dots-1-2-5)
Move to previous form control: Backspace-dots-1-2-3-4-5-6
Move to next form control: Enter-dots-1-2-3-4-5-6
Move to previous list item: Backspace-I (dots-2-4)
Move to next list item: Enter-I (dots-2-4)
Move to top of screen: Space-1-2-3
Move to bottom of screen: Space-4-5-6
Scroll down one screen: Space-3-4-5
Scroll up one screen: Space-1-2-6
Execute current item: Enter or Cursor routing key
Back button: Space-e, F4 or Space-Z
Move to specific object: press first letter of object name
Go to Home screen: F1
Activate App Actions Menu: Enter-I on focused app
Open Notification Shade: Space-1-2-3-4-5-6
Activate Notification: Enter
Delete notification: Space-D (dots-1-4-5)
Clear all notifications: Space-Enter-D (dots-1-4-5)
Activate Edit Box: Enter
Increase Slider Value: Backspace-Space-4
Decrease Slider Value: Backspace-Space-1
Refresh list: Enter-R (dots-1-2-3-5)
Double Tap: Space-Enter
Double Tap and Hold: Backspace-Space-Enter
Start/Stop Hold: Backspace-Space-Dot-2
Create label: Enter-L (dots-1-2-3)
Open Shortcuts list: Backspace-I (dots-2-4)
Reset BrailleSense Launcher: F2-F3-1-2-3-4-5-6-7-8

[bookmark: _Toc492454044][bookmark: _Toc26180004][bookmark: _Toc209372504]16.12.2 When Editing Text
Go to next character: Space-6
Go to previous character: Space-3
Go to next word: Space-5
Go to previous word: Space-2
Go to next line: Space-4
Go to previous line: Space-1
Go to next paragraph: Space-5-6
Go to previous paragraph: Space-2-3
Go to beginning of paragraph: Space-1-3
Go to end of paragraph: Space-4-6
Go to top of document: Space-1-2-3
Go to bottom of document: Space-4-5-6
Delete current character: Space-1-4-5
Delete previous character: Backspace
Delete current word: Backspace-2-5
Delete current line: Backspace-1-4
Delete current paragraph: Backspace-2-3-5-6
Move to next display length: Down Scroll
Move to previous display length: Up Scroll

[bookmark: _Toc492454045][bookmark: _Toc26180005][bookmark: _Toc209372505]16.12.3 Media Key Functions when in "App Mode"
Open Main menu: Stop button
Recent Apps: Play button
Back: Record button
Move to previous object: Previous button
Move to next object: Next button
Android Media play/Pause: Hold Play button
Android previous track: Hold Previous button
Android Next track: hold Next button
Mobile Screen Reader on-off: Stop and Next buttons
Call Google Voice Assistant: Record and Play buttons




 10 
 

